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Préface
Ce manuel présente tous les produits Lookout™ basés sur Windows, y
compris les systèmes de développement Runtime, les systèmes
“Runtime-only” et Lookout Express™.

Identification du produit

Les symboles suivants indiquent qu’une portion du texte exclut un
système Lookout particulier :

e

N’est pas disponible sur les systèmes “Runtime-Only”
e

N’est pas disponible sur les systèmes Lookout Express

Ces symboles apparaissent à côté des titres de chapitres, des en-têtes de
sections et des paragraphes, selon le cas.

Les caractéristiques et les fonctions qui ne sont pas disponibles sur
Lookout Express sont entre autres :

• La base de données historique Citadel™ (enregistrement de données
historiques)

• L’HyperTrend™ (tendances en temps réel et historique combinées)

• L’enregistrement et l’impression d’une alarme/événement
(l’affichage et l’acquittement d’alarmes sont supportés)

• La redondance Lookout (c’est-à-dire la caractéristique Standby)
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• Quelques classes d’objets, à savoir DDETable (tableau DDE),
Interpolate (insertion), Spreadsheet (feuille de calcul), Neutralzone
(hystérésis), Junction (jonction), Playwave, Event (événement) et
Run (exécution)

• L’impression du panneau (affiche la copie sur papier)

Conventions typographiques

Ce document utilise les conventions typographiques suivantes :

Convention
format

Type d’informations Exemple

Flèche (→) Sépare les sélections d’une barre
de menu des sélections d’un
menu déroulant

File→Save As…

(Fichier→Enregistrer sous…)

Caractères gras Nom d’un champ d’entrée de
données d’une boîte de dialogue

Nom du champ

Caractères Courier Ce que vous tapez, par exemple,
le contenu d’un champ d’entrée
de données d’une boîte de
dialogue, ou bien une expression

nomdefichier.lkp

Majuscules Le nom d’une touche sur le clavier (EFFACER)

Caractères
italiques

Un terme spécial ou une
référence croisée

Reportez-vous au chapitre 4
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1. Introduction

Bienvenue
Félicitations ! Vous avez maintenant à votre disposition le meilleur
logiciel d'automatisation de l'industrie. Que vous ayez l'intention de
l'utiliser comme SCADA (contrôle de supervision et acquisition de
données) ou simple IHM (Interface Homme-Machine), Lookout
représente la solution idéale pour vos applications de traitement en
continu ou par lot.

Lookout est entièrement orienté objet et événementiel : une architecture
toute nouvelle dans l'industrie des logiciels d’automatisation industrielle.
Cette architecture fait de Lookout l’IHM la plus rapide qui soit. Pour
une description détaillée, voir la section intitulée L’architecture, à
partir de la page 5.

L'architecture unique du système Lookout vous permet de développer
une application entièrement en ligne, sans aucun arrêt, ne serait-ce que
pendant une seconde. Vous n'avez pas à recompiler et/ou télécharger une
base de données chaque fois que vous apportez une modification ni à
basculer d'un programme à un autre. Vous n'avez même pas à exécuter
des programmes différents de développement/configuration. En
revanche, vous pouvez ajouter, supprimer et modifier des panneaux de
contrôle, de la logique, des graphes, des API (Automates Programmables
Industriels), des téléterminaux, des E/S et autres périphériques de terrain
sans interrompre votre processus. Cela signifie que vous pouvez voir les
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valeurs des champs changer sur vos panneaux de contrôle et même
répondre aux alarmes pendant que vous éditez votre processus.

Etant donné que vous n'avez pas à passer constamment des progiciels de
développement aux progiciels d'exécution, vous économisez beaucoup
de temps et d'argent. Et du fait que vous n'avez pas à compiler des bases
de données ni à écrire des scripts (ou même comprendre leur concept),
vous n'avez plus d'angoisse devant un moniteur vide ou un message
d'erreur compilateur à déchiffrer.

La facilité d'exécution ne s'arrête pas là. Grâce à la simplicité,
l'homogénéité et la bonne conception de Lookout, votre période
d'apprentissage et donc votre période de développement se trouvent
considérablement réduites, de même que vos angoisses, maux d'estomac
et maux de tête.

Du fait que le système Lookout n'exige pas l'exécution simultanée d'une
demi-douzaine de programmes, et en raison de la vitesse supérieure
inhérente à sa structure orientée objet et événementielle, vous pouvez
facilement utiliser Lookout avec d'autres programmes dans
l'environnement multitâches Windows de Microsoft. Pendant que
Lookout contrôle votre processus, vous pouvez ouvrir une feuille de
calcul pour créer un graphe contenant les chiffres de production du mois
en cours ou les taux moyens de débit horaire du jour précédent, puis
lancer un traitement de texte pour générer un document, y coller le
graphe et l'envoyer à une imprimante laser.

Le reste de ce chapitre décrit l'architecture unique du système Lookout.
Il couvre les éléments de base nécessaires pour comprendre comment
Lookout peut fournir la solution répondant exactement à vos
applications de traitement en continu et/ou par lot.
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L’architecture
Le concept essentiel de Lookout réside dans son architecture unique.
Une fois que vous connaîtrez bien les éléments fondamentaux de sa
structure orientée objet et événementielle, tout le reste vous semblera
logique.

Qu'entend-on par Objet ?
Un objet est entièrement autonome. Il possède une base de données
prédéfinie, un jeu de paramètres et une fonctionnalité intégrée. Le
diagramme suivant représente la fonctionnalité, les données membres et
les paramètres d'un objet.

données membres
logiques

données membres
textuelles

données membres
numériques

Un objet renferme ses données, ses paramètres et sa fonctionnalité.

Pensez à un objet comme à la représentation logicielle d'une chose
concrète, comme par exemple, un interrupteur électrique. Vous pouvez
faire en sorte qu'il allume ou éteigne la lumière. Dans Lookout, l'objet
Switch (booléen) représente l'interrupteur électrique concret. La
fonctionnalité de l'objet vous permet d'allumer ou d'éteindre la lumière.
Ses paramètres définissent les limites de sa fonctionnalité. Par exemple,
le paramètre Security Level (niveau de sécurité)  de l'objet Switch
(booléen) détermine qui peut allumer et éteindre. La base de données de
l'objet comprend la valeur qui indique la position réelle de l'interrupteur.
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La base de données  
Chaque objet possède sa propre base de données intégrée. Certaines
classes d'objets (ou types d'objets) ont des bases de données très
restreintes, alors que d'autres ont des bases de données étendues. La base
de données d'un objet représentant un API peut être composée de
milliers de données membres, alors que celle de l'objet Switch (booléen)
n'en a que deux. Vous ne construisez pas la base de données d'un objet
car elle est automatiquement disponible lorsque vous créez l'objet.

Les paramètres
Les paramètres d'un objet aident à définir ses caractéristiques ou sa
nature. Lookout utilise les paramètres d'un objet pour compléter la
définition de la fonctionnalité de cet objet. Par exemple, Data Rate
(débit) , Parity (parité) , et Stop Bits (bits d’arrêt)  sont trois paramètres
parmi ceux qui définissent le fonctionnement d'un objet Modbus.

Les fonctions
Pensez aux fonctions comme à la manière dont un objet fonctionne ou
accomplit une tâche. La fonctionnalité est un concept général qui
s'applique de la même façon à tous les objets d'une classe d'objets
donnée, tandis que les paramètres peuvent être uniques et aident à
définir la fonctionnalité spécifique d'un objet particulier.

Les classes d'objets

Un objet est simplement un élément particulier d'une classe particulière
d'objets. Par exemple, un Potentiomètre et un Interrupteur représentent
des classes d'objets différentes, mais vous pouvez créer 20
potentiomètres et 30 interrupteurs, soit en tout 50 objets, en n'utilisant
que deux classes d'objets.

Le système Lookout possède une immense bibliothèque de classes
d'objets. Pour créer un objet, vous choisissez simplement la classe
d’objets voulue dans la liste de Lookout. Cela définit le type d'objet que
vous désirez. Puis vous donnez un nom unique à l'objet (nom de
variable) et définissez ses paramètres.
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La connexion des objets

Dans Lookout, vous connectez des objets afin de permettre aux signaux
de passer entre les objets quasiment de la même manière que si vous
câbliez un relais à action différée à un relais de démarrage moteur. Ceci
peut se faire en connectant les uns aux autres les membres de la base de
données des objets ou en connectant les membres de la base de données
aux paramètres.

 Exemple de connexions entre deux objets

Vous pouvez par exemple identifier la donnée membre numérique d'un
objet Pot (potentiomètre) comme source du paramètre High Limit (limite
élevée)  d'un objet Alarm (alarme). Lorsque vous ajustez le
Potentiomètre, le paramètre High Limit  change dans l'objet Alarm.

Les stratégies de contrôle

Alors que vous créez et connectez des objets, vous obtenez un réseau
formé de nombreux objets connectés les uns aux autres pour exécuter
une stratégie de contrôle unique. Cette stratégie de contrôle est le
"cerveau" du panneau de contrôle qui achemine les signaux issus des
valeurs acquises vers les graphes à barres et les indicateurs visuels sur
les panneaux de contrôle. Il active et désactive les alarmes. Il peut
prendre des décisions complexes en se basant sur les valeurs des signaux
de contrôle acquis et des consignes ajustées via des potentiomètres et des
interrupteurs sur le panneau de contrôle. La stratégie de contrôle peut
comprendre des formules complexes de type feuille de calcul. Au fur et à
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mesure que vous concevez le système de contrôle, vous pouvez choisir la
façon de répartir le contrôle entre Lookout et les API et/ou les
téléterminaux. Pour des informations sur la création et la connexion des
objets, reportez-vous au chapitre 5.

Le traitement événementiel

Il est crucial de comprendre maintenant que Lookout est entièrement
événementiel et non piloté par boucle. Pour assimiler complètement ce
concept unique, il convient de dévier un peu du sujet pour expliquer
comment fonctionnent les programmes pilotés par boucle.

Les applications pilotées par boucle s’opposent à l'architecture de
Lookout. Elles exécutent les codes en séquence de haut en bas et
rebouclent par le haut pour exécuter le même code sans arrêt.

Boucle infinie, exécutant sans cesse la
lecture et l’écriture de valeurs vers et
de la base de données centrale. La
logique pilotée par boucle reteste les
valeurs et les règles perpétuellement
et inutilement.

Regle 1

Regle 2

Regle 3

Regle 4

Le driver est
une application
séparée

BASE DE DONNEES
CENTRALE

Notification passive

CONCEPT DU PILOTAGE PAR BOUCLE

Règle 1

Règle 2

Règle 3

Règle 4

 Exemple de programme logiciel conventionnel piloté par boucle
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Dans ce modèle de programmation (qui est encore très répandu dans
l'industrie des processus d'automatisation), un certain segment du code
ou de la règle s'exécute des millions de fois avant que le résultat ne
diffère du résultat précédent. Cela représente un gaspillage de temps
précieux au niveau du traitement de texte et retarde les réponses aux
événements fréquents. Plus on ajoute de règles aux systèmes pilotés par
boucle, plus le temps de réponse est lent. De plus, si vous ajoutez un
plus grand nombre de noms de variables à la base de données centrale,
vous remarquerez une dégradation de la vitesse et des performances
d'ensemble, cela du fait que la base de données centrale utilise un
système de notification passive selon laquelle les règles de la logique
pilotée par boucle doivent scruter une base de données de plus en plus
grande pour trouver les valeurs appropriées. Plus la base de données est
grande, plus la règle prend de temps pour trouver les données dont elle a
besoin pour accomplir sa fonction.

Contrairement à ce modèle de programmation, Lookout est entièrement
événementiel. Chaque objet demeure au repos complet, c'est-à-dire qu'il
ne fait rien avant que ne se produise un événement.

Commutateur

Formule

API

Chronomètre

Panneau
de contrôle

Enregistreur
de

données

EVENEMENTS
(notification active)

Le driver est
simplement un autre objet

OBJETS

L’architecture événementielle et orientée objet de Lookout
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Un événement correspond à un changement dans la valeur des données.
Lorsqu'un signal d'entrée change, l'objet “se réveille” et traite la valeur
selon sa fonctionnalité. Les objets envoient des signaux uniquement
lorsque le résultat de leur fonctionnalité change et, ainsi, un événement
se produit. De ce fait, un événement se propage dans votre
système/configuration, créant une réaction en chaîne qui n'affecte que les
objets de la chaîne. Ce phénomène s'appelle notification active. Les
objets ne s'animent que lorsqu'ils sont informés d'un événement. Sinon,
ils demeurent au repos et n'utilisent pas de temps de traitement. Ce
concept événementiel simule étroitement la réaction des interrupteurs,
des boutons-poussoirs et des relais physiques, et explique pourquoi
Lookout est le logiciel d'automatisation industrielle le plus rapide au
monde.

Le pilotage événementiel comparé au pilotage par boucle
Comparez la notification active à la notification passive. La première est
par nature pilotée par les événements, tandis que la seconde requiert une
boucle d'exécution constante pour vérifier si la valeur des données a
changé.

Prenons comme exemple deux personnes essayant d'échanger des
informations : vous et moi. Je ne dispose que de deux moyens pour vous
envoyer des données. Vous pouvez me demander la nature des
informations en question ou je peux tout simplement vous les
communiquer sans que vous me le demandiez. Selon la première
méthode, vous devez me demander sans cesse si quelque chose a changé
(est-ce qu'un événement s'est produit ?). C'est exactement ce que font les
règles pilotées par boucle lorsqu'elles questionnent sans cesse la base de
données centrale. Imaginez le gaspillage de temps et d'effort si vous me
demandez toutes les secondes de vous informer des événements les
plus récents de la journée et si je vous réponds quasiment toutes les
secondes : Rien de nouveau à signaler. Le dialogue serait constant et nos
UC proverbiales seraient sans cesse occupées à parler pour quasiment ne
rien dire.

En revanche, vous pourriez me demander de vous informer chaque fois
qu'il se passe quelque chose (lorsqu’un événement se produit). C'est ce
qui se produit quand nous connectons deux objets ensemble dans
Lookout. Selon ce scénario, vous attendez tranquillement que je vous
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tienne au courant quand, et seulement quand, quelque chose change. Pas
de nouvelles obsolètes, pas de répétitions, pas de gaspillage de temps ni
d'effort. Nos petites UC ne perdent pas leur temps à parler alors qu'elles
pourraient faire quelque chose d'utile.

Comme vous pouvez l'imaginer, l'ajout d'objets dans Lookout se traduit
par un besoin réduit de temps processeur par rapport à l'ajout de
nouvelles règles ou l'agrandissement de la base de données centrale d'un
système traditionnel piloté par boucle.

Etant donné que Lookout est entièrement événementiel, l'ordre dans
lequel vous créez et connectez les objets n'affecte pas le fonctionnement
de votre stratégie de contrôle.

Les services Environnement   

Vous avez sans doute deviné que la pierre angulaire de la technologie
objet est l'objet lui-même et que Lookout crée l'environnement dans
lequel les objets se trouvent et fonctionnent. Très souvent, les objets
nécessitent l'utilisation de ressources systèmes telles que le port série, le
disque dur ou des fonctions multimédias. Par exemple, plusieurs objets
API peuvent avoir besoin d'utiliser le même port de communication sur
PC. Dans ce cas, Lookout doit fournir un service ou un mécanisme que
les objets peuvent utiliser pour accéder au port de communication de
manière ordonnée et ponctuelle.

Qu'entend-on par service ?
Un service est un outil que Lookout met à la disposition des objets, ou
une fonction exécutée par Lookout en dehors de sa structure orientée
objet. Chaque service offre une fonction unique. Les services
Environnement de Lookout sont décrits dans les paragraphes ci-après.

Le service Communication
Vous pouvez configurer certaines classes d'objets Protocol (protocole)
pour représenter et communiquer avec des API et des téléterminaux via
les ports série de votre ordinateur. Ce service, souvent appelé Sous-
système de communication (COMSUB), répartit l'utilisation des ports
série entre des objets qui représentent des API et des téléterminaux. Par
exemple, une seule radio bidirectionnelle connectée au port série de
l'ordinateur peut communiquer avec plusieurs marques de téléterminaux
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sur le terrain, chacune utilisant un protocole différent. Ou alors,
soixante-quinze API sur le terrain peuvent partager une banque de cinq
modems dial-up. Pour des informations sur la configuration des
communications, reportez-vous au chapitre 6.

Le service Base de données
Le service Base de données permet aux utilisateurs de définir et/ou de
modifier les paramètres d'origine des données membres. Par exemple, la
classe d'objets Modbus comprend une donnée membre native appelée
40001. Vous pouvez donner à cette donnée membre native un
pseudonyme ou "petit nom" comme PumpSpeed et définir les
conversions d'unité, le déclenchement d’alarme, les zones mortes et
autres paramètres connexes. Lookout vous permet également d'importer
des informations de la base de données issues de progiciels externes tels
que Siemens APT. Pour de plus amples informations sur les services
Base de données offerts par Lookout, reportez-vous au chapitre 5.

Le service Graphes
Lookout possède une immense bibliothèque de graphes standard, dont
une grande variété d'interrupteurs, de potentiomètres, de boutons-
poussoirs, de graphes à barres, de valves, de réservoirs, de pompes, etc.
Si vous ne trouvez pas le graphe que vous voulez utiliser, vous pouvez
créer votre propre graphe personnalisé et l'ajouter dans la bibliothèque
Lookout. Pour de plus amples informations sur les graphes, reportez-
vous au chapitre 8.

Le service Alarme
Le sous-système d’Alarme est un mécanisme puissant et souple qui
permet de générer, d'afficher, d'enregistrer et d'imprimer des alarmes. Ce
sous-système est composé de plusieurs secteurs distincts, dont la fenêtre
d’alarme, les paramètres objets comme Alarm Group (groupe alarme)
et Alarm Priority (priorité alarme) , des filtres d'alarmes, des paramètres
d'affichage et des réglages d'impression.
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Lookout archive les alarmes sur disque de manière permanente. Vous
pouvez facilement imprimer l'historique des alarmes. Pour des
informations complémentaires, reportez-vous au chapitre 9.

Le service Multimédia   
Lookout fournit également un service multimédia qui vous permet de
jouer des fichiers son et de voir les vidéos intégrées.

Le service Sécurité
Lookout est muni d'un système de sécurité complet très sophistiqué à
trois niveaux : sécurité de contrôle, sécurité de visualisation et
vérification de l'action. Vous pouvez choisir quels opérateurs peuvent
contrôler certains objets, quels sont ceux qui peuvent afficher certains
panneaux de contrôle et quels objets invitent les opérateurs à vérifier les
commandes. Pour de plus amples informations sur la sécurité, reportez-
vous au chapitre 10.

Le service Enregistrement historique
Le service Enregistrement historique vous permet de stocker sur disque
des informations systèmes en temps réel soit sous forme de fichiers
ASCII non compressés, séparés par une virgule, soit en un nouveau
format très compressé.

L'enregistreur d'événements de Lookout surveille qui a fait quoi et à quel
moment : une tâche qu’on appellera Analyse rétrospective. Lookout
enregistre les commandes effectuées par l’utilisateur, qu’il s’agisse de la
fermeture d'un fichier processus ou du basculement d'un interrupteur ou
du réglage d'un potentiomètre. A chaque événement, Lookout enregistre
le nom de l'utilisateur, la date et l'heure de l'événement, le nom de
variable de l'objet ajusté et les réglages préalables et futurs de l'objet.
Pour des informations complémentaires sur les services Enregistrement,
reportez-vous au chapitre 11.

Le service ODBC
Le service ODBC (connectivité ouverte de la base de données) de
Lookout permet à d'autres applications, telles qu’Access de Microsoft,
de questionner la base de données historique de Lookout. Pour des
informations complémentaires sur les services ODBC, reportez-vous au
chapitre 12 intitulé "Langage SQL".
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Le service DDE
Lookout peut envoyer ses valeurs processus courantes à d'autres
applications et il peut utiliser les valeurs temps réel provenant d'autres
applications. Le système Lookout agit aussi bien comme client DDE que
serveur DDE. Reportez-vous au chapitre 13.

Le service Gestion de réseau
Lookout fournit un service complet de gestion de réseau client-serveur
via le réseau NetDDE. Le service NetDDE de Lookout vous permet de
connecter des nœuds en tant que serveurs, clients ou dans une
configuration d'égal à égal. Ce service vous permet de surveiller et de
contrôler votre processus à partir de plusieurs stations de travail sur un
réseau. Pour des informations sur les ordinateurs de gestion de réseau
Lookout, reportez-vous au chapitre 14.

Le service Redondance
Le service Redondance de Lookout vous permet de configurer deux
ordinateurs d'automatisation industrielle pour la redondance afin de
transférer automatiquement la surveillance et le contrôle en cas de panne
de l'un des ordinateurs. Pour des informations sur la configuration de la
redondance, reportez-vous au chapitre 15.
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2. Installation de Lookout

La configuration matérielle
Le système Lookout doit être installé sur un ordinateur personnel IBM
386, 486 ou Pentium. Cet ordinateur doit disposer d'au moins 4 Mo de
mémoire vive (RAM) et d'espace disque dur. Il doit comporter un lecteur
de disquette, une souris (version bus de préférence) et un ensemble écran
vidéo/contrôleur de capacité VGA (640 x 480) minimum. Un
coprocesseur mathématique 80387 est facultatif : Lookout exploite
automatiquement le coprocesseur de votre ordinateur.

Comme Lookout peut tourner 24 heures par jour, votre ordinateur doit
être protégé contre les surtensions d’alimentation CA. Une alimentation
sans interruption (UPS) fournit la meilleure protection possible. Ce
mécanisme assure un isolement complet entre la source d'alimentation
AC et l'ordinateur, et est alimenté par batterie en cas de panne
d'électricité totale ou localisée. Si vos applications ne demandent pas de
batterie de secours, un suppresseur de surtension de qualité suffit pour
protéger votre ordinateur contre la plupart des surtensions et des pointes
de tension électriques.

Vous aurez sans doute besoin d’une imprimante de qualité pour générer
des rapports d'alarmes, des rapports d'événements et des rapports
personnalisés. Une imprimante laser possède une capacité d'impression
rapide des graphes et des rapports de qualité supérieure. Une imprimante
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matricielle produit une impression acceptable mais beaucoup moins
rapide qu'une imprimante laser. Une imprimante à jet d’encre produit
une impression de qualité intermédiaire.

La configuration logicielle
Le logiciel Lookout existe en version 16 bits ou 32 bits.

La version 16 bits peut être exploitée sous Windows 3.1 ou plus de
Microsoft, Windows pour Workgroups 3.11 ou plus et Windows 95. Elle
nécessite DOS 3.0 ou plus.

La version 32 bits peut être exploitée sous Windows 95 et Windows NT.

Les versions futures de Lookout exigeront une capacité étendue comme
celle des versions futures de DOS et Windows ; il vous faudra peut-être
actualiser vos plates-formes DOS et Windows avant d'installer les mises
à jour futures du logiciel Lookout.

L’installation de Lookout
Pour installer Lookout
1. Insérez la disquette 1 Lookout dans le lecteur A ou le lecteur B de

votre ordinateur.

2. Si vous utilisez Windows 95, cliquez sur le bouton Démarrer, puis
sur Exécuter...

Si vous utilisez Windows 3.x ou Windows NT, sélectionnez
Fichier→Exécuter... dans la fenêtre Gestionnaire de programmes.
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3. Tapez A:\SETUP si vous utilisez l'unité A. Tapez B:\SETUP  si
vous utilisez l'unité B. Puis sélectionnez OK.

Si vous installez Lookout sur une plate-forme Windows à 16 bits
comme Windows 3.1 ou 3.11 par exemple, Setup installera
automatiquement la version 16 bits de Lookout.

Si vous installez Lookout sur une plate-forme Windows à 32 bits
comme Windows 95 ou Windows NT par exemple, Setup vous
offrira le choix entre la version Lookout à 16 bits et celle à 32 bits.
A part les différences d'architecture logicielle interne, la différence
fondamentale entre les deux versions Lookout est le support driver.

Remarque La version 32 bits de Lookout n'accepte pas Modbus Plus ni le driver
Siemens TI505 H1 sous Windows 95 ou Windows NT. De même, la
version 16 bits de Lookout n'accepte pas Modbus Plus ni le driver
SiemensTI505 H1 sous Windows NT.

4. Lorsqu’on vous le demande, choisissez la version 16 bits ou 32 bits
de Lookout. Ensuite, Lookout vous offre la possibilité d'installer son
driver ODBC. (Ce driver est nécessaire si vous voulez interroger la
base de données historique Citadel à l'aide de SQL.) Pour des
informations sur la caractéristique SQL, reportez-vous au
chapitre 12.

5. Fermez toutes les applications susceptibles d’utiliser ODBC. Il peut
s’agir de tableurs, de traitements de texte, de programmes de base de
données, de MS Query, etc.

6. Choisissez l'ODBC à 16 bits, l'ODBC à 32 bits ou aucun, vous
pourrez toujours l'installer ultérieurement si vous le voulez. Setup
vous invite à nommer le sous-répertoire du disque dur dans lequel
seront installés les fichiers Lookout.

7. Utilisez Browse (parcourir) pour taper le nom d'un autre répertoire
ou sélectionnez OK pour accepter le nom de répertoire recommandé.

8. Suivez les autres instructions Setup pour terminer l'installation de
Lookout.

Remarque N'oubliez pas d'enregistrer votre logiciel Lookout !
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Le lancement initial de Lookout
La première fois que vous lancez Lookout, il vous demande un certain
nombre d’informations.

Remarques Tant qu'il n'est pas enregistré, le logiciel Lookout ne dispose que de 50
E/S et ne fonctionne que pendant 30 jours. Lorsque vous enregistrez
Lookout, il est déverrouillé pour usage permanent selon le nombre d'E/S
approprié. Si vous n'enregistrez pas votre Lookout dans les 30 jours,
il passera à 4 E/S seulement et ne fonctionnera que pendant une
heure avant de s'arrêter. Vous devez remplir le contrat de licence et
en envoyer un exemplaire par courrier ou télécopie à National
Instruments pour enregistrer votre Lookout.  A réception du formulaire
d'enregistrement, nous générerons un code d'identification pour
déverrouillage de Lookout que nous vous communiquerons ensuite par
courrier ou télécopie, accompagné de votre code personnel.

Dans certains pays, Lookout nécessite une clé matérielle. Demandez à
National Instruments pour savoir si vous êtes concernés. Si Lookout vous
a été livré avec une clé, n'oubliez pas de l'introduire dans le port parallèle
de votre ordinateur avant d'activer le logiciel.

Pour le lancement initial de Lookout
1. Lancez Lookout en sélectionnant Démarrer→Programmes→

Lookout→Lookout, ou double-cliquez sur l'icône Lookout.

La boîte de dialogue d’enregistrement apparaît.
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2. Tapez votre nom dans le champ Name (nom) .

3. Tapez le nom de la société dans le champ Organization
(organisation)  tel qu'il apparaît sur la télécopie du code
d'identification que nous vous avons envoyée en réponse à votre
demande d'enregistrement, y compris les signes de ponctuation.
Etant donné que ce texte est utilisé avec le code d'identification, il
doit être tapé correctement.

4. Tapez le numéro de série de votre logiciel dans le champ Serial
Number (numéro de série) . (Il se trouve sur le formulaire
d'enregistrement).

5. Tapez votre code d'identification à 12 caractères dans le champ
Keycode (code d’identification) . Ce code d'identification n'est pas
sensible aux majuscules/minuscules et vous pouvez omettre les traits
d'union. Il convient de noter qu'il n'y a pas d'espace autour des traits
d'union.

6. Après avoir rempli les deux entrées, appuyez sur Entrée ou
sélectionnez OK.
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Si vous avez tapé correctement la combinaison organisation/numéro
de série/code d'identification, Lookout apparaît sur votre écran sans
processus en cours d'exécution.

Si vous n'avez pas encore reçu votre code d'identification de
National Instruments, vous pouvez attendre encore un peu avant de
taper les données d'enregistrement. Sélectionnez OK et Lookout
vous informera que vous n'avez pas encore enregistré votre logiciel.
Cela n'a pas d'importance ; sélectionnez OK de nouveau jusqu'au
lancement de votre Lookout.

  

Si vous êtes certain d'avoir tapé les données correctement et si
Lookout continue à ne pas les accepter, téléphonez à notre service
technique. Nous vous aiderons à lancer le programme le plus vite
possible.
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3. Démarrage
Ce chapitre explique comment lancer et exploiter le logiciel Lookout. Il
décrit l’écran Lookout et vous apprend quelques raccourcis souris et
clavier importants.

Le lancement de Lookout
Pour lancer Lookout

Remarque Si vous utilisez Lookout en dehors des Etats-Unis, son lancement
exigera peut-être une clé matérielle. N'oubliez pas de l'introduire dans le
port parallèle de votre ordinateur avant d'activer le logiciel.

• Lancez Lookout en choisissant Démarrer→Programmes→Lookout,
ou en double-cliquant sur l'icône Lookout.

Au lancement initial de Lookout, vous verrez probablement sur l'écran
un diagramme comme celui qui se trouve à la page suivante.
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A ce stade-là, aucun fichier de processus Lookout n'est encore ouvert.
Aucun suivi ni contrôle n'est exploité.

Pour ouvrir un fichier de processus

1. Sur la barre de menus, choisissez l'article du menu File→Open...
(Fichier→Ouvrir).

2. Dans le champ des données File Name , tapez le nom d'un fichier de
processus Lookout ou choisissez un fichier de processus dans la liste
et sélectionnez OK.

Les noms des fichiers de processus Lookout sont suivis de l’extension
.LKP. Si Lookout trouve le fichier et qu’il s’agit bien d’un fichier de
processus valide, il l’ouvre et commence immédiatement à exécuter le
processus.
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Lorsqu'un fichier de processus s'ouvre, Lookout offre des options
supplémentaires et affiche les panneaux de contrôle et la fenêtre
d’alarme.

Le chargement automatique du processus

Si votre ordinateur exploite Lookout 24 heures sur 24, veillez à ce qu'en
cas de perte temporaire d'alimentation, l'ordinateur se réinitialise
automatiquement et commence à exécuter le processus dès que
l'alimentation est restaurée.

Windows 3.x et Windows NT 3.x
Pour assurer le chargement automatique du processus, ajoutez la
commande WIN à la fin de votre fichier AUTOEXEC.BAT. Cela charge
automatiquement Windows quand l'ordinateur s'initialise. Puis ajoutez
un groupe de programmes Démarrage (StartUp) dans le Gestionnaire de
programmes s'il n'en existe pas encore. Tout programme au sein du
groupe Démarrage se charge automatiquement lors du chargement
Windows.

Enfin, ajoutez un nouvel article de programme dans le groupe
Démarrage (StartUp).

Cela assure le chargement automatique de Lookout chaque fois que
Windows est relancé. Vous devez également vous assurer que le fichier
de processus et le panneau de contrôle appropriés apparaissent dans
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Lookout lors du chargement. Cela s'accomplit à l'aide de la commande
Options→System… (Options→Système). Pour de plus amples
informations, reportez-vous à Options→System… au chapitre 16,
Commandes du menu Runtime.

Windows 95 et Windows NT 4.0

1. Dans Windows 95, cliquez sur Démarrer→Paramètres→Barre des
tâches.

2. Dans la boîte de dialogue Propriétés de la Barre des tâches,
sélectionnez l'onglet Menu Démarrer.

3. Cliquez sur le bouton Ajouter...

4. Dans le champ Ligne de commande  de la boîte de dialogue Créer
un raccourci, tapez C:\LOOKOUT\LOOKOUT.EXE, puis cliquez
sur Suivant.

5. Sélectionnez le dossier Menu Démarrer→Programmes→Démarrage,
puis cliquez sur Suivant.

6. Sélectionnez un nom (LOOKOUT, par exemple) pour le raccourci ;
cliquez sur Terminer et sur OK.

7. Ensuite, assurez-vous que le fichier de processus et le panneau de
contrôle appropriés apparaissent dans Lookout lors de son
chargement. Cela s'accomplit à l'aide de la commande
Options→System… (Options→Système). Pour de plus amples
informations, reportez-vous à Options→System au chapitre
Commandes du menu Runtime.

L'écran Lookout
Lookout apparaît d'abord en occupant tout l’écran. Vous pouvez cliquer
sur le bouton Restore (retour à la taille précédente) en haut à droite de
l'écran pour remettre Lookout à sa taille normale. A ce moment-là, vous
pouvez voir plusieurs applications en même temps sur l'écran.
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Lookout, Microsoft Word et Microsoft Excel exploités simultanément

Le second bouton avec la flèche de réduction situé en haut à droite de la
fenêtre Lookout est le bouton de réduction. Cliquez sur ce bouton pour
réduire Lookout à la taille de la petite icône qui se trouve au bas de
l'écran. Double-cliquez sur l'icône Lookout pour revenir à la taille
précédente. Lookout continue à exécuter le processus déjà chargé
(alarme, enregistrement, contrôle, etc.) que sa taille soit agrandie,
normale ou iconique.
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La barre de titres

La barre de titres qui se trouve en haut de la fenêtre Lookout contient le
nom du programme et le titre du processus en cours d'exécution.

La barre de menus

La barre de menus indique les commandes menu actuellement
disponibles. Ces commandes peuvent ou non être à la disposition de
l'utilisateur en fonction de son niveau de sécurité (voir Commandes du
menu Runtime, chapitre 16). Pour sélectionner une commande de menu,
cliquez sur le titre du menu pour que se déroule le menu correspondant,
puis sur la commande du menu choisie. Ou bien appuyez sur la touche
ALT, puis tapez la lettre soulignée associée à la commande. Par exemple,
vous pouvez exécuter File→Open... (Fichier→Ouvrir) en appuyant
successivement sur ALT F O. En outre, certaines commandes sont
associées à des raccourcis clavier qui apparaissent à droite.

Barre de titres

Barre de
menus

Barre
d’état

Panneau de
contrôle

Zone de
travail

Bouton
Retour
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En ce qui concerne l'exemple précité, CTRL+O exécute aussi la
commande File→ Open... (Fichier→Ouvrir).

La barre d'état

La barre d’état se trouve en bas de la fenêtre Lookout. Elle change
lorsqu'elle passe en mode Edition ou qu’elle en sort. Lorsqu'elle n'est pas
en mode Edition, la barre d'état est grise avec l'heure et la date affichées
à l'extrémité gauche de la barre. Ensuite figure le nom de l'utilisateur
actuellement connecté. Le nom de la société apparaît au milieu et enfin
l'état de l’alarme est à l'extrémité droite de la barre d'état.

e

En mode Edition, la barre d'état devient jaune. Les coordonnées X et Y
de l'objet actuellement sélectionné apparaissent à l'extrémité gauche de
la barre. Ensuite figurent la largeur et la hauteur de l'objet en question.
Le nom de variable de l'objet sélectionné apparaît au milieu et l'état de
l'alarme apparaît à l'extrémité droite de la barre d'état.

La zone de travail Lookout

La zone de travail Lookout est l’espace qui se trouve entre la barre de
menus et la barre d'état. C'est la zone où vous affichez et exploitez les
panneaux de contrôle. La fenêtre d’alarmes apparaît également dans
cette zone. C’est aussi là que les utilisateurs organisent et agencent les
panneaux de contrôle.
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La zone de travail visible à l’écran n'est qu'une fenêtre de votre zone de
travail virtuelle. Si les panneaux de contrôle et leurs icônes sont
partiellement ou entièrement en dehors de la zone de travail visible,
Lookout affiche automatiquement des barres de défilement horizontal et
vertical le long du côté droit et en bas de la zone de travail visible. Si les
barres de défilement sont visibles, vous devez parcourir la zone de
travail pour voir tous vos panneaux de contrôle.

Les panneaux de contrôle

Les panneaux de contrôle sont composés d'interrupteurs, de boutons, de
graphes à barres, d'écrans numériques, de graphes de tendance et autres
composants qui vous permettent de surveiller et de contrôler
visuellement l'usine. Les panneaux peuvent couvrir tout l'écran, être
iconiques ou de taille intermédiaire. Vous pouvez déplacer les panneaux
sur l'écran en saisissant la barre de titres à l'aide du curseur et en la
déplaçant. Des panneaux de contrôle peuvent également “surgir”
lorsqu'un événement se produit, comme par exemple le fait d’appuyer
sur un bouton-poussoir ou d’activer une alarme. Le nombre de panneaux
de contrôle que vous pouvez créer est illimité ; il en est de même du
nombre d'objets affichés sur un seul panneau.

Les panneaux de contrôle peuvent être de tailles différentes et apparaissent
dans la zone de travail Lookout sous diverses formes : agrandis, normaux,
iconiques. Il existe deux types de panneaux de contrôle : normaux et
locaux. Un panneau de contrôle normal est agrandi, normal ou iconique au
sein de la zone de travail Lookout. Le panneau de contrôle local
fonctionne différemment. Son état peut être local ou iconique. Lorsqu'un
panneau de contrôle local "apparaît", il couvre tous les autres panneaux
jusqu'à ce que l'utilisateur réduise sa taille. Vous pouvez utiliser les
commandes du menu Window (fenêtre) pour réorganiser et afficher les
panneaux de contrôle dans la zone de travail.

L'apparence des panneaux de contrôle n'est pas "standard". Les
concepteurs personnalisent entièrement chaque panneau de contrôle en
fonction de leurs besoins particuliers à l’aide d'interrupteurs, de
potentiomètres et autres objets graphiques. Certains panneaux de
contrôle peuvent n'afficher que des informations, alors que d'autres
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affichent à la fois des informations de contrôle et d'affichage. Les
informations affichées sont toujours les plus récentes obtenues par
Lookout via sa communication avec vos dispositifs d'E/S.

Lookout offre au concepteur de fichiers de processus (appelé dans
l'industrie Intégrateur système) un grand champ d’action pour ce qui est de
l'apparence et du fonctionnement des panneaux de contrôle. Par exemple,
l'intégrateur peut dessiner ses propres interrupteurs pour remplacer des
interrupteurs standard. Il peut facilement faire en sorte qu’un bouton-
poussoir ou un interrupteur fonctionne contrairement aux habitudes. Il peut
insérer, derrière le panneau, des actions et conditions différées qui ne sont
pas nécessairement visibles en regardant le panneau.

Comme vous le savez maintenant, Lookout est un système de panneaux
de contrôle, tout au moins au niveau graphique. Les panneaux de
contrôle sont les fenêtres de votre processus qui vous permettent de
contrôler l'équipement en basculant tout simplement des interrupteurs,
en pressant ou en tournant des boutons. Il est crucial de savoir que
contrairement aux interrupteurs et boutons réels, vous pouvez attribuer
des niveaux de sécurité aux interrupteurs, aux boutons et à tous les
panneaux de contrôle de Lookout. Cette caractéristique vous permet
d'empêcher les utilisateurs qui ne possèdent pas le niveau de sécurité
approprié d'exploiter certains dispositifs. Pour de plus amples
informations sur la sécurité, reportez-vous au chapitre 10.

Contrairement aux interrupteurs et boutons concrets, vous pouvez afficher
le même objet de contrôle plusieurs fois sur le même panneau de contrôle
et sur des panneaux de contrôle différents. Lorsque vous tournez un
bouton affiché en plusieurs endroits, il tourne automatiquement à chaque
endroit. Par contre, le même objet de contrôle peut apparaître sous
différentes formes à chaque endroit. Ainsi, vous pouvez afficher un
potentiomètre sous forme de glissière horizontale sur un panneau, d’un
ensemble de boutons d’incrémentation/de décrémentation sur un autre
panneau ou d’un bouton sur un troisième panneau.
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Les tâches de l'utilisateur

A l'usine, les utilisateurs peuvent choisir parmi de nombreuses méthodes
pour ajuster les points de consigne et/ou passer d'un panneau de contrôle
à un autre. Citons les commandes activées par la souris, la trackball,
l’écran tactile ou le clavier.

Lorsqu'un curseur se déplace sur un objet contrôlable, il se transforme en
main, ce qui indique que vous avez maintenant le contrôle de l'objet et
que vous pouvez cliquer dessus. Les objets contrôlables comprennent les
interrupteurs, les potentiomètres et les boutons-poussoirs.

Lorsque l'on utilise un clavier, les touches fléchées déplacent le curseur
sur l'écran. La touche TAB fait sauter le curseur d'un objet contrôlable à
l'autre et la barre d’espacement agit comme le bouton gauche de la
souris, vous permettant de cliquer sur un objet contrôlable.

Les intégrateurs système peuvent également relier des touches fonctions
du clavier aux panneaux de contrôle et autres objets, ce qui vous permet
de basculer d'un panneau de contrôle à l'autre ou d'émettre des
commandes de contrôle en appuyant simplement sur une touche
fonction.

L'environnement de développement
L'architecture unique de Lookout vous permet de développer rapidement
un fichier de processus complet. Tout développement est interactif. Vous
ne procédez à aucune programmation ni compilation. A l'aide des boîtes
de dialogue, vous créez simplement des objets et connectez leurs
signaux. Le cycle de développement crée trois fichiers uniques pour
chaque application : un fichier de processus, un fichier code source et un
fichier d'état.
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Le fichier de processus

Un fichier de processus est un fichier compilé exécutable qui contient
des informations complètes sur la configuration de votre application de
contrôle de processus. Il est mis à jour toutes les fois que vous
sélectionnez la commande File→Save... (Fichier→Enregistrer). Les
fichiers de processus sont suivis de l’extension .LKP  (LooKout Process)
et sont des fichiers binaires. Vous ne modifiez ni éditez directement des
fichiers de processus avec un éditeur de texte. Lookout compile le fichier
.LKP  objet par objet à mesure que vous les développez dans Lookout.
Cette approche singulière vous permet de rester en ligne pendant la
création, mise à jour ou édition de votre application. Il n’est pas
nécessaire d’arrêter votre processus. Rien n’échappe à Lookout au
moment d’ajouter ou de supprimer des contrôleurs, des E/S ou des
graphes, ou de modifier votre logique.

Le fichier code source

Lookout met aussi automatiquement à jour un fichier code source
correspondant lorsque vous appelez la commande File→Save
(Fichier→Enregistrer). Ce fichier contient toute la documentation sur
votre fichier de processus, y compris la définition des objets, les noms de
variables, la configuration des E/S, les communications, la logique de
commande, l'agencement du panneau de contrôle et autres paramètres
objet. Les noms de fichiers code source sont suivis de l’extension .LKS .
(LooKout Source). Ce sont des fichiers de texte ASCII standard que
vous pouvez imprimer ou afficher facilement sur n'importe quel éditeur
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de texte. Cela vous permet d'imprimer votre configuration pour une mise
au point ultérieure ou pour obtenir de la documentation.

Le fichier d'état

Un troisième type de fichier, le fichier d'état, contient les valeurs réelles
des données membres des objets. Ces valeurs comprennent les points de
consigne et autres données importantes conservées et utilisées par les
objets. Vous pouvez considérer le fichier d'état comme une mémoire
permanente pour les points de consigne et les tendances temps réel de
Lookout. Lookout utilise le fichier d'état pour se rappeler la position des
interrupteurs, des potentiomètres et des courbes de tendance. Au premier
chargement de l'application, Lookout lit le fichier d'état approprié pour
déterminer dans quel état les potentiomètres, les interrupteurs, les
courbes de tendance, etc. doivent se trouver au lancement.

Le fichier d'état est mis à jour chaque fois que vous sauvegardez, fermez
ou quittez le fichier d'application Lookout. Il peut également être mis à
jour de façon périodique, comme défini dans la boîte de dialogue System
Options. Cette boîte de dialogue peut être appelée en sélectionnant la
commande menu Options→System… (Options→Système). Les noms
des fichiers d'état sont suivis de l’extension .LST  .(Lookout STate).

Le processus de développement
La première étape de développement d'un fichier de processus consiste à
créer un objet Panel (panneau de contrôle). Les panneaux de contrôle
sont des fenêtres qui agissent un peu comme des tableaux et permettent
de placer d'autres objets tels que des interrupteurs, des potentiomètres et
des tendances à afficher. On les appelle panneaux de contrôle car ils
ressemblent à de vrais panneaux de contrôle physiques composés
d’interrupteurs, de boutons-poussoirs, d’encadrements, d’incrustations,
de lampes, de jauges, etc. L'apparence et la fonction des panneaux de
contrôle ne sont limitées que par votre imagination.

Si vous sélectionnez la commande File→New… (Fichier→Nouveau), elle
appelle automatiquement la boîte de dialogue pour créer le premier objet
Panel.
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Après avoir créé au moins un panneau de contrôle, vous pouvez créer et
afficher d'autres objets sans restriction de nombre. Les objets peuvent
être insérés/affichés sur un ou plusieurs panneaux de contrôle. Vous
pouvez par exemple insérer le même interrupteur sur plusieurs
panneaux. Il suffit de basculer Switch sur un panneau et l'objet bascule
immédiatement sur tous les panneaux.

Les premiers objets créés sont souvent ceux qui représentent vos API et
vos téléterminaux. Ces classes d'objets utilisent en général les ports de
communication de votre ordinateur et, de ce fait, vous devez configurer
ces ports pour radio, modem ou câblage, selon le cas. Pour des
informations sur la configuration des communications, reportez-vous au
chapitre 6.

Lorsque vous créez un objet qui représente un API, un téléterminal ou un
autre dispositif d'E/S, ses fonctions et bases de données font
naturellement partie intégrante de l'objet. La fonctionnalité intégrée dans
ce type de classe d'objets comprend un driver de protocole qui permet à
l'objet de converser avec le dispositif physique. La base de données
d'origine (par défaut) comprend tous les enregistreurs, bits, signaux,
paramètres et autres valeurs que le dispositif peut transmettre ou
recevoir de Lookout.

A ce stade-là, vous pouvez ajouter des données membres aux bases de
données d'origine de vos objets. Ces nouvelles données membres
(appelées pseudonymes) peuvent comprendre des noms descriptifs, des
paramètres de mise à l'échelle des signaux, des paramètres d'alarme, etc.

Au fur et à mesure que vous créez les objets, vous les "connectez" les
uns aux autres. Le type d'objets que vous créez (par exemple, Pot
(potentiomètre), Switch (booléen), Modbus, Trend (tendance), etc.) et la
manière dont vous les connectez déterminent la façon dont ils
répondront à votre processus.

Un grand nombre des classes d'objets que vous utiliserez exploiteront les
services Environnement fournis par Lookout. Par exemple, la classe
d'objets Pot (potentiomètre) vous permet de lui attribuer un niveau de
sécurité, alors que la classe d'objets Alarm utilise le sous-système de
traitement d’Alarme. Lors de la création des objets exploitant ces
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services, vous pourrez configurer ces services en fonction des exigences
de votre application.

La dernière étape de développement d'un fichier de processus est l'appel
de la commande File→Save (Fichier→Enregistrer). Comme mentionné
plus haut, elle enregistre vos configurations de logique et graphiques sur
disque et crée /met à jour les fichiers .LKP , .LKS  et .LST .

Il va sans dire que vous devez appeler la commande File→Save pour
éviter toute perte fortuite de travail. De même, il est utile de sauvegarder
votre travail de temps en temps sur une autre disquette.

Les raccourcis de configuration
e

Les raccourcis de souris

Ce manuel fait référence à plusieurs raccourcis exécutés par la souris. Il
convient de porter une attention particulière à ces méthodes. Il est très
facile de se familiariser avec les commandes souris d’autant que cela
s'avérera très utile au cours du développement de l'application.

Fonction Action souris

Pour sélectionner  l’affichage
objet, un graphe, un texte, une
expression, ou tout autre article
sur un panneau d'affichage

Cliquer  : sélectionner l'article en plaçant
le curseur sur l'article et cliquer avec le
bouton gauche de la souris. (Voir
remarque.)

Pour copier  l’affichage objet, un
graphe, un texte, une expression,
ou tout autre article sur un
panneau d'affichage

Majuscule-Tirer : sélectionner l'(les)
article(s) à copier. Tenir la touche
Majuscule enfoncée et cliquer avec le
bouton gauche de la souris tout en tirant
l'(les) article(s).
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Fonction Action souris

Pour modifier les paramètres
d'affichage  d'un objet, d’un
graphe, d’un texte, d’une
expression, ou de tout autre
article sur un panneau d'affichage

Cliquer avec le bouton droit  :
sélectionner l'(les) article(s) à modifier.
Positionner le curseur sur l'(les) article(s)
et cliquer avec le bouton droit de la
souris.

Pour modifier les paramètres de
définition  d'un objet ou d'une
expression

Majuscule-Cliquer avec le bouton droit :
sélectionner l'(les) article(s) à modifier.
Positionner le curseur sur l'(les) article(s)
et tenir la touche Majuscule enfoncée en
cliquant avec le bouton droit de la souris.

Remarque  Vous pouvez sélectionner plusieurs articles sur un panneau d'affichage
par un simple “lasso” (champ sélectionné). Les commandes ultérieures
affectent tout le groupe en même temps ou basculent d'un article à
l'autre, en vous demandant de nouvelles instructions. Vous pouvez
interrompre ce processus en tenant enfoncée la touche Majuscule et en
sélectionnant OK ou Cancel dans la boîte de dialogue en cours.

e

Les raccourcis de clavier
Le tableau suivant liste les raccourcis disponibles lorsque Lookout est en
mode Edition.

Commandes clavier en mode Edition

Pour sélectionner cette commande menu Appuyez sur

Fichier Nouveau... CTRL+N

Ouvrir... CTRL+O

Connexion... CTRL+L

Fermer... CTRL+D

Edition Annuler xxxx CTRL+Z

Couper CTRL+X

Copier CTRL+C

Coller CTRL+V

Supprimer SUPPR

Mode Edition CTRL+ESPACE
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Insertion Objet affichable... INSER

Expression... CTRL+E

Texte/Plaque/Incrustation... CTRL+T

Panneau de contrôle... CTRL+P

Objet Créer... CTRL+INSER

Composition Aligner à gauche CTRL+GAUCHE

Aligner à droite CTRL+DROITE

Aligner le haut CTRL+HAUT

Aligner le bas CTRL+BAS

Centrer vert. F9

Centrer horiz. MAJ+F9

Composition Espacer uniformément en travers ALT+DROITE

Espacer uniformément vers le bas ALT+BAS

Grouper CTRL+G

Dissocier CTRL+U

Déplacer vers l’avant CTRL+F

Déplacer vers l’arrière CTRL+B

 Alarmes Montrer CTRL+A

Silence CTRL+S

e

Le rappel des noms de variables

De nombreuses boîtes de dialogue contiennent des champs d'expression.
Les champs d'expression sont jaunes et signalent que vous pouvez
obtenir de l'aide afin d'identifier ou de vous rappeler des variables et
leurs données membres en cliquant avec le bouton droit de la souris
(cliquer avec le bouton droit sur le champ d'expression sélectionné).

Supposons que vous vouliez tracer le débit dans un conduit de retour
d'eau. Vous commencez à créer l'objet Trend (tendance), mais comme
c'est lundi et que vous n'avez pas encore pris votre café, vous ne vous
rappelez pas le nom de variable que vous voulez tracer. Il vous suffit
donc de cliquer avec le bouton droit de la souris sur le champ
d'expression de la courbe de tendance (c'est-à-dire le champ dans lequel
vous tapez normalement le nom de variable à tracer).
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Lorsque vous cliquez avec le bouton droit de la souris sur un champ
d'expression quel qu'il soit, Lookout affiche la boîte de dialogue Editeur
d'expression, comme illustré par le diagramme ci-après.

 
Editeur d'expression activé en cliquant avec le bouton droit sur une donnée
membre jaune

L'utilisation de la boîte de dialogue Editeur d'expression vous permet de
coller facilement des noms d'objets et leurs données membres
directement dans le champ d'expression. Après la sélection d'un objet et
d'une donnée membre, leur collage dans la donnée membre de l'éditeur

1. Sélectionnez
le nom de
variable.

2. Sélectionnez la
donnée membre.

4. Cliquez sur OK.

Sélectionnez le champ
d’expression jaune et cliquez
dessus avec le bouton droit
pour invoquer l’éditeur
d’expressions.

3. Cliquez sur
Paste
(coller).
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d'expression et le clic sur OK, Lookout écrit votre expression dans la
donnée membre d'expression de la tendance. Pas besoin de café !

L’Editeur d’expression écrit
votre nouvelle expression sur
le champ d’expression jaune.
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4. Tour d’horizon du développeur
e

Les fonctions décrites dans ce chapitre ne sont pas disponibles en
versions Runtime-Only (temps d’exécution uniquement) de
Lookout. Ainsi, ce chapitre explique en détail les fonctions du mode
Edition de Lookout.

Vous allez traverser toutes les étapes de développement d’un fichier de
processus simple. Reportez-vous à la section appropriée de ce guide pour
des informations détaillées sur une classe d’objets, une fonction ou une
caractéristique particulière.

Remarque Si vous n’avez jamais utilisé Windows de Microsoft, familiarisez-vous
d’abord avec les concepts décrits dans le Guide d’utilisation de Windows.
Ensuite, apprenez à utiliser les menus déroulants, à travailler dans les
boîtes de dialogue et à passer d’une application Windows à l’autre.

Le système à contrôler avec ce fichier de processus comprend un API et
un téléterminal, communiquant tous deux via le protocole standard
Modbus. Vous avez choisi Modbus comme exemple de protocole car il
est très répandu et bien connu dans les industries SCADA et de contrôle
de processus.

La tâche consiste à effectuer la connexion à l’API via les
communications série câblées et à relier le téléterminal à Lookout via les
communications radio. En supposant que Lookout se trouve sur une
radio à distance (non pas le répéteur maître).
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Le système que vous avez choisi à titre d’exemple est un système de
supervision du niveau d’eau dans un réservoir surélevé situé à plusieurs
kilomètres (téléterminal à distance) et de contrôle d’une pompe à l’usine
(API local). Quand le niveau du réservoir tombe au-dessous d’un certain
niveau, la pompe démarre et remplit le réservoir. Quand le réservoir est
rempli, la pompe s’arrête. Le réservoir est une cuve d’eau de 150 mètres
de profondeur (50 pieds).

Lancez Lookout. Le programme apparaît sur un écran vierge.

Sélectionnez File→New... (Fichier→Nouveau) pour commencer
l’élaboration du fichier de processus. Lookout affiche la boîte de
dialogue New Control Panel (nouveau panneau de contrôle).
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Tapez dans le panneau de contrôle le nom de variable Tag et le titre Title
appropriés et sélectionnez Normal comme type de panneau. Votre écran
a maintenant cette apparence :

Sélectionnez la flèche d’agrandissement sur le panneau Overview
(panorama) pour l’agrandir au maximum. Le panneau occupe maintenant
tout l’écran ; le titre du panneau apparaît entre parenthèses à la fin de la
barre de titres de Lookout. Vous n’êtes pas obligé de créer des panneaux
couvrant tout l’écran et vous pouvez choisir de les créer en vous basant
sur leur état “normal”. C’est une question de préférence.

Cliquez sur ce
bouton pour
agrandir le
panneau.
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Remarque Pensez à la résolution de l’écran lorsque vous créez des panneaux
d’affichage (par exemple, VGA au lieu de Super VGA). Le même
panneau peut présenter une apparence différente sur les ordinateurs
dont les drivers de résolution d’affichage sont différents. Reportez-vous à
la documentation sur la résolution des écrans dans la section “Panel” du
chapitre “Définitions des classes d’objets” avant d’élaborer vos panneaux.

Ajoutons maintenant la logique et les graphiques qui contrôlent et
affichent la pompe et le réservoir. Il convient de créer d’abord un
potentiomètre qui simule un niveau variable dans le réservoir au lieu de
relier directement le registre Modbus pour cette entrée analogique. Etant
donné que la majorité des lecteurs ne disposent pas de périphériques
Modbus, ceci vous permet de simuler un signal analogique. Après avoir
démontré le processus avec un potentiomètre de simulation, nous
expliquerons comment relier le système à ses registres Modbus
respectifs.

Sélectionnez Object→Create... (Objet→Créer) et ensuite Pot
(potentiomètre) dans la liste des classes d’objets.
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Double-cliquez sur la classe d’objets ou sélectionnez la classe souhaitée,
puis sélectionnez OK.

Remplissez la boîte de dialogue exactement comme indiqué ci-dessous.

Sélectionnez OK quand vous avez terminé. Lookout vous demande
immédiatement de sélectionner un type d’affichage pour le
potentiomètre.
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Sélectionnez l’ascenseur, puis OK. Lookout insère le potentiomètre dans
le panneau de contrôle actif. Vous pouvez maintenant agrandir et/ou
repositionner le potentiomètre n’importe où sur le panneau à l’aide des
poignées de dimensionnement.

Sélectionnez maintenant Insert→Expression... (Insérer→Expression).

Poignées de
dimensionnement
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Sélectionnez SimulationLevel  (niveau de simulation) comme
valeur à insérer. Sélectionnez le bouton Paste (coller) pour insérer le
nom de variable dans le champ d’expression et sélectionnez OK. Vous
pourriez également taper le nom de variable dans le champ d’expression
ou double-cliquer dessus pour qu’il se colle dans le champ d’expression.

Lookout vous demande ensuite de sélectionner les caractéristiques
d’affichage pour le signal numérique que vous venez de nommer.
Sélectionnez les mêmes paramètres que ci-dessous. Sélectionnez bleu
foncé comme couleur de barre (Bar Color ) et blanc comme fond
(Background Color ). Il est à noter que le style d’arrière-plan
(Background Style ) est réglé sur rectangle et que le maximum est 50.

Grille de
couleurs
dont il est
question
dans la
remarque.
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Remarque Lookout utilise beaucoup les grilles de couleurs dans la plupart de ses
boîtes de dialogue. Malheureusement, elles ressortent mal dans ce guide
en noir et blanc. Ces grilles permettent de sélectionner la couleur de
nombreux éléments de façon extrêmement rapide et facile. Cependant,
elles peuvent être légèrement différentes d’un ordinateur à l’autre.

Une fois que vous avez sélectionné OK dans la boîte de dialogue
Display Numeric Signal (afficher le signal numérique), Lookout place le
graphique à barres dans le panneau de contrôle. Vous pouvez le
redimensionner et le déplacer partout sur l’écran. Réglez votre panneau
de contrôle pour qu’il ressemble au panneau suivant.

Ce graphique à barres simule le niveau d’eau dans le réservoir. Mais
pour lui donner une apparence plus réelle, placez dessus le graphique
d’un réservoir qui servira de coupoir ou de masque.

Sélectionnez la commande Insert→Graphic... (Insérer→Graphique) puis
le fichier graphique tank1_a.wmf . Comme vous avez choisi un fichier
méta, vous pouvez le redimensionner à la taille du graphique à barres et
“masquer” ainsi une partie du graphique à barres.
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Appuyez sur CTRL-BARRE D’ESPACEMENT pour sortir du mode
Edition et déplacez la glissière de haut en bas pour voir l’effet de
remplissage créé par votre masque de réservoir et le graphique à barres.
Puis retournez en mode Edition pour créer une tendance de niveau du
réservoir.

Avant de continuer, sauvegardez votre travail. Nous vous conseillons de
prendre l’habitude de sauvegarder périodiquement votre fichier de
processus quand vous créez un nouveau système ou modifiez un système
existant. Sélectionnez File→Save… (Fichier→Enregistrer) parmi les
commandes du menu, tapez tutorial  comme nom de fichier et
sélectionnez OK.
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Votre travail se trouve maintenant sur le disque dur sous le nom de
TUTORIAL.LKP. Le nouveau nom du fichier apparaît maintenant dans
la barre de titres de Lookout, suivi du titre du panneau de contrôle actif.

Sélectionnez Object→Create... (Objet→Créer) parmi les commandes du
menu et sélectionnez la classe Trend (tendance).

Remarque L’exemple suivant utilise une classe d’objets Runtime-Only Trend
(graphe de tendance du mode Runtime-Only). Cette classe d’objets n’est
incluse que dans les systèmes Lookout Express. Elle ne trace pas de
données historiques. Le programme HyperTrend™ dans tous les autres
systèmes Lookout trace les données historiques et actuelles et ne
comprend pas de paramétrage Sample Interval  (échantillon d’intervalle).

Remplissez les paramètres comme indiqué ci-dessous. Si votre tendance
comprend l’option Show button bar  (montrer la barre à boutons),
sélectionnez-la.

Observez que vous avez défini Trend Width  (largeur de tendance) à 1
minute, ceci afin d’observer immédiatement les fluctuations dans votre
potentiomètre de simulation. La largeur de tendance serait normalement
bien plus longue (1 jour ou 1 semaine par exemple).

Après avoir introduit la variable de la tendance (SimulationLevel ),
sélectionnez le bouton Accept (accepter). Ensuite, sélectionnez le bouton
OK. La boîte de dialogue suivante apparaît.
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Sélectionnez les paramètres d’affichage et sélectionnez de nouveau OK.
Comme c’est le cas pour tous les autres objets, vous pouvez
redimensionner et/ou déplacer la tendance sur votre panneau de contrôle.

Sortez de nouveau du mode Edition et déplacez la glissière de haut en
bas pour voir l’effet produit. (Nous vous conseillons de sauvegarder
également votre fichier.)

Il convient maintenant de créer un interrupteur MAA et un objet Neutral
Zone (hystérésis) pour contrôler la pompe. Retournez en mode Edition et
créez un objet Pot (potentiomètre) qui vous servira d’interrupteur à trois
positions (1=Hand [manuelle], 2=Off [arrêt], 3=Auto[automatique]).
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Sélectionnez l’option bouton comme style d’affichage.

Après l’insertion du potentiomètre, ajoutez le texte approprié à l’aide de la
commande Insert→Text/plate/inset... (Insérer→Texte/Plaque/ Incrustation).
Ensuite, encerclez le texte et le bouton, puis groupez-les à l’aide de la
commande Arrange→Group (Réorganiser→Groupe). Vous pouvez
maintenant déplacer le groupe entier d’objets comme un seul élément.
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e

Créez maintenant une hystérésis, que vous nommerez PumpAuto .

L’étape suivante consiste à créer un objet “Expression”, que vous
nommerez PumpRun (exécution pompe).
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Observez la logique de votre expression. Si l’interrupteur MAA = 1,
vous êtes en position manuelle et souhaitez que la pompe fonctionne,
OU si l’interrupteur MAA = 3, vous êtes en position Auto ET il faut
déterminer si l’hystérésis requiert le démarrage de la pompe (l'option
below [inférieur]) signifie que le signal est au-dessous du seuil inférieur
et que la pompe doit démarrer). Si l’interrupteur MAA = 2, vous êtes en
position Arrêt et le résultat de l’expression est faux.

Sélectionnez le bouton OK. Lookout fait apparaître la boîte de dialogue
Insert Expression (insérer expression). Choisissez PumpRun si cette
option n’est pas déjà dans la fenêtre et sélectionnez OK.

PumpRun produit un signal logique. Vous pouvez donc choisir deux
fichiers graphiques à afficher : un pour le signal “on” (activé) et un pour
le signal “off” (désactivé). Cliquez sur la sélection Custom
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(personnalisé) et déroulez la liste On jusqu’au fichier PMP1_RD.WMF.
Puis déroulez la liste Off  et sélectionnez PMP1_GRN.WMF. Après avoir
choisi les fichiers appropriés, sélectionnez OK.

Comme précédemment, vous avez choisi deux fichiers méta qui peuvent
être redimensionnés en tirant une poignée de dimensionnement.
Redimensionnez et placez la pompe comme indiqué ci-dessous.
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Avant de quitter le mode Edition et de tester le système, ajoutons un
élément final. Il serait intéressant de faire une lecture numérique du
niveau d’eau dans le réservoir. Il est possible d’insérer une nouvelle
expression et choisir l’option numérique comme style d’affichage ; mais
utilisez plutôt l’un des raccourcis de Lookout.

Cliquez simplement sur le réservoir : le mot “graphic” (graphique)
apparaît dans la barre d’état. Ceci indique exactement ce qui a été
sélectionné. Comme vous avez superposé le graphique sur le graphique à
barres, il faut cliquer une fois de plus pour sélectionner l’article suivant
de la pile. La barre d’état affiche maintenant SimulationLevel
(niveau de simulation). Vous pouvez ainsi copier et modifier rapidement
les paramètres d’affichage de l’expression. Maintenez enfoncée la
touche Majuscule tout en tirant le graphique à barres (cette option
s’appelle MAJ-tirer). Ceci copie le graphique à barres. Reportez-vous à
la section “Les raccourcis de souris” au chapitre 3 pour des
instructions sur l’utilisation d’une souris. Sélectionnez et positionnez
maintenant le curseur sur le nouveau graphique à barres. Cliquez avec le
bouton droit de la souris pour modifier et afficher les paramètres.

Remplissez la boîte de dialogue comme indiqué ci-dessous et
sélectionnez OK.

Redimensionnez maintenant l’affichage numérique et placez-le sur le
réservoir.
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Il convient maintenant de sortir du mode Edition et de tester le système.
Réglez l’interrupteur MAA sur la position Auto et déplacez le bouton à
glissière de haut en bas pour vérifier si votre hystérésis fonctionne
correctement. Puis réglez l’interrupteur MAA sur Off et Hand pour
achever le test. La pompe change de couleur selon votre logique.

Retournez maintenant en mode Edition. Vous allez ajouter des plaques,
des échelles et du texte, entre autres, dans l’écran.

Sélectionnez d’abord Insert→Text/plate/inset... puis Plate  (plaque)
comme style d’arrière-plan. N’entrez pas de texte dans la fenêtre.
Sélectionnez OK. Cette technique extrêmement facile permet de créer
rapidement des plaques et des incrustations de différentes couleurs.
Essayez pendant quelques instants différentes combinaisons de plaques,
d’incrustation et de couleurs d’arrière-plan.
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Après avoir inséré la plaque, mettez-la en haut à gauche du panneau de
contrôle et tirez la poignée de dimensionnement pour l’agrandir. Ensuite,
placez la plaque derrière tous les autres éléments à l’aide de la
commande Arrange→Move to Back (Disposer→Placer derrière). Vous
pouvez alors continuer de ranger et de dimensionner la plaque ou les
autres objets.

Continuez d’ajouter des plaques, des incrustations et du texte. En
quelques minutes, votre écran ressemble à l’écran ci-après. Vous aurez
peut-être à redéplacer ou à redimensionner quelques objets.
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Changez maintenant la glissière verticale en glissière horizontale et
repositionnez-la. Sélectionnez la glissière avec le bouton gauche de la
souris puis cliquez sur le bouton droit de la souris pour revoir les
paramètres d’affichage. Reportez-vous à la section “Les raccourcis de
souris” au chapitre 3 pour des instructions sur l’utilisation de la souris.

Après avoir déplacé la glissière en bas du panneau de contrôle, ajoutez
deux échelles : une pour la glissière et l’autre pour la tendance.

Sélectionnez Insert→Scale...(Insérer→Echelle) et remplissez la boîte de
dialogue en conséquence.
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Après avoir positionné l’échelle à côté de la tendance, MAJ-tirez sur
l’échelle pour en faire une copie. Puis cliquez avec le bouton droit de la
souris pour modifier la seconde échelle de la glissière horizontale.

Sortez de nouveau du mode Edition et testez le système en déplaçant la
glissière et le bouton “knob”.

Ultérieurement, il ne sera évidemment pas nécessaire d’effectuer les
étapes préliminaires pour créer des signaux de simulation. Cependant, il
est prudent de tester la logique avant d’effectuer une véritable
connexion.
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Commencez par les étapes nécessaires pour relier votre API et votre
téléterminal à Lookout. Configurez d’abord les ports de communication.
Sélectionnez la commande Options→Serial Ports... (Options→Ports
série) dans le menu. Configurez COM1 pour une connexion série câblée
à votre API local et sélectionnez Accept. Ensuite, sélectionnez COM2
dans la liste déroulante Serial Port , puis Radio (RTS/CTS) . Vous
utilisez ce port pour communiquer avec le téléterminal déporté au
réservoir surélevé. Sélectionnez Accept (accepter) de nouveau. Vous
avez terminé. Sélectionnez maintenant Quit (quitter).

Il convient maintenant de connecter un contrôleur de protocole Modbus
à votre processus. Vous devez d’abord créer un objet Modbus avec
Object→Create...(Objet→Créer).
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Voici l’API local de l’usine qui contrôle l’utilisation de la pompe.
N’oubliez pas que vous êtes câblé à cet API via COM1.

L’étape suivante consiste à connecter le signal de l’hystérésis à un
registre sur l’API. Ce signal démarre et arrête la pompe. Sélectionnez
Object→Edit Connections... (Objet→Editer connexions) dans le menu,
puis Local_PLC  (API local).

Commencez par entrer 100  dans la donnée membre Select member
(sélectionner le champ). Puis appuyez sur le bouton Select pour signaler
à Lookout que vous allez relier un signal au registre 100  sur un
périphérique Modbus nommé Local_PLC . Tapez maintenant
PumpAuto.below  dans la fenêtre d’expression du haut et sélectionnez
le bouton Accept. Vous venez de relier une expression au registre 100 ;
un message de confirmation apparaîtra.
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Vous devez à présent créer un autre objet Modbus pour le téléterminal
déporté. Comme vous l’avez probablement constaté, chaque contrôleur
possède son propre objet dans Lookout. Chacun de ces objets détermine
la méthode d’interrogation, le groupage lecture-écriture, etc.

Etant donné que la communication avec le téléterminal s’effectue via
radio à distance, vous devez sélectionner un port série configuré pour
des communications radio. Ici, l’option est COM2.



Partie 1. Points essentiels

62

Il reste maintenant à remplacer le signal dans l’hystérésis de
SimulationLevel  (la glissière) par l’entrée analogique provenant du
téléterminal au site du réservoir surélevé. Sélectionnez Object→Modify...
(Objet→Modifier) dans le menu et sélectionnez PumpAuto .

Entrez Remote_RTU.40001  pour lire le niveau d’eau dans le
réservoir provenant du contrôleur comme valeur entière 16 bits.

Maintenant, votre fichier de processus est complet et opérationnel. Bien
que cette tâche soit relativement simple, c’est-à-dire démarrer et arrêter
une pompe selon le niveau d’eau dans le réservoir, vous avez étudié les
nombreux principes fondamentaux de la structure orientée objet de
Lookout. Vous avez également appris plusieurs raccourcis pour copier et
modifier des graphiques et des expressions.

Remarque Il est important de ne pas oublier que Lookout reste en ligne
(interrogation des API et téléterminaux, enregistrement des données,
déclenchement d’alarme, exécution de logiques de contrôle, etc.), même
quand vous êtes en mode Edition. Il n’est pas nécessaire d’arrêter le
système matériel pour modifier l’application Lookout, ni pour ajouter ou
retirer un élément matériel d’E/S, d’API, de téléterminaux, de contrôleurs
de boucle, etc.
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5. Utilisation des objets
Ce chapitre ainsi que la section du chapitre 1 intitulée L’architecture
sont les deux sections les plus importantes de ce guide. Elles
décrivent en détail les composants fondamentaux de l’architecture
Lookout. La bonne compréhension de ces chapitres est essentielle à
une utilisation optimale de Lookout.

e

Vous ne pouvez créer, modifier ou relier des objets qu’en utilisant les
systèmes Development/Runtime de Lookout. Ces capacités ne sont pas
disponibles avec les systèmes Runtime-only de Lookout.

La définition de l’objet
Les systèmes orientés objet semblent faire fureur en ce moment. Et
pourtant, la plupart des produits soi-disant orientés objet ne le sont pas
réellement. En effet, ils ne font qu’appliquer la technique au niveau
superficiel ou graphique et ne vous permettent que de manipuler
visuellement des symboles ou des “objets” sur l’écran. Qu’un concepteur
de logiciel se serve de C++ ou d’autres techniques de programmation
dotée d’une orientation objet ne signifie pas pour autant que le produit est
orienté objet au niveau de l’application. La différence est ENORME !

La véritable définition d’un objet est un ensemble autonome de données,
de paramètres et de fonctions. Chaque objet comprend sa propre base de
données prédéfinie, son jeu de paramètres et sa fonction intégrée. Vous
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ne développez pas la base de données de l’objet : elle est
automatiquement disponible quand l’objet est créé.

Le diagramme ci-dessous présente tous les paramètres et membres de la
base de données possibles pour un objet. Sachez toutefois que bon
nombre des classes d’objets ne supporte qu’une partie de ceux qui vous
sont présentés.

données membres
logiques

données membres
textuelles

données membres
numériques

Un objet regroupe ses données, paramètres et fonctions dans un ensemble

Pensez à un objet comme à la représentation logicielle d’une chose
concrète. Par exemple, un interrupteur électrique est une chose concrète.
Vous pouvez l’allumer et l’éteindre. Dans Lookout, l’objet Switch
(interrupteur) représente l’interrupteur électrique concret. Sa fonction
vous permet de l’allumer ou de l’éteindre, un paramètre détermine le
niveau de sécurité et un ensemble de données contient la valeur qui
indique la position de l’interrupteur.

Les classes d’objets
Les objets sont simplement des éléments séparés d’une classe d’objets
particulière. Les classes spécifient différents types d’objets. Par
exemple, un Potentiomètre et un Interrupteur représentent des classes
d’objets différentes, mais vous pouvez créer 20 potentiomètres et 30
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interrupteurs, soit en tout 50 objets en n’utilisant que deux classes
d’objets.

Le système Lookout possède une immense bibliothèque de classes
d’objets. Pour créer un objet, vous choisissez simplement la classe
d’objets voulue dans la liste de Lookout. Cela définit le type d’objet que
vous désirez. Vous donnez ensuite un nom unique à l’objet (nom de
variable).

La classe d’objets globaux est une sorte spéciale de classe d’objets. Ces
objets représentent des données du système global comme le nombre
d’alarmes actuellement activées. (Ce nombre n’est pas une donnée
membre d’un objet particulier). A la différence d’autres classes d’objets
où vous pouvez créer plusieurs objets de la même classe, vous ne pouvez
pas créer, modifier ou effacer des objets globaux, mais vous pouvez
utiliser leurs données membres de la même façon que les données
membres de tout autre objet.

Les fonctions
Les différentes classes d’objets ont été créées pour remplir des fonctions
singulièrement différentes. Par exemple, la classe d’objets Pot
(potentiomètre) opère de façon radicalement différente de la classe
d’objets Switch (booléen). Ce concept représente la fonction intégrée
dans chaque classe d’objets. Pensez à la fonction comme à la manière
dont un objet fonctionne, opère ou accomplit une tâche. La fonction est
un concept général qui s’applique de la même façon à tous les objets
d’une même classe d’objets donnée. L’extrait suivant du chapitre 18 est
un exemple de définition d’une classe d’objets. Reportez-vous au
chapitre 18 pour les définitions des classes d’objets.

Switch (booléen) génère un signal logique que les autres objets recevront. Les
Switch changent d’état quand vous cliquez dessus avec le bouton de la souris,
le trackball, l’écran tactile ou la barre d’espacement de votre clavier.
Définition de la classe d’objets Switch
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Les paramètres
Les paramètres d’un objet aident à définir ses caractéristiques ou sa
nature. Lookout utilise les paramètres d’un objet pour compléter la
définition de la fonction de cet objet. Par exemple, Data Rate (débit),
Parity (parité), et Stop Bits (bits d’arrêt) sont trois paramètres parmi
ceux qui définissent le fonctionnement d’un objet Modbus. D’autres
exemples comprennent : Control security level  (niveau de sécurité du
contrôle) d’un objet Switch (booléen) ; Minimum , Maximum , et
Resolution  d’un objet Pot ; et Data (données) d’un objet Average
(moyenne).

Chaque classe d’objets supporte un jeu de paramètres que vous devez
remplir ou sélectionner quand vous créez un nouvel objet. Quelques
paramètres supportent des expressions. D’autres exigent des valeurs
constantes. Quelques-uns vous demandent de sélectionner un réglage
spécifique. Les paramètres qui acceptent des expressions apparaissent
comme des champs jaunes d’entrée de données. Ces paramètres peuvent
recevoir des signaux (c’est-à-dire, ouverts à l’écriture). Reportez-vous au
chapitre 7 pour des informations supplémentaires sur les expressions.

Tous les paramètres d’une classe donnée sont visibles dans la boîte de
dialogue de définition de l’objet. Reportez-vous au chapitre 18 pour les
définitions de classes d’objets.



Chapitre 5.  Utilisation des objets

69

On est un paramètre qui
accepte une expression. Les
expressions apparaissent
dans des champs d’entrée
de données jaunes.

Log events  est un paramètre qui
exige une sélection Marche/Arrêt.
Les sélections apparaissent sous
forme de cases.

Position source  est un
paramètre qui requiert une
sélection spécifique. Les
sélections spécifiques
apparaissent sous forme de
boutons de radio.

Service  est un paramètre qui
accepte une valeur constante.
Les valeurs constantes
apparaissent dans des champs
d’entrée blancs.

Boîte de dialogue de définition de l’interrupteur

La base de données
Dans l’exemple d’interrupteur ci-dessus, la valeur ou donnée membre de
l’objet fait partie de la base de données autonome de l’objet. Les
données membres peuvent soit générer (écrire) des signaux, soit recevoir
(lire) des signaux, ou les deux.

Toutes les données membres comprennent une valeur unique de trois
types : numérique, logique ou textuelle. Elles doivent lire ou écrire des
signaux compatibles. Par exemple, vous ne pouvez pas connecter une
donnée membre qui génère un signal logique à une donnée membre qui
reçoit un signal numérique. Ne vous inquiétez pas, Lookout procède à de
sérieuses vérifications quand vous reliez des objets. Il ne vous permet
pas de mélanger les signaux.

Chaque objet a sa propre base de données intégrée. Ces données
membres sont connues comme champs natifs et peuvent être considérées
comme les données membres par défaut ou automatiques. Comme vous
le verrez plus loin dans ce chapitre, vous pouvez ajouter et/ou modifier
la base de données native pour qu’elle convienne à vos exigences
spécifiques.
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Certaines classes d’objets possèdent une base de données très limitée,
alors que d’autres en ont de très étendues. La base de données d’un objet
représentant un API peut avoir des milliers de données membres, alors
que celle d’un objet Switch (booléen) n’a que deux données membres.
Chaque classe d’objets comprend une explication de sa base de données
située dans sa définition. L’extrait suivant du chapitre 18 est un exemple
d’explication de base de données d’une classe d’objets. Reportez-vous
au chapitre 18 pour les définitions des classes d’objets.

Données
membres

Type Lecture Ecriture Description

(Implicite) Logique Oui Non Position Switch

Visible Logique Non Oui Quand la valeur est fausse, l’objet
Switch (booléen) ne peut pas être
vu sur le panneau d’affichage.
Quand la valeur est vraie,
l’interrupteur peut être vu et
contrôlé.

Données membres de la classe d’objets Switch

Les données membres booléennes

Les données membres booléennes comprennent une valeur qui
représente un état binaire activé ou désactivé. Un interrupteur de courant
est un dispositif logique : il est soit allumé, soit éteint. Les valeurs des
champs booléens sont généralement utilisées pour indiquer qu’un
élément de l’équipement est en marche, qu’un interrupteur de seuil est
ouvert ou fermé, ou pour contrôler l’équipement qui peut être éteint ou
allumé. L’objet Switch génère un signal logique qui est allumé quand
l’interrupteur est levé et éteint quand il ne l’est pas. De la même façon,
l’objet Pushbutton (bouton-poussoir) génère une valeur logique “allumé”
quand le bouton-poussoir est enfoncé. L’objet Pulse (impulsion) génère
un signal logique qui s’allume et s’éteint à intervalles prédéfinis, créant
ainsi une impulsion logique.
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Les signaux logiques que certains objets génèrent peuvent être
graphiquement affichés dans un panneau de contrôle. Reportez-vous au
chapitre 8, “Graphiques”, pour plus d’informations.

Lookout reconnaît les constantes logiques suivantes comme des
expressions :

Constantes logiques qui représentent un état “allumé” : yes , true ,
On (oui, vrai, allumé).

Constantes logiques qui représentent un état “éteint” : no , false ,
off (non, faux, éteint).

Les données membres numériques

Une donnée membre numérique est un nombre à virgule flottante qui
représente les valeurs analogiques comme le niveau d’eau dans un
réservoir, la pression, le débit et la température. Les champs numériques
sont représentés également comme une période de temps (durée) ou
comme un temps absolu (par exemple, un moment particulier du jour, de
la semaine, du mois ou de l’année). L’objet potentiomètre génère un
signal numérique, et les points d’entrée et de sortie analogiques sur les
API sont surveillés et contrôlés par des signaux numériques. Les signaux
numériques vont de -1,7x10308 à 1,7x10308 et la magnitude peut atteindre
un minimum de 1,7 x 10-308.

Les constantes numériques figurent sous forme de chiffres décimaux
(0-9), le signe moins (-), le symbole exposant (E ou e) et le séparateur de
format temporel (:).

Exemples de constantes numériques :

0

-123,779999

1,5E7 = 15.000.000

-3,7E-3 = -0,0037

-,0036

123356636,2345791
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Le temps ou les signaux temporels sont stockés par Lookout comme
valeurs numériques qui représentent des jours et des fractions de jour.
Par exemple, vous entrez une heure comme 1:00:00 et Lookout stocke le
nombre sous forme de 0,04167 ou 1/24 de jour. Les jours sont
représentés par la portion entière du nombre. Le chiffre zéro représente
le 1er janvier 1900. Lookout interprète le nombre à la droite des deux-
points de l’extrême droite (:) comme des secondes, le nombre à la droite
des deuxièmes deux-points (à partir de la droite) comme des minutes, le
chiffre suivant comme des heures et le chiffre à la gauche des troisièmes
deux-points (à partir de la droite) comme des jours. Si l’entrée ne
contient aucun deux-points, l’intervalle de temps sera interprété en jours.

Exemples de constantes d’intervalles numériques de
temps :

0:23 = 23 secondes ou 0,0002662 jour

75:00 = 75 minutes, 0 seconde, ou 0,05208 jour

12:00:05:01 = 12 jours, 0 heure, 5 minutes, 1 seconde ou 12,003484 jours

199:: = 199 heures, 0 minute, 0 seconde ou 8,2917 jours

0:10,023 = 10,023 secondes ou 0,0001160 jour

12,75 = 12,75 jours

17:64:22,5 = numéro non valable étant donné que l’option heures est spécifiée,
    les minutes doivent être <= 59

Les signaux numériques générés par certains objets peuvent certes être
affichés graphiquement dans le panneau de contrôle. Reportez-vous au
chapitre 8, “Graphiques”, pour plus d’informations. Si le signal
numérique est affiché numériquement, Lookout fournit un grand choix
de formats numériques, à savoir :

Général

“Général” nombre affiché sous la forme la plus compacte
possible

123,789 affiché comme 123,789
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Zéros en tête

“000000000” 123,789 affiché comme 000000124

“00000000” 123,789 affiché comme 00000124

“0000000” 123,789 affiché comme 0000124

“000000” 123,789 affiché comme 000124

“00000” 123,789 affiché comme 00124

“0000” 123,789 affiché comme 0124

“000” 123,789 affiché comme 124

“00” 123,789 affiché comme 124

“0” 123,789 affiché comme 124

Chiffres fractionnels suivis de zéros :

“0,0” 123,789 affiché comme 123,8

“0,00” 123,789 affiché comme 123,79

“0,000” 123,789 affiché comme 123,789

“0,0000” 123,789 affiché comme 123,7890

“0,00000” 123,789 affiché comme 123,78900

“0,000000” 123,789 affiché comme 123,789000

“0,0000000” 123,789 affiché comme 123,7890000

“0,00000000” 123,789 affiché comme 123,78900000

Notation exponentielle/scientifique :

“0E0” 123,789 affiché comme 1E+2

“0,0E+0” 123,789 affiché comme 1,2E+2

“0,00E+0” 123,789 affiché comme 1,24E+2

“0,000E+0” 123,789 affiché comme 1,238E+2

“0,0000E+0” 123,789 affiché comme 1,2379E+2

“0,00000E+0” 123,789 affiché comme 1,23789E+2

“0,000000E+0” 123,789 affiché comme 1,237890E+2

“0,0000000E+0” 123,789 affiché comme 1,2378900E+2

“0,00000000E+0” 123,789 affiché comme 1,23789000E+2
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Les signaux numériques peuvent aussi représenter des temps et des
intervalles de temps absolus. Etant donné que les dates et les heures sont
représentées par des valeurs numériques, elles peuvent être ajoutées,
soustraites et comprises dans des expressions, tout comme les autres
signaux numériques.

Un intervalle représente une durée ou une période de temps. Les
intervalles de temps sont indiqués en heures, minutes, secondes et en
fractions de secondes. Les formats numériques qui représentent les
intervalles de temps sont caractérisés par des lettres majuscules (par
exemple “H” au lieu de “h”).

Intervalles de temps

 “H” 0,4789 affiché comme 11 (heures)

“H.H” 0,4789 affiché comme 11,5 (heures)

“H.HH” 0,4789 affiché comme 11,49 (heures)

“M” 0,4789 affiché comme 690 (minutes)

“M.M” 0,4789 affiché comme 689,6 (minutes)

“M.MM” 0,4789 affiché comme 689,62 (minutes)

“S” 0,4789 affiché comme 41377 (secondes)

“S.S” 0,4789 affiché comme 41377,0 (secondes)

“S.SS” 0,4789 affiché comme 41376,96 (secondes)

“HH:MM” 0,4789 affiché comme 11:29 (11 heures, 29 minutes)

“HH:MM:SS” 0,4789 affiché comme 11:29:36 (11 heures, 29
minutes, 36 secondes)

“HH:MM:SS.S” 0,4789 affiché comme 11:29:36,9

“HH:MM:SS.SS” 0,4789 affiché comme 11:29:36,96

“HH:MM:SS.SSS” 0,4789 affiché comme 11:29:36,960

“MM:SS” 0,4789 affiché comme 689:36 (689 minutes, 36
secondes)

“MM:SS.S” 0,4789 affiché comme 689:36,9

“MM:SS.SS” 0,4789 affiché comme 689:36,96

“MM:SS.SSS” 0,4789 affiché comme 689:36,960
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Les dates et les heures absolues indiquent un moment spécifique dans le
temps. Lookout stocke toutes les dates et tous les temps absolus sous
forme de signaux numériques. Il utilise le système de datation de 1900
où le chiffre 0 correspond à minuit le 1er janvier 1900. Le chiffre 1
correspond à minuit le 2 janvier 1900 et ainsi de suite. Par exemple, le
nombre 34491,5 représente midi, le 6 juin 1994.

Les formats numériques qui représentent le temps absolu sont
caractérisés par des lettres minuscules (par exemple, “hh:mm” au lieu de
“HH:MM”).

Dates et temps absolus

“hh:mm” 34668,7889 affiché comme 18:56  (6:56 p.m.)

“hh:mm:ss” 34668,7889 affiché comme 18:56:02

“mm/jj hh:mm” 34668,7889 affiché comme 11/30 18:56

“mm/jj hh:mm:ss” 34668,7889 affiché comme 11/30 18:56:02

“mm/jj/aa” 34668,7889 affiché comme 11/30/94

“mm/jj/aa hh:mm” 34668,7889 affiché comme 11/30/94 18:56

“mm/jj/aa hh:mm:ss” 34668,7889 affiché comme 11/30/94 18:56:02

Les données membres texte

Les données membres texte comprennent des chaînes de caractères
textuels. Ces chaînes de caractères sont les caractères qui peuvent
s’afficher. Vous pouvez utiliser les signaux textuels pour afficher les
descriptions des alarmes sur le panneau d’alarme, pour afficher des
étiquettes sur un panneau de contrôle, et sous la forme de paramètres ou
d’expressions. Vous pouvez entrer des signaux textuels comme
constantes ou vous pouvez les construire à l’aide de nombreuses
fonctions textuelles disponibles dans les expressions. Assurez-vous que
les constantes textuelles sont placées entre guillemets (“ ”) quand vous
les utilisez au sein d’expressions.
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Exemples de constantes textuelles :

“Température de l’eau :”

“ ”             (chaîne de texte vide)
“Niveau bas dans le
réservoir ‘Polymer 2’”

“gpm”

Les données membres (implicites)

Vous constaterez qu’une grande partie des classes d’objets comprend
une donnée membre (implicite). Cette valeur implicite est logique,
numérique ou textuelle, selon la classe d’objets, et suit les mêmes règles
observées par les autres données membres. Le champ implicite
représente ce que Lookout considère comme la donnée membre la plus
fréquemment utilisée dans cette classe d’objets. C’est souvent la seule
donnée membre d’une classe. Elle a été créée uniquement pour
économiser du temps et pour réduire la saisie nécessaire pour désigner
une donnée membre spécifiée.

Par exemple, Lookout pourrait vous demander de spécifier le signal
numérique généré par un objet Pot en tapant Pot1.numeric  où Pot1
est le nom de variable et numeric  est la valeur courante du
potentiomètre. Entrez plutôt Pot1  et Lookout suppose automatiquement
que vous faites allusion à la valeur implicite du potentiomètre. La
définition du potentiomètre au chapitre 18 précise que la donnée membre
(implicite) est la valeur actuelle du potentiomètre.
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La création d’objets

Pour créer un objet

1. Veillez à être en mode Edition. (Sélectionnez Edit→Edit Mode
[Editer→Mode Edition] si nécessaire).

2. Dans la barre de menus Lookout, sélectionnez la commande
Object→Create… (Objet→Créer).

  
 La liste des classes d’objets

 Quand vous sélectionnez une classe d’objets, une boîte de dialogue
apparaît, vous permettant de définir les paramètres de l’objet.

 Double-cliquez sur la classe
d’objets souhaitée comme
raccourci pour la sélectionner
et cliquez sur le bouton OK.
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La barre de titres vous rappelle la classe que
vous avez sélectionnée.

Les champs blancs de données vous
permettent d’entrer des constantes en tant que
paramètres.

Les champs jaunes vous permettent d’entrer
des expressions en tant que paramètres.

 Une boîte de dialogue de définition de l’objet

 Pour cet exemple, sélectionnez la classe d’objets Pot
(potentiomètre). La classe d’objets que vous sélectionnez dépend du
type de fonction choisi.

3. Attribuez un nom de variable unique à l’objet. Les noms de variables
autorisés sont décrits dans la section Noms de variable d’objets, ci-
après.

4. Déterminez les paramètres du nouvel objet. Reportez-vous à la
définition spécifique de la classe d’objets au chapitre 18 pour des
informations sur une classe d’objets particulière.

 Chaque classe d’objets comprend des paramètres uniques. Certains
paramètres peuvent être définis comme des expressions. Les
expressions sont décrites au chapitre 7.

5. Sélectionnez OK pour créer le nouvel objet.

 De nombreuses classes d’objets ne sont pas habituellement affichées
dans un panneau de contrôle. Comment feriez-vous, par exemple,
pour afficher un objet Neutralzone (hystérésis) ? D’autre part,
beaucoup de classes d’objets, comme l’objet potentiomètre, peuvent
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s’afficher dans un panneau de contrôle. Quand vous créez un tel
objet, Lookout vous présente une boîte de dialogue d’affichage qui
vous permet de définir comment l’objet sera affiché.

 

 Boîte de dialogue d’affichage du potentiomètre

6. Dans la boîte de dialogue d’affichage, sélectionnez la représentation
voulue de l’objet et cliquez sur OK.

7. A l’aide des poignées de dimensionnement, placez l’objet dans le
panneau de contrôle comme bon vous semble.

Les noms de l’objet

Un nom de variable est un nom que vous attribuez à un objet spécifique.
Les noms de variables peuvent comprendre les caractères de A à Z, de a
à z, de 0 à 9 ainsi que le caractère de soulignement ( _ ). Les noms de
variables peuvent comprendre jusqu’à trente-deux (32) caractères et
doivent commencer par une lettre. La barre d’espacement et la touche
TAB ne sont pas acceptées. Lookout ne fait pas de différence entre les
majuscules et les minuscules, ainsi SW2 et sw2 représentent le même
nom de variable. Il vous faut attribuer un nom de variable unique à
chaque objet. Lookout ne vous permet pas de créer ou de modifier un
objet si le nom de variable n’est pas unique ou s’il ne respecte pas les
conventions d’attribution.
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Noms de variables autorisés

Pompe3_MAA

PompeServiceElevé3_Exécuter

EffacerNivPuits_de_Route289_et_N35

TempéCavitéF

Boutonpoussoir1

tempsd’exécution

Sw1EtSw2

L’utilisation des mots clés de Lookout (noms de classes d’objets et noms
de fonctions) comme noms de variables n’est pas acceptée. Par exemple,
vous ne pouvez pas utiliser des termes comme Switch, DelayOn,
STDEV, Modbus, nif, ou Tendance parce que ce sont des mots clés
réservés.

Noms de variables non autorisés

3Pompe_MAA (commence par un chiffre)

_PompeServiceElevé3_Exécuter (commence par un
soulignement)

EffacerNivPuits de Route289  et  N35 (comprend des espaces)

# TempéCavitéF (commence par #)

Boutonpoussoir (mot réservé)

Cenomabienplusdetrente-
deuxcaractères

(trop long)

Et (mot réservé)
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L’édition des bases de données d’objets
Lookout crée automatiquement une base de données native pour un objet
quand vous le créez. La base de données native est présentée à la fin de
chaque définition de classe d’objets au chapitre 18.

Vous pouvez créer de nouvelles données membres et/ou modifier les
paramètres de n’importe quelle donnée membre existante. Ces
paramètres comprennent des éléments comme les seuils des alarmes, les
filtres de déviation, les facteurs de mise à l’échelle, l’enregistrement
historique et les pseudonymes.

Remarque La base de données native de tout objet dans Lookout peut être
modifiée. Cependant, ceci n’est pratique que pour les objets dont les
bases de données natives sont très grandes, comme les objets drivers et
les objets DataTable (tableau de données).

Pour éditer les paramètres des bases de données

1. Dans la barre de menus Lookout, sélectionnez Object→Edit
Database… (Objet→Editer la base de données).
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2. Dans la liste déroulante Edit, sélectionnez l’objet désiré.

 Sélectionnez la classe d’objets Modbus à titre d’exemple. Une fois
que vous avez sélectionné l’objet désiré, la boîte de dialogue
suivante apparaît.

 

3. Pour chaque donnée membre à configurer :

a) Identifiez la donnée membre désirée en l’entrant dans la donnée
membre Member . Si vous modifiez une donnée membre déjà
configurée, vous pouvez simplement la sélectionner dans la liste
déroulante Configured points  (points configurés).

Remarque Plusieurs champs de paramètres changeront automatiquement selon la
donnée membre que vous sélectionnez. Lookout détermine
automatiquement si la donnée membre est logique ou numérique et vous
présente les attributs appropriés des paramètres.
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b) Configurez les paramètres appropriés comme il se doit.
Reportez-vous aux explications suivantes pour obtenir des
informations détaillées sur les paramètres.

c) Sélectionnez Save (enregistrer) ou Update (mise à jour). (Si
vous modifiez une donnée membre déjà définie, le bouton Save
se transforme en bouton Update.)

Lookout stocke tous les nouveaux paramétrages pour la donnée
membre spécifiée quand vous sélectionnez Save ou Update. De plus,
Lookout ajoute la donnée membre modifiée dans la liste déroulante
Configured points  pour une consultation ultérieure. Lookout
répercute immédiatement les modifications apportées dans toute
votre configuration.

4. Sélectionnez Quit (quitter) pour sortir de la boîte de dialogue.

Les paramètres du champ numérique
Le diagramme et les paragraphes suivants décrivent les paramètres des
données membres numériques. Notez que les données membres logiques
utilisent un certain nombre de paramètres identiques.
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Le champ Alias  vous permet de renommer toute donnée membre native.
Ces pseudonymes agissent un peu comme des “surnoms”. Par exemple,
l’objet driver Tiway comprend la donnée membre native WX100 qui
représente une entrée analogique. Vous pouvez lui attribuer un
pseudonyme comme FlowRate  (débit). A partir de ce moment-là, vous
pouvez référencer le pseudonyme FlowRate  au lieu de son premier
nom WX100. Il va de soi que tous ses paramètres associés (par exemple,
la mise à l’échelle) seront appliqués à la valeur du pseudonyme.

Les pseudonymes sont une bonne façon d’isoler votre configuration
Lookout et de la protéger des modifications de votre API, de votre
téléterminal ou de vos E/S. Par exemple, considérez un transmetteur de
débit câblé pour une entrée analogique à WX100. Vous pouvez attribuer
le pseudonyme FlowRate au WX100, comme dans l’exemple précédent.
Des panneaux de contrôle multiples peuvent alors afficher la donnée
membre FlowRate  que plusieurs autres objets de Lookout peuvent
utiliser. Si par la suite vous décidez de recâbler le transmetteur pour une
entrée analogique à WX101, vous n’avez qu’à modifier le pseudonyme
FlowRate  pour refléter la nouvelle adresse E/S. Lookout répercutera
immédiatement cette modification unique partout où FlowRate  est
utilisé. Vous pouvez modifier tous les paramètres associés d’un
pseudonyme existant sauf le nom même du pseudonyme. Si vous essayez
de modifier un nom de pseudonyme existant, le bouton Update se
transforme en bouton Save et vous créez tout simplement un nouveau
pseudonyme. Ceci ne modifie pas le pseudonyme existant.

En général, les utilisateurs ne donnent des pseudonymes qu’aux objets
dont les bases de données natives sont très grandes, comme les objets
drivers (par exemple, Tiway et Modbus) et les objets DataTable (tableau
de données).

Remarque Comme pour tous les autres paramètres, les pseudonymes sont
optionnels. Vous pouvez donc attribuer des paramètres de mise à
l’échelle, d’alarmes et d’enregistrement pour toute donnée membre
native et les sauvegarder dans la liste Configured points  sans pour
autant attribuer un pseudonyme.
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La Description  apparaît comme le texte de message dans la fenêtre
d’alarme. Elle peut contenir des espaces et être très longue. Les
guillemets ne sont pas nécessaires.

Prefix  (préfixe) et Suffix (suffixe) font partie de la description mais
n’apparaissent pas dans la fenêtre d’alarme. Ce sont tout simplement des
textes descriptifs supplémentaires.

Vous pouvez définir Scaling  (mise à l’échelle) en entrant Raw units
(unités brutes) et Eng. units  (unités ingén.). La donnée membre “brute”
est convertie (mise à l’échelle) à une valeur au format ingénieur. L’API
dans cet exemple génère une valeur brute de 6.400 à 32.000. Lookout
convertit ce signal brut pour qu’il aille de 0 mgd à 200 mgd (ce qui est
un peu plus facile à comprendre). La conversion est linéaire. Reportez-
vous aux spécifications de votre matériel pour les unités brutes
maximales et minimales associées aux dispositifs analogiques. Si vous
laissez les champs Raw units  et Eng. units  vides, Lookout ne fera pas la
mise à l’échelle de ce signal.

L’option Deviation  (déviation) filtre les variations sans intérêt des
signaux numériques. La figure suivante montre deux valeurs tracées sur
une tendance dans Lookout. Une ligne représente la valeur brute non
filtrée. L’autre ligne en marches d’escalier représente la valeur filtrée
après être passée par une option Deviation  de 2.
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La base de données historique de Lookout utilise Deviation  comme un
critère qui déclenche l’enregistrement d’une nouvelle valeur de données
historique sur disque. Reportez-vous au chapitre 11 pour plus
d’informations sur l’enregistrement de données.

Le champ de données Forced  (forcé) vous permet d’entrer
manuellement une valeur constante pour la donnée membre. Quand vous
sélectionnez la case Forced  et que vous entrez une valeur dans le champ,
Lookout force la valeur au format ingénieur à être la même que la valeur
entrée, sans tenir compte de la valeur actuelle de la donnée membre
native. Vous pouvez utiliser cette option en cas de panne du capteur ou
pendant l’entretien d’un capteur, c’est-à-dire quand l’API reçoit un
mauvais signal du transmetteur.

Les paramètres Alarm condition  (état d’alarme) vous permettent de
définir les seuils de l’alarme et leurs priorités correspondants. Lookout
compare les consignes d’alarme avec les valeurs au format ingénieur
(c’est-à-dire le chiffre après la mise à l’échelle et le filtrage). Si vous
n’entrez pas les paramètres de mise à l’échelle, Lookout affecte les
paramètres d’alarme directement au signal brut.

Vous pouvez attribuer un pseudonyme ou une donnée membre native
pour tout Group d’alarme existant ou vous pouvez créer un nouveau
Group . Pour créer un nouveau Group , entrez simplement son nom.
Reportez-vous au chapitre 9 pour plus d’informations sur les alarmes.

Le paramètre d’alarme Deadband  (zone morte) vous permet d’éviter le
battement irrégulier entre un état normal et un état d’alarme quand la
valeur du signal est proche du seuil d’alarme. La figure suivante montre
une valeur tracée par rapport à ses seuils d’alarme Hi (haut) et Lo  (bas).
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Traitement d’alarme d’une donnée membre aux consignes d’alarme indiqués et
dont la zone morte Deadband  est 12

Comme vous pouvez le constater, Lookout génère une alarme dès que la
valeur franchit les consignes d’alarme Hi ou Lo . L’alarme redevient
normale quand la valeur est au-dessous du seuil haut d’alarme moins la
valeur de la zone morte, ou bien est au-dessus du seuil bas d’alarme plus
la valeur de la zone morte. La zone morte est également valable pour
tous les seuils d’alarme HiHi  (haut-haut) et LoLo  (bas-bas).

Les paramètres Log to historical database (enregistrement dans la base
de données historique) définissent la durée de stockage d’une valeur
dans la base de données historique Citadel sur votre disque dur. Si vous
ne sélectionnez pas cette option, Lookout n’enregistre pas la valeur sur
votre disque. Si n’importe quel paramètre de mise à l’échelle ou de
filtrage est défini, Lookout enregistre la valeur mise à l’échelle et filtrée
(c’est-à-dire la valeur au format ingénieur). Reportez-vous au chapitre
11 pour plus d’informations sur les données d’enregistrement.

Les paramètres du champ booléen
Plusieurs paramètres des champs booléens sont différents des paramètres
des champs numériques. La mise à l’échelle d’un signal logique ne
requiert qu’une case Invert Logical Signal  (inverser le signal logique).

Alarme

Alarme

Normal

Normal

Zone morteBas

Haut

72,0
60,0

150,0
138,0
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Quand vous sélectionnez cette case, une valeur ON (activé) est
représentée par une valeur OFF (désactivé) et vice versa. Quand vous ne
la sélectionnez pas, ON reste ON et OFF reste OFF.

Un signal de base de données logique est indiqué dans la figure suivante.

Les paramètres d’alarme d’un signal logique comprennent le champ
d’affectation d’alarme Group  et la case Generate Logical Alarm
(générer alarme logique). Quand elle est sélectionnée, la donnée membre
génère une alarme toutes les fois que la valeur est ON ; l’état d’alarme
est annulé toutes les fois que la valeur est OFF. Remarquez que si la case
Invert Logic Signal est sélectionnée, la valeur utilisée est la valeur
inversée. Reportez-vous au chapitre 9 pour plus d’informations sur les
alarmes.

L’importation et l’exportation des bases de
données d’objets

Le service d’importation des bases de données vous permet de copier les
paramètres d’une donnée membre à partir d’un fichier de tableur d’Excel
directement dans un objet. Le service d’exportation de base de données
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vous permet de copier la base de données d’un objet dans un tableur
d’Excel. Considérez les utilisations possibles de ces services :

• Exporter les définitions de paramètres d’une base de données d’un
objet dans Excel pour la documentation.

• Exporter la base de données d’un objet dans Excel, effectuer des
remplacements globaux dans les paramètres de la donnée membre,
puis importer les modifications.

• Créer une liste de noms de variables dans Excel ou dans une
application qui exporte dans Excel, puis copier cette liste de noms de
variables dans Lookout.

• Dans le cas d’un processus qui utilise plusieurs objets drivers et en
double (comme un gazoduc ou un système de distribution d’eau),
définir les paramètres uniques de la base de données d’un objet
driver dans Excel, puis importer cette base de données dans
plusieurs objets drivers.

Bien que vous puissiez importer et exporter la base de données de
n’importe quel objet, vous trouverez que ces services sont les plus utiles
pour des objets dont la base de données native est très grande, comme
les objets drivers et les objets DataTable.

Remarque La commande Options→Import APT vous permet d’importer les
paramètres d’une base de données directement d’une base de données
APT dans un objet Tiway. Pour plus d’informations, reportez-vous à la
description des commandes au chapitre 16, Commandes du menu
Runtime.

L’exportation de la base de données d’un objet

Pour exporter la base de données d’un objet :

1. Dans la barre de menus Lookout, sélectionnez Object→Edit
Database… (Objet→Editer→Base de données).

2. Dans la liste déroulante d’édition d’un objet, sélectionnez l’objet
désiré.
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 Vous pouvez voir dans le diagramme suivant que vous avez
sélectionné un objet Modbus qui comprend déjà plusieurs points
logiques et numériques (données membres) définis.

 

3. Dans la boîte de dialogue de la base de données de l’objet, cliquez
sur le bouton Export.

 

4. Dans la boîte de dialogue Export Object Database to… (Exporter la
base de données de l’objet), sélectionnez un chemin de répertoire,
entrez un nom de fichier et cliquez sur OK.
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Et voilà ! Quand vous exportez la base de données d’un objet, Lookout
n’exporte pas nécessairement toutes les données membres possibles
(beaucoup d’objets drivers ont une capacité de plusieurs milliers de
champs). Lookout exporte plutôt les points configurés, c’est-à-dire les
données membres qui ont au moins un paramètre déjà défini. A titre
indicatif, Lookout exporte également les champs natifs en cours
d’utilisation (c’est-à-dire reliés à d’autres objets).

Le fichier tableur créé par la commande Export de Lookout est au format
Excel version 2.0. Un exemple du fichier .XLS  est présenté dans le
diagramme ci-après.
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La création de la feuille de calcul d’une base de données

La façon la plus facile de créer la feuille de calcul d’une base de données
pour un objet est de créer l’objet dans Lookout, de définir les paramètres
pour un membre booléen et un membre numérique et d’exporter sa base
de données. La fonction d’exportation fournit automatiquement tous les
titres des colonnes ; les deux champs de bases de données fournissent
quelques exemples à suivre.

Observez que la Rangée 1 comprend le titre des colonnes. Ces colonnes
comprennent les noms de tous les paramètres des membres de la base de
données. Etant donné que Lookout référence le titre mais pas le numéro
de la colonne, vous devez écrire le titre des colonnes avec précision.
Lookout ignore les espaces et ne fait pas la différence entre les
majuscules et les minuscules. Le tableau suivant liste tous les titres
possibles des colonnes.

Titre des colonnes de la feuille de calcul

Commande Données
membres

Pseudonyme Description

Préfixe Suffixe Min Eng Max Eng

Min brut Max brut Inversion? Déviation

Forcer? Valeur forcée Groupe d’alarme Niveau bas-bas

Priorité bas-bas Niveau bas Priorité bas Niveau haut

Priorité haut Niveau haut-haut Priorité haut-haut Priorité logique

Enregistrer
données?

Durée de vie

Lookout requiert des titres de colonnes “Commande” et “Champ”. Tous
les autres titres sont optionnels. “Commande” doit être dans la cellule
A1. L’ordre d’apparition des autres titres de colonnes ne pose aucun
problème.

Quand vous importez une base de données, Lookout lit les 30 premières
colonnes (A-AD) et ne tient pas compte des colonnes sans titre.

Les rangées sous les titres des colonnes (en dessous de la rangée 1)
représentent chacune un membre de la base de données. Par exemple, la
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rangée 5 dans la figure représente la donnée membre dont le
pseudonyme est FIC101Mode. Comme le montre la figure ci-après, vous
pouvez facilement ajouter des rangées pour définir de nouveaux points.
Les rangées associées à FIC101 ont été copiées, puis les nouvelles
rangées on été légèrement modifiées en identifiant les champs natifs
différents et en leur donnant des descriptions et des pseudonymes
nouveaux.

Si vous sélectionnez File→Save... (Fichier→Enregistrer) dans Excel et
que vous travaillez sur une version ultérieure, le programme vous
demande si vous voulez actualiser le format de votre feuille de calcul.
Cette demande est représentée ci-dessus. Sélectionnez toujours No (non).
La fonction d’importation n’accepte pas actuellement les fichiers
tableurs d’Excel en version 5.0.
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L’importation de la base de données d’un objet

Quand vous importez une base de données, Lookout lit les 30 premières
colonnes (A-AD) et ignore les colonnes sans titre. Il ignore également la
colonne AE et les suivantes.

Chaque rangée dans la colonne Commande (colonne A) comprend soit le
mot clé “insert” (insérer) soit le mot clé “delete” (effacer). Quand vous
importez une base de données, Lookout ignore les rangées qui n’ont ni le
mot clé “insert” ni le mot clé “delete”. Il ajoute les enregistrements dont
le mot clé de commande est “insert.” Il enlève les enregistrements dont
le mot clé est “delete”. Pour déterminer les enregistrements à effacer,
Lookout utilise le nom du pseudonyme de l’enregistrement ou, si
l’enregistrement n’a pas de pseudonyme, il le fait correspondre avec le
nom du champ de l’enregistrement.

Pour importer la base de données d’un objet :

1. Dans la barre de menus Lookout, sélectionnez Object→Edit
database.

2. Dans la liste déroulante d’édition de l’objet, sélectionnez l’objet
désiré.

3. Dans la boîte de dialogue de la base de données de l’objet, cliquez
sur le bouton Import.
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4. Dans la boîte de dialogue Import Object Database from… (importer
la base de données d’un objet à partir de), sélectionnez un chemin de
répertoire, puis le nom du fichier désiré, et cliquez sur OK.

Quand vous avez terminé, Lookout vous présente un jeu de
statistiques d’importation de la base de données, comme indiqué ci-
après.

Comme vous pouvez le constater ci-après, les points ajoutés dans la
feuille de calcul de la base de données ont été correctement ajoutés à la
liste Configured points .
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La copie de la base de données d’un objet

Les fonctions d’importation et d’exportation facilitent la copie de la base
de données d’un objet. Ceci est tout particulièrement utile quand vous
créez de grandes applications SCADA, comme les gazoducs avec
plusieurs stations de compresseurs.

L’essentiel au moment de définir plusieurs objets drivers qui nécessitent
une base de données en double est de créer d’abord un objet dans
Lookout pour chaque téléterminal ou API. Créez ensuite une base de
données unique dans Excel, puis importez cette base de données dans
chaque objet driver.

La connexion d’objets
Dans Lookout, vous “câblez” ou connectez des objets afin de permettre
aux signaux de contrôle de passer entre les objets quasiment de la même
manière que si vous câbliez un relais à action différée à un relais de
démarrage moteur. Une fois reliés, les objets transmettent des signaux
entre les divers membres et paramètres de leur base de données.
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Il existe deux méthodes élémentaires pour relier des objets : en
connectant la donnée membre au paramètre ou en connectant les
données membres les unes aux autres. La méthode que vous utilisez
dépend de votre objectif.

La connexion de données membres aux paramètres

Commencez par identifier la donnée membre (implicite) d’un objet Pot
(potentiomètre) comme la source Data (données) d’un objet Average
(moyenne). Vous pouvez aisément constater que Data est un paramètre
car il apparaît dans la boîte de dialogue de l’objet Average. Le
diagramme ci-après reflète graphiquement votre tâche.

données membres
NUMERIQUES

BASE DE DONNEES

données membres
LOGIQUES

(potentiomètre) (moyenne)

donnée membre
NUMERIQUE BASE DE DONNEES

Activer
rétablissement

Une connexion est établie entre l’objet Pot et l’objet Average en identifiant le
nom de variable de l’objet Pot dans le champ Data de l’objet Average.

Pour commencer, créez un objet Pot comme indiqué. Reportez-vous à la
section intitulée La création d’objets plus haut dans ce chapitre pour des
informations détaillées.
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Créez maintenant un objet Average (moyenne) comme indiqué ci-
dessous. Remarquez que vous effectuez la connexion du signal
numérique du potentiomètre au paramètre Data. L’objet Average calcule
maintenant la moyenne du niveau de Pot1  avec le temps, comme décrit
dans la définition de l’objet Average au chapitre 18.

L’identification des données membres d’objets

Etant donné qu’une grande partie des objets génère plusieurs signaux qui
peuvent servir d’entrées à d’autres objets, le nom de variable de l’objet
n’est pas toujours suffisant pour identifier le signal voulu. Il vous faudra
plutôt identifier le nom de variable de l’objet et la donnée membre
correspondante. Par exemple, un objet Modbus génère des milliers de
signaux, parfois logiques et parfois numériques. Pour spécifier quel
signal est le signal voulu dans un objet Modbus en particulier, entrez le
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nom de variable de l’objet suivi d’un point et la donnée membre que
vous désirez. Supposons que vous avez développé un objet Modbus avec
un nom de variable PLC1, que vous voulez afficher la valeur qui réside
dans le registre 40001 et que le statut du registre est 100. Vous n’avez
qu’à référencer ces données membres particulières en tapant
PLC1.40001  dans une expression et PLC1.100  dans une autre
expression.

La connexion de données membres à des données
membres

Au cours du paragraphe suivant, nous traiterons de l’exemple précédent
où vous avez créé un potentiomètre nommé Pot1 . Dans cet exemple,
vous allez créer un objet Modbus et connecter le signal numérique
généré par votre potentiomètre à un registre de rétention de 16 bits à
l’adresse 40001 sur l’API. Le diagramme suivant reflète graphiquement
votre tâche.

Une connexion est établie entre l’objet Pot (potentiomètre) et une donnée
membre d’un objet Modbus.

Pour commencer, créez un objet Modbus. Ne vous inquiétez pas si vous
n’avez pas un vrai API. Acceptez simplement le paramétrage par défaut
de Lookout dans la boîte de dialogue Modbus et cliquez sur OK.

N o m b re d e ten tatives P arité

P ort  sér ie   In te rro ga t ion   b its  d e d on n é es

S érie M od bu s

V i te sse  d e s  d o n n é e sn o m b re  d e  te n ta t iv e s

BASE DE DONNEES BASE DE DONNEES
Reportez-vous à la définition

Modbus pour une liste  
complète de toutes les données

membres numériques et
logiques.

Connexion à la base
de données
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Dans la barre de menus Lookout, sélectionnez la commande de menu
Object→Edit Connections… (Objet→Editer connexions). Utilisez cette
commande de menu toutes les fois que vous effectuez la connexion à une
autre base de données d’un objet.

Dans la liste déroulante Edit
Object Connections, sélectionnez
l’objet qui contient la donnée
membre à laquelle vous allez vous
connecter. Souvenez-vous que
vous effectuez la connexion du
Pot1 à la donnée membre 40001
dans votre objet Modbus. Vous
remarquerez peut-être que l’objet
Average (moyenne) que vous avez
développé précédemment
n’apparaît pas dans la liste. Ceci
vient du fait que cette boîte de
dialogue filtre tous les objets qui
n’ont pas de données membres
ouvertes à l’écriture. Il n’est donc pas possible de les relier.

Dans le champ de données Select member  (sélectionnez un champ),
entrez la donnée membre à laquelle vous voulez vous connecter.
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Cliquez sur le bouton Select (sélectionner) pour identifier la donnée
membre sur laquelle écrire. Observez que le texte reflète maintenant le
champ spécifique ; Modbus1.40001 =. Observez également le signe
d’égalité ( = ). Ceci vous demande de relier une expression au
Modbus1.40001. Pour cet exemple, ce sera l’expression Pot1 .

Dans le champ d’expression jaune, entrez le nom de variable Pot1 .

Cliquez sur le bouton Accept. Ceci “soude” la connexion et un message
s’affiche confirmant cette action. Vous verrez également que la donnée
membre 40001 a été ajoutée dans la liste déroulante Existing
connections  (connexions existantes).

Félicitations ! Vous venez de relier la donnée membre d’un objet à la
donnée membre d’un autre objet. Tout changement apporté à la valeur
(implicite) de Pot1  cause un événement et envoie un signal à tous les
autres objets qui y sont reliés. Etant donné que l’expression Pot1  est
maintenant connectée au Modbus1.40001 , régler Pot1  change la
valeur de la donnée membre 40001  dans l’objet Modbus1.
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L’affichage des données membres sur les
panneaux de contrôle

Pour afficher une donnée membre sur un panneau de
contrôle

1. Dans la barre de menus Lookout, sélectionnez Insert→Expression...
(Insérer→Expression).

2. Dans la liste déroulante des noms de variable Tags, sélectionnez
l’objet désiré. Vous pouvez également taper le nom de variable et la
donnée membre dans le champ d’expression jaune. Reportez-vous au
chapitre 7, “Expressions”, pour plus d’informations.

 

 Dans ce cas, vous avez sélectionné un objet Modbus API. Quand
vous sélectionnez un objet, Lookout liste la donnée membre de cet
objet.

3. Dans la liste déroulante Data members  (données membres),
sélectionnez la donnée membre désirée.
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4. Cliquez sur Paste (coller) et sélectionnez OK.

 Lookout réagit en présentant la boîte de dialogue d’affichage
numérique (ou logique). Le type de boîte de dialogue dépend du type
de donnée membre insérée (numérique ou logique). Ici, le signal est
numérique (PLC_2.WaterPressure ).

 

5. Sélectionnez les paramètres d’affichage désirés, puis OK.
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6. Communications en série

Introduction
Certaines classes d’objets représentent des appareils physiques externes
comme, entre autres, les API, les téléterminaux et les contrôleurs, et
communiquent avec eux. Quelques exemples comprennent Modbus,
Tiway, AB_PLC5 et Optomux. Nous utilisons ici le nom générique
Driver pour désigner ces types de classes d’objets. La fonctionnalité
intégrée aux objets Driver leur permet de communiquer avec les
appareils physiques qu’ils représentent. En fait, les objets Driver
constituent la démarche principale suivie par Lookout pour
communiquer avec le monde extérieur.

Dans les systèmes traditionnels, le “driver” est une application séparée
qui fonctionne indépendamment de l’interface de l’opérateur. Dans ces
systèmes, le programme driver dispute le temps processeur avec d’autres
applications, comme les gestionnaires de bases de données, les interfaces
IHM et les enregistreurs de données historiques. (C’est pourquoi on
parle beaucoup du multitâche et du temps processeur.)

Par opposition, les drivers de Lookout ne sont pas des applications
séparées. Les objets Driver fonctionnent comme n’importe quel autre
objet de l’environnement événementiel de Lookout à une différence
près : ils communiquent avec des appareils externes.
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Les utilisateurs travaillant sur des systèmes traditionnels prévoient un
temps d’immobilisation considérable pour concevoir, configurer et
établir leurs drivers et leurs bases de données. Ils doivent également
affecter un driver particulier à un port série précis. Dans ces
configurations, plusieurs drivers ne partagent pas un seul et unique port
série.

Avec Lookout, le débit en bauds, les bits de données, la parité et les bits
d’arrêt ne sont pas associés à un port série particulier. Ainsi, les drivers
chargés des différents protocoles et débits de bauds utilisent le même
port et donc le même modem ou la même fréquence radio. Cette capacité
vous permet de mélanger et de marier différents téléterminaux, API et
autres appareils sur une fréquence radio unique sans crainte de conflit de
communication et sans matériel spécial. Par exemple, une radio
bidirectionnelle reliée à un port série sur l’ordinateur peut communiquer
avec plusieurs marques de téléterminaux à distance, chacune ayant son
propre protocole. Ou, soixante-quinze API à distance peuvent partager
un jeu de cinq modems Dial-up.

Tout ceci est possible grâce au Sous-système de communication
(COMSUB) unique de Lookout. COMSUB est un environnement où les
objets accèdent aux ports série dans l’ordre et à temps. Ce chapitre décrit
le fonctionnement et la configuration de COMSUB.

Remarque Certains objets Driver de Lookout communiquent avec des appareils
physiques via un matériel dédié. Ces objets Driver n’utilisent pas de ports
série mais leurs propres cartes de réseau pour s’interfacer avec le
monde extérieur. Quelques exemples comprennent Modbus Plus (carte
SA85), Data Highway (carte KT) et DeltaTau (carte PMAC). La
configuration du port série n’est pas nécessaire pour ces classes
d’objets. Pour savoir si une classe d’objets particulière utilise un port
série, reportez-vous à la définition de cette classe d’objets, au
chapitre 18.
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Le fonctionnement du COMSUB
COMSUB (le sous-système de communications en série de Lookout)
affecte les ports série aux objets Driver.

Habituellement, un objet Driver avertit le COMSUB qu’il a besoin d’un
port série précis pour interroger un appareil (à la fréquence du paramètre
Poll Rate  de cet objet). Si le port série sollicité est libre, COMSUB
affecte le port série à l’objet. Quand l’objet prend le contrôle du port
série, il définit les paramètres de communication du port comme le débit
en bauds et le protocole, puis il interroge l’appareil associé. Quand le
cycle de scrutation est achevé, l’objet Driver libère le port pour que
COMSUB puisse l’affecter à d’autres objets Driver.

Vous pouvez configurer chaque port série pour des communications
Hardwired, Dial-up ou radio. Ces dernières sont définies via les
paramètres du port série.

Remarque Les paramètres de communications port série doivent être définis pour
chaque type de produit Lookout, y compris les systèmes
Development/Runtime, Runtime-Only et Express.

La modification des paramètres du port série
1. A partir de la barre de menus Lookout, sélectionnez la commande

Options→Serial Ports… (Options→Ports série).

 



Partie 2. Guide de l’utilisateur

108

2. Dans le champ de données Port série , sélectionnez le port de
communication à définir. Nous avons sélectionné COM1.

3. Pour le port de communication sélectionné, spécifiez les paramètres
port série souhaités. Ces paramètres sont décrits dans les
paragraphes suivants.

4. Sélectionnez Accept (accepter) pour sauvegarder les modifications
effectuées dans les paramètres port série.

5. Sélectionnez Quit (quitter) pour sortir de la boîte de dialogue.

Les paramètres du port série
Le champ de données Port série  est une liste déroulante que vous
utilisez pour sélectionner le port de communication à définir. Microsoft
Windows supporte jusqu’à 9 ports série, mais la plupart des ordinateurs
ne supportent que 2 ports série sans autre matériel.

Le paramètre Receive gap  est disponible pour tout type de connexion en
série. Ce chiffre spécifie le nombre d’octets vides (ou la durée) que le
driver reçoit d’un contrôleur avant de reconnaître la fin d’un cadre de
message et de demander un autre message. Normalement, vous devez
régler ce paramètre sur 5 par défaut. Cependant, si vous recevez des
alarmes indiquant des communications parasitées, essayez d’augmenter
ce nombre afin d’accorder à Lookout plus de temps “mort” pour accuser
réception d’un message complet. Par exemple, à un débit en bauds réduit
de 1200, vous devez paramétrer Receive gap  sur 30 environ.

Les paramètres Hardwired

Les connexions en série Hardwired  n’exigent pas de handshaking
matériel pour le contrôle de ligne. Utilisez ce paramètre pour toutes les
communications en série excepté quand il s’agit d’un téléphone dial-up
et de récepteurs radio à distance. Utilisez également ce paramètre lors
d’une connexion directe entre Lookout et Master Repeater (répéteur
maître) sur un système radio ou via un modem à ligne privée. Etant
donné que le Master Repeater est un appareil duplex complet qui n’exige
pas l’activation et la désactivation de la fréquence, il agit comme un
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réseau physiquement câblé. D’autres types de connexions câblées
comprennent RS-232, RS-422, RS-485 et les lignes téléphoniques
privées.

Les paramètres Handshaking RTS/CTS

Sélectionnez l’option de connexion en série Radio (RTS/CTS)  pour
connecter le port série à un appareil qui exige le handshaking matériel
RTS/CTS. RTS/CTS est un mécanisme de handshaking matériel local
entre l’ordinateur local et le dispositif de communication local. En
général, le RTS/CTS est utilisé avec un transmetteur radio qui doit être
activé pendant la transmission de données et désactivé pendant la
réception de données. D’autres médias de communication mi-duplex
tels que RS-485, peuvent exiger un handshaking matériel RTS/CTS.
Nous supposons ici que vous communiquez par radio, bien que le
mécanisme RTS/CTS fonctionne de la même façon avec d’autres
mécanismes de communication RTS/CTS.

Quand vous sélectionnez le handshaking matériel RTS/CTS, Lookout
contrôle la broche RTS (requête d’envoi) et surveille la broche CTS
(prêt à émettre) (broches 4 et 5 respectivement sur un connecteur RS-232
de 25 broches) pendant la transmission de données. Vous devez donc
veiller à ce que la broche RTS (broche 4) soit câblée directement sur
votre câble RS-232. La broche CTS (broche 5) est facultative, comme
expliqué plus loin.

Lookout initie une transmission en série sur un port RTS/CTS en
excitant d’abord la RTS pour activer la radio. Ensuite, Lookout surveille
la broche CTS. Quand le transmetteur radio est activé et prêt à
transmettre, la radio excite CTS et Lookout commence immédiatement à
transmettre les données. Si pour une raison quelconque, la radio n’excite
pas CTS dans le délai CTS timeout  (la valeur par défaut est 100
millisecondes), Lookout suppose que la radio est prête à transmettre et
effectue la transmission.

Le paramètre CTS timeout  représente la durée d’attente maximale de
Lookout à l’excitation RTS pour CTS avant la transmission. L’activation
de la plupart des radios demande de 10 à 80 millisecondes. Référez-vous
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aux spécifications de votre radio et aux paramètres des interrupteurs DIP
pour déterminer le délai d’activation de votre radio.

Si votre radio peut exciter CTS quand elle est prête à transmettre,
ajoutez à peu près 50 millisecondes à la spécification de délai
d’activation de la radio et utilisez la valeur totale pour le paramètre CTS
timeout . Si votre radio n’excite pas CTS, ajoutez à peu près 20
millisecondes au délai d’activation de votre radio, puis augmentez la
valeur en incréments de 10 millisecondes jusqu’à ce que la radio à
distance commence à recevoir correctement les premiers octets du
message.

Certaines radios excitent CTS avant d’être prêtes à transmettre. Dans ce
cas, déconnectez la ligne CTS (broche 5 sur un connecteur RS-232 de 25
broches) et réglez le paramètre CTS timeout  sur une valeur
suffisamment élevée pour que la radio puisse être activée avant la
transmission.

Après avoir transmis le dernier octet de données, Lookout continue à
exciter RTS, gardant la radio activée jusqu’à ce que le délai de temps
RTS delay off  expire. Vous devez régler cette valeur sur celle par
défaut, c’est-à-dire zéro milliseconde pour que Lookout puisse
désactiver la radio rapidement pour recevoir la réponse.

La plupart des radios, quand elles sont désactivées, génèrent un bruit
que l’appareil à distance peut décoder en tant qu’octets imprévus “à
jeter”. Certains appareils à distance rejettent des messages entiers au lieu
de décoder les données valables et d’ignorer les octets superflus. Dans
ce cas, vous pouvez maintenir activée votre radio pendant plusieurs
millisecondes via le paramètre RTS delay off . Ce délai retarde le bruit
suffisamment longtemps pour que l’appareil à distance reconnaisse le
dernier cadre de données comme étant valable avant de recevoir les
octets créés par le bruit.

Si le paramètre RTS delay off  est trop élevé, l’appareil à distance
commence à transmettre sa réponse avant que la radio locale ne soit
désactivée. Ceci provoque une alarme de communication dans Lookout.
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Les paramètres du modem Dial-Up

Vous devez sélectionner une connexion en série Dial-up  quand vous
utilisez un modem avec une ligne téléphonique commutée (ligne non
privée). Vous pouvez personnaliser ces paramètres pour votre modem et
ligne téléphonique particuliers. Les paramètres par défaut pour Dialing
prefix  sont basés sur le jeu de commandes AT de Hayes Corporation, qui
est le standard industriel pour les modems de données. Le tableau
suivant explique nos paramètres par défaut.

Paramètres Dialing prefix  (reportez-vous au mode d’emploi du modem pour
les commandes supplémentaires)

AT Attention code (Code d’attention). Doit précéder toutes les commandes.
D Composer le numéro de téléphone avec ces modificateurs : P pour

appel par impulsion, T pour appel par touches
En Mode écho local : E pour pas d’écho
Mn Haut-parleur allumé ou éteint : M pour haut-parleur toujours éteint
Vn Codes résultat verbal ou numérique : V pour codes résultat numérique
Xn Code résultat et options pour composer : X4 pour obtenir la tonalité

avant de composer le numéro et pour reconnaître un signal occupé

Quand vous utilisez un modem dial-up externe avec Lookout, la ligne
DTR dans votre câble entre le modem et l’ordinateur doit être câblée en
ligne droite. Cette ligne est la broche 20 sur un connecteur RS-232 de 25
broches et la broche 4 sur un connecteur de 9 broches. Lookout utilise la
ligne DTR pour ordonner au modem de déconnecter (raccrocher) et
retourne au mode commande.

Certains modems ne sont pas configurés par le fabricant pour répondre à
la ligne DTR. Ainsi, une fois que Lookout réussit à composer le numéro
d’un modem à distance et achève le cycle de scrutation, il abandonne la
ligne DTR, mais le modem reste connecté. Après quelques secondes
pendant lesquelles Lookout essaie de joindre et d’abandonner la ligne
DTR pour attirer l’attention du modem, Lookout émet une alarme
signalant que le modem ne répond pas. Ceci signifie que le modem n’est
pas configuré pour surveiller la ligne DTR.
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La commande standard à Hayes Corporation qui consiste à configurer le
modem de façon à raccrocher et à entrer en mode commande quand le
DTR est perdu, est &D2. Vous pouvez utiliser un programme terminal
pour régler de façon permanente ce paramètre sur la plupart des modems
en entrant la commande de modem AT&D2&W pour stocker le paramètre
une fois pour toutes dans la mémoire non volatile du modem. Ou vous
pouvez ajouter &D2 au paramètre Dialing prefix . Le Dialing prefix  par
défaut étant ATX4MVEDT, vous pouvez peut-être le changer en
AT&D2X4MVEDT.

Le paramètre Retries  est le nombre de fois que Lookout compose le
numéro de téléphone spécifié et essaie de se connecter au modem à
l’autre bout du fil. Si, après un certain nombre d’essais, Lookout n’arrive
pas à se connecter, il provoque une alarme et passe au numéro de
téléphone suivant sur la liste d’interrogation, si elle existe.

Le paramètre Wait for connexion  est la durée d’attente de Lookout pour
la réception du signal de connexion de retour du modem appelé par
Lookout. Ce délai commence la première fois que Lookout envoie la
commande du préfixe téléphonique au modem local. Le délai doit être
suffisamment long pour que le modem local puisse recevoir le signal de
ligne, composer le numéro téléphonique, laisser le modem à distance
répondre à l’appel et renvoyer un message de connexion. Si ce délai est
trop court, votre système peut marcher à la perfection mais n’accomplir
aucune connexion.

Le paramètre Pause between calls  est la durée d’attente de Lookout
après avoir raccroché et avant d’envoyer le signal de préfixe d’appel
suivant au modem local. Si ce délai est trop court, vous ne pouvez pas
raccrocher l’appel en cours ni essayer d’appeler le numéro suivant car
vous êtes encore connecté à l’appel précédent.

Remarque Vos modems, radios et lignes téléphoniques locaux peuvent fonctionner
plus rapidement ou plus lentement que les paramètres par défaut. Il vous
faudra peut-être essayer différents paramètres jusqu’à ce que vous
trouviez les meilleurs pour votre système.
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7. Expressions
e

Les intégrateurs système créent et utilisent un grand nombre
d’expressions dans les versions Development/Runtime de Lookout
pendant la création des fichiers de processus. Ce chapitre ne
s’applique pas aux versions Runtime-Only de Lookout.

Ce chapitre explique les nombreuses fonctions et utilisations des
expressions Lookout. Il est essentiel de bien comprendre cette section
pour que Lookout devienne un outil efficace.

Les expressions sont des instructions mathématiques puissantes et
flexibles en temps réel. Elles ressemblent aux formules des feuilles de
calcul qui comprennent un mélange de constantes et de signaux variables
provenant des objets.

Les expressions peuvent être courtes et simples, ou extrêmement
compliquées, avec plusieurs entrées de signaux, d’appels de fonctions et
plusieurs niveaux de parenthèses. Lookout est doté d’une très grande
bibliothèque de fonctions intégrées dont les fonctions logiques,
mathématiques, statistiques, textuelles, trigonométriques et temporelles.

Une expression unique peut incorporer n’importe quel nombre de
signaux numériques, logiques et textuels au sein de son calcul.
Cependant, le résultat de l’expression ne peut être que numérique,
logique ou textuel. Si vous essayez de créer une expression non autorisée
(par exemple, en ajoutant une valeur logique à une valeur numérique),
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Lookout émet un avertissement sonore et affiche un message d’erreur.

Le type de variable renvoyé par la fonction la plus éloignée, ou par
l’opérateur dans l’expression, dicte le type de signal généré par une
expression.

Les expressions simples se composent de valeurs uniques sans aucune
modification, manipulation, mathématique ou logique (par exemple, un
nom de variable unique d’objet tel que Pot1 ). Quand vous ajoutez une
fonction d’appel, mathématique, etc., à une simple expression, vous
créez une expression complexe (par exemple, Pot1  > 33).

Les exemples suivants sont des expressions typiques ; cependant, vos
expressions peuvent être plus complexes en raison des exigences de
votre système.

VRAI
Rend toujours la valeur Vrai (activé)

Pot1
Rend la valeur actuelle de Pot1

879.03
Rend toujours la valeur 879,03

1:04:33
Rend la valeur 0,0448264. Si c’est un format en heures, minutes et
secondes, l’affichage est 1:04:33

Pressure * 2.31
Multiplie la pression par 2,31

(Switch1 or Switch2) and TankLevel > 65.2
Si Switch1 ou Switch2 sont les valeurs Vrai, et que le niveau du
réservoir (TankLevel) est supérieur à 65.2, rend Vrai, sinon rend
Faux.
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Pressure >= Setpoint and !ReliefValve and
TimeOccuring > 0:30

Si le paramètre Pressure est supérieur ou égal à Setpoint,
ReliefValve est Faux et TimeOccuring est supérieur à 30 secondes,
rend Vrai, sinon rend Faux.

nif(PLC1.AutoPos, AutoTemp, nif(PLC1.ManPos,
ManualTemp,0))

Si le pseudonyme AutoPos de l’API1 est Vrai, rend la valeur
d’AutoTemp. Si le pseudonyme membre ManPos de l’API1 est Vrai,
rend la valeur de ManualTemp, sinon rend la valeur 0.

tif(HOA=1,“Hand”,tif(HOA=2,“Off”,“Auto”))
Si le commutateur HOA est sur la position 1, rend “Hand”. S’il est
sur la position 2, rend “Off”, sinon rend “Auto”.

Vérifiez que vos expressions n’essaient pas de calculer des opérations
non autorisées telles que diviser par zéro ou trouver le cosinus d’un arc
pour un chiffre supérieur à 1, par exemple. Si un signal peut assumer une
valeur qui oblige Lookout à tenter une opération mathématique
impossible, vous devez vérifier si cette condition existe dans
l’expression. Les expressions capturent les opérations mathématiques
impossibles et génèrent des alarmes dans le groupe d’alarmes Math. Les
alarmes ne sont pas réenclenchées tant que l’expression n’est pas
corrigée. Les conditions impossibles capturées par Lookout sont, entre
autres, les divisions par zéro, la racine carrée d’un chiffre négatif, le
débordement numérique négatif et le débordement numérique positif.

Remarque Les expressions sont automatiquement recalculées chaque fois qu’une
référence change dans l’expression (c’est-à-dire, quand un événement a
lieu). Il s’agit du même concept événementiel que celui qui est appliqué
par les objets.
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La création d’expressions
Lookout utilise souvent des expressions. Vous pouvez créer des
expressions comme objets indépendants, paramètres dans des objets,
connexions aux données membres de l’objet ou tout simplement pour les
insérer dans les panneaux de contrôle.

Comme partout ailleurs dans Lookout, vous utilisez des boîtes de
dialogue pour créer des expressions pendant l’application. Remarquez
qu’il n’y a que deux types de champs de saisie de données dans les
boîtes de dialogue de Lookout : les blancs et les jaunes. Les champs
blancs n’acceptent que les valeurs constantes, tandis que les champs
jaunes n’acceptent que les expressions.

Remarque Tous les champs jaunes de saisie de données dans les boîtes de
dialogue acceptent des expressions.

Les expressions sur les panneaux de contrôle

La commande Insert→Expression... (Insérer→Expression) affiche
graphiquement sur le panneau de contrôle le résultat d’une expression.
Notez que cette méthode ne crée pas d’objet, donc pas de signal de sortie
que d’autres expressions ou objets peuvent utiliser. (Il n’y a pas de Tag
associé à l’expression).

En <MAJ>-déplaçant et <MAJ>-cliquant avec le bouton droit de la
souris, vous pouvez facilement et rapidement modifier les expressions
sur les panneaux de contrôle et leurs graphiques respectifs. Reportez-
vous à la section intitulée Les raccourcis de configuration au chapitre 3.

Selon le résultat de l’expression (c’est-à-dire, logique, numérique ou
textuel), la boîte de dialogue d’affichage appropriée apparaît. Reportez-
vous au chapitre 8 pour plus d’informations sur l’affichage des
graphiques.
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Exemple d’une expression logique et la boîte de dialogue d’affichage
correspondante.

Exemple d’une expression numérique et la boîte de dialogue d’affichage
correspondante.

Exemple d’une expression textuelle et la boîte de dialogue d’affichage
correspondante.
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Les objets Expression   

Vous pouvez créer un objet Expression avec la commande de menu
Object→Create... (Objet→Créer). Tout comme les autres classes
d’objets, la classe d’objet globale (expression) exige un nom de variable
unique.

D’autres expressions et/ou objets peuvent référencer le débit d’un objet
(expression). Pour cette raison, vous utilisez habituellement un objet
(expression) quand vous souhaitez définir une condition unique que
votre application utilisera plusieurs fois. Au lieu de définir la même
expression à plusieurs endroits, vous la créez une fois pour toutes et
utilisez son nom de variable quand nécessaire.

Vous pouvez facilement référencer, dans l’exemple ci-dessus, le nom de
la valeur AllValvesOpen , au lieu de l’expression toute entière.

Les expressions comme paramètres

De nombreuses classes d’objets acceptent les expressions comme
paramètres. Dans ce cas, le paramètre s’attend à ce que l’expression
rende un type de signal particulier : numérique, logique ou textuel.
Reportez-vous aux définitions d’objets au chapitre 18 pour plus
d’informations.
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Dans l’exemple ci-dessus, On/off signal  attend une expression logique
et Timer delay  sollicite une expression numérique. Valve1  et Valve2
sont les noms de variables des commutateurs : les relier produit un
résultat logique et satisfait ainsi la première condition. AlarmOnDelay
est le nom de variable d’un potentiomètre qui ajuste la consigne du délai
d’horloge, crée un signal numérique et satisfait la seconde condition.

Etant donné que le champ du paramètre Timer delay  est une expression,
de nombreuses configurations sont possibles, y compris les suivantes :

• Entrez simplement une constante (dans ce cas, le délai ne change
jamais).

• Entrez le nom d’un signal qui représente la sortie d’un autre objet tel
qu’un potentiomètre (l’opérateur peut ainsi ajuster le délai).

• Entrez une expression complexe qui calcule “automatiquement” le
délai selon plusieurs entrées.

Le paramètre On/off signal  peut être configuré de la même façon.

Les champs des paramètres des expressions sont jaunes pour indiquer
qu’une aide est disponible lorsque vous élaborez vos expressions.
Supposez, par exemple que vous avez oublié si le nom de variable de la
valve dans l’exemple précédent est Valve1, Valve_1 ou ValveOne. En
positionnant le curseur sur le champ jaune d’expression et en cliquant
avec le bouton droit de la souris (ce que nous appelons “cliquer à
droite”), vous appelez l’affichage de la boîte de dialogue Expression
Editor. Dans cette boîte de dialogue, vous pouvez facilement
sélectionner le nom de variable correct (Valve1 ) et le recopier
directement dans le champ d’expression. Cliquer sur OK et Lookout
écrit l’expression dans le champ du paramètre.
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Les expressions comme connexions

De nombreux objets ont des données membres que vous pouvez relier
via des expressions. Ces données écrites acceptent les expressions
comme des entrées, tout comme le font les paramètres. Pour relier une
expression à une donnée membre, sélectionnez Object→Edit
Connexions…(Objet→Editer connexions) au menu de Lookout.
Reportez-vous au chapitre 5 pour de plus amples informations sur la
connexion des expressions aux données membres.

Boîte de dialogue Edit connections

La boîte de dialogue des expressions
La boîte de dialogue des expressions s’affiche quand vous cliquez avec
le bouton droit de la souris sur le champ jaune du paramètre d’un objet
ou quand vous sélectionnez Insert→Expression… (Insérer→Expression).
Elle s’affiche également en “MAJ-cliquant à droite” (c’est-à-dire, que
vous cliquez avec le bouton droit de la souris et maintenez enfoncée la
touche MAJ) sur une expression existante qui s’affiche comme un
graphique sur le panneau de contrôle.
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Observez les trois champs dans la boîte de dialogue Insert Expression.
Le champ jaune du haut est l’endroit où vous entrez votre expression. Le
champ en bas à gauche liste tous les Tags  de l’objet qui génèrent des
signaux lisibles. Le champ en bas à droite est une liste des Data
members lisibles des objets actuellement sélectionnés.

Notez que le bas de la boîte de dialogue affiche quelle classe d’objets est
sélectionnée dans la liste de Tags  et quel type de signal est sélectionné
dans la liste Data Members .

Vous pouvez entrer directement une expression ou vous pouvez utiliser
la fonction Paste de Lookout pour faciliter la sélection et l’insertion des
noms de variables dans le champ d’expression. A mesure que vous
sélectionnez des Tags dans la liste déroulante, le nom à la droite du
bouton Paste change en conséquence.

Quelques objets ont plusieurs données membres lisibles, comme par
exemple, un objet Modbus. Dans l’exemple qui suit, ModbusPLC a été
sélectionné parmi une liste de noms de variables. Remarquez comment
Lookout enchaîne le nom de variable, suivi d’un point ainsi que des
données membres sélectionnées.

Une fois que vous avez combiné le nom de variable et les données
membres désirés, appuyez sur le bouton Paste. Lookout colle alors le
nom de variable dans le champ d’expression. Si vous appuyez à nouveau
sur le bouton Paste, vous recopiez une autre instance du nom de variable,
cette fois-ci dans la fenêtre d’expression près du curseur.
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Remarque Double-cliquer est un raccourci pour sélectionner le nom de variable et
pour appuyer sur le bouton Paste. Cliquez deux fois de suite sur le nom
de variable désiré et Lookout colle immédiatement ce nom dans la
fenêtre d’expression. Jouez avec ces deux techniques pour bien
comprendre l’usage de ces fonctions. Plusieurs autres boîtes de dialogue
utilisent le même principe et une bonne maîtrise de ce procédé est un
atout indispensable.

Vous pouvez évidemment préférer de saisir ou de modifier
manuellement un nom de variable, des données membres, des fonctions
mathématiques, etc. dans le champ d’expression. La liste Tags  n’est là
que pour vous aider à vous rappeler des objets que vous avez déjà
définis.

La syntaxe d’expressions
Les opérateurs sont des instructions dans une expression qui effectuent
une opération sur une valeur ou qui combinent des valeurs pour élaborer
une nouvelle valeur. Par exemple, un opérateur simple est le symbole /.
Il divise une valeur par une autre ; la formule (5 / 2) lit “cinq divisé par
deux” et produit un résultat de 2,5. Le cinq et le deux de l’exemple
précédent sont des opérandes (l’opérateur “/” requiert des opérandes
numériques).
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Le caractère espace

Lookout vous permet d’utiliser des touches TAB et des espaces entre les
opérateurs, les fonctions et les paramètres de fonctions. Ceci facilite la
lecture des expressions. Les exemples de ce manuel comprennent des
espaces entre les opérateurs pour plus de clarté.

Nous appelons les espaces et les TAB des "caractères espace" parce
qu’ils accordent de l’espace entre les paramètres ; tout comme les
espaces entre les mots et les paragraphes d’un livre améliorent la
présentation et la lisibilité du texte. Utilisez les caractères espace pour
séparer les noms d’objets dans une expression. Lookout ne tient pas
compte des caractères espace. (Souvenez-vous que vous ne pouvez pas
intégrer des caractères espace dans des noms de variables ou des
pseudonymes.)

Les opérateurs arithmétiques

Les opérateurs suivants effectuent une arithmétique de base. Ils exigent
des opérandes numériques et produisent des résultats numériques.

Opérateurs arithmétiques
+ Addition
- Soustraction
* Multiplication
/ Division
% Pourcentage (divise la valeur précédente par 100)
^ Action exponentielle
- Négation (inverse additif de la valeur suivante)

L’opérateur textuel

L’opérateur textuel est le caractère esperluette (&). Une esperluette relie
deux chaînes de caractères de texte. Par exemple, l’expression “Call
me“ & “Ishmael”  produit un signal textuel Call me Ishmael
(appelez-moi Ishmael).  Généralement, l’opérateur textuel est
utilisé (1) dans l’intégration d’une valeur numérique dans une chaîne de
caractères de texte, (2) dans la vérification de l’expression d’une action,
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(3) dans un message d’alarme et (4) pour être envoyé au panneau
d’affichage d’un API à distance. L’expression

“Flow rate is ” & TEXT(Flow, “0.00”)& “ gpm”

produit le signal textuel suivant Flow rate is 141.23 gpm (le
débit est 141.23 gpm) , si l’on suppose que Flow est un signal
numérique dont la valeur s’arrondit à 141,23.

Les opérateurs de comparaison

Les opérateurs de comparaison comparent deux valeurs numériques et
produisent un résultat logique qui est VRAI ou FAUX (activé ou
désactivé).

Opérateurs de comparaison

< Inférieur à

> Supérieur à

<= Inférieur ou égal à

>= Supérieur ou égal à

= Egal à

<> N’est pas égal à

La comparaison de deux valeurs numériques est nécessaire une fois que
les stratégies du processus de contrôle sont établies. L’expression
TankLevel<50  est VRAI quand le paramètre TankLevel  est
inférieur à 50 et FAUX quand il est supérieur ou égal à 50. Il est facile
de voir comment vous pouvez utiliser le résultat de cette formule pour
contrôler la valve de remplissage d’un réservoir.
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Vous pouvez maintenant relier le résultat logique de OpenFillValve
à un API ou à un téléterminal pour contrôler la valve de remplissage.
Remarquez que la valve s’ouvre quand le niveau du réservoir est
inférieur à 50 et se ferme quand il est supérieur à 50. Dans la plupart des
cas, ceci fait que la valve s’ouvre et se ferme trop souvent quand que le
niveau du réservoir est autour de 50. Neutralzone est une classe d’objets
munie d’une zone morte intégrée qui contrôle mieux la valve de
remplissage du réservoir. L’exemple suivant montre une meilleure
utilisation de l’opérateur de comparaison :

Veuillez noter qu’il n’est pas conseillé d’utiliser les opérateurs de
comparaison “égal à” et “n’est pas égal à” ( “=” and “<>” ) pour
comparer une valeur analogique d’un API ou le résultat de calculs
mathématiques dans une expression. Etant donné que les valeurs
numériques (virgule flottante) ont 17 chiffres significatifs, il est possible
que TankLevel = 40  ne soit jamais exactement vrai à cause du
nombre élevé de chiffres significatifs. Il est cependant acceptable



Partie 2. Guide de l’utilisateur

126

d’utiliser “=”et “<>” pour des chiffres que vous savez rationnels, comme
le signal numérique provenant du potentiomètre dans l’exemple
suivant :

Créez un commutateur à 3 positions avec la classe d’objets Pot
(potentiomètre).

1=Manuelle    2=Arrêt    3=Auto

Vous pouvez maintenant créer un objet expression qui active la pompe si
le commutateur HOA est en position Manuelle (Hand), ou s’il est en
position Auto et que TankLevel  est inférieur à 40.
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Remarquez que le signal HOA est exactement 1,00 ; 2,00 ou 3,00.

Les fonctions d’expressions
Il existe plus de cinquante fonctions d’expression intégrées,
généralement classées de la façon suivante :

• les fonctions logiques

• les fonctions de sélection

• les fonctions mathématiques

• les fonctions statistiques

• les fonctions textuelles

• les fonctions trigonométriques

• les fonctions date/heure

Le reste de ce chapitre décrit chaque fonction, spécifie la syntaxe utilisée
et présente une des façons d’utiliser chaque fonction.
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Les fonctions logiques

AND Syntaxe  : logical1 AND logical2 AND logical3...

Exemple : Switch1 AND Pot1 > 50.0

Description : Si Switch1 est activé et Pot1 est supérieur à 50.0, rend VRAI,
sinon FAUX. Rend VRAI si tous les paramètres logiques sont
VRAI.

FAUX Syntaxe : FAUX

Exemple : FAUX

Description : Rend la valeur logique FAUX. N’accepte pas les paramètres.

LIF Syntaxe : LIF (logical, logical result1, logical
result2)

Exemple : LIF(Switch1, FAUX, Pot1 > 50.0)

Description : Si la valeur logique est VRAI, rend le résultat logique1, sinon
résultat logique2. Dans cet exemple, si Switch1 est activé, il
produit la valeur logique FAUX. Sinon, il rend le résultat
logique de Pot1 > 50.0.

NIF Syntaxe : NIF (logical, numeric result1, numeric
result2)

Exemple : NIF(Switch1, 99.9, Pot1)

Description : Si la valeur logique est VRAI, rend le résultat numérique1,
sinon résultat numérique2. Dans cet exemple, si Switch1 est
activé, il produit la valeur numérique 99.9, sinon il produit la
valeur de Pot1.

NOT Syntaxe : NOT (logical)  ou !logical

Exemples : NOT(Switch1) ou !Switch1

Description : Si la valeur logique est VRAI, rend FAUX, sinon VRAI. Dans
cet exemple, si Switch1 est activé, rend FAUX, mais si
Switch1 est désactivé, rend VRAI.
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OR Syntaxe : logical1 OR logical2 OR logical3...

Exemple : Switch1 OR Pot1 > 50.0

Description : Rend VRAI si au moins un paramètre logique est VRAI. Dans
cet exemple, si Switch1 est activé ou Pot1 est supérieur à 50,
ou les deux, l’expression rend VRAI. Si aucune des deux
conditions n’est VRAI, rend FAUX.

TIF Syntaxe : TIF (logical, text result1, text result2)

Exemple : TIF(Switch1, “Text Message”, TextInput1)

Description : Si la valeur logique est VRAI, rend résultat textuel1, sinon
rend résultat textuel2. Notez la présence des guillemets. Dans
cet exemple, si Switch1 est activé, il produit Text
Message , sinon, il produit la valeur textuelle en cours de
TextInput1.

VRAI Syntaxe : VRAI

Exemple : VRAI

Description : Rend la valeur logique VRAI. N’accepte pas les paramètres.

XOR Syntaxe : logical1 XOR logical2 XOR logical3...

Exemple : Switch1 XOR Pot1 > 50.0

Description : Rend VRAI si seulement un paramètre logique est VRAI.
Dans cet exemple, si Pot1 est supérieur à 50 et Switch1 est
activé, il produit FAUX (car les deux paramètres logiques
sont VRAI). Si Pot1 est inférieur à 50 et Switch1 est activé, il
produit VRAI (parce que seul un paramètre logique est
VRAI).
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Les fonctions de sélection

LSELECT Syntaxe : LSELECT (numeric, logical1,
logical2, logical3,...)

Exemple : LSELECT(Pot1, Switch1, VRAI, Pb1)

Description : Rend un résultat logique se basant sur une portion
entière de la valeur numérique. Si numérique est
inférieur à 2,0, LSELECT rend la valeur logique1.
Si la valeur numérique est supérieure au nombre de
paramètres logiques, LSELECT rend le dernier
paramètre logique listé. Dans cet exemple, si la
valeur de Pot1 est 1,4, rend la valeur de Switch1. Si
la valeur de Pot1 est 3,0 ou supérieure, rend la
valeur de Pb1. Si la valeur de Pot1 est 2,0, il rend la
valeur logique VRAI.

NSELECT Syntaxe : NSELECT (numeric, numeric1,
numeric2, numeric3,...)

Exemple : NSELECT(Pot1, Pot2, Pot3, 14.3)

Description : Rend un résultat numérique basé sur une portion
entière de la valeur numérique. Si la valeur
numérique est inférieure à 2,0, NSELECT rend
numérique1. Si la valeur numérique est supérieure
au nombre de paramètres numériques, NSELECT
rend le dernier paramètre listé. Reportez-vous à la
description de l’exemple LSELECT.
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TSELECT Syntaxe : TSELECT(numeric, text1, text2,
text3,...)

Exemple : TSELECT(Pot1, “Auto”, “Manual”,
“Local”, “Locked”)

Description : Rend un résultat textuel basé sur une portion entière
de la valeur numérique. Si la valeur numérique est
inférieure à 2,0, TSELECT rend texte1. Si la valeur
numérique est supérieure au nombre de paramètres
textuels, TSELECT rend le dernier paramètre listé.
Reportez-vous à la description de l’exemple
LSELECT.

Les fonctions mathématiques

ABS Syntaxe : ABS(numeric)

Exemple : ABS(Pot1 - 50.0)

Description : Rend la valeur absolue de la valeur numérique.
Dans cet exemple, si Pot1 est égal à zéro, la
fonction rend 50.0.

EXP Syntaxe : EXP(numeric)

Exemple : EXP(Pot1)

Description : Rend la base du logarithme naturel, e (2,71828182),
élevée à la puissance de la valeur numérique. Dans
cet exemple, si Pot1 est 2,0, la fonction rend
2,718281822 ou approximativement 7,38906. EXP
est l’inverse de la fonction, LN. Pour calculer les
valeurs d’autres puissances, utilisez l’opérateur
exponentiel ( ^ ).
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FACT Syntaxe : FACT(numeric)

Exemple : FACT(4.2)

Description : Rend le factoriel de la portion entière de la valeur
numérique. Dans cet exemple, la fonction rend le
factoriel de 4, ou 1*2*3*4, ou 24. Le factoriel de
zéro, FACT(0), ou tout autre numéro inférieur à zéro,
est un (1).

INT Syntaxe : INT(numeric)

Exemple : INT(4.2)

Description : Arrondit la valeur numérique à l’entier inférieur le
plus proche. Dans cet exemple, la fonction INT rend
4. Observez également que INT(-8.5) = -9 .
Reportez-vous à TRUNC.

LN Syntaxe : LN(numeric)

Exemple : LN(PLC.AI1)

Description : Rend le logarithme naturel numérique. Les
enregistreurs naturels sont basés sur la constante, e
(2,71828182). Dans cet exemple, si PLC.AI1 =
1000,0 la fonction rend 6,90776.

LOG Syntaxe : LOG(numeric1, numeric2)

Exemple : LOG(Pot1,2)

Description : Rend le logarithme numérique1 à la base
numérique2, où numérique1 est un chiffre positif
réel. Dans cet exemple, si Pot1 = 8,0, la fonction
rend 3,0.
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LOG10 Syntaxe : LOG10(numeric)

Exemple : LOG10(Pot1)

Description : Rend le logarithme de la base-10 de la valeur
numérique, où la valeur numérique est un chiffre
positif réel. Dans cet exemple, si Pot1 = 100,0 la
fonction rend 2,0.

MOD Syntaxe : MOD(numeric1, numeric2)

Exemple : MOD(50,8)

Description : Rend le modulus (reste) de la valeur numérique1 divisé
par la valeur numérique2, où numérique2 n’est pas égal
à zéro. Dans cet exemple, 50 divisé par 8 est égal à 6
avec un reste de 2. Ainsi, la fonction rend 2.

PI Syntaxe : PI()

Exemple : PI()

Description : Rend une approximation de PI: 3,1415927. N’accepte
pas les paramètres.
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PRODUCT Syntaxe : PRODUCT(numeric1, numeric2,
numeric3,...)

Exemple : PRODUCT(2,4,6,10)

Description : Rend le produit de toutes les valeurs numériques
multipliées les unes par les autres. Dans cet
exemple, la fonction rend 2*4*6*10 ou 480.

RAND Syntaxe : RAND()

Exemple : RAND() * Pot1

Description : Génère un nouveau numéro au hasard entre 0 et 1
chaque fois que la formule dont cette fonction fait
partie est recalculée. N’accepte pas les paramètres.
Dans cet exemple, chaque fois que la valeur de
Pot1 change, la fonction génère un nouveau
numéro au hasard et le multiplie par la valeur de
Pot1.

ROUND Syntaxe : ROUND(numeric1, numeric2)

Exemple : ROUND(Pot1,2)

Description : Arrondit la valeur numérique1 aux positions
décimales de la valeur numérique2. Dans cet
exemple, si Pot1 est égal à 15,745, la fonction rend
15,75. Si numérique2 est égal à zéro, la fonction
rend un nombre entier. Si numérique2 est inférieur
à zéro, la fonction rend zéro.
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SIGN Syntaxe : SIGN(numeric)

Exemple : SIGN(Pot1)

Description : Rend 1 si la valeur numérique est positive, 0 si la
valeur numérique est 0, -1 si la valeur numérique
est négative. Dans cet exemple, si Pot1 est -
0,00001, la fonction rend -1.

SQRT Syntaxe : SQRT(numeric)

Exemple : SQRT(ABS(Pot1))

Description : Rend la racine carrée de la valeur numérique, où la
valeur numérique est un numéro positif réel. Dans
cet exemple, si Pot1 est -25,0, la fonction absolue
commence par convertir la valeur du potentiomètre
à 25 positif, puis la fonction racine carrée calcule
√25 = 5.

TRUNC Syntaxe : TRUNC(numeric)

Exemple : TRUNC(8.9)

Description : Tronque la valeur numérique à son composant
entier en ôtant sa partie fractionnelle. Dans cet
exemple, la fonction TRUNC rend 8. Remarquez
également que
TRUNC(-8.9) = -8 . Reportez-vous à INT.
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Les fonctions statistiques

AVG Syntaxe : AVG(numeric1, numeric2,
numeric3,…)

Exemple : AVG(2,4,-6,12)

Description : Rend la moyenne arithmétique de toutes les
valeurs numériques listées. Cette fonction
demande au moins deux paramètres numériques.
Dans cet exemple, la fonction rend (2+4-6+12) / 4
ou 3,0.

MAX Syntaxe : MAX(numeric1, numeric2,
numeric3,…)

Exemple : MAX(2,4,-6,12)

Description : Rend la plus haute valeur de toutes les valeurs
numériques listées. Cette fonction demande au
moins deux valeurs numériques. Dans cet
exemple, la fonction rend 12.

MIN Syntaxe : MIN(numeric1, numeric2,
numeric3,…)

Exemple : MIN(2,4,-6,12)

Description : Rend la plus basse valeur de toutes les valeurs
numériques listées. Cette fonction demande au
moins deux valeurs numériques. Dans cet
exemple, la fonction rend -6.
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STDEV Syntaxe : STDEV(numeric1, numeric2,
numeric3,…)

Exemple : STDEV(2.9,4.5,5.0,4.3,3.8)

Description : Rend l’écart-type en échantillon des valeurs
numériques listées. (L’écart-type est une mesure
de dispersion, calculée comme la racine carrée
positive de la variance.) Cette fonction calcule
l’écart-type en utilisant la méthode non partiale ou
n-1. Cette fonction demande au moins deux
valeurs numériques. Dans cet exemple, la fonction
rend 0,796869.

STDEVP Syntaxe : STDEVP(numeric1, numeric2,
numeric3,…)

Exemple : STDEVP(2.9,4.5,5.0,4.3,3.8)

Description : Rend l’écart-type d’une population complète de
valeurs numériques. Cette fonction calcule l’écart-
type en utilisant la méthode partiale ou n. Cette
fonction demande au moins deux valeurs
numériques. Dans cet exemple, la fonction rend
0,712741.

SUM Syntaxe : SUM(numeric1, numeric2,
numeric3,…)

Exemple : SUM(2,4,-6,12)

Description : Rend la somme de toutes les valeurs numériques
listées. Cette fonction demande au moins deux
valeurs numériques. Dans cet exemple, la fonction
rend 12.
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VAR Syntaxe : VAR(numeric1, numeric2,
numeric3,…)

Exemple : VAR(2.9,4.5,5.0,4.3,3.8)

Description : Rend la variance échantillon des valeurs
numériques listées. (La variance est une mesure
de dispersion). Cette fonction calcule la variance
en utilisant la méthode non partiale ou n-1. Cette
fonction demande au moins deux valeurs
numériques. Dans cet exemple, la fonction rend
0,635.

VARP Syntaxe : VARP(numeric1, numeric2,
numeric3,…)

Exemple : VARP(2.9,4.5,5.0,4.3,3.8)

Description : Rend la variance de population des valeurs
numériques listées. Cette fonction calcule la
variance en utilisant la méthode partiale ou n.
Cette fonction demande au moins deux valeurs
numériques. Dans cet exemple, la fonction rend
0,508.

Les fonctions textuelles

EXACT Syntaxe : EXACT(text1, text2)

Exemple : EXACT(TextEntry1, “batch a”)

Description : Rend VRAI si texte1 correspond exactement à texte2,
sinon rend FAUX. Les majuscules et minuscules
comptent. Dans cet exemple, la fonction rend VRAI si
le résultat textuel de TextEntry1 correspond
exactement à “batch a ” (remarquez que l’entrée de
cet exemple est entièrement écrite en minuscules).
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FIND Syntaxe : FIND(text1, text2, numeric)

Exemple : FIND("ON","Reactor A is ON",1)

Description : Cherche texte1 dans texte2 en commençant après les
caractères numériques et rend la position du premier
caractère où commence la correspondance. Les
majuscules et minuscules comptent. Le produit de
cette fonction est numérique. Il rend 0 si aucune
correspondance n’est trouvée. Dans cet exemple, la
fonction parcourt toute la chaîne de caractères pour
trouver le mot ON et rend 14, indiquant la position du
premier caractère du mot. Reportez-vous également à
la fonction SEARCH.

FIXED Syntaxe : FIXED(numeric1, numeric2)

Exemple : “The flow is ” & FIXED(Pot1,2)

Description : Arrondit la valeur numérique1 aux positions
décimales de la valeur numérique2, puis convertit
numérique1 en une chaîne de caractères de texte.
Dans cet exemple, si Pot1 est égal à 123.456 , la
fonction FIXED rend la valeur textuelle “123.46” .
Ainsi toute la chaîne de caractères de texte est “The
flow is 123.46 .” (“Le débit est
123.46.” ). Si la valeur numérique2 est négative ou
si elle est omise, la valeur numérique1 est arrondie à
l’entier le plus proche. Par exemple,
FIXED(123.588)  rend: “124” Reportez-vous
également à TEXT.
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LEFT Syntaxe : LEFT(text, numeric)

Exemple : LEFT("Reactor A is ON",9)

Description : Récupère le nombre spécifié de caractères de
l’extrémité gauche du texte et produit une valeur
textuelle. Dans cet exemple, la fonction rend Reactor
A (Réacteur A) .

LEN Syntaxe : LEN(text)

Exemple : LEN("Reactor A is ON")

Description : Rend la longueur de la chaîne de caractères de texte (le
nombre de caractères en texte). Dans cet exemple, la
fonction rend la valeur numérique 15.

LOWER Syntaxe : LOWER(text)

Exemple : EXACT(LOWER(TextEntry1),“batch a”)

Description : Convertit tout le texte en minuscules. Dans cet
exemple, la fonction LOWER garantit la
correspondance même quand le texte TextEntry1 est
“Batch A,” “BATCH A” ou “batch A.”

MID Syntaxe : MID(text, numeric1, numeric2)

Exemple : MID("Reactor A is ON",9,7)

Description : Récupère les caractères numérique2 du milieu du texte,
en commençant par le caractère numérique1. Dans cet
exemple, la fonction rend la valeur textuelle,  “A is
ON” (“A est activé”).
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PROPER Syntaxe : PROPER(text)

Exemple : PROPER("reactor A is ON")

Description : Ecrit en majuscules le premier caractère de chaque mot
du texte. Dans cet exemple, la fonction rend la valeur
textuelle,  “Reactor A Is ON ” (Réacteur A Est
Activé”).

REPLACE Syntaxe : REPLACE(text1, numeric1, numeric2, text2)

Exemple : REPLACE(“Reactor A is ON”,9,1,“B”)

Description : Remplace les caractères numérique2, en commençant
par le caractère numérique1 du texte1, par du texte2.
Cette fonction demande que le nombre de caractères
dans texte2 corresponde à la valeur numérique2. Dans
cet exemple, la fonction rend la valeur textuelle,
“Reactor B is ON ” (Réacteur B est activé”).

REPT Syntaxe : REPT(text, numeric)

Exemple : REPT(“Lookout ”,Pot1)

Description : Répète le texte le nombre de fois donné. Dans cet
exemple, si la valeur de Pot1 est 8, la fonction rend la
valeur textuelle,  “Lookout Lookout Lookout
Lookout Lookout Lookout Lookout
Lookout ”.

RIGHT Syntaxe : RIGHT(text, numeric)

Exemple : RIGHT("Reactor A est activé",7)

Description : Récupère le nombre spécifié de caractères à l’extrémité
droite du texte et le produit comme valeur textuelle.
Dans cet exemple, la fonction rend la valeur textuelle,
A is ON .
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SEARCH Syntaxe : SEARCH(text1, text2, numeric)

Exemple : SEARCH("on","Reactor A is ON",1)

Description : Repère texte1 dans texte2 en commençant par le
caractère numérique, et rend la position du premier
caractère où commence la correspondance. Les
majuscules et minuscules ne comptent pas. Le produit
de cette fonction est numérique. Il rend 0 s’il n’y a pas
de correspondance. Dans cet exemple, la fonction
parcourt toute la chaîne de caractères pour repérer le
ON, on , On, ou oN et rend 14, indiquant la position du
premier caractère du mot. Reportez-vous également à
FIND.

TEXT Syntaxe : TEXT(numeric, text)

Exemple : TEXT(Pot1,“0.00”)

Description : Comme la fonction FIXED, la fonction TEXT convertit
des valeurs numériques en valeurs textuelles. Mais
tandis que FIXED vous permet de spécifier le nombre
de décimales, TEXT vous permet de spécifier le format
numérique souhaité dans le paramètre textuel. Si Pot1
est égal à 12,3456, la fonction rend la valeur textuelle
“12,35”. Reportez-vous aux Formats numériques du
chapitre 5. Reportez-vous également à FIXED.

TRIM Syntaxe : TRIM(text)

Exemple : TRIM("Reactor   A    is ON")

Description : Taille les nombreux espaces entre les mots. Cet
exemple comprend plusieurs espaces de chaque côté du
mot, “A”. Cette fonction rend “Reactor A is ON ”
(Réacteur A est activé) et élimine tous les espaces
répétés.
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UPPER Syntaxe : UPPER(text)

Exemple : EXACT(UPPER(TextEntry1),“BATCH A”)

Description : Ecrit en majuscules tout le texte. Dans cet exemple, la
fonction UPPER garantit la correspondance même
quand le texte TextEntry1 est “Batch A,” “BATCH A”
ou “batch A.”

Les fonctions trigonométriques

ACOS Syntaxe : ACOS(numeric)

Exemple : ACOS(Pot1)

Description : Rend le cosinus d’arc de la valeur numérique (c’est-à-
dire, rend l’angle du cosinus que vous spécifiez comme
valeur numérique). La valeur numérique doit être entre
-1 et 1. Le résultat est le produit en radians et s’étend
de 0 à π. Dans cet exemple, si Pot1 = .5, la fonction
rend 1,0472 radians (60 degrés). Vous pouvez exprimer
l’arc cosinus en degrés en multipliant le résultat par
180/π.

ASIN Syntaxe : ASIN(numeric)

Exemple : ASIN(Pot1)

Description : Rend le sinus d’arc de la valeur numérique (c’est-à-
dire, rend l’angle du cosinus que vous spécifiez comme
valeur numérique). La valeur numérique est le sinus de
l’angle et doit s’étendre entre -1 et 1. La valeur
résultante est fournie en radians et s’étend de -π/2 à
π/2. Dans cet exemple, si Pot1 = -1, la fonction rend -
1,5708.
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ATAN Syntaxe : ATAN(numeric)

Exemple : ATAN(Pot1)

Description : Rend la tangente d’arc de la valeur numérique (c’est-à-
dire, rend l’angle de la tangente que vous spécifiez
comme valeur numérique). La valeur résultante est
fournie en radians et s’étend de -π/2 à π/2. Dans cet
exemple, si Pot1 = 180, la fonction rend 1,56524
radians (90 degrés à peu près).

ATAN2 Syntaxe : ATAN2(numericX, numericY)

Exemple : ATAN2(5, 5)

Description : Rend la tangente d’arc pour les coordonnées spécifiées
x- et y- (c’est-à-dire, rend l’angle d’une ligne partant de
l’origine (0.0) jusqu’à un point spécifié par la paire de
coordonnées numériqueX et numériqueY que vous
spécifiez). La valeur résultante est fournie en radians et
s’étend de plus de -π à π. Dans cet exemple, la fonction
rend 0,785398 radians (45 degrés).

COS Syntaxe : COS(numeric)

Exemple : COS(Pot1)

Description : Rend le cosinus de la valeur numérique où numérique
est l’angle en radians. Dans cet exemple, si Pot1 =
1,047, la fonction rend 0,500171. Vous convertissez les
degrés en radians en multipliant par π/180.



Chapitre 7.  Expressions

145

SIN Syntaxe : SIN(numeric)

Exemple : SIN(Pot1)

Description : Rend le sinus de la valeur numérique où numérique est
l’angle en radians. Dans cet exemple, si Pot1 =
3,14159, la fonction rend 1,2246E-16 (en fait, zéro).
Vous convertissez les degrés en radians en multipliant
par π/180.

TAN Syntaxe : TAN(numeric)

Exemple : TAN(Pot1*PI()/180)

Description : Rend la tangente de la valeur numérique où numérique
est l’angle en radians. Dans cet exemple, la valeur de
Pot1 est 45, mais elle est en degrés, non en radians.
Effectuez donc la conversion en radians en multipliant
cette valeur par π/180. Dans cet exemple, la fonction
rend 1.
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Les fonctions date/heure  

NOW Syntaxe : NOW(logical)

Exemple : NOW($Keyboard.F1)

Description : Rend une valeur numérique qui représente la date et
l’heure actuelles du système toutes les fois qu’un signal
change à l’intérieur des parenthèses. Le résultat est un
numéro à virgule flottante où le nombre entier
représente la date et la fraction l’heure du jour. Dans
cet exemple, quand vous appuyez sur la touche de
fonction F1, la date et l’heure s’affichent sous la forme
d’un nombre unique, tel que 34738,3. Si vous changez
le format numérique (Numeric Format ) du nombre en
“mm/dd/yy hh:mm:ss ” (moismois/jourjour/anan
heureheure/minuteminute/secondeseconde), le même
chiffre sera affiché ainsi : “02/08/95 07:49:02.”

TODAY Syntaxe : TODAY(logical)

Exemple : TODAY($Keyboard.F1)

Description : Rend une valeur numérique qui représente la date
actuelle du système toutes les fois qu’un signal change
à l’intérieur des parenthèses. Le résultat est un nombre
entier qui représente le nombre de jours écoulés depuis
le premier janvier 1900. Dans cet exemple, quand vous
appuyez sur la touche de fonction F1, la date s’affiche
sous la forme d’un nombre unique, tel que 34738. Si
vous changez le format numérique (Numeric Format )
du chiffre en “mm/dd/yy ” (moismois/jourjour/anan),
le même chiffre sera affiché ainsi : 02/08/95.”
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Remarque Si vous ne voulez afficher que l’heure actuelle (c’est-à-dire, sans la date),
ôtez tout simplement la fonction today  (aujourd’hui) de la fonction now
(maintenant).

Exemple :  NOW($Keyboard.F1) - TODAY($Keyboard.F1)

Dans cet exemple, si vous souhaitez que le résultat s’actualise toutes les
secondes, remplacez $Keyboard.F1 par une horloge d’une impulsion à la
seconde.



Chapitre 8.  Graphiques

149

8. Graphiques
e

Les graphiques sont souvent créés et utilisés dans les systèmes
Development/Runtime pendant l’intégration et le développement de
l’application. Ce chapitre ne couvre pas les systèmes Runtime-Only.

Un graphique est tout article visible sur un panneau de contrôle de
Lookout. Il existe plusieurs façons d’afficher un “graphique” sur un
panneau de contrôle. La méthode que vous utilisez dépend de votre
objectif.

Indépendamment de cet objectif, il y a deux classes de graphiques : les
statiques et les dynamiques. Les graphiques statiques ne changent jamais
d’état, tandis que les graphiques dynamiques changent d’état selon les
variations de votre processus. Les procédés pour afficher les deux
classifications graphiques varient considérablement ; l’effet graphique
que vous souhaitez obtenir détermine la méthode d’affichage à suivre.

Ce chapitre décrit comment ajouter des graphiques statiques et
dynamiques dans le panneau de contrôle et comment concevoir et
utiliser des graphiques personnalisés.

Pour faciliter votre tâche, Lookout offre une ample bibliothèque de
graphiques comprenant plusieurs interrupteurs, potentiomètres, boutons-
poussoirs, graphes à barres, valves, réservoirs, pompes, plaques,
incrustations, échelles et bien plus encore. Nous avons tout fait pour
qu’au lieu de passer votre temps à dessiner des symboles, vous puissiez
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développer et mettre au point votre application. Cependant, il peut
arriver que les graphiques standard de la bibliothèque Lookout ne
répondent pas exactement à vos besoins. C’est pourquoi, chaque copie
de Lookout est fournie avec un programme tiers de dessin. Utilisez-le
(ou tout autre logiciel de dessin) pour créer vos propres graphiques.

National Instruments centre ses efforts sur le développement et
l’amélioration des produits SCADA et des systèmes de commande de
processus les plus sophistiqués et puissants disponibles sur le marché.
C’est pourquoi nous avons choisi de ne pas devenir une entreprise de
logiciels de dessin. Pour ajouter à Lookout des fonctions de dessin
personnalisées, il nous faudrait le doter de la puissance et de la
flexibilité offertes par les programmes de dessin aujourd’hui sur le
marché. Ainsi, au lieu de réinventer la roue, nous préférons laisser les
logiciels de dessin personnalisés répondre à ce besoin.

Remarque Pensez à la résolution de l’écran quand vous créez un panneau
d’affichage (c’est-à-dire, VGA au lieu de Super VGA). L’apparence d’un
même panneau diffère selon les pilotes de résolution des ordinateurs.
Veuillez lire la section sur les résolutions d’écran dans la description des
objets Panel (panneau) au chapitre 18 avant de créer vos panneaux.

Les graphiques statiques
Les graphiques statiques ne changent jamais d’état. Ils existent sur un
panneau de contrôle comme un tableau suspendu à un mur : ils ne
changent pas et ne se déplacent pas. Les graphiques statiques peuvent
être aussi simples que des étiquettes textuelles, des plaques, des
incrustations et des échelles, ou aussi compliqués que des vues
schématiques d’ensemble complexes et des images photographiques
scannérisées.
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L’affichage de textes, plaques, incrustations, rectangles
et lignes

L’utilisation efficace de textes, plaques et incrustations peut rendre un
panneau de contrôle intuitif et facile à exploiter. L’exemple suivant
montre comment les plaques et les incrustations organisent les
informations relatives à deux pompes.

Pour créer du texte, des plaques, des incrustations, des rectangles
ou des lignes statiques dans Lookout, sélectionnez la commande
Insert→Text/plate/inset… (Insérer→Texte/plaque/incrustation). Ce
faisant, la boîte de dialogue suivante apparaît.

Plaque

Incrustation
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Pour créer un rectangle, une ligne, une plaque ou une incrustation,
laissez vide le champ Texte et sélectionnez Background style (arrière-
plan) désiré. La fenêtre Preview (prévisualisation) montre quelle sera
l’apparence de l’élément d’affichage.

Pour créer une ligne verticale ou horizontale, sélectionnez Rectangle .
Après avoir cliqué sur OK, établissez la longueur et la largeur désirées
du rectangle. (N’oubliez pas que la barre d’état jaune indique les
dimensions.)

Remarque Lookout utilise de nombreuses grilles de couleurs dans un grand nombre
de boîtes de dialogue. Il est regrettable que ce manuel noir et blanc ne
puisse les représenter à leur juste valeur. Ces supports visuels facilitent
énormément le choix des couleurs des éléments. Les couleurs sont
toutefois légèrement différentes d’un ordinateur à l’autre.

Certains adaptateurs d’affichage informatique ne peuvent afficher que 16
couleurs unies sur l’écran. L’adaptateur standard VGA avec le driver
VGA pour Windows ne supporte directement que 16 couleurs. Windows
utilise une technique qui juxtapose des points de couleurs différents pour
stimuler l’affichage de couleurs qui ne sont pas directement supportées
par des couleurs unies. Par exemple, Lookout peut afficher la couleur
orange comme une configuration pixel alternant les bits rouges et jaunes
sur l’écran.

Fenêtre de prévisualisation
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Certains objets dans Lookout exigent des couleurs unies et si vous
spécifiez une couleur juxtaposée, Lookout affiche la couleur unie la plus
proche. Un objet Trend (tendance), par exemple, demande une couleur
unie pour son arrière-plan et pour ses lignes de tendance. De plus,
Lookout affiche toujours le texte en couleurs unies. Ne soyez donc pas
surpris si vous obtenez une ligne jaune quand vous spécifiez vert pastel
pour une ligne de tendance. Les graphes à barres et l’arrière-plan des
panneaux de contrôle sont quasiment les seuls articles que vous puissiez
afficher en couleurs juxtaposées.

Certains adaptateurs d’affichage supportent simultanément 256 et même
16 millions de couleurs sur un écran. Bien que Lookout ne vous permette
de spécifier que 28 couleurs, il affiche des images personnalisées sur les
panneaux de contrôle avec toutes les couleurs disponibles.

L’affichage de graphiques statiques personnalisés

Chaque symbole dans le sous-répertoire graphique de Lookout est un
fichier séparé. Lookout supporte deux types de fichiers graphiques :
Windows Device-Independent Bitmap (.BMP) et Windows Metafile
(.WMF).

Pour afficher le bitmap statique et les images fichiers méta sur un
panneau de contrôle, sélectionnez la commande Insert→Graphic...
(Insérer→Graphique). Quand vous sélectionnez Insert→Graphic...,
la boîte de dialogue Insert Graphic apparaît, comme ci-dessous.
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Cette boîte de dialogue liste tous les bitmaps et fichiers méta qui se
trouvent dans le sous-répertoire GRAPHIC sous le répertoire racine
LOOKOUT.

La liste déroulante est une liste alphabétique qui contient toutes vos
images. A mesure que vous sélectionnez chaque fichier, un croquis est
affiché dans la fenêtre de prévisualisation à droite de la liste. Les
graphiques sont dimensionnés pour la fenêtre de prévisualisation et
peuvent être un peu différents sur le panneau de contrôle.

Remarque  Un raccourci pour trouver un graphique précis dans la liste déroulante
consiste à taper la première lettre du nom du fichier. La liste se déroule
automatiquement jusqu’au premier fichier de la liste qui commence par
cette lettre.

Si vous sélectionnez un fichier bitmap (.BMP), vous pouvez utiliser les
donnée membres Transparent pixel  pour spécifier quels pixels de
couleurs dans ce graphique sont transparents dans Lookout. En fait, la
zone de visualisation devient un plan de coordonnées X-Y, où 0,0 est le
coin en haut à gauche du graphique (et non toute la zone de
visualisation). Entrez n’importe quelle coordonnée X et Y et le pixel
correspondant devient transparent ainsi que tous les autres pixels de la
même couleur. Le diagramme suivant montre le plan de coordonnées
avec les points “spéciaux” (négatifs) et leurs emplacements. Les valeurs
par défaut pour les pixels transparents restent vides. Quand les champs
X et Y sont vides, aucun pixel ne doit être transparent.
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Cet exemple montre un bitmap gris et blanc. Utilisez ce graphique
comme un type de masque  ou “cookie cutter” (forme) à placer sur le
graphe à barres. Le réservoir semble donc se remplir à mesure que le
graphe à barres augmente. Cependant, il faut que l’intérieur du réservoir
(zone blanche) soit transparent tandis que le reste du graphique (zone
grise) reste visible ; c’est-à-dire, “masque” le graphe à barres sous-
jacent. Vous pouvez soit deviner les coordonnées X,Y de n’importe quel
pixel blanc du graphique, soit spécifier le centre exact du graphique en
sélectionnant -1 ,-1  comme pixel transparent. Etant donné que -1 ,-1
est un pixel blanc, tous les autres pixels blancs deviennent transparents
quand ils sont insérés dans le panneau de contrôle.

Remarque Les graphiques de fichiers méta de Windows sont normalement plus
faciles à utiliser et à manipuler que les images bitmap. A la différence
des bitmaps, ils peuvent être redimensionnés dans Lookout. Grâce à leur
structure intrinsèque, vous pouvez également utiliser des fichiers méta
comme des “masques” sans spécifier de pixels transparents.
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Les graphiques dynamiques
En général, les panneaux de contrôle du processus exigent une animation
(par exemple, une pompe qui change de couleur pour indiquer
l’activation ou la désactivation). Comme indiqué au tableau suivant,
Lookout comprend plusieurs outils d’animation.

Outils d’affichage des graphiques dynamiques

Classe d’objets Animator
(animateur)

Un objet Animator assure l’animation complète graphique :
mouvement horizontal et/ou vertical, redimensionnement et
visibilité dynamiques et séquencement dynamique.

Classe d’objets Multistate
(multi-états)

Un objet Multistate affiche jusqu’à six graphiques personnalisés
différents, sur la base de la logique avancée “if-then-else” (si-
alors-sinon).

Classe d’objets Pipe
(tuyau)

Un objet Pipe commande à un rectangle ou à une ligne (de
n’importe quelle dimension) de changer de couleur ou de
clignoter, sur la base de la logique avancée “if-then-else” (si-alors-
sinon).

Classe d’objets DialGauge
(cadran-jauge)

Un objet DialGauge affiche un signal numérique comme une
aiguille de balayage sur une jauge analogique ou un cadran.

Classe d’objets Gauge
(jauge)

Un objet Gauge commande à une expression numérique (nombre
numérique ou diagramme à barres) de changer de couleur ou de
clignoter, sur la base de la logique avancée.

Classe d’objets Spinner
(disque rotatif)

Un objet Spinner est un petit disque rotatif. Il peut être activé ou
désactivé par un signal logique ; ou la vitesse de sa rotation peut
refléter la magnitude d’une valeur numérique.

Classe d’objets Switch
(booléen)

Un objet Switch peut représenter ses deux positions par des
symboles standard d’interrupteurs ou des graphiques
personnalisés.
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Classe d’objets
Pushbutton (bouton-
poussoir)

Un objet Pushbutton peut ressembler à un bouton qui change
quand il est enfoncé, ou il peut être transparent. Vous pouvez
utiliser ces boutons transparents avec les graphiques
personnalisés.

Classe d’objets Pot
(potentiomètre)

Un objet Pot peut s’afficher comme un bouton, une glissière
verticale, une glissière horizontale, des boutons d’incrémentation
et de décrémenation ou comme un nombre numérique.

Expression logique Quand vous créez une expression qui produit une valeur logique,
vous pouvez représenter cette valeur avec des indicateurs
lumineux standard, du texte ou des graphiques personnalisés.

Expression numérique Quand vous créez une expression qui produit une valeur
numérique, vous pouvez représenter cette valeur avec un nombre
numérique ou un diagramme à barres verticales ou horizontales.

Expression textuelle Quand vous créez une expression qui produit une valeur textuelle,
vous pouvez représenter cette valeur en utilisant n’importe quels
style et taille de police de caractères chargés dans votre
ordinateur.

Pour des informations sur une classe d’objets en particulier, reportez-
vous au chapitre 18. Pour des informations sur les expressions,
reportez-vous au chapitre 7.

L’affichage de signaux logiques dynamiques

Les expressions logiques et les objets Switch (booléen) sont deux outils
souvent utilisés pour l’animation graphique. L’exemple ci-dessous
montre un objet Switch affiché sur un panneau de contrôle. Le signal
qu’il génère est aussi affiché de plusieurs façons.

Expression du signal
Switch

Objet
Switch

(booléen)
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L’objet Switch (booléen) est représenté en deux positions : On et Off
(marche et arrêt). Les graphiques du côté droit du panneau de contrôle
illustrent les trois façons d’afficher graphiquement le signal logique
généré par l’interrupteur.

Ne confondez pas les graphiques représentant l’objet Switch avec les
graphiques représentant le signal de l’objet Switch. Ceux-ci sont des
expressions de la valeur (implicite) de l’interrupteur, créés via la
commande de menu Insert→Expression…(Insérer→Expression).

Prenez un exemple. Commencez par sélectionner le signal logique que
vous souhaitez représenter avec des graphiques dynamiques. Ce signal
peut être l’entrée logique d’un API. Utilisez un interrupteur dans
Lookout pour simuler le contact du démarreur à relais d’un moteur.

Créez un objet Switch et appelez-le PumpSwitch . Une fois que les
paramètres de cet interrupteur sont définis, Lookout présente la boîte de
dialogue des paramètres d’affichage pour l’interrupteur. Vous pouvez
choisir de représenter l’interrupteur avec un graphique standard ou avec
un graphique personnalisé. Sélectionnez l’un des graphiques standard et
appuyez sur OK.

Ajoutez maintenant une expression qui représente le signal généré par
l’objet Switch. Sélectionnez la commande Insert→Expression...
(Insérer→Expression) et choisissez PumpSwitch .

Fenêtres de prévisualisation
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Quand vous sélectionnez OK, Lookout présente la boîte de dialogue
d’affichage Display Logical Signal. Sélectionnez les caractéristiques
d’affichage pour l’expression d’un signal logique.

Cliquez sur la sélection Custom . Puis parcourez les listes déroulantes
On et Off  jusqu’à ce que vous trouviez les fichiers graphiques
appropriés. Remarquez que vous parcourez les mêmes fichiers dans les
deux listes. C’est parce que vous explorez tous les fichiers dans un seul
sous-répertoire graphique, C:\LOOKOUT\GRAPHIC. Pour des raisons
de confirmation et vérification, le mini-croquis de vos sélections
graphiques On et Off  apparaît dans les deux fenêtres de prévisualisation.

Fenêtres de prévisualisation
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Cliquez sur OK et testez votre exemple en basculant l’interrupteur. Les
graphiques changent selon vos sélections dans les fenêtres de
prévisualisation On et Off.

Vous pouvez utiliser ce concept de base pour afficher n’importe quel
signal dynamique dans un panneau de contrôle. Essayez également
d’autres options avec la sélection Text  dans cette boîte de dialogue.

Si vous souhaitez représenter plus de deux conditions avec des
graphiques dynamiques, utilisez un objet Multistate (multi-états). Vous
pouvez également utiliser un objet Pipe (tuyau) pour qu’une ligne ou un
rectangle change dynamiquement de couleur et clignote.

L’affichage de signaux numériques dynamiques

Les expressions numériques et les objets Pot (potentiomètre) sont deux
des outils les plus souvent utilisés pour l’animation graphique.
L’exemple suivant montre un objet Pot affiché sur un panneau de
contrôle. Vous pouvez afficher de diverses façons le signal qu’il génère.

 

Le graphique représente l’objet Pot (potentiomètre) comme une
glissière, une entrée numérique et des boutons d’incrémentation et de
décrémentation. Ce sont des représentations graphiques du même objet
Pot. Les graphiques du côté droit du panneau de contrôle sont tout
simplement deux façons différentes d’afficher graphiquement le signal
numérique généré par l’objet Pot (potentiomètre).

Expression du signal
Pot (potentiomètre)

Objet Pot
(potentiomètre)



Chapitre 8.  Graphiques

161

Prenons un exemple. Commencez par sélectionner le signal numérique
que vous souhaitez représenter avec des graphiques dynamiques. Ce
signal peut être l’entrée analogique d’un API. Utilisez un objet Pot
(potentiomètre) pour cet exemple.

Créez un potentiomètre et appelez-le PumpSpeed. Une fois que les
paramètres Pot sont définis, Lookout présente la boîte de dialogue de ses
paramètres d’affichage. Vous pouvez choisir n’importe quel graphique
standard pour représenter le potentiomètre.

Ajoutez maintenant une expression qui représente le signal généré par
l’objet Pot (potentiomètre). Sélectionnez la commande
Insert→Expression... (Insérer→Expression) et choisissez PumpSpeed.
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Quand vous sélectionnez OK, Lookout présente la boîte de dialogue
Display Numeric Signal. Sélectionnez les caractéristiques d’affichage
pour l’expression d’un signal numérique.

Si vous sélectionnez le style d’affichage Digital , vous pouvez utiliser le
bouton Font (police de caractères) pour sélectionner le style et la taille
souhaités de la police de caractères. Vous pouvez également spécifier le
format Numeric format pour la valeur. Pour plus d’informations sur les
formats numériques, reportez-vous au chapitre 5.

Appuyez sur OK et testez votre exemple en ajustant le potentiomètre.
Les graphiques changent selon vos sélections.

Si vous souhaitez représenter le signal numérique avec des graphiques
personnalisés mobiles, utilisez la classe d’objets Animator (animateur).

L’affichage de signaux textuels dynamiques

L’élaboration d’expressions textuelles est l’une des nombreuses
méthodes d’affichage de messages textuels dynamiques sur un panneau
de contrôle. Comme expliqué dans la section intitulée L’affichage de
signaux logiques dynamiques, cette méthode permet d’afficher jusqu’à
deux messages textuels séparés. Cependant, vous devez parfois afficher
trois messages textuels séparés, ou plus, dans une déclaration unique. Un
signal numérique, par exemple, peut déterminer le message à afficher.

Fenêtre de
prévisualisation
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Prenez un exemple. Commencez par sélectionner le signal numérique
que vous souhaitez utiliser pour savoir quel message est affiché. Ce
signal peut être l’entrée analogique d’un API. Utilisez un potentiomètre
pour cet exemple.

Créez un potentiomètre et appelez-le Pot1 . Définissez les paramètres
minimum, maximum, et de résolution du potentiomètre avec les valeurs
1, 4, et 1 respectivement.

Ajoutez maintenant une expression qui utilise l’une des nombreuses
fonctions d’expression de Lookout. Sélectionnez la commande
Insert→Expression... (Insérer→Expression) et entrez l’expression
suivante. Reportez-vous au chapitre 7 pour plus d’informations sur la
fonction TCHOOSE.

Quand vous sélectionnez OK, Lookout présente la boîte de dialogue
Display Text Signal. Sélectionnez les caractéristiques d’affichage pour
l’expression d’un signal textuel. Essayez de sélectionner Inset  comme
style d’arrière-plan.
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Cliquez sur OK et testez votre exemple en réglant le potentiomètre. Le
texte change selon votre expression.

La création de graphiques personnalisés
Il se peut qu’aucun des graphiques standard fournis par Lookout ne
réponde à vos besoins. C’est pourquoi, nous livrons un logiciel de dessin
tiers avec chaque copie de Lookout. Vous pouvez l’utiliser, ou tout autre
logiciel de dessin, pour créer vos propres graphiques.

Lookout supporte les bitmaps Windows Device-Independent (.BMP) et
les fichiers méta Windows Metafiles (.WMF). Ces deux formats sont
très courants parmi les logiciels de dessin. Souvenez-vous, peu importe
comment le fichier graphique est inclus dans un de ces deux formats :
avec le programme de dessin fourni avec Lookout ou un autre ;
l’important est que le fichier soit converti en l’un de ces deux formats.

Fenêtre de
prévisualisation
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Une fois que le fichier graphique personnalisé est créé, copiez-le dans le
sous-répertoire GRAPHIC sous le répertoire racine LOOKOUT. Tous les
graphiques standard et personnalisés résident dans ce sous-répertoire
pour en faciliter l’utilisation. Dès que votre fichier graphique
personnalisé est à cet emplacement, Lookout peut y accéder autant de
fois que nécessaire dans un même fichier ou dans d’autres fichiers de
processus.

Un exemple progressif

Un des points forts de Windows est l’exécution simultanée de Lookout
et de Windows Draw (Draw). (Etant donné que nous livrons Draw de
Micrografx avec Lookout version16 bits, nous l’utilisons ici comme
exemple de programme de dessin.) Passons à un exemple un peu plus
compliqué pour vous apprendre quelques astuces. Créez le graphique
d’un réservoir surélevé qui, lorsqu’il est inséré dans Lookout, semble se
remplir d’eau. Pour plus d’informations, reportez-vous à la section
intitulée Les graphiques statiques, plus haut dans ce chapitre.

Avant de continuer, vous devez vous familiariser avec Draw car ses
fonctions ne sont pas décrites ici.
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Commencez par dessiner la moitié d’un réservoir (étape 1). L’étape
suivante consiste à copier et à réfléchir cette image pour créer l’autre
moitié (étape 2). Reliez maintenant les symboles pour créer un objet
“réservoir fermé” (étape 3).

           

  Etape 1  Etape 2 Etape 3

Dessinez ensuite un rectangle autour du réservoir et reliez le rectangle et
le réservoir en un seul objet (étape 4). Pour le masque, vous devez
sélectionner une couleur d’arrière-plan assortie au panneau de contrôle.
Sélectionnez le groupe d’objets et cliquez sur la sélection grise de la
barre (étape 5). Votre dernière tâche avant d’exporter le fichier consiste
à choisir le paramètre invisible pour le style de ligne (étape 6).

               

          Etape 4  Etape 5     Etape 6
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Sélectionnez la commande File→Export... (Fichier→Exporter) du menu
Draw.

Parcourez la liste déroulante File Type  jusqu’à repérer WMF Windows
Metafile . Ensuite, changez le répertoire d’exportation pour qu’il soit
C:\LOOKOUT\GRAPHICS. Entrez un nom de fichier DOS valable dans
le champ Export file as  et appuyez sur Export. Vous avez réussi à
exporter le graphique dans le sous-répertoire de graphiques de Lookout
comme fichier méta.

Maintenant passez à Lookout (si Lookout est lancé, appuyez sur ALT-
TAB). Utilisez Object→Create... (Objet→Créer) pour créer un objet Pot
(potentiomètre). Sélectionnez Insert→Expression…
(Insérer→Expression), puis le potentiomètre et cliquez sur OK. Ensuite,
dans la boîte de dialogue Display Numeric Signal, sélectionnez le graphe
à barres, puis le paramètre “rectangle” et cliquez sur OK.
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Il ne reste plus qu’à insérer le graphique par-dessus le graphe à barres,
qui agit comme un masque ou un “cookie cutter”. Utilisez la commande
Insert→Graphic...(Insérer→Graphique) et sélectionnez
ELEVTANK.WMF. Ensuite, positionnez le graphique sur le graphe à
barres et étirez-le pour lui donner la dimension souhaitée. Sortez du
mode Edition et testez votre exemple en déplaçant la glissière vers le
haut et vers le bas.

En général, la création de graphiques personnalisés n’est pas aussi
compliquée. Cet exemple démontre ici la création d’un “masque”
graphique à titre de référence.
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Les types de fichiers graphiques
Lookout accepte les bitmaps Windows Device-Independent (.BMP) et
les fichiers méta Windows Metafiles (.WMF).

Les bitmaps

Les fichiers bitmap sont des fichiers trame : ils comprennent des pixels
de couleurs différentes. Les bitmaps sont toujours rectangulaires et ne
peuvent pas être redimensionnés car chaque pixel du bitmap occupe un
pixel sur l’écran. Cependant, si vous sélectionnez un pixel transparent,
Lookout affiche sur des panneaux de contrôle des images trame qui ne
sont pas rectangulaires.

Généralement, les fichiers bitmap comprennent une extension de
fichier.BMP . Le programme Paint livré avec Windows est compatible
avec des fichiers bitmap .PCX (un autre format bitmap très courant) et
peut convertir des images en bitmaps de Windows.

Les fichiers méta

Les fichiers méta sont des fichiers vecteurs ; ils comprennent des
coordonnées reliées par des lignes et des courbes, ainsi que des
commandes de remplissage. Un fichier vecteur peut ne comprendre que
deux jeux de coordonnées reliés par une ligne, ou un jeu complexe de
remplissages en couleur, et de lignes et courbes en couleur créant des
images d’art linéaire. Les fichiers méta ne sont pas nécessairement
rectangulaires.

Etant donné que les fichiers méta comprennent un jeu de coordonnées,
ils peuvent être redimensionnés et étirés à n’importe quelle taille ou
proportion. Microsoft n’a pas ajouté les informations sur la taille dans le
format des fichiers méta de base. Aldus Corporation (concepteur de
PageMaker) a créé un en-tête de fichier méta pour ces informations. La
plupart des logiciels qui génèrent des fichiers méta ajoutent également
cet en-tête. Sans ce dernier, Lookout ne sait pas comment maintenir les
proportions correctes (rapport hauteur/largeur) pour un fichier méta.
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Vous pouvez facilement déterminer si un fichier méta comprend ces
informations supplémentaires en redimensionnant le graphique sur un
panneau de contrôle avec la touche CTRL enfoncée ; si les informations
sur la forme sont disponibles, Lookout ne vous permet pas d’étirer le
dessin fichier méta hors de ses limites.

Les bitmaps comparés aux fichiers méta

Quel est format le plus attrayant : bitmap ou fichier méta ? Chacun a ses
avantages et inconvénients. En général, l’affichage des bitmaps est plus
rapide que celui des fichiers méta. En fait, un dessin complexe sous
format bitmap peut s’afficher 100 fois plus vite que le fichier méta
correspondant. Si vous souhaitez afficher des images scannérisées de
qualité photographique avec des centaines de couleurs, les bitmaps
s’imposent.

Les fichiers méta sont redimensionnables : vous pouvez les étirer pour
leur donner n’importe quelle taille ou n’importe quelle proportion. Les
fichiers méta sont généralement plus petits que les fichiers bitmap et
occupent donc moins d’espace sur le disque et moins de mémoire que les
fichiers bitmap. Vous pouvez utiliser un fichier à l’écran qui comprend
un dessin fichier méta d’une pompe pour afficher plusieurs pompes de
diverses tailles. Les programmes de dessin graphique comme Micrografx
Draw et Corel Draw permettent de sauvegarder vos images d’art linéaire
comme fichiers méta. Ces programmes permettent de copier l’image à
l’écran sur le presse-papiers Windows et de la coller dans un programme
Paint pour conversion en fichier bitmap.

Pour combiner les performances, la simplicité et l’esthétique des
panneaux de contrôle, vous opterez probablement pour les deux
formats : fichier méta et bitmap. En général, un fond schématique ou une
vue globale du système important doit suivre un format bitmap, tandis
que les pompes, les valves, les lampes et autres graphiques doivent
suivre un format fichier méta.
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Les considérations sur la mémoire

Lookout charge chaque graphique dans la mémoire de l’ordinateur la
première fois qu’elle est affichée. L’image reste en mémoire jusqu’à ce
que Lookout ou une autre application demande plus de mémoire que
celle qui est disponible ; à ce moment-là, le graphique est rejeté de la
mémoire et doit être rechargé du disque chaque fois qu’il s’affiche. De
cette façon, vous pouvez afficher plus de bitmaps et de fichiers méta sur
l’écran que ce que la mémoire peut comprendre en une seule fois.

L’exécution de Windows en mode amélioré sur un ordinateur 386 ou
486 comprend également une fonction nommée mémoire virtuelle.
Windows utilise la mémoire virtuelle pour échanger des images mémoire
entre la mémoire et le disque, ce qui donne aux applications l’impression
d’avoir plus de mémoire. Si la mémoire disponible se réduit et que
Windows a recours à la mémoire virtuelle pour jongler avec les
applications et les données entre disque et mémoire, l’application ralentit
considérablement. Pour plus d’informations sur la mémoire virtuelle,
reportez-vous à votre Guide d’Utilisation de Windows. Si l’indicateur
lumineux du lecteur de disquette de votre ordinateur clignote chaque fois
que vous lancez un nouveau panneau de contrôle dans Lookout,
envisagez un ajout de mémoire.
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9. Alarmes
Les paramètres des objets et des bases de données génèrent des alarmes
dans Lookout. En tant que service Environnement de Lookout, le sous-
système d’alarme est un mécanisme puissant et flexible qui filtre,
affiche, enregistre et imprime les alarmes. Ce chapitre décrit comment
Lookout génère des alarmes et comment configurer les services fournis
par ce sous-système d’alarme.

La définition des conditions d’alarmes
Il existe deux façons de créer une condition d’alarme. Selon la première
méthode, vous définissez les paramètres d’alarme quand vous modifiez
la base de données d’un objet. Nous appelons cette méthode Alarmes
générées par la base de données. La seconde méthode utilise les objets
Alarm (alarme) pour définir les conditions d’alarme. Nous appelons
cette méthode Objet Alarm.

Les alarmes générées par la base de données

La plupart des objets comprennent des données membres numériques ou
logiques. Si vous le voulez, Lookout génère une alarme quand ces objets
dépassent certaines conditions. Ces conditions peuvent inclure High,
Low, High-High et Low-Low (haut, bas, haut-haut et bas-bas).
Sélectionnez Object→Edit Database… (Objet→Editer base de données)
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pour modifier les paramètres d’alarme des données membres d’un objet.

Ceci est probablement la façon la plus efficace de définir des conditions
d’alarme simple ou “standard”. Cette méthode est particulièrement utile
lors de la configuration des alarmes pour des données qui dérivent
d’objets à bases de données volumineuses, comme les objets Driver et
les objets DataTable (tableau de données). Reportez-vous à L’édition des
bases de données d’objets au chapitre 5 pour plus d’informations.

Les objets Alarm

Les objets Alarm (alarme) dédiés peuvent aussi générer des alarmes.
Vous définissez et créez des objets Alarm individuellement avec la
commande Object→Create... (Objet→Créer). Avec cette méthode, vous
créez des alarmes qui sont provoquées par n’importe quel événement ou
combinaison d’événements que vous précisez. Ainsi, vous pouvez créer
un critère d’alarme aussi simple ou complexe que vous le souhaitez.
Vous n’êtes plus limité par les conditions d’alarme traditionnelles (c’est-
à-dire, High (haut), Low (bas), Rate-of-Change (taux de changement).
Reportez-vous à Objet Alarm au chapitre 18 pour plus d’informations.
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Les objets Alarm ne sont pas la seule source de signaux d’alarme.
Plusieurs classes d’objets génèrent leurs propres signaux d’alarme : les
objets Driver, les objets Spreadsheets (feuilles de calcul) et les objets
Expression peuvent également générer des alarmes.

Plusieurs classes d’objets génèrent des alarmes du type “référence
circulaire”. Une référence circulaire est une condition où le signal généré
par un objet est renvoyé à cet objet en tant que paramètre soit
directement, soit indirectement. Les références circulaires sont toujours
des alarmes de priorité 10 qui doivent être corrigées en testant le fichier
de processus.
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Le sous-système d’alarme
Le sous-système d’alarme comprend plusieurs éléments qui vous rendent
maître de l’affichage, de l’acquittement, de l’impression, du groupement,
de la priorité et du filtre des alarmes. Il est important de bien comprendre
ces divers composants avant de sélectionner une structure pour votre
système d’alarme.

Les groupes d’alarmes

Vous pouvez classifier les alarmes par groupes pour améliorer leur
organisation. Les groupes d’alarme permettent aux opérateurs de filtrer
provisoirement les alarmes indésirables et de les acquitter groupe par
groupe.

Le nombre de groupes que vous pouvez créer ou le nombre d’alarmes
que vous pouvez affecter à un groupe est illimité. Cependant, il est
important de planifier soigneusement la structure de vos alarmes pour
que les opérateurs puissent filtrer les alarmes par groupes d’importance.
Ceci est particulièrement utile quand votre système subit un grand
nombre d’alarmes et que vous ne souhaitez voir ou traiter que des
groupes et/ou priorités bien précis. Reportez-vous à Objet Alarm au
chapitre 18 et à L’édition des bases de données des objets au chapitre 5
pour plus d’informations.

Les priorités d’alarmes

Vous affectez l’un des 10 niveaux de priorité à chaque alarme. La
priorité 1 est la priorité la plus basse et 10 la plus haute.

Les alarmes Priority 1  n’exigent pas l’acquittement de l’opérateur ;
Lookout les enlève de la liste dans la fenêtre d’alarme quand elles sont
désactivées, acquittées ou non. Lookout n’enregistre pas de façon
permanente les alarmes Priority 1 sur disque.

N’affectez la priorité 1 qu’aux alarmes mineures et sans conséquence. Il
est fort possible que les alarmes Priority 1 ne fassent pas partie de votre
stratégie de contrôle. En général, si une occurrence est suffisamment
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importante pour passer à un état d’alarme, elle exige un acquittement de
l’opérateur et un enregistrement permanent dans un fichier sur disque.

Les alarmes Priority 2  et plus exigent un acquittement de l’opérateur
avant d’être enlevées de la liste d’alarmes. Cependant, Lookout
n’enregistre pas sur disque les alarmes Priority 2. N’affectez la priorité 2
ou plus basse qu’aux alarmes qui ne demandent pas d’enregistrement
permanent.

Les alarmes Priority 3 et plus exigent l’acquittement de l’opérateur
avant que Lookout ne les enlève de la liste d’alarmes. De plus, Lookout
stocke immédiatement les alarmes Priority 3 et plus haute sur disque en
format binaire quand elles sont activées, désactivées et  acquittées.

Le paramètre Data files location  dans la boîte de dialogue System
Options spécifie le répertoire racine sous lequel commence
l’enregistrement de toutes les données. Lookout stocke les fichiers
d’alarme dans des sous-répertoires mensuels sous ce répertoire racine.
Reportez-vous à la commande Option →System... (Option→Système) au
chapitre 16 pour plus d’informations. Les alarmes de Priority 3 à 10
agissent pareillement et sont enregistrées au fichier ALARMS.DAT dans
le répertoire de données du mois en cours sous le répertoire racine
spécifié.

e

Le progiciel Lookout Express n’enregistre pas les alarmes sur
disque. Vous pouvez voir les alarmes qui sont actives, ou inactives
mais pas encore acquittées, dans la fenêtre d’alarmes.

La fenêtre d’alarmes

La fenêtre d’alarmes liste par ordre chronologique toutes les alarmes
actives ou sans acquittement. Les alarmes les plus récentes sont en début
de liste. Si les alarmes sont trop nombreuses pour être visualisées toutes
à la fois, une barre déroulante apparaît à la droite de la fenêtre d’alarmes
pour dérouler la liste.

Pour visualiser la fenêtre d’alarmes, appuyez sur CTRL+A, sélectionnez
Alarms→Show... (Alarmes→Afficher), ou cliquez sur la case Alarm
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Indicator à l’extrême droite de la barre d'état de Lookout en bas de
l’écran. La boîte figure dans le graphique de la page suivante.

La fenêtre d’alarmes de Lookout agence les couleurs de façon à
identifier rapidement l’état des alarmes. Les alarmes actives sont rouges
et les alarmes inactives non acquittées sont bleues. Si une alarme est
active et acquittée, la description reste rouge tandis que le reste des
informations sur l’alarme (Time [heure], Group [groupe], Priority
[priorité], Tag [nom de valeur]) sont en noir.

Quand une alarme active/acquittée est désactivée, Lookout enlève
l’alarme de la fenêtre d’alarmes. De plus, quand vous acquittez une
alarme inactive, Lookout l’enlève de la fenêtre d’alarmes.

Cliquez ici pour
ouvrir la fenêtre
d’alarmes
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Lookout peut lister la même condition d’alarme plusieurs fois dans la
fenêtre d’alarmes, car une nouvelle ligne est ajoutée à la liste chaque fois
que l’alarme devient active. Après avoir listé 100 exemples de la même
alarme, Lookout abandonne la condition la plus ancienne pour faire
place à la prochaine occurrence. Ainsi, Lookout affiche dans la fenêtre
d’alarmes les 100 occurrences les plus récentes de chaque alarme.
D’autres alarmes continuent à s’accumuler comme prévu jusqu’à ce que
leur limite de 100 occurrences soit atteinte.

Vous pouvez visualiser des informations détaillées sur une alarme
particulière de la liste en sélectionnant l’alarme dans la Fenêtre
d’alarmes, puis sélectionnez la commande Alarms→Acknowledge...
(Alarmes→Acquitter).

Les options d’affichage d’alarmes

Vous pouvez changer le style d’affichage de la fenêtre d’alarmes avec la
commande Alarms→Display Options... (Alarmes→Options d’affichage)
(En haut, en bas, flottant). Avec cette commande, vous pouvez également
modifier le format de l’affichage interne de la fenêtre d’alarmes (police de
caractères, en-tête et autres informations sur l’alarme).

La sélection Window style  (style de fenêtre) détermine où la fenêtre
d’alarmes sera placée dans la zone de travail de Lookout. Si vous
sélectionnez Floating  (flottant), le panneau de contrôle de la fenêtre
d’alarmes est de style local et vous pouvez le dimensionner et le
déplacer sur l’écran. Vous pouvez minimiser la fenêtre d’alarmes
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flottante n’importe quand en appuyant sur sa flèche de réduction (bouton
pour minimiser).

Le paramètre Window height  (hauteur de la fenêtre) spécifie comment
afficher un grand nombre d’alarmes Lookout dans la fenêtre d’alarmes.
Cette option n’est disponible que pour les fenêtres de type Top  (en haut)
et Bottom (en bas). La hauteur actuelle de la fenêtre d’alarmes est
automatiquement réglée en fonction de la police de caractères et de la
hauteur sélectionnées pour la fenêtre. Redimensionnez la fenêtre
d’alarmes flottante quand vous le souhaitez en saisissant le bord et en
étirant la fenêtre jusqu’à la taille voulue. Si les alarmes sont trop
nombreuses pour être visualisées toutes à la fois, une barre déroulante
apparaît à la droite de la fenêtre d’alarmes pour dérouler la liste.

L’exemple suivant montre une fenêtre d’alarmes typique avec la position
Window réglée sur Bottom , toutes les options Show  (montrer)
sélectionnées et Window height  réglé sur 12. Notez que plusieurs
alarmes surviennent plusieurs fois.

Les filtres d’alarmes

Vous pouvez filtrer les alarmes par groupe, par priorité et par occurrence
avec la commande Alarms →Filter Options... (Alarmes→Options de
filtrage).

L’option Most Recent Occurrences  (occurrences les plus récentes)
filtre plusieurs occurrences d’une alarme et n’affiche que la plus récente.
Cette option est utile quand un événement d’alarme surgit
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continuellement et génère plusieurs instances d’alarme. L’option All
Occurrences  (toutes les occurrences) affiche chaque instance d’une
alarme particulière (jusqu’à 100 occurrences de la même alarme).

Le paramètre Display Alarms at or above Priority (afficher les alarmes
à leur priorité ou plus) agit également comme un filtre. Lookout affiche
les alarmes avec cette priorité, ou une priorité supérieure, et exclut
toutes les alarmes de priorité inférieure.

La sélection Display Groups  (groupes d’affichage) spécifie quels
groupes d’alarmes afficher dans la Fenêtre d’alarmes et exclut toutes les
autres. Cliquez sur les groupes que vous désirez voir et sélectionnez la
case All Groups  (tous les groupes) pour afficher chaque groupe
d’alarmes. Vous devez désélectionner la case All Groups  avant de
sélectionner les groupes Display Groups .

Vous pouvez basculer l’option Audible Alarms  (alarmes sonores) pour
l’activer ou la désactiver. Quand cette option est activée, les nouvelles
occurrences d’alarme émettent un code sonore via le haut-parleur de
votre ordinateur. Après les six premiers codes sonores, la fréquence est
réduite à un code sonore toutes les dix secondes et continue ainsi jusqu’à
l’acquittement de l’alarme. Lookout émet un code sonore jusqu’à
l’acquittement de chaque alarme. Si vous constatez des alarmes
intempestives, vous pouvez désactiver provisoirement cette option. De
plus, si vous souhaitez arrêter rapidement le code sonore sans
acquittement, appuyez sur CTRL+S.
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Dans cet exemple, vous demandez à Lookout d’afficher l’occurrence la
plus récente des alarmes dans des groupes “Conveyors” (transporteurs),
“Pipeline” et “Plant” (usine) avec une priorité de 6 ou plus. Il est évident
que de nombreuses alarmes actives peuvent surgir dans d’autres groupes,
ou dans les groupes sélectionnés d’une priorité inférieure, ou qu’une
même alarme ait des occurrences multiples ; mais elles ne sont pas
affichées dans la fenêtre d’alarmes à cause des paramètres filtre.

Ceci peut mener un opérateur à penser qu’une alarme n’a pas lieu parce
qu’elle n’est pas visible. Pour pallier cette situation, Lookout vous offre
un moyen rapide de déterminer si des alarmes sont filtrées et combien.
Le coin droit de la barre d’état affiche le nombre d’alarmes visibles
parmi le total d’alarmes (visible:total). La différence entre les deux
représente le nombre d’alarmes filtrées. Cet exemple montre 15 alarmes
visibles, 25 alarmes au complet et 10 alarmes filtrées.

Pour voir rapidement toutes les alarmes, sélectionnez le bouton Display
All (afficher tout) dans la boîte de dialogue Alarm Filters (filtres alarme)
et appuyez sur OK. La fenêtre d’alarme affiche maintenant toutes les
alarmes actives et/ou non acquittées, tandis que la barre d’état reflète ce
changement.

L’impression d’alarmes
e

Le progiciel Lookout Express ne supporte pas l’impression
d’alarmes enregistrées parce qu’il ne les enregistre pas sur disque.

La commande Alarms→Print... (Alarmes→Imprimer) invoque une boîte
de dialogue où vous pouvez spécifier la période de temps des alarmes
que vous souhaitez imprimer.
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Dans l’exemple ci-dessus, vous utilisez l’option Range  pour spécifier un
délai de temps arbitraire en saisissant les dates et heures exactes (heure
militaire) à imprimer. Quand vous sélectionnez Print, Lookout ouvre
le(s) fichier(s) d’alarme approprié(s), effectue la mise en page du rapport
selon les paramètres Columns  (colonnes) et envoie le résultat à votre
gestionnaire d’impression Windows (et donc à votre imprimante).

Les sélections Printouts  servent à déterminer exactement quelles
informations sur l’alarme seront comprises dans le rapport. Snapshot
Only  (croquis seulement) présente un “panorama” des états de vos
alarmes au début du champ d’impression spécifié. Cependant, ceci
n’indique pas ce qui s’est passé pendant cette période de temps. L’option
Snapshot & Journal  crée un rapport imprimé couvrant ce qui s’est
passé pendant la période de temps, y compris au début du champ.

L’acquittement d’alarmes

Avant de pouvoir acquitter une alarme, il faut la sélectionner. Pour
sélectionner une alarme, “cliquez” sur la ligne de l’alarme choisie dans
la fenêtre d’alarmes. Une coche apparaît alors dans la colonne de gauche
indiquant que cette alarme est sélectionnée. Pour désélectionner une
alarme, cliquez de nouveau sur la ligne de l’alarme et la coche disparaît.
Vous pouvez sélectionner et désélectionner de cette façon n’importe
quelle combinaison d’alarmes.
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La commande Alarms→Select All... (Alarmes→Sélection globale) est un
raccourci qui sélectionne toutes les alarmes pour l’acquittement. Cette
commande est particulièrement utile si votre processus subit de
nombreuses alarmes, car la sélection individuelle peut prendre beaucoup
de temps.

La commande Alarms→Deselect All... (Alarmes→Désélection globale)
est un raccourci pour désélectionner toutes les alarmes déjà
sélectionnées pour l’acquittement. Si vous souhaitez ne désélectionner
que certaines alarmes, cliquez sur l’alarme individuelle.

Utilisez la commande Alarms→Acknowledge... (Alarmes→Acquitter)
pour acquitter les alarmes que vous avez sélectionnées pour
l’acquittement. Si aucune alarme n’est sélectionnée quand vous invoquez
cette commande, une boîte de message apparaît :

Si vous sélectionnez une ou plusieurs alarmes pour l’acquittement, la
boîte de dialogue suivante apparaît et présente plus d’informations sur
la(les) alarme(s). Elle vous permet également d’acquitter des alarmes
séparément, en appuyant sur Acknowledge (acquitter), ou bien
globalement, en appuyant sur Acknowledge All (acquitter toutes). Quand
vous acquittez une alarme inactive, Lookout l’enlève de la fenêtre
d’alarmes. De plus, quand une alarme acquittée/active est désactivée,
Lookout l’enlève de la fenêtre d’alarmes.
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Le bouton Acknowledge All acquitte toutes les alarmes sélectionnées
uniquement. Les boutons Previous (précédent) et Next (suivant) vous
permettent de naviguer avec la touche TAB à travers toutes les alarmes
sélectionnées pour l’acquittement. Quand vous acquittez une alarme,
Lookout enregistre sur disque la date, l’heure et le nom de compte de
l’opérateur qui a effectué l’acquittement. Quand vous en avez terminé
avec cette boîte de dialogue, sélectionnez le bouton Quit (quitter).

Un objet global spécial, nommé $Alarm (alarme), vous permet
d’acquitter des alarmes avec des boutons-poussoirs ou d’autres
expressions logiques. Vous pouvez ainsi contourner les commandes de
menu et/ou acquitter des alarmes à partir de nœuds de réseau Lookout à
distance. Par exemple, vous pouvez créer un bouton-poussoir unique qui
acquitte toutes les alarmes, ou plusieurs boutons-poussoirs pour acquitter
des groupes d’alarmes spécifiques.

L’objet $Alarm donne également l’accès aux signaux numériques qui
indiquent le nombre des alarmes actives actuelles ou le nombre
d’alarmes non acquittées dans un groupe particulier, par exemple.
Reportez-vous à $Alarm au chapitre 18 pour plus d’informations.



Chapitre 10. Sécurité

187

10. Sécurité
Les services Environnement de Lookout comprennent un sous-système
de sécurité sophistiqué et exhaustif à trois échelons : la sécurité de
contrôle, la sécurité d’affichage et la vérification de l’action. Ce système
vous permet de sélectionner quels opérateurs ont le contrôle de quels
objets, quels opérateurs peuvent visualiser quels panneaux de contrôle et
quels objets incitent l’opérateur à effectuer la vérification des
commandes.

Lookout exige un nom prédéfini et un mot de passe correspondant (si
nécessaire) pour qu’un opérateur ouvre une session. Pour ce faire,
sélectionnez la commande File→Log on… (Fichier→Accéder), appuyez
sur CTRL+L ou cliquez sur la case Account name (nom d’utilisateur)
dans la barre d’état. Nous appelons ces noms/mots de passe des
Accounts (comptes). Chaque compte jouit d’un niveau de sécurité.
Lookout utilise les noms d’utilisateurs quand il enregistre des
événements sur disque et quand les opérateurs acquittent des alarmes.
Ceci permet de savoir exactement quel opérateur était au travail quand
un événement s’est produit. Le système de sécurité de Lookout fait grand
usage des noms d’utilisateurs.

e

Le système Lookout Express n’enregistre pas les événements sur
disque.
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La sécurité de contrôle
La sécurité de contrôle permet d’évincer les opérateurs de certains objets
individuels. Plusieurs classes d’objets dans Lookout supportent la
sécurité de contrôle. Elles comprennent les Pot (potentiomètre), les
Switch (booléen) et les Pushbutton (bouton-poussoir). Comme vous
l’avez sans doute remarqué, toutes ces classes fournissent un type de
“contrôle” : les potentiomètres contrôlent les signaux numériques de
sortie, tandis que les interrupteurs et les boutons-poussoirs contrôlent les
signaux logiques de sortie. Chacune de ces classes comprend un
paramètre de niveau de sécurité de contrôle. Reportez-vous au chapitre
18 pour plus d’informations.

Lookout compare le paramètre de sécurité d’un objet avec le niveau de
sécurité du compte de l’opérateur pour déterminer s’il détient le contrôle
de cet objet. Si le niveau de sécurité du compte est égal ou supérieur au
niveau de sécurité de l’objet, le curseur de la souris se transforme en
main quand il est placé sur l’objet. Ceci signifie que l’opérateur peut
régler le contrôle sur l’objet, ou qu’il en a le contrôle.

Quand vous cliquez avec le bouton gauche de la souris, la main se
transforme en poignet (reportez-vous au bouton).

Si le niveau de sécurité de l’opérateur est inférieur à celui de l’objet, le
curseur se transforme en symbole international pour NON, indiquant



Chapitre 10. Sécurité

189

qu’il lui est impossible de contrôler l’objet, comme indiqué dans la
figure ci-après.

Etant donné que cette fonction s’utilise objet par objet (et non par classe
entière), les intégrateurs système peuvent empêcher l’accès des
interrupteurs, des potentiomètres et des boutons-poussoirs de haute
priorité aux opérateurs de bas niveau, mais leur permettre toutefois de
régler d’autres objets dont le niveau de sécurité est moins élevé.

Il existe une fonction supplémentaire pour la sécurité de contrôle : le
paramètre de contrôle d’un objet du panneau de contrôle. Lookout
applique ce paramètre de sécurité à tous les objets présents sur ce
panneau. Il utilise le niveau de sécurité le plus haut des deux pour
déterminer si un opérateur détient le contrôle d’un objet. Reportez-vous
à la définition de l’objet Panel (panneau de contrôle) au chapitre 18
pour plus d’informations.

La sécurité d’affichage
Il existe trois catégories de sécurité d’affichage : les panneaux de
contrôle, les objets contrôlables et les paramètres système. Ceci vous
offre la possibilité de “masquer” des panneaux de contrôle entiers aux
opérateurs selon leur niveau de sécurité. Vous pouvez également
masquer des objets comme des potentiomètres, des interrupteurs et des
boutons-poussoirs, ainsi que défendre l’accès de plusieurs ressources
système standard de Windows.
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Les panneaux de contrôle

La sécurité d’affichage permet de masquer des panneaux de contrôle
entiers aux opérateurs d’un niveau de sécurité bas. Les objets Control
Panel (panneau de contrôle) définissent la sécurité d’affichage pour des
panneaux de contrôle entiers. Prenez comme exemple un panneau de
contrôle avec un niveau de sécurité d’affichage de 6. Si un opérateur de
niveau 5 (ou inférieur) ouvre une session, il ne peut pas voir le panneau
de contrôle et ne sait même pas qu’il existe. Si un opérateur de niveau 6
(ou plus haut) ouvre une session, le panneau de contrôle est
immédiatement affiché. Cette fonction est utile pour masquer des
panneaux rarement utilisés ou qui contiennent des informations
confidentielles.

Les objets contrôlables

Les objets contrôlables tels que les Pots (potentiomètres), Switches
(booléens) et Pushbuttons (boutons-poussoirs), comprennent tous une
donnée membre écrite appelée visible . Quand sa valeur est Vrai,
vous pouvez voir le potentiomètre, l’interrupteur ou le bouton-poussoir
sur un panneau de contrôle. Quand sa valeur est Faux, vous ne pouvez ni
voir ni régler le potentiomètre, l’interrupteur ou le bouton-poussoir. La
valeur par défaut est Vrai, ce qui garantit que l’objet est visible quand il
est créé.

Vous pouvez connecter la donnée membre visible  d’un
potentiomètre, par exemple, à l’indicateur de mode d’un contrôleur.
Quand le contrôleur est en mode contrôle de l’ordinateur, la donnée
membre visible  du potentiomètre peut être Vrai, permettant à
l’opérateur de voir le potentiomètre et de régler la consigne. Mais quand
le contrôleur n’est pas en mode contrôle de l’ordinateur, la donnée
membre visible  peut être Faux, masquant ainsi le potentiomètre à
l’opérateur et le privant de son contrôle.
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Les paramètres système

Vous définissez la sécurité afin que les utilisateurs d’un certain niveau
de sécurité ne puissent pas fermer Lookout. C’est-à-dire qu’ils sont
“enfermés” dans Lookout. Ces paramètres de sécurité sont définis via la
commande de menu Options→System… (Options→Système).

Vous pouvez également identifier les niveaux de sécurité en deçà
desquels la barre de menus n’est pas affichée et la barre de titres n’est
pas visible. Et pour que les utilisateurs débutants ne se perdent pas dans
le programme, vous pouvez limiter le nombre de fenêtres locales
susceptibles de s’ouvrir en même temps. Reportez-vous à la commande
de menu Options→System… (Options→Système) au chapitre 16 pour
plus d’informations.

La vérification de l’action
La vérification de l’action de Lookout ne repose sur aucun type de
niveau de sécurité ; cependant, elle est extrêmement utile pour vérifier
en détails la commande d’un opérateur. Les classes d’objets Switch et
Pushbutton  supportent cette fonction. Quand elle est activée, l’option
Verify (vérification) invoque une boîte de message vous incitant à
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sélectionner Yes (oui) ou Cancel (annuler). Le résultat de votre décision
détermine si Lookout exécute la commande précédente de l’opérateur
(par exemple, l’interrupteur est activé ou non, le bouton-poussoir est
enfoncé ou non).

Tous les paramètres de vérification de l’action acceptent les expressions
textuelles, dont les données dynamiques. Un exemple est un interrupteur
qui démarre une pompe remplissant un réservoir, mais qui ne doit pas
démarrer si le niveau d’eau du réservoir est trop élevé. Entrez
l’expression suivante dans le paramètre Verify On  de l’interrupteur :

“Are you sure you want to turn on pump
#4? The water level in the Highland
storage tank is currently at ” &
TEXT(level, “0.0”) & “ meters. The
maximum level for turning on a pump is
79.5 meters.”

(“Etes-vous sûr de vouloir démarrer la
pompe numéro 4 ? Le niveau d’eau dans
le réservoir Highland est
actuellement” & TEXT (niveau, “0.0”) &
“ mètres. Le niveau maximum pour
démarrer une pompe est 79.5 mètres”.

L’avertissement apparaît chaque fois que vous activez l’interrupteur.
Notez que le niveau d’eau est dynamique : il change pour refléter la
valeur de level  (niveau) quand l’interrupteur est activé.

Quand vous désactivez l’interrupteur, aucun avertissement n’apparaît
parce que le paramètre Verify Off  n’a pas été spécifié. Si vous souhaitez
désactiver l’avertissement Verify On , effacez tout simplement toute
l’expression dans la donnée membre.
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Remarque La vérification du bouton-poussoir fonctionne de façon similaire. Sauf que
quand vous sélectionnez Yes (oui), le bouton-poussoir ne crée qu’un
signal de sortie provisoire. Il est impossible de maintenir le bouton
enfoncé quand la vérification de l’action est activée.

Les comptes
Les comptes font partie intégrante du système de sécurité de Lookout.
La commande de menu Options→Accounts... (Options→Comptes)
permet aux détenteurs d'un niveau de sécurité de 10 de créer, réviser ou
effacer des noms d’utilisateurs du système. Les comptes comprennent,
entre autres, les mots de passe de l’opérateur et les niveaux de sécurité.

Toute personne ayant accès à la commande Options→Accounts... peut
effacer tous les autres comptes et/ou changer arbitrairement des mots de
passe et des niveaux de sécurité.

Remarque Faites très attention quand vous affectez des comptes de niveau 10.
Seules les personnes responsables de la sécurité du système doivent
détenir un niveau 10 ! Soyez également prudent quand vous affectez des
niveaux de sécurité 8 ou supérieurs. Entre autres, ces niveaux accordent
aux opérateurs la possibilité de fermer le fichier de processus, de quitter
Lookout et, dans les versions de développement de Lookout, de modifier
le fichier de processus.
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Le procédé de création et le procédé de révision des comptes sont
identiques.

La donnée membre Your password (votre mot de passe) permet d’entrer
votre propre mot de passe (si vous en avez un). Lookout l’exige avant
d'ajouter ou de modifier un compte.

Les champs Account Name  (nom d’utilisateur), New password
(nouveau mot de passe) et Confirm password  (confirmer le mot de
passe) peuvent comprendre n’importe quelle combinaison de caractères
alphanumériques. Le champ Security Level  (niveau de sécurité) s’étend
de 1 à 10.

Le champ Idle Time  (temps d’arrêt) est la durée pendant laquelle
l’ordinateur est à l’arrêt (pas de mouvement de la souris ni d’action au
clavier) avant que Lookout ne ferme automatiquement la session de
l’opérateur. Si vous entrez 0 (zéro), le temps d’arrêt est désactivé.
Utilisez cette fonction pour les comptes de haut niveau afin de les fermer
automatiquement quand l’ordinateur est laissé seul trop longtemps. Une
fois que la session d’un compte est fermée, le compte nommé (nobody)
(personne) entre en session.
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Vous pouvez modifier le niveau de sécurité d’un compte (nobody) de la
même façon que les autres comptes. Il est donc possible d’établir un
compte (nobody) avec un niveau de sécurité de 10. Dans ce cas, si un
détenteur de niveau bas ferme la session, (nobody) ouvre
automatiquement la session avec un niveau de sécurité de 10 et
l’opérateur a immédiatement accès à toutes les commandes de Lookout !
Nous suggérons de donner au compte (nobody) un niveau de sécurité de
0, après avoir créé quelques comptes d’un niveau de sécurité 10. Le
compte (nobody) est le seul nom d’utilisateur qui supporte le niveau de
sécurité 0.

Remarque Si votre compte est le seul avec un niveau 10 de sécurité et que vous
oubliez votre mot de passe, vous ne pouvez plus accéder à la
commande System→Accounts… (Système→Comptes) et il vous est
impossible de modifier les paramètres des comptes. Dans ce cas,
appelez National Instruments pour obtenir un nouveau mot de passe.
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11. Enregistrement : données et 
événements

e

Lookout Express n’enregistre pas les données ou les événements
sur disque. Ce chapitre ne couvre pas les systèmes Lookout
Express.

Lookout emploie plusieurs méthodes pour enregistrer des informations
système en temps réel sur disque. Le type d’informations que vous
enregistrez et ce que vous voulez en faire, une fois celles-ci sur votre
disque dur, déterminent la méthode d’enregistrement utilisée. Ce
chapitre décrit trois méthodes d’enregistrement :

• La méthode Spreadsheet Logger (enregistreur de feuilles de calcul)
crée des fichiers de texte standard ASCII au format de fichier de
valeurs séparées par des virgules (.CSV). Vous pouvez ouvrir et
éditer ces fichiers avec des programmes courants de tableurs et de
bases de données.

• La méthode Citadel™ Threaded Database Logger (enregistreur de
base de données historique) crée une base de données historique à
laquelle les objets HyperTrend™ de Lookout peuvent accéder en
temps réel. Vous pouvez récupérer ces données avec les requêtes
SQL (Structured Query Language).
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• La méthode Event Logger (enregistreur d’événements) crée une
analyse rétrospective chronologique de qui a fait quoi et quand.

Ces trois méthodes d’enregistrement présentent un grand éventail de
capacités et d’informations. Si vos besoins sont très complexes, ils
peuvent requérir les trois méthodes à la fois sur un système unique. Elles
ne sont pas incompatibles.

Remarque Une quatrième méthode d’enregistrement est l’enregistrement d’alarmes
sur disque. Reportez-vous au chapitre 9, Alarmes, pour plus
d’informations sur l’enregistreur d’alarmes.

L’enregistreur de feuilles de calcul
Lookout peut stocker des informations système en temps réel sur disque
en utilisant les objets Spreadsheet (feuille de calcul).

Remarque Nous vous conseillons cette méthode d’enregistrement de données
quand vous souhaitez créer des fichiers ASCII permanents que vous
pourrez ensuite ouvrir avec des logiciels tiers comme Excel, Lotus et
Foxpro.

Vous pouvez configurer un fichier de processus unique (un fichier.LKP )
pour générer des fichiers tableur en créant plusieurs objets Spreadsheet
(feuille de calcul). De cette façon, vous avez plusieurs fichiers tableur
dans divers sous-répertoires ; chacun avec des données différentes et
stocké selon divers critères d’enregistrement. Reportez-vous à la
définition de l’objet Spreadsheet (feuille de calcul) au chapitre 18 pour
plus d’informations.

Lookout ajoute des rangées de données aux fichiers tableur après des
intervalles pairs et impairs, après un changement de la valeur des
données, quand un événement se passe ou après une combinaison des
trois. Vous pouvez ainsi établir des critères répondant à vos besoins
particuliers en termes de stockage de données.
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Un objet Spreadsheet (feuille de calcul) doté de mécanismes complexes définis
pour provoquer l’enregistrement.

Lookout ne garde pas les fichiers tableur ouverts, mais ouvre brièvement
un fichier chaque fois qu’il ajoute une nouvelle rangée de données au
fichier. Lookout peut enregistrer une nouvelle rangée de données
approximativement 10 fois par seconde ; cependant, il arrondit
l’horodateur associé à chaque rangée à la seconde près.

Etant donné que Lookout est exploité sous l’environnement multitâche
de Windows, vous pouvez lancer un tableur ou une base de données
Windows en même temps que Lookout. Vous pouvez donc ouvrir à tout
moment un fichier tableur généré par Lookout.

L’emplacement des données

Le paramètre Data files location  dans la boîte de dialogue System
Options spécifie le répertoire racine sous lequel commence
l’enregistrement de données. Lookout stocke les fichiers tableur dans les
sous-répertoires de ce répertoire racine. Reportez-vous à la commande
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Options→System... (Options→Système), au chapitre 16, et à la
définition de l’objet Spreadsheet au chapitre 18 pour plus
d’informations.

La boîte de dialogue System Options spécifie le chemin du répertoire racine
pour le fichier tableur.

Les fichiers CSV
Actuellement, tous les fichiers tableur générés par Lookout utilisent le
format selon lequel les valeurs sont séparées par une virgule (.CSV). Le
format .CSV est un texte séparé par des virgules où chaque ligne du
fichier représente une rangée de données tableur. La première rangée du
fichier comprend des noms de signaux et décrit les données stockées
dans chaque colonne du fichier. La première colonne du fichier tableur
comprend la date et l’heure correspondant aux données dans la rangée.

Le format des fichiers dont les valeurs sont séparées par une virgule a
l’avantage de stocker les mêmes données sur moins d’espace disque que
les formats natifs de fichiers tableur. Un autre avantage est son format
générique qui permet à plusieurs applications de tableurs et de bases de
données d’ouvrir et d’analyser les données. De plus, de nouvelles
données peuvent être ajoutées à la fin des fichiers .CSV beaucoup plus
rapidement qu’aux fichiers natifs tableurs.

Répertoire racine pour le
fichier tableur
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Vous pouvez visualiser et modifier les fichiers tableur avec un traitement
de texte standard ; cependant, un tableur comme Microsoft Excel est un
meilleur outil de visualisation, de modification et d’impression des
rapports personnalisés.

Fichier tableur typique de Lookout avec Excel
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Les erreurs de fichier et de disque

Si Lookout constate un problème en recherchant le répertoire de données
ou les fichiers tableur, ou en enregistrant les données sur disque, il
déclenche une alarme de priorité 8 avec un message décrivant l’erreur.
Par exemple, si l’emplacement de l’arborescence est paramétré sur
Monthly (mensuel), votre Data file location  est défini comme
C:\LOOKOUT. De même, si Lookout trouve un disque plein en écrivant
sur un fichier nommé DATA.CSV, le texte d’alarme avertit que :

(Disk is full) “c:\lookout\1994\sep\data.csv”

 (Le disque est plein)  “c:\lookout\1994\sep\data.csv”

Quand vous élucidez la cause de cette alarme, il y a remise à zéro
automatique.

L’accès simultané aux fichiers

Lookout n’ouvre les fichiers tableur que brièvement chaque fois qu’il
ajoute une nouvelle rangée de données au fichier. Ainsi, le fichier est
toujours disponible pour votre tableur préféré. Cependant, les tableurs
gardent les fichiers ouverts de façon à interdire l’accès écriture par
d’autres programmes. Si vous avez un fichier de données ouvert dans
Excel, Lookout ne peut pas y ajouter une nouvelle rangée de données.
Dans ce cas, Lookout émet une alarme expliquant le problème.

Error writing spreadsheet file: Permission denied
[c:\lookout\1993\sep\data.csv]

Erreur d’écriture fichier tableur. Permission niée
[c:\lookout\1993\sep\data.csv]

Ne craignez pas de perdre des données. Chaque fois que Lookout
détermine que le fichier tableur est ouvert par un autre programme, il
crée une mémoire tampon provisoire dans la mémoire principale et y
enregistre toutes les données de la feuille de calcul. Quand vous fermez
le fichier tableur, Lookout le met à jour et restaure l’alarme.
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L’excès d’informations

Il est possible que la version actuelle d’Excel ne puisse pas charger tout un
fichier tableur, car Excel se limite actuellement à 16 384 rangées de
données. Les feuilles de calcul créées avec des intervalles d’une minute
produisent 44 641 rangées de données si l’emplacement de l’arborescence
est paramétré sur Monthly (mensuel). Les feuilles de calcul créées toutes
les deux minutes produisent 22 321 rangées de données. Mais il existe des
moyens de stocker des données avec ces intervalles. La première option est
de changer l’emplacement de l’arborescence à Daily (tous les jours). Ceci
ne produit que 1 440 rangées de données par jour avec des intervalles
d’enregistrement d’une minute. La deuxième option est d’utiliser un
éditeur de texte pour fractionner le fichier plus grand en fichiers plus petits
capables d’être chargés par votre tableur préféré.

En plus de la limite des 16 384 rangées avec Excel, il existe une limite de
256 colonnes de données. Une colonne est utilisée pour la date et l’heure,
ce qui laisse 255 données membres (expressions) lisibles par Excel.

Si vous créez un objet Spreadsheet (feuille de calcul) qui enregistre
cinquante données membres (noms de variable et/ou expressions) à des
intervalles de cinq minutes, vous produirez 14 400 points de données par
jour ou 432 000 points de données par mois ! Sachez que s’il est facile
de générer tant de données, il est difficile de les trier et d’en extraire les
informations essentielles.

Remarque Nous vous conseillons de prêter une attention particulière à chaque point
de données et à l’intervalle de temps entre les données afin de ne pas
générer un amoncellement des données.
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L’enregistreur de la base de données
historique Citadel ™

Remarque Nous vous conseillons cette méthode d’enregistrement de données si
vous souhaitez visualiser des informations historiques avec HyperTrends
de Lookout ou accéder aux données historiques avec la requête SQL
(Structured Query Language).

Lookout peut stocker des informations système en temps réel sur disque
avec l’enregistreur de base de données historique Citadel, une méthode
simple de stockage des données numériques et logiques en un format très
condensé.

Dans le cas d’autres programmes d’enregistrement historique, les
utilisateurs doivent spécifier une fréquence d’enregistrement. Cela
signifie, d’une part, que d’autres programmes ne réagiront pas aux
fluctuations supérieures à la fréquence d’enregistrement et, d’autre part,
qu’une fréquence d’enregistrement trop élevée entraîne un gaspillage
d’espace disque. Vous pouvez éviter ces deux problèmes en utilisant la
base de données historique de Lookout.

Premièrement, Citadel ne vous demande pas de spécifier une fréquence
d’échantillonnage. Chaque fois que la valeur d’un point change, le
programme enregistre le changement immédiatement sur disque. Les
avantages sont nombreux. D’abord, les données sur disque reflètent avec
précision le comportement actuel du point qui est enregistré. La base de
données sait exactement quand la valeur du point a changé. Ensuite,
l’espace occupé sur le disque correspond exactement au volume
d’informations qui sont enregistrées. Si, comme c’est le cas avec
d’autres systèmes, la même valeur d’un point est enregistrée sans arrêt,
l’espace sur le disque est occupé sans pour autant ajouter des
informations sur ce point.

L’“historique” de la base de données historique est une ligne de
continuité du nom ou du point d’une donnée membre. Elle relie toutes
les valeurs historiques d’un point précis et devient une ligne continue
dans un objet HyperTrend.
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L’historique peut s’interrompre si Lookout est lui-même interrompu de
manière imprévue ou si une donnée membre est modifiée provisoirement
dans le but de ne PAS s’enregistrer sur disque. Si tel est le cas,
HyperTrend dessine l’historique sous forme de ligne continue, les
sections vides représentant les espaces entre données.

Vous pouvez ajouter n’importe quel nombre de nouveaux historiques
aux bases de données en configurant un nouveau point, comme expliqué
dans les paragraphes suivants. Cependant, vous ne pouvez pas enlever
des traces individuelles dans les bases de données.

Une fois que les données sont stockées sur disque, vous pouvez les
visualiser avec tout objet HyperTrend dans Lookout ou avec la requête
SQL. Les HyperTrends sont des fenêtres donnant sur votre base de
données historique. Reportez-vous à la définition de la classe d’objets
HyperTrend au chapitre 18 pour plus d’informations.

SQL est un langage standard de l’industrie supporté par la plupart des
programmes de bases de données tiers. Il permet aux autres applications
de récupérer directement des données de Citadel. Reportez-vous au
chapitre 12, Langage SQL, pour plus d’informations.

Vu que Citadel utilise l’heure GMT pour horodater les données, il n’est
donc pas nécessaire de compenser, lors de la comparaison historique, les
données enregistrées dans différentes zones horaires. L’objet
HyperTrend fait la conversion automatique entre le temps universel et le
système horaire de chaque pays avant d’afficher automatiquement
l’historique des données. Vous identifiez votre zone horaire dans la boîte
de dialogue System Options. Reportez-vous à Options→System…
(Options→Système) au chapitre 16 pour plus d’informations.

L’emplacement des données

Le paramètre Data files location  dans la boîte de dialogue System
Options spécifie le répertoire racine sous lequel l’enregistrement de
données doit commencer. La base de données historique est stockée dans
ce répertoire. Reportez-vous à la commande Options→System...
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(Options→Système) au chapitre 16 pour plus d’informations.

A la différence des fichiers tableur, il ne peut y avoir qu’une seule base
de données historique par copie de Lookout. Ceci peut affecter les
intégrateurs système qui souhaitent développer plusieurs fichiers de
processus (chacun avec sa propre base de données historique) sur un seul
ordinateur. Pour ce faire, installez Lookout plusieurs fois sur le même
ordinateur, mais dans des répertoires différents. Cette technique vous
laisse spécifier différents emplacements pour chaque base de données
historique : une pour chaque copie de Lookout.

La création d’une base de données historique

Vous pouvez enregistrer n’importe quelle donnée membre numérique ou
logique de tout objet dans la base de données historique. Pour ajouter
une valeur à la base de données Citadel :

1. Sélectionnez la commande de menu Object→Edit Database...
(Objet→Editer base de données) et choisissez un objet qui comprend
les données que vous souhaitez enregistrer.

2. Identifiez la valeur que vous souhaitez enregistrer dans la donnée
membre Member . Si la valeur est déjà configurée, vous pouvez la
sélectionner dans la liste Configured points .

3. Sélectionnez Log to historical database  et choisissez une étendue
temporelle appropriée.

4. Entrez une valeur dans le champ Deviation .

Reportez-vous à la section intitulée Les critères d’enregistrement, à
la page suivante, pour plus d’informations sur les paramètres de
déviation étendue temporelle.
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5. Cliquez sur le bouton Save (sauvegarde) ou sur le bouton Update
(mise à jour). Si vous êtes en train de modifier un point configuré
existant, le bouton passe automatiquement à Update.

6. Configurez toutes les données membres dans cet objet que vous
souhaitez enregistrer dans la base de données Citadel.

7. Cliquez sur le bouton Select Object (sélectionner un objet) et
choisissez le prochain objet qui comprend les données que vous
souhaitez enregistrer. Répétez les étapes 2 à 6. Ensuite, cliquez sur
Quit (quitter).

Les critères d’enregistrement

Lookout n’a besoin de connaître que trois éléments pour créer un nouvel
historique dans la base de données Citadel : le nom que porte la valeur, à
quel moment l’enregistrer et combien de temps la conserver. Ces trois
éléments sont traités ci-dessous.
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Le nom de la valeur
Lookout affecte un nom à chaque historique de la base de données pour
l’archivage et la récupération. Si aucun pseudonyme n’est spécifié,
Lookout utilise le nom de la donnée membre native tel qu’il est affiché
dans le champ Member . Si un pseudonyme est affecté à la donnée
membre native, Lookout utilise le nom de ce pseudonyme. De toutes
façons, le nom utilisé est le même que celui qui est enregistré dans la
liste Configured points . Dans l’exemple ci-dessus, le nom est
PLC.FIC101FLOW.

Quand enregistrer
Si le changement d’une valeur analogique est égal ou supérieur au
paramètre Deviation , Lookout enregistre une nouvelle valeur sur disque
dans la base de données historique. Si les paramètres Scaling  sont
établis, Lookout compare le paramètre Deviation  aux modifications dans
les valeurs Eng units  au moment de savoir choisir quand enregistrer un
nouveau point. Si les paramètres Scaling  sont vides, il compare le
paramètre Deviation  avec le signal brut (non mis à l’échelle). Le
paramètre Deviation  n’est pas disponible pour les signaux logiques ; sa
fonction est d’enregistrer toutes les transitions d’état des valeurs
logiques sur disque.

La durée de conservation
Lookout doit savoir combien de temps vous souhaitez garder cet
historique de données dans la base de données. Selon votre choix,
Lookout garde les données au moins pendant la durée spécifiée dans les
paramètres Log to historical data base .

L’excès d’informations

Le logiciel Citadel crée un sous-répertoire spécial nommé CITADEL
dans le répertoire Lookout. C’est une réserve pour vos fichiers de base
de données historique qui ne doit jamais être ni déplacée ni renommée.

Lookout crée et conserve la base de données historique en tranches de 1
Méga-octet. Ainsi, il vous faut au moins 1 Mo d’espace disque
disponible pour commencer l’enregistrement de données. Quand le
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premier fichier de 1 Mo est rempli, Lookout crée un second fichier de 1
Mo dans le même répertoire. Quand ce dernier est rempli, Lookout crée
un autre fichier de 1 Mo, et ainsi de suite, jusqu’à ce que tous les
historiques puissent être gardés sur disque pendant les périodes
spécifiées dans la donnée membre Log to historic database lifespan .
Lookout surveille l’état de votre lecteur et émet une alarme quand la
quantité d’espace disponible de votre disque est inférieure à 500 Ko.

La base de données historique utilise des méthodes non conventionnelles
(voire révolutionnaires) pour condenser, stocker et récupérer un nombre
important de données. La vitesse pour tracer et rechercher le démontre
très clairement. Cependant, déterminez avec prudence les paramètres
Deviation  pour chaque historique de données. Si ce champ est vide,
N’IMPORTE QUEL changement de valeur analogique provoque
l’enregistrement sur disque d’un nouveau point. Comme vous pouvez
l’imaginer, il est facile, ainsi, de générer des masses d’informations
inutiles. Par contre, si votre paramètre Deviation  est trop vaste, très peu
d’informations, ou même aucune, sont enregistrées sur disque. Vous
devez choisir un paramètre Deviation  acceptable pour chaque historique.

Remarque Nous vous conseillons de considérer avec discernement l’importance de
chaque point de donnée et le paramètre Deviation  qui vous semble
convenable, pour éviter la production d’une masse de données.

L’enregistreur d’événements
L’enregistreur d’événements de Lookout est très différent des
enregistreurs de tableurs et de bases de données. Son objectif est de
savoir qui fait quoi et quand.

Remarque Nous vous recommandons cette méthode d’enregistrement de données
quand vous souhaitez créer un programme chronologique d’événements
ou une analyse rétrospective.

Lookout enregistre les commandes d’opérateurs comme des événements
spécifiques. Ces commandes comprennent, entre autres, la clôture d'un
fichier de processus, l'accès au mode Edition et le réglage d'un
potentiomètre. Avec chaque événement, Lookout enregistre le nom de
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l’utilisateur (qui), la date et l’heure de l’événement (quand), le nom de
variable de l’objet réglé et les paramètres Avant et Après de l’objet
(quoi).

En fait, vous créez une analyse rétrospective pour une station de travail
précise. Chaque fois qu’un utilisateur entre ou sort du mode Edition,
qu’il ouvre un nouveau fichier ou ajuste une consigne, vous pouvez créer
une archive permanente de l’événement. Vous pouvez l’utiliser, ensuite,
pour savoir qui a activé l’interrupteur maître d’arrêt “Master Kill
Switch” ou quand une consigne importante a été réglée et à quel niveau.

Vous pouvez également définir des événements personnalisés en
utilisant la classe d’objets Event (événement). Il s’agit d’une classe
d’objets flexible et puissante qui vous permet de choisir parmi vos
propres messages d’événement quels seront ceux enregistrés selon une
détente définie par l’utilisateur. Reportez-vous à la définition de la
classe d’objets Event (événement) au chapitre 18 pour plus
d’informations.

Il existe également certains événements globaux qui sont toujours
enregistrés : exécuter Lookout, fermer Lookout, ouvrir un fichier de
processus, fermer un fichier de processus, accéder au mode Edition,
quitter le mode Edition, et ouvrir et fermer une session.

L’emplacement des données

Le paramètre Data file location  dans la boîte de dialogue System
Options spécifie le répertoire racine dans lequel tout enregistrement de
données doit s’effectuer en premier. Les fichiers d’événements sont
stockés dans les sous-répertoires mensuels de ce répertoire racine.
Reportez-vous à la commande Options→System... (Options→Système)
au chapitre 16 pour plus d’informations.

C:\DATA\1993\OCT\EVENT.DAT
            \NOV\EVENT.DAT
            \DEC\EVENT.DAT
       \1994\JAN\EVENT.DAT
            \FEB\EVENT.DAT
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Vous pouvez visualiser ces fichiers en les imprimant avec la commande
File→Print →Events… (Fichier→Imprimer→Evénements). Reportez-
vous à la commande File→Print→Events… (Fichier→
Imprimer→Evénements)… au chapitre 16 pour plus d’informations.

L’excès d’informations

L’enregistreur d’événements peut stocker des informations objet par
objet. Il existe trois classes d’objets qui supportent cette fonction :
Switch (interrupteur), Pot (potentiomètre) et Pushbutton (bouton-
poussoir). Reportez-vous aux Définitions des classes d’objets pour plus
d’informations sur l’activation de l’enregistreur d’événements objet par
objet. Chaque fois que vous activez un interrupteur, que vous réglez un
potentiomètre ou que vous appuyez sur un bouton-poussoir, Lookout
enregistre l’événement sur disque. Bien entendu, il est facile ainsi de
générer des masses d’informations inutiles qui deviennent très
encombrantes et difficiles à trier.

En activant l’enregistreur d’événements pour qu’il ne sélectionne que les
objets critiques Switch (booléen), Pot (potentiomètre) et Pushbutton
(bouton-poussoir), vous pouvez réduire considérablement le volume
d’informations enregistrées dans le fichier d’événements. Par exemple,
sur la douzaine d’interrupteurs que contient un panneau de contrôle, un
seul risque d’avoir besoin d’un réglage. Vous pouvez donc utiliser cet
interrupteur au lieu des douze autres pour activer l’enregistreur
d’événements. Quand cet interrupteur est activé, l’événement est
enregistré sur disque, mais quand les onze autres interrupteurs sont
réglés, aucun événement n’est enregistré.
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La génération de rapports
Il existe deux façons de créer des rapports personnalisés avec Lookout :
avec la fonction d’impression intégrée dans les panneaux de contrôle ou
selon l’approche Lookout tierce partie.

Les rapports du panneau de contrôle

Les objets des panneaux comprennent une donnée membre spéciale
nommée print . Quand la valeur de ces données membres passe de
Faux à Vrai, Lookout copie une image du panneau de contrôle qu’il
imprime ensuite via le gestionnaire d’impression de Windows. Reportez-
vous à la définition de la classe d’objets Panel (panneau) au chapitre
18.

Pour configurer votre rapport personnalisé, élaborez votre ou vos
panneau(x) en fonction de l’apparence désirée pour le rapport et reliez
un signal logique de déclenchement au(x) panneau(x) approprié(s). Vous
pouvez relier n’importe quelle expression logique au membre print  ;
inutile que le panneau de contrôle soit visible pour être imprimé. Ainsi,
un opérateur peut regarder un écran (panneau) tandis que s’imprime
automatiquement un autre écran. Lookout détermine la taille du panneau
à imprimer selon ses dimensions. Ces dimensions sont entrées et éditées
dans la boîte de dialogue de définition du panneau, comme indiqué dans
la figure suivante.
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Attention à l’impression d’un panneau de style Normal  conçu pour être
agrandi dans Lookout. Même si votre panneau de contrôle est agrandi,
seule la zone définie par les paramètres Width  (largeur) et Height
(hauteur) de votre objet Panel (panneau) sera imprimée. Ainsi, votre
panneau peut ressembler à celui-ci quand il est agrandi, mais seule une
portion est imprimée.

Si le panneau ci-dessus a un paramètre Height  de 300 pixels et un
paramètre Width  de 400 pixels et si votre résolution vidéo est établie sur
800 x 600, votre impression ressemble à la figure suivante.
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Vous pouvez facilement y remédier en modifiant les dimensions Height
et Width  de votre objet Panel (panneau) afin qu’elles correspondent
mieux à la résolution de votre écran. Souvenez-vous qu’il s’agit des
panneaux du style Normal  uniquement. Les panneaux du style Popup  et
Popup no icon  sont imprimés selon les principes WYSIWYG (What
You See Is What You Get [tel écran, tel écrit]).

Les rapports tiers
S’il vous faut des capacités plus complexes que celles offertes par la
méthode précédente, nous recommandons l’usage d’un des nombreux
tableurs tiers. Aujourd’hui, les tableurs sont dotés de nombreuses
commandes macro qui facilitent la génération de rapports en cliquant sur
un bouton. Avec Excel, vous écrivez des macros qui vous demandent la
date du rapport et ouvrent automatiquement le bon fichier, extraient les
données et impriment des rapports contenant graphes et tableaux
numériques. Vous lancez ces macros depuis Lookout en cliquant avec la
souris ou vous pouvez automatiquement les invoquer via des horloges
predéfinies.

Selon cette approche, Lookout dépend de votre tableur pour générer des
rapports. Pour ajouter à Lookout des fonctions de génération de rapports,
il nous faudrait le doter de la puissance et de la flexibilité offertes par les
tableurs actuels. Ainsi, au lieu de réinventer la roue, nous préférons
laisser les tableurs existants répondre à ce besoin.
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12. Langage SQL
e

Lookout Express n’enregistre pas les données et n’a pas d’outils
d’extraction des données enregistrées. Ce chapitre ne couvre pas
les systèmes Lookout Express.

Introduction
La base de données historique Citadel comprend un driver ODBC (Open
Database Connectivity). Ce driver permet aux autres applications de
récupérer directement des données de Citadel via les requêtes SQL
(Structured Query Language).

Qu’est-ce que l’ODBC ?

ODBC est un système standard développé par Microsoft qui définit les
mécanismes d’accès aux données résidant dans les systèmes de gestion
de bases de données (DBMS). Virtuellement, toutes les applications
Windows peuvent récupérer des données d’une base de données ODBC.

Qu’est-ce que le SQL ?

Structured Query Language (SQL) est un langage standard dans
l’industrie qui sert à récupérer, mettre à jour et gérer des données. En ce
qui concerne Lookout, vous utilisez le SQL pour façonner des requêtes
d’extraction des données Citadel. Outre cette extraction de données, le
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driver ODBC de Citadel comprend plusieurs transformations de données
intégrées qui simplifient considérablement l’analyse statistique des
données extraites.

La configuration du driver ODBC

Pour configurer le driver ODBC de Citadel

1. Fermez toutes les applications actuellement servies par ODBC,
c’est-à-dire les tableurs, les traitements de texte, les bases de
données, MS Query, etc. Il n’est pas nécessaire d’arrêter Lookout.

2. Si vous travaillez sous Windows 95, cliquez sur le bouton Démarrer,
pointez sur Paramètres, puis cliquez sur Panneau de configuration.
Sinon, sélectionnez l’icône du panneau de configuration dans le
groupe de programmes principal.

3. Dans la boîte de dialogue du panneau de configuration, sélectionnez
le driver ODBC 32 bits, ou l’icône ODBC si vous utilisez le driver
ODBC 16 bits.

4. Dans la boîte de dialogue Sources de données (Data Sources),
sélectionnez 

 

5. Sélectionnez le driver Citadel , puis 
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6. Effectuez les modifications appropriées. Par exemple, si Lookout et
la base de données Citadel ne sont pas dans le répertoire
C:\LOOKOUT, vous devrez peut-être modifier le chemin de la base
de données.

Remarque Quelques applications ne sont pas complètement adaptées au driver
ODBC. Si vous envisagez d’utiliser Microsoft Query, Microsoft Access ou
Visual Basic, vérifiez que Maximum Column Name Length  (longueur
maximum du nom de colonne) n’a pas plus de 62 caractères. En effet,
ces programmes ne peuvent pas traiter des noms de variables plus
longs. D’autres progiciels complètement adaptés à ODBC doivent
pouvoir accepter des noms de variables jusqu’à 126 caractères. Tous les
historiques dont les noms de variables sont plus longs que Maximum
Column Name Length sont exclus des requêtes.

Si vous envisagez d’utiliser Microsoft Access ou Visual Basic,
sélectionnez Convert special characters (conversion de caractères
distincts). Ceci force les noms de variables de Lookout à suivre un format
accepté par ces applications en remplaçant des caractères du nom de
variable de la façon suivante :

Caractère d’origine Converti en

point (.) barre oblique inverse ( \ )

esperluette ( & ) symbole pour à ( @ )

exclamation ( ! ) barre verticale ( | )

7. Sélectionnez OK et CLOSE (fermer) pour quitter.
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L’accès aux données Citadel

La table Threads

Le driver ODBC présente les données Citadel aux autres applications
sous forme de table “Threads”. La table comprend un champ ou une
colonne pour chaque donnée membre enregistrée dans la base de
données Citadel.

La table comprend également trois champs qui servent à spécifier les
critères de requête et à activer l’horodateur des données récupérées :
Interval , LocalTime  et UTCTime.

Interval permet de spécifier le taux d’échantillonnage de la valeur de la
requête. Le paramètre Interval peut être de 10 minutes ou de plusieurs
années. La valeur par défaut Interval  est 1 (un jour).

N’oubliez pas que Citadel enregistre uniquement une valeur quand elle
change (Citadel est événementielle). Mais avec Interval, Citadel peut
accepter des requêtes à intervalles réguliers sur une période de temps.

LocalTime  et UTCTime  indiquent l'heure d'enregistrement des valeurs.
En fait, Citadel stocke le temps sous format UTCTime  et établit l’heure
LocalTime  à partir du temps stocké. Quand vous ne spécifiez pas
d’heure, Citadel part de minuit du jour en cours.

La clause où de la requête suivante profite des paramètres Interval et
LocalTime  pour sélectionner les données d’une période spécifiée à
intervalles d’une minute. Remarquez que les formats de l’heure et de la
date sont les mêmes que ceux de Lookout.

SELECT * FROM Threads
WHERE LocalTime>“12/1 10:00”

   AND LocalTime<“12/2 13:00”
   AND Interval=“1:00”
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Les transformations de données

Vos requêtes peuvent comprendre des commandes spéciales qui
transforment les données et facilitent le traitement et l’analyse des
données historiques. Le tableau suivant liste les commandes de
transformation de données.

Transformations de données
Min{Datapoint} Rend le minimum pour Datapoint pendant l’intervalle.

Max{Datapoint} Rend le maximum pour Datapoint pendant l’intervalle.

Avg{Datapoint} Rend la moyenne pour Datapoint pendant l’intervalle.

Stdev{Datapoint} Rend l’écart-type pour Datapoint pendant l’intervalle.

Starts{Datapoint} Rend le nombre de démarrages, c’est-à-dire le nombre de transitions OFF
(désactivé) à ON (activé) pour Datapoint pendant l’intervalle.

Stops{Datapoint} Rend le nombre d’arrêts, c’est-à-dire le nombre de transitions ON (activé)
à OFF (désactivé) pour Datapoint pendant l’intervalle.

ETM{Datapoint} Rend la durée pendant laquelle Datapoint était en état ON pendant
l’intervalle.

Qual{Datapoint} Il peut y avoir des discontinuités dans les historiques de données Citadel
suite à des arrêts de la machine, de Lookout, etc. Qual rend le rapport
entre le temps pour lequel des données valables existent pour Datapoint
pendant l’intervalle, et la durée de l’intervalle. Ainsi, si des données
valables n’existent que pour la moitié de l’intervalle, Qual rend 0,5.

Ces transformations de données permettent de calculer et de récupérer
directement des informations complexes de la base de données, comme
les moyennes et les écarts-types. Grâce à cette fonction, il n’est plus
nécessaire d’extraire des données brutes, puis de les traiter dans une
autre application pour obtenir les informations nécessaires.
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Supposez, par exemple, que vous souhaitez savoir combien de fois un
moteur de compression a démarré au mois de décembre ainsi que la
durée de fonctionnement pendant ce mois. La requête suivante fournit
les réponses :

SELECT “Starts{PLC.MotorRun}”,
                 “ETM{PLC.MotorRun}”
FROM Threads
WHERE LocalTime>=“12/1/95”

   AND LocalTime<“1/1/96”
   AND Interval=“31”

Des exemples SQL

Les exemples suivants sont des commandes de requête typiques, quoique
vos requêtes puissent être plus compliquées, en raison des exigences de
votre système.

SELECT *
FROM Threads

Récupère la valeur courante de chaque donnée membre enregistrée
dans Citadel. Etant donné que votre requête n’a pas lieu au même
moment qu’une interrogation de l’API, les signaux scannérisés des
API ne sont pas inclus dans les données récupérées.

SELECT *
FROM Threads
WHERE Interval=“0:01”

Récupère la valeur de chaque donnée membre enregistrée
aujourd’hui par incréments d’une seconde. Observez que la valeur
de l’intervalle est spécifiée entre guillemets.
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SELECT LocalTime, “Pot1”
FROM Threads
WHERE LocalTime>“8:50”
  AND Interval=“0:01”

Récupère et horodate la valeur de Pot1 en incréments d’une seconde
depuis 8 heures 50 ce matin jusqu’à maintenant. Les noms de
variables sont entre guillemets.

SELECT LocalTime, “AB1.I:3”, “Max{AB1.I:3}”
FROM Threads
WHERE LocalTime>“10/1/95”
  AND LocalTime<“11/1/95”
  AND Interval=“1:00”

Récupère et horodate une entrée API d’Allen-Bradley à intervalles
d’une minute pour le mois d’octobre. Indique également la valeur la
plus haute de l’entrée en une minute.

SELECT LocalTime, “OVEN1_SP”, “PLC.OVEN1_PV”,
 “Max{PLC.OVEN1_PV}”, “Min{PLC.OVEN1_PV}”,

    “Avg{PLC.OVEN1_PV}”
FROM Threads
WHERE  LocalTime>=“14:00”
  AND LocalTime <“15:00”
  AND Interval=“1:00:00”

Récupère la température d’un four à 15 heures et présente la
température la plus élevée, la température la plus basse et la
température moyenne entre 14 heures et 15 heures.

Un exemple progressif de l’utilisation de Microsoft
Query

Microsoft Query est un outil graphique de récupération de données
fourni avec Microsoft Office et Microsoft Excel. Il permet de construire
votre déclaration SQL via des boîtes de dialogue interactives. Ici,
l’exemple est un peu plus complexe pour vous apprendre quelques
astuces.
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Pour activer MS Query, double-cliquez sur l’icône MS Query,
qui se trouve normalement dans le groupe de programmes MS
Office. Si vous ne trouvez pas l’icône, cherchez dans
C:\WINDOWS\MSAPPS\MSQUERY.

Sélectionnez File→New Query…
(Fichier→Nouvelle requête)
d’abord, puis la source de données
Citadel,  comme indiqué ci-
contre.

Remarque Si MS Query ne se connecte pas à Citadel, c’est que vous n’avez pas
encore enregistré de données dans Citadel ou que le chemin Database
path spécifié dans la boîte de dialogue Setup (installation) du ODBC est
incorrect.

Remarque Si Citadel n’est pas listée dans la boîte de dialogue Select Data Source
(sélectionner la source de données), vous ne l’avez peut-être pas encore
ouverte. Sélectionnez Other… (autre), puis Citadel  parmi les sources
de données ODBC. Si Citadel n’est pas listée comme source ODBC Data
Source, vous devez l’installer. Reportez-vous à la section de ce chapitre
intitulée La configuration du driver ODBC.

Dans la boîte de dialogue Add
Tables (ajouter tables), double-
cliquez sur Threads . Ensuite,
fermez la boîte de dialogue.

MS Query affiche maintenant toute
la fenêtre Query (requête) avec la
table Threads . Remarquez la liste
de noms de variables dans la table
Threads . C’est une liste
exhaustive de tous les noms de
variables enregistrés dans Citadel.
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Pour afficher la valeur d’un champ, glissez-la sur le volet de données.

 

Pour visualiser une valeur de transformation de données, entrez la
fonction directement dans une colonne vide. Par exemple, pour
visualiser la plus petite valeur d’PLC.AI2, entrez “min{PLC.AI2}” .
Respectez l’emploi des guillemets et des accolades.

Les données ci-dessus ont été récupérées sans utiliser de critères de
spécification ; le driver ODBC a donc utilisé les critères par défaut. Il
existe plusieurs façons de spécifier des critères. Utilisez dans cet
exemple le volet de critères. Cliquez sur le bouton View Criteria
(visualiser les critères).

Pour ajouter un champ au volet de critères, glissez-le comme indiqué en
page suivante.

...sur la colonne vide du volet de données.

Glissez le champ que vous souhaitez visualiser...
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Quand vous entrez des valeurs de critères admissibles, vérifiez que la
syntaxe est celle des clauses “where” (où) des exemples SQL fournis
dans ce chapitre. Pour spécifier un démarrage à 9 heures 45 aujourd’hui,
par exemple, entrez >=“9:45” . Reportez-vous au diagramme de la
page suivante.

Dès que vous spécifiez un critère, Microsoft Query récupère
immédiatement les données spécifiées. Vous pouvez enregistrer votre
requête à n’importe quel stade de son développement. N’oubliez pas
qu’à mesure que vous façonnez votre requête, l’application
construit une déclaration SQL. Quand vous cliquez sur le bouton
SQL, vous pouvez visualiser et modifier la déclaration de
requête, comme indiqué dans le diagramme suivant.

Glissez le champ...

...dans la colonne vide du volet
critères
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L’utilisation de Microsoft Excel

Pour extraire des données de Citadel, lancez Excel et sélectionnez
Données→Obtenir données externes... Cette commande Excel lance
directement Microsoft Query. A partir de maintenant, vous pouvez utiliser
une requête existante ou en créer une nouvelle. Reportez-vous à la section
intitulée Un exemple progressif de l’utilisation de Microsoft Query.

Quand vous terminez de construire votre requête, retournez les résultats
en sélectionnant Fichier→Retourner données à Microsoft Excel... Excel
réagit en présentant la boîte de dialogue Obtenir données externes, ce
qui vous permet de modifier ou de
confirmer les cellules de destination pour
le jeu de résultats. Si vous souhaitez plus
tard mettre à jour le jeu de résultats avec
une seconde requête Citadel, vérifiez que
Keep Query Definition  (garder la
définition de la requête) reste sélectionné.
Sélectionnez OK pour écrire les données dans une feuille de travail
Excel.
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Pour la mise à jour de votre jeu de résultats, sélectionnez n’importe
quelle cellule de résultat dans la feuille de travail, puis
Données→Obtenir données externes… et cliquez sur le bouton
Rafraîchir.

L’utilisation de Microsoft Access

Remarque Selon la norme SQL/92, un identificateur délimité est toute chaîne de 128
caractères ou moins entre guillemets ainsi que les caractères d’un
identificateur délimité qui ne font pas l’objet d’une vérification de syntaxe
SQL. Malheureusement, Microsoft Access effectue sa propre vérification
de syntaxe pour les requêtes ODBC via une syntaxe non standard SQL,
même à l’intérieur des identificateurs délimités. C’est pour cela que
National Instruments présente Convert Special Characters comme
sélection dans la boîte de dialogue Citadel ODBC Setup. Après la
sélection, le driver ODBC convertit les caractères refusés en caractères
acceptés par Access, comme suit :

Caractère non permis Converti en

point (.) barre oblique invesrse ( \ )

esperluette ( & ) symbole à ( @ )

exclamation ( ! ) barre verticale ( | )

Ainsi, un identificateur de Lookout comme Modbus1.40001  est perçu
par Access comme l’identificateur délimité Modbus1\40001 .
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Quand vous recherchez des données Citadel via MS Access, vous devez
employer la syntaxe non standard SQL de Microsoft Access dans votre
déclaration de sélection. Vérifiez que vous utilisez les caractères
spéciaux compatibles avec Access et des guillemets doubles autour des
noms Thread de Lookout. Vous devez également utiliser des crochets [ ]
autour des identificateurs et des symboles # autour des horodateurs. Par
exemple, pour récupérer LocalTime , Pot1 , et Tiway1.V101  où
LocalTime  est supérieur à 11/20/95 18:00:00 (20 Novembre 1995 - 18
heures) et où Interval  est une seconde, entrez :

SELECT LocalTime, ["Pot1"], ["Tiway1\V101"]
FROM Threads
WHERE LocalTime > #11/20/95 6:00:00 PM#
  AND Interval = '0:01'

Pour interroger Citadel depuis MS
Access, ouvrez une base de données,
sélectionnez File→Attach Table…
(Fichier→Attacher table), puis <SQL
Database> . Dans la boîte de
dialogue SQL Data Sources,
sélectionnez Citadel , comme
indiqué ci-contre. Ensuite, dans la
boîte de dialogue Attach Tables, sélectionnez Threads . Le nouveau
tableau est maintenant relié à votre base de données.

Vous pouvez, à présent, créer des requêtes dans Access pour l’extraction
directe de données de la base de données Citadel.
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L’utilisation de Visual Basic

Remarque Le logiciel Visual Basic dépend des DLL de Microsoft Access pour
exécuter les requêtes ODBC. Etant donné qu’il utilise la syntaxe SQL non
standard d’Access, vérifiez que l’option Convert Special Characters
(convertir les caractères spéciaux) est sélectionnée dans la boîte de
dialogue Citadel ODBC Setup. Reportez-vous à la remarque de la page
précédente.

L’emploi du driver ODBC de Citadel avec Visual Basic est le même que
pour tout autre driver ODBC. Pour récupérer et visualiser des données,
vous devez commencer par créer un contrôle de données et au moins un
contrôle de texte.

Placez d’abord un contrôle de données dans un formulaire ouvert.
Réglez sa propriété Connect  sur DSN=Citadel  et double-cliquez sur
sa propriété Record Source  pour identifier Threads  comme table
source.

Sélectionnez Query
(requête) et New
(nouveau) pour
récupérer des
données Citadel
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La propriété Record Source  peut rester sur Threads  si vous souhaitez
sélectionner toutes les données pour tous les historiques dans la base de
données Citadel ; sinon, vous pouvez condenser votre requête en entrant
une déclaration de sélection SQL dans la propriété Record Source . Par
exemple, pour récupérer LocalTime , Pot1 , et AB1.I:3  où
LocalTime  est supérieur à 11/20/95 18:00:00 et inférieur à 18:30:00 et
où Interval  est une minute, entrez :

SELECT LocalTime, ["Pot1"], ["AB1\I:3"]
FROM Threads
WHERE LocalTime > #11/20/95 6:00:00 PM#
  AND LocalTime < #11/20/95 6:30:00 PM#
  AND Interval = '1:0'

Vous devez employer la syntaxe SQL de Microsoft Access dans votre
déclaration de sélection. N’oubliez pas d’utiliser les caractères convertis
pour la compatibilité avec Access et des guillemets doubles autour des
noms Thread de Lookout pour les identifier comme identificateurs
délimités. Le SQL d’Access exige également des crochets [ ] autour des
identificateurs et des symboles # autour des horodateurs.

Placez maintenant un contrôle Text dans le formulaire. Réglez sa
propriété Data Source  sur le nom de votre contrôle Data, comme par
exemple, Data1 . Cliquez sur la propriété Data Champ  pour la mettre
en surbrillance, puis utilisez la boîte déroulante de combinaison de la
feuille pour sélectionner le nom du champ souhaité. Toutes les données
membres enregistrées doivent être listées, y compris LocalTime,
Interval, Pot1, etc. Répétez cette étape pour chaque donnée membre que
vous souhaitez afficher sur votre formulaire.
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13.  Echange dynamique de 
 données

L’échange dynamique de données (DDE) est le protocole de Microsoft
basé sur les messages. Les applications telles que Microsoft Excel et
Lookout emploient le DDE pour se relier aux données détenues par
d’autres applications. Quand les données changent dans une application
source, le protocole exécute la mise à jour dynamique de toutes les
données reliées (en temps réel). Quand le DDE est établi avec Lookout,
il présente un environnement Windows de travail beaucoup plus intégré :
vous pouvez relier de façon dynamique d’autres applications Windows
avec Lookout.

Il existe plusieurs formats du protocole DDE. Lookout supporte les
formats standard Microsoft, “XlTable” et “CF-TEXT”. XlTable est
souvent cité comme format “Fast table” et CF-TEXT comme format
“ancien texte”. Lookout supporte également les liens clefs DDE et
NetDDE.

Quand deux applications exécutent un échange dynamique de données,
elles participent à une conversation DDE, où Lookout agit soit comme
application cliente, soit comme application serveur (ou les deux à la fois
dans une configuration d’égal à égal). Si Lookout reçoit des données
d’une autre application, Lookout est le client, mais si une autre
application reçoit des données de Lookout, Lookout est le serveur.
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L’application client est chargée d’établir un lien DDE avec le serveur.
Quand Lookout est un client, il essaye d’abord d’établir un lien XlTable
DDE (parce que c’est le plus efficace). Si l’application serveur ne
supporte pas ce format, Lookout emploie le format CF_TEXT DDE.

Avant d’établir un lien, l’application client doit identifier l’emplacement
des données désirées. Une adresse à trois paliers identifie l’emplacement
des données : Service, Topic (rubrique) et Item (article). Reportez-vous à
la documentation de l’application pour déterminer son service, sa
rubrique et son article.

Le palier Service spécifie le nom de l’application serveur auquel le
client est connecté. Chaque application qui supporte le DDE comprend
un nom de service unique. LOOKOUT est le nom de service de Lookout
et EXCEL est le nom de service de Microsoft Excel.

Le palier Topic est le deuxième niveau de l’adresse à trois paliers. Dans
le cas de plusieurs applications comme Excel et Lookout, Topic
(rubrique) spécifie un fichier particulier. Le Topic de Lookout est le nom
du fichier de processus, moins l’extension .LKP. Par exemple, vous
référencez le fichier de processus PLANT.LKP comme PLANT quand
c’est la rubrique du lien DDE.

Le palier Item identifie la valeur ou les données spécifiques reliant le
serveur et le client. Un Item (article) dans une application Lookout serait
le nom de variable de l’objet, suivi d’une donnée membre spécifique si
nécessaire, par exemple, TagName.datamember . Reportez-vous à la
section intitulée L’identification des données membres d’un objet, au
chapitre 5, pour des informations détaillées sur la sélection d’objets et
de données membres. Un article dans une feuille de calcul serait le nom
d’une cellule.
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Les liens entre Lookout et d’autres
applications

Comme expliqué plus haut, Lookout peut agir comme un client DDE, un
serveur DDE, un client/serveur DDE ou toute autre combinaison des
trois. Il existe donc trois façons de relier Lookout à une autre application
via le DDE :

• Lookout est le serveur

• Lookout est le client

• Lookout est le client et le serveur (égal à égal)
Remarque Toutes les valeurs numériques, logiques et textuelles dans Lookout sont

automatiquement à la disposition de toutes les autres applications via le
DDE. Aucune installation spéciale n’est nécessaire.

Vu l’emploi et la reconnaissance de Microsoft Excel, nous l’utilisons
dans nos exemples.

Le serveur DDE

Dans cet exemple, vous souhaitez envoyer des informations depuis
Lookout à une autre application (Lookout est le serveur). Créez d’abord
un potentiomètre dans Lookout afin de pouvoir relier sa valeur en temps
réel à une cellule dans Excel. Chaque fois que le potentiomètre est
ajusté, la valeur dans la cellule change automatiquement.

1. Vérifiez que Lookout n’est pas en mode Edition.

2. Maintenez enfoncée la touche Ctrl et cliquez avec le bouton gauche 
de la souris sur l’objet que vous souhaitez relier. Dans cet exemple, 
sélectionnez l’objet Pot (potentiomètre) que vous venez de créer.

 Lookout émet un bip sonore quand la valeur de l’objet est
correctement copiée sur le presse-papiers. L’objet peut être une
glissière, un graphe à barres, un interrupteur, un bouton-poussoir, un
affichage numérique, un objet d’entrée textuelle, un bouton ou
quasiment n’importe quel autre article dans Lookout qui contient
une valeur.
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3. Lancez Excel et sélectionnez une cellule à laquelle vous souhaitez 
relier la valeur.

4. Si votre version d’Excel est 5.0 ou plus, sélectionnez Edit→Paste 
Special… (Editer→Coller spécial). Ensuite, cliquez sur Paste Link
(coller lien). Si votre version d’Excel est plus ancienne, sélectionnez
Edit→Paste Link (Editer→Coller lien).

Félicitations ! Vous avez créé votre première connexion DDE. Répétez
ce procédé autant de fois que nécessaire. Si vous reliez un grand nombre
d’objets à Excel, les outils de copie et d’édition d’Excel rendront votre
tâche plus aisée.

Toutes les applications ne supportent pas le raccourci Presse-papiers
Windows que nous venons de décrire. Vous devrez peut-être introduire
manuellement Service, Topic (rubrique), et Item (article) de Lookout
dans l’autre application avant de créer un lien DDE, du fait que le format
des informations saisies varie selon les programmes. Il est donc
judicieux de lire les instructions contenues dans la documentation de
l’application à ce sujet.

Le client DDE

Dans cet exemple, vous souhaitez importer des informations depuis une
autre application dans Lookout comme, par exemple, utiliser une valeur
calculée dans un tableur comme consigne de contrôle du processus pour
une application Lookout. Pour ce type de lien DDE, Lookout est le client
et l’application tableur est le serveur. Vu que Lookout est le client, il est
chargé d’établir le lien avec les données du serveur. Il faut donc
identifier Service, Topic et Item dans Lookout. Ce sont des paramètres
objets de la classe d’objets DdeLink.

e

Vous ne pouvez ni créer ni modifier des objets dans les versions
Runtime-Only de Lookout. Vous devez donc exécuter ce procédé avec le
système Development/Runtime de Lookout.

1. Sélectionnez Object→Create… (Objet→Créer), puis la classe
DdeLink.
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2. Dans le champ Service , entrez le
nom du logiciel (Excel  dans ce
cas).

3. Dans Topic  (rubrique), entrez le nom
du fichier tableur.

4. Dans Item  (article), entrez l’adresse
de la cellule dont vous souhaitez lire
la valeur.

 Remarquez que l’adresse saisie de la cellule est r1c1 . Ce qui se
traduit par rangée1/colonne1 (cellule A1) dans Excel. La structure
DDE d’Excel exige ce format. Ne nous demandez pas la raison, car
seul Microsoft la connaît.

5. Cliquez sur OK et de nouveau sur OK quand Lookout vous demande
d’insérer l’expression DDE1. Ensuite, choisissez le format
d’affichage et cliquez sur OK une dernière fois.

Pour tester votre lien, entrez une valeur numérique dans la cellule A1 de
votre feuille de calcul. Toute valeur introduite dans la feuille de calcul
est immédiatement écrite dans l’expression DDE de votre panneau. Vous
pouvez relier l’objet DDE nouvellement créé à d’autres objets Lookout.
Reportez-vous à la définition de DdeLink au chapitre 18 pour plus
d’informations.

Remarque L’objet DdeTable est une autre façon de relier des données à Lookout via
DDE. Cette classe d’objets relie un grand volume de données via le
format XlTable. Reportez-vous à la définition de DdeTable au chapitre 18
pour plus d’informations.

Le DDE égal à égal

Supposez que vous vouliez pousser l’exemple de Lookout comme
Serveur un peu plus loin et que vous vouliez ajuster le potentiomètre
pour pouvoir changer une valeur dans Excel tout en entrant une valeur
différente dans Excel pour ajuster le potentiomètre. En d’autres termes,
vous voulez envoyer des données dans les deux directions à travers un
lien DDE. Il est facile de créer de tels liens bidirectionnels pour les
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objets contrôlables par l’utilisateur (c’est-à-dire, les interrupteurs, les
potentiomètres et les boutons-poussoirs).

e

Vous ne pouvez ni créer ni modifier des objets dans les versions
Runtime-Only de Lookout. Vous devez donc exécuter ce procédé avec le
système Development/Runtime de Lookout.

1. Sélectionnez Object→Create…
(Objet→Créer) et définissez un
nouveau  potentiomètre ou
sélectionnez Object→Modify...
(Objet→Modifier) puis votre objet
Pot (potentiomètre) existant.

2. Changez l’option Position source
de Local à DDE.

3. Dans Service , entrez le nom du
logiciel (Excel).

4. Dans Topic , entrez le nom du
fichier de données.

5. Dans Item , entrez l’adresse de la cellule dont vous souhaitez lire la
valeur.

6. Cliquez sur OK pour créer/modifier la définition de l’objet.

7. Si l’objet est nouveau, insérez son membre d’affichage dans le
panneau afin de pouvoir tester le lien.

Pour tester votre lien, entrez une valeur dans la cellule spécifiée de la
feuille de calcul et observez le potentiomètre. Ensuite, ajustez-le et
observez la cellule de la feuille de calcul. Les valeurs au sein des deux
applications changent en même temps.
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Remarque Le lien avec un objet Pot (potentiomètre) a une valeur numérique. Entrez
donc une valeur numérique dans la cellule de la feuille de calcul. Or, le
lien avec un objet Switch (booléen) ou Pushbutton (bouton-poussoir) a
une valeur logique. Les valeurs reliées logiques sont affichées dans les
cellules de la feuille de calcul comme “true ” (vrai) ou “false ” (faux).
Pour changer la valeur logique dans la cellule d’une feuille de calcul,
entrez “true ” ou “false ”, 0 ou 1, “on” ou “off”.

Les alarmes DDE
Cannot establish DDE conversation with <service>, <topic>
(Impossible d’établir une conversation DDE avec <service>, <rubrique>)

Cette alarme est déclenchée si un client Lookout n’arrive pas à établir le
lien avec le serveur correspondant aux paliers Service et Topic précisés.
Cette alarme est également déclenchée si le serveur clôt la conversation
(si le serveur est arrêté, par exemple). L’alarme est désactivée quand le
client Lookout réussit à établir un lien avec un Item (article) du serveur.

Vérifiez que les entrées pour Service et Topic (rubrique) ont été
correctement saisies quand vous avez créé l’objet qui emploie DDE.
Vérifiez aussi que l’application du serveur est bien lancée. Si le serveur
se trouve sur un autre ordinateur du réseau, vérifiez que le réseau est
bien activé. Si le serveur est sur un ordinateur qui exploite Windows NT,
vérifiez que vous êtes autorisé à ouvrir une session sur cet ordinateur et
que l’utilisateur actuel qui a ouvert une session sur la machine NT a
validé le secteur DDE auquel vous essayez d’accéder (reportez-vous à la
discussion sur la validation des secteurs DDE dans le chapitre sur les
réseaux).

DDE client error for <service>, <topic>, <item>: (received NACK for advise)
DDE client error for <service>, <topic>, <item>: (received NACK for request)
(Erreur client DDE pour <service>, <rubrique>, <article> : [NACK reçu pour
conseil])
(Erreur client DDE pour <service>, <rubrique>, <article> : [NACK reçu pour
requête])

Vérifiez que l’article nommé existe sur le serveur et que celui-ci
supporte les liens DDE pour cet article. Lookout supporte les liens avec
n’importe quelle donnée membre lisible par ses objets.
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DDE client error for <service>, <topic>, <item>: (received NACK for poke)
(Erreur client DDE pour <service>, <rubrique>, <article> : [NACK reçu pour
poussée])

Cette alarme est déclenchée si vous avez déporté un objet DataTable
(tableau de données), Pushbutton (bouton-poussoir), Pot (potentiomètre),
Switch (booléen), ou TextEntry (saisie de texte) vers un article non écrit.
Les seuls objets Lookout qui supportent l’écriture (pokes) sont
DataTable, PushButton, Pot, Switch, et TextEntry. Ces objets ne
supportent l'écriture que dans leurs données membres implicites. Vous
pouvez donc déporter, via DDE, un potentiomètre à un objet DataTable
(tableau de données) Table1 mais pas Table1.A1.

Si le serveur fonctionne sous Windows NT, il se peut que le secteur
DDE de l’ordinateur soit configuré pour supporter la lecture mais pas
l’écriture.

DDE client error for <service>, <topic>, <item>: (advise timed out)
DDE client error for <service>, <topic>, <item>: (request timed out)
DDE client error for <service>, <topic>, <item>: (poke timed out)
(Erreur client DDE pour <service>, <rubrique>, <article> : (durée expirée conseil])
(Erreur client DDE pour <service>, <rubrique>, <article> : (durée expirée requête])
(Erreur client DDE pour <service>, <rubrique>, <article> : (durée expirée poussée])

Vérifiez que l’application serveur est bien lancée. Vérifiez aussi que
l’article existe sur le serveur. Si celui-ci se trouve sur un autre ordinateur
du réseau, vérifiez que le réseau est bien activé.

DDE client error for <service>, <topic>, <item>: (received invalid data)
DDE Server: corrupt data block poked to item <item>, topic <topic>
(Erreur client DDE pour <service>, <rubrique>, <article> : (données non valables
reçues])
(Serveur DDE : bloc données corrompues poussé à article <article>, rubrique
<rubrique>)

Le serveur a reçu un bloc de données corrompues provenant du client ou
vice versa. Des difficultés de réseau peuvent occasionner ce genre de
problème. Si l’alarme est cohérente et prévisible, vous avez peut-être
découvert une erreur. Dans ce cas, sollicitez auprès de notre personnel
une “requête d’action corrective”.
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DDE Server: failed to post advise for item <item>, topic <topic>
(Serveur DDE : n’a pas affiché conseil pour article <article>, rubrique <rubrique>)

Vérifiez que l’application client est bien lancée et que l’article existe
encore sur le client. Si le client est sur un autre ordinateur du réseau,
vérifiez que le réseau est activé.
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14. Gestion de réseau
Avec Lookout, vous pouvez surveiller et contrôler votre processus
depuis n’importe quelle station de travail (nœud) sur le réseau. La
gestion de réseau de Lookout permet de :

• Visualiser simultanément les mêmes écrans ou d’autres écrans sur
des nœuds séparés.

• Ajuster des consignes depuis n’importe quel nœud.

• Acquitter des alarmes depuis n’importe quel nœud.

• Configurer des nœuds spécifiques pour la surveillance uniquement.

• Configurer l’architecture égal à égal.

• Configurer une architecture client-serveur.

• Configurer des nœuds de réseau pour communiquer via des lignes
téléphoniques standard.

• Configurer des nœuds de réseau pour communiquer par radio.

La gestion de réseau de plusieurs nœuds Lookout est un outil puissant et
avancé. Ce chapitre et ses exemples font référence à plusieurs concepts
et termes traités ailleurs dans ce manuel. Avant de commencer, vous
devez avoir acquis des connaissances solides en architecture Lookout et
avoir travaillé avec Lookout sur un nœud simple.



Partie 2. Guide de l’utilisateur

242

Les exigences de la gestion de réseau Lookout sont les suivantes :

1. Vous devez acheter et installer sur chaque ordinateur une copie sous
licence de Lookout.

2. Vous devez installer sur chaque ordinateur du réseau le matériel
approprié.

3. Vous devez installer Windows pour Workgroups, Windows 95 ou
Windows NT de Microsoft sur chaque ordinateur.

Vu que Lookout est une application native de Windows, il supporte les
mêmes réseaux que Windows de Microsoft, y compris Microsoft
Windows Network, Microsoft LAN Serveur, Novell NetWare, Banyan
VINES, 3Com 3+Open, DEC Pathworks, IBM LANServer, etc.

Les considérations sur la gestion de réseau
La gestion de réseau avec Lookout n’est rien de plus qu’un échange de
données entre deux ou plusieurs nœuds Lookout. Les données sont
transmises entre des objets qui les réceptionnent. Il existe deux méthodes
fondamentales pour transmettre des données entre plusieurs nœuds
Lookout. La première méthode exige un lien NetDDE (Network
Dynamic Data Exchange) pour chacune des valeurs transmises entre
nœuds : c’est la méthode de La gestion de réseau multiliens. La seconde
méthode établit un “concentrateur de données” à chaque nœud où seuls
les concentrateurs (tableaux) sont reliés entre nœuds : c’est la méthode
de La gestion de réseau par tableaux. Bien que les deux méthodes
nécessitent la connexion d’objets sur un réseau qui emploie NetDDE, la
mise en œuvre et les effets obtenus sont très différents.

Si vous comptez utiliser l’une des méthodes NetDDE, vous devez
configurer l’activation NetDDE automatique et peut-être les secteurs
validés DDE. Reportez-vous à “La gestion de réseau avec DDE” à la fin
de ce chapitre pour des instructions sur l’installation.
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Il existe une autre méthode pour établir des capacités réseau entre
plusieurs nœuds Lookout. Cependant, à la différence des deux autres
méthodes, cette technique ne s’appuie pas sur la transmission de données
entre nœuds Lookout. Ce sont vos API, téléterminaux ou E/S qui
assurent l’échange de données entre nœuds. C’est la méthode de La
gestion de réseau matérielle.

La gestion de réseau multiliens
La gestion de réseau multiliens correspond à la transmission de données
d’un objet sur ordinateur à un autre objet sur un autre ordinateur. Une
fois que les objets sont reliés, toute modification dans la valeur d’un
objet est immédiatement communiquée et affichée par le second objet
sur l’autre ordinateur.

Objet 1

Objet 2

Objet 3

Objet 4

Objet 5

Objett 1

Objet 2

Objet 3

Objet 4

Objett 5

Liens DDE entre
objets dans des

nœuds différents

Nœud 1 Nœud 2

Gestion de réseau multiliens

La façon d’acheminer les données entre deux objets sur le réseau dépend
de la nature contrôlable ou non des objets.
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Les liens entre objets contrôlables

Les objets contrôlables par l’utilisateur ont une option DDE. Ces objets
comprennent :

• Les objets Pot (potentiomètre)

• Les objets Switch (booléen)

• Les objets Pushbutton (bouton-poussoir)

Les objets contrôlables (Pot, Switch et Pushbutton) ont chacun trois
options de source de position : Local , Remote  et DDE. Quand vous
sélectionnez DDE, vous demandez que l’objet obtienne sa valeur depuis
une source à distance : une cellule dans une feuille de calcul, une autre
application sensible au DDE ou une seconde copie de Lookout sur le
réseau.

Relier des objets contrôlables sur un réseau
Deux ordinateurs qui satisfont les exigences mentionnées ci-dessus sont
nécessaires et les communications réseau doivent avoir été vérifiées.
Pour distinguer les deux ordinateurs, l’un se nomme Station1 et l’autre
Station2.

1. A la Station1, créez un objet Switch (booléen) Switch1 . Laissez la
source Position à la valeur par défaut de Local .
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2. A la Station2, créez un objet Switch (booléen) correspondant nommé
Switch1 . Changez la source Position à DDE. (Bien qu’il ne soit
pas nécessaire d’attribuer des noms de variables assortis aux objets
sur réseau, ce procédé rend votre documentation plus facile à
suivre.)

 

3. Dans Service , entrez \\Station1\NDDE$ , où “Station1” est le
nom de réseau de l’autre ordinateur.

 Dans l’exemple ci-dessus, Station1  est le nom de l’autre
ordinateur. Les barres obliques inverses, “NDDE” et le symbole $
sont exigés par Windows pour Workgroups.

4. Dans Topic , entrez Filename$ , où “Filename” est le nom du
fichier de processus Lookout de l’autre ordinateur.

 Le symbole $ est nécessaire tandis que l’extension .LKP  ne l’est
pas.

5. Dans Item , entrez le nom de l’objet sur l’autre ordinateur que vous
voulez relier (ici, l’autre objet s’appelle également Switch1 ).

6. Cliquez sur OK.

Basculez l’interrupteur pour tester votre réseau. Quand vous basculez
l’interrupteur sur l’une des deux stations, il bascule immédiatement à
l’autre station de travail. Vous pouvez ajouter, modifier, effacer ou
réviser votre logique sur l’un ou l’autre ordinateur, complètement en
ligne, sans perturber le lien réseau entre les deux !
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Les liens entre objets non contrôlables

Si un objet n’est ni un Pot (potentiomètre), ni un Switch (booléen) ni un
Pushbutton (bouton-poussoir), il n’a probablement pas de capacités DDE
intégrées. Cependant, l’intention est tout simplement de transmettre des
données entre deux ordinateurs. Une fois que les données sont dans
Lookout, elles sont accessibles par n’importe quel objet. Vous pouvez
donc créer un objet DdeLink pour recevoir des données depuis une autre
application via DDE ou NetDDE. Reportez-vous à la définition de
DdeLink au chapitre 18 pour plus d’informations. Dans cet exemple,
l’autre application est Lookout, lancée sur un deuxième ordinateur.

Accéder aux données en temps réel sur un autre ordinateur
Deux ordinateurs qui satisfont les exigences mentionnées ci-dessus sont
nécessaires et les communications réseau doivent avoir été vérifiées.
Pour distinguer les deux ordinateurs, l’un se nomme Station1 et l’autre
Station2.

1. A la Station1, créez un objet Average (moyenne). Cet objet peut
créer la moyenne de n’importe quelle valeur, mais donnez-lui le nom
de variable Average1 .

2. A la Station2, créez un objet DdeLink et nommez-le Average1 .
Bien qu’il ne soit pas nécessaire d’attribuer des noms de variables
assortis aux objets sur un réseau, ce procédé rend votre
documentation plus facile à suivre.
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3. Dans Service , entrez \\Station1\NDDE$ , où “Station1” est
l’autre nom de réseau de l’ordinateur.

 Dans l’exemple ci-dessus, Station1  est le nom de réseau de
l’autre ordinateur. Les barres obliques inverses, “NDDE” et le
symbole $ sont exigés par Windows pour Workgroups.

4. Dans Topic , entrez Filename$ , où “Filename” est le nom du
fichier de processus Lookout de l’autre ordinateur.

 Le symbole $ est également nécessaire tandis que l’extension .LKP
ne l’est pas.

5. Dans Item , entrez le nom de l’objet sur l’autre ordinateur que vous
voulez relier (ici, l’autre objet s’appelle également Average1 ).

6. Cliquez sur OK.

7. Achevez la définition de l’objet DdeLink en insérant l’expression
DDE dans votre panneau.

Une fois le lien établi, connectez d’autres objets de la Station2 à l’objet
DdeLink nommé Average1 . Souvenez-vous que le simple fait de
nommer l’objet DdeLink Average1  n’en fait pas pour autant un objet
Average. Il ne fait que recevoir les données depuis l’objet Average de la
Station1. L’habit ne fait pas le moine !

La mise en réseau des tables
La mise en réseau des tables requiert la consolidation de toutes les
données à partager sur le réseau en une table unique ou matrice de
valeurs. Pensez à ces tables comme à des “concentrateurs de données”,
même si elles sont plus que des dépôts de données. Reportez-vous à la
définition de DataTable au chapitre 18 pour plus d’informations. Vous
pouvez relier une table via NetDDE à la table correspondante sur un
autre ordinateur. Une fois reliées, les tables actualisent mutuellement
leurs bases de données modifiées.
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Remarque La mise en réseau des tables est l’un des concepts les plus compliqués
et avancés de Lookout. Vous devez vous être entièrement familiarisé
avec les objets, les connexions de bases de données, les événements et
l’architecture générale de Lookout avant de lire cette section.

Table Table

Nœud 1 Nœud 2

Objet 1 Objet 1Objet 2

Objet 3 Objet 4

Objet 2

Objet 3 Objet 4

Lien DDE entre
“concentrateurs de

données”

Mise en réseau des tables

Relier plusieurs DataTables pour la mise en réseau est très simple.
Cependant, vous devez considérer et planifier plusieurs aspects avant de
vous lancer dans cette application. Prenons un exemple qui montre
comment mettre la table sur réseau.

Cet exemple comprend trois ordinateurs, chacun d’eux lançant Lookout.
Ces trois nœuds sont déjà établis sur le réseau sous les noms Station1,
Station2 et Station3. Station1 est le seul nœud directement connecté à un
API. Or, vous voulez surveiller et contrôler vos E/S depuis les trois
nœuds. Le diagramme qui suit illustre la structure du réseau de cet
exemple.
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API

Station1

/RRNRXW

Station2

/RRNRXW

Station3

/RRNRXW

API API API

Réseau propriétaire

Réseau local

Le matériel E/S peut être
des API, des
téléterminaux, des
contrôleurs, ou tout autre
appareil avec lequel
Lookout communique.

Avec un peu de préparation, vous pouvez configurer Lookout à la
Station1 de façon à pouvoir réutiliser facilement son fichier de processus
à la Station2 et à la Station3. Le diagramme suivant montre la
disposition générale du fichier de processus de Lookout à la Station1.
Notez que, pour simplifier cette explication, les objets Driver sont
connectés à l’objet DataTable (tableau de données) par des tirets tandis
que les autres objets sont connectés par des traits continus.

Station1

objet
Driver

objet
Driver

objet
Driver

objet
Driver

objet
(autre)

objet
(autre)

objet
(autre)

objet
(autre)

objet
Data
Table
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Le concept le plus important concerne les objets Driver et leurs
connexions à DataTable. Vous modifierez éventuellement ce fichier de
processus, pour qu’il fonctionne aux Station2 et Station3 en effaçant
toutes les connexions aux objets Driver, puis vous effacerez les objets
Driver aux Stations 2 et 3.

Il est important d’acheminer tous les signaux vers et depuis l’objet
Driver à travers DataTable (tableau de données). Si vous souhaitez
afficher une entrée analogique d’un API sur un panneau de contrôle, ne
connectez pas le signal API directement à ce panneau. Connectez-le
d’abord à DataTable, puis connectez les cellules appropriées de
DataTable au panneau de contrôle. Si vous devez connecter la consigne
d’un opérateur à la sortie d’un API, ne connectez pas la consigne
directement à l’API. Connectez-la d’abord à DataTable, puis connectez
les cellules appropriées de DataTable à la sortie de l’API. Ceci n’est
nécessaire que pour les signaux provenant d’un objet Driver ou destinés
à un objet Driver. Bien que ce procédé ajoute une autre étape à la
configuration de votre Lookout à la Station1, il simplifie sensiblement le
développement du fichier de processus aux Station2 et Station3.

Maintenant que vous avez développé une application à la Station1, il
faut la déplacer à la Station2. Copiez le fichier de processus et effacez
toutes les connexions vers et depuis nos objets. Ensuite, effacez tous les
objets Driver.

Souvenez-vous que la Station2 ne doit pas essayer de communiquer avec
les API car il n’y a pas de connexion physique au réseau propriétaire. La
Station2 doit recevoir ses informations de la Station1.

Il ne reste plus qu’à modifier l’objet DataTable à la Station2. Changez
son paramètre Table location  en DDE. Dans le champ Service, entrez
\\Station1\NDDE$ . Dans Topic , entrez Filename$ , où
“Filename” est le nom du fichier de processus à la Station1. Dans Item ,
entrez le nom de variable de l’objet DataTable à la Station1. Vos objets
DataTable ont maintenant une connexion bidirectionnelle à travers un
lien NetDDE.
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A ce stade, rien n’est plus simple que d’ajouter des stations opérateur au
réseau. Copiez le fichier de processus de la Station2 à la Station3, ou à
d’autres nœuds de Lookout sur le réseau. Il n’est pas nécessaire de
modifier les fichiers.

La topographie de votre réseau Lookout ressemble maintenant à
celle-ci :

Station1 Station2 Station3

objet
Driver

objet
Driver

objet
Driver

objet
Driver

objet
(autre)

objet
(autre)

objet
(autre)

objet
(autre)

objet
(autre)

objet
(autre)

objet
(autre)

objet
(autre)

objet
(autre)

objet
(autre)

objet
(autre)

objet
(autre)

objet
Data
Table

objet
Data
Table

objet
Data
Table

Connexion
NetDDE

Connexion
NetDDE

Le réseau matériel
Une caractéristique fondamentale doit être présente pour mettre en
œuvre la méthode de réseau matériel. Tous les nœuds de Lookout que
vous souhaitez mettre sur réseau doivent communiquer directement avec
tout votre matériel, comme le montre la figure suivante. C’est pour cette
raison que la méthode de réseau matériel n’est applicable que dans
certaines conditions.
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API

Station1

/RRNRXW

Station2

/RRNRXW

Station3

/RRNRXW

API API API

Le matériel E/S peut
être des API, des
téléterminaux, des
contrôleurs, ou tout
autre appareil avec
lequel Lookout
communique.

Des trois méthodes de gestion de réseau, celle-ci est la plus directe.
Configurez un fichier de processus à un nœud et copiez-le dans tous les
autres nœuds qui communiquent directement avec votre matériel. La
seule chose à ne pas oublier, quand vous élaborez votre fichier de
processus, est de configurer tous les Pot (potentiomètre), Switch
(booléen), et Pushbutton (bouton-poussoir) avec le paramètre Remote ,
ce qui garantit la synchronisation avec le point d’écriture. Donc, si
l’interrupteur d’un des nœuds Lookout change l’état d’une sortie, tous
les interrupteurs correspondants des autres nœuds Lookout constatent la
modification et basculent automatiquement pour maintenir la
synchronisation. Reportez-vous aux descriptions de Pot, Switch, et
Pushbutton au chapitre 18 pour plus d’informations sur le paramètre
Remote .

Les topologies de votre matériel, de votre réseau et de vos
communications déterminent si cette méthode peut être employée ou
non. La méthode de réseau matériel est rarement applicable car il est rare
que tous les nœuds Lookout puissent communiquer directement avec
tout votre matériel.
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La mise en réseau multiliens comparée à la
mise en réseau des tables

Chaque méthode présente des avantages et des inconvénients. La
méthode multiliens est rapide et facile pour les très petites tâches.
Cependant, tout lien NetDDE exige du temps processeur et plus les liens
sont nombreux plus le processeur est utilisé. Souvenez-vous que chaque
valeur transmise aux ordinateurs exige un objet DdeLink séparé. Votre
ordinateur peut rapidement “s’embouteiller” si des centaines de liens
transmettent sans arrêt des valeurs aux ordinateurs.

Par ailleurs, la méthode des tables peut exiger plus de temps de
planification et de développement, mais il n’existera qu’un lien NetDDE
entre ordinateurs connectant les DataTables. Cette méthode réduit
considérablement le trafic DDE sur le réseau. C’est donc la meilleure
méthode pour les grands systèmes où les ordinateurs partagent des
centaines ou des milliers de valeurs sur le réseau.

Quand le volume de points devient-il excessif ? On ne sait pas
exactement, mais les propriétaires de Lookout utilisent la méthode de
mise en réseau des tables pour des systèmes ayant plus de 6000 valeurs ;
le délai de mise à jour est bien inférieur à une seconde avec une
utilisation de l’unité centrale de trois pour cent seulement.

La gestion de réseau avec DDE
Lookout emploie Network DDE (Dynamic Data Exchange) pour
supporter la gestion de réseau client/serveur.

Deux composants de MS Windows sont nécessaires au Network DDE :
l’agent Network DDE (NETDDE.EXE) et le gestionnaire NetDDE Share
Database Manager (DSDM). L’utilisation de ces composants dépend du
système d’exploitation utilisé par Lookout : Windows pour Workgroups,
Windows 95 ou Windows NT.
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Le programme NETDDE.EXE est un agent qui fonctionne en tâche de
fond et qui transfère les messages DDE entre ordinateurs. Ce programme
doit être lancé avant de démarrer une instance de Lookout si elle doit
agir en tant que serveur. Lookout ne lance pas automatiquement
NETDDE.EXE car c’est une perte de temps et de ressources si Lookout
n’est pas employé comme serveur. En outre, il ne peut pas savoir si un
autre ordinateur essaiera de s’y connecter ou pas.

Le démarrage automatique de NETDDE.EXE

Les trois sections suivantes expliquent comment garantir le démarrage
de NETDDE.EXE chaque fois que vous lancez Windows.

Windows pour Workgroups
1. Dans Windows, sélectionnez l’icône du panneau de configuration

(ou exécutez CONTRÔLE.EXE via la boîte de dialogue File→Run…
(Fichier→Exécuter)) du gestionnaire de programmes.

2. Dans la fenêtre du panneau de configuration, sélectionnez l’icône du
réseau.

3. Cliquez sur l’option Démarrage.

4. Dans la boîte de dialogue Paramètres de démarrage, vérifiez que la
case Enable Network DDE (activer réseau DDE) est bien cochée.

5. Cliquez sur OK, puis encore sur OK pour fermer le panneau de
configuration.

Windows 95
1. Dans Windows 95, cliquez sur Démarrer→Paramètres→Barre des

tâches...

2. Dans la boîte de dialogue Propriétés de la Barre des tâches,
sélectionnez l’onglet “Programmes Menu Démarrer”.

3. Cliquez sur le bouton Ajouter...

4. Dans le champ Ligne de commande de la boîte de dialogue “Créer
un raccourci”, entrez NETDDE.EXE, puis cliquez sur Suivant.
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5. Sélectionnez le dossier Menu Démarrer→Programmes→Démarrage,
puis cliquez sur Suivant.

6. Sélectionnez un nom (par exemple, NetDDE) pour le raccourci et
cliquez sur Terminer, puis sur OK.

Windows NT
1. Dans le gestionnaire de programmes, double-cliquez sur l’icône du

panneau de configuration (ou exécutez CONTRÔLE.EXE via la boîte
de dialogue Fichier→Exécuter… du gestionnaire de programmes).
Si vous utilisez la version 4.00 de NT, cliquez sur Démarrer, pointez
sur Paramètres et sélectionnez le panneau de configuration.

2. Dans la fenêtre du panneau de configuration, double-cliquez sur
l’icône Services.

3. Dans la liste de services, sélectionnez Réseau DDE .

4. Cliquez sur le bouton Démarrage...

5. Dans la case Type de démarrage , sélectionnez Automatique .

6. Cliquez sur OK puis sur Fermer pour quitter le panneau de
configuration.

L’ajout de la validation d’un secteur DDE

Pour qu’une autre personne se connecte à un secteur DDE (par exemple,
processus$) sur votre ordinateur en cours de session, vous devez “faire
confiance” au secteur DDE. Quand une autre personne à distance
connecte au secteur, votre contexte de sécurité domine car vous êtes en
session. Vous devez autoriser cette personne à accéder au secteur. Même
un administrateur ne peut pas valider un secteur pour votre compte.

Dans Windows pour Workgroups et Windows 95, les secteurs validés
sont automatiquement créés par Lookout.

Dans Windows NT, vous devez utiliser le programme DDESHARE.EXE
pour ajouter un secteur validé. L’installation exacte dépend du niveau de
sécurité que vous exigez. Les étapes suivantes décrivent comment établir
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un secteur qui offre un accès DDE total à Lookout à toutes les personnes
sur le réseau.

1. A partir du gestionnaire de programmes, sélectionnez
Fichier→Exécuter… Si vous utilisez une version 4.00 de NT,
cliquez sur Démarrer et sélectionnez Exécuter.

2. Entrez DDESHARE.EXE.

3. Sélectionnez Shares→DDE Shares...

4. Dans la boîte de dialogue “DDE Shares”, sélectionnez Add a Share...

5. Dans la boîte de dialogue “DDE Share Properties” :

a. Pour Share Name , entrez le nom du fichier de processus
Lookout que vous souhaitez partager, sans l’extension .LKP  et
avec le symbole $ à la fin. Ainsi, si votre fichier de processus est
PROCESSUS.LKP, vous entrez PROCESSUS$ sur cette ligne.

b. Pour Static Application Name , entrez Lookout .

c. Pour Static Topic Name , entrez le fichier de processus sans
l’extension, par exemple, PROCESSUS.

d. Ne cochez pas les cases Allow start application  et service .

e. Dans la case Item Security , sélectionnez la case Grant
access  to  all  items  (accorder l’accès à tous les éléments).

f. Cliquez sur le bouton Permissions....

g. Dans la boîte de dialogue “DDE Share Name Permissions” :

i) Dans la liste Names , sélectionnez EVERYONE (tous). S’il
n’y a pas d’entrée pour EVERYONE, utilisez le bouton
Ajouter... et la boîte de dialogue associée pour la créer.

ii) Dans la case Type of Access , sélectionnez Full
Control .

iii) Cliquez sur OK.

h. Cliquez sur OK.
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6. De retour dans la boîte de dialogue “DDE Shares”, sélectionnez le
secteur que vous venez de créer et cliquez sur le bouton Trust Share.

7. Dans la boîte de dialogue “Trusted Share Properties”, sélectionnez le
bouton Initiate to Application Enable et cliquez sur OK.

8. De retour dans la boîte de dialogue “DDE Shares”, cliquez sur OK.

9. Quittez le programme DDE Shares.

Remarque Pour qu’un secteur DDE soit disponible, il doit être validé par l’utilisateur
en session (étapes 6 à 9). Sinon, le secteur peut être disponible en tant
que service quand vous sélectionnez la case “Is service” dans la boîte de
dialogue “DDE Share Properties”. Dans ce cas, le secteur est toujours
accessible aux personnes répertoriées dans la boîte de dialogue “DDE
Share Name Permissions”.

Remarque Quand un client Lookout essaie de se connecter à un serveur DDE sur
une machine exploitant NT, son nom d’utilisateur et son mot de passe
valables pour la machine du serveur peuvent être demandés. Si c’est
ainsi, le mot de passe de l’utilisateur ne doit pas être NULL car la
connexion au serveur ne serait pas établie.
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15. Redondance
Lookout vous permet de configurer deux ordinateurs de contrôle du
processus pour la redondance afin d’assurer le transfert automatique des
fonctions de contrôle à l’ordinateur de réserve en cas de défaillance de
l’ordinateur principal.

Remarque Ce chapitre concerne les systèmes de mise en réseau de plusieurs
nœuds Lookout. Il ne couvre pas les systèmes autonomes. Lisez d’abord
les informations sur les fichiers de processus (.LKP ) et les fichiers d’état
(.LST ).

Vous pouvez établir la redondance informatique avec la fonction
standby (de réserve) de Lookout. Cette fonction se rapporte à une
configuration de réseau où un ordinateur est l’ordinateur principal et
l’autre l’ordinateur de réserve. En général, l’ordinateur principal
surveille et contrôle le processus tandis que l’ordinateur de réserve
surveille l’ordinateur principal. Si le nœud de réserve ne reçoit pas
d’impulsion du nœud principal pendant une durée déterminée,
l’ordinateur de réserve prend automatiquement le contrôle et joue le rôle
de machine principale. La figure suivante représente une structure de
réseau typique de Lookout avec l’option “standby” configurée.
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API

/RRNRXW /RRNRXW /RRNRXW

pri mar y.lkp net work.lkppri mar y.lkp
net work.lkp

Machine
principale

Machine de
réserve

Réseau local

Le matériel E/S peut
comprendre des API,
des téléterminaux, des
contrôleurs, ou tout
autre appareil avec
lequel Lookout
communique.

Les éléments de base de Standby
Vous devez comprendre trois principes fondamentaux non inclus dans le
diagramme. D’abord, les deux machines principales et de réserve
doivent accéder directement à vos E/S de terrain. Si la machine
principale échoue, vous ne pouvez pas compter sur elle dans votre
stratégie de secours. C’est pour cette raison que votre machine de
réserve doit accéder directement à toutes vos E/S, car elle prendra en
charge la machine principale. Il existe plusieurs manières d’obtenir ce
résultat, selon la topologie de vos communications, de votre matériel et
de votre réseau. N’hésitez pas à nous appeler si vous souhaitez des
suggestions.

Le second principe veut que vous puissiez choisir n’importe quel nœud
sur le réseau comme machine de réserve. Cette machine ne doit pas être
nécessairement l’ordinateur le plus proche physiquement sur le réseau ;
cependant, c’est souvent le cas en raison des contraintes établies par le
premier principe. Pendant les opérations normales (par exemple, pendant
que la machine principale fonctionne correctement), l’ordinateur de
réserve est identique aux autres nœuds sur le réseau. C’est-à-dire que
Lookout lance des fichiers de processus identiques sur tous les nœuds du
réseau (NETWORK.LKP dans cet exemple). Cependant, la machine de
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réserve doit également posséder une copie du fichier de processus de la
machine principale dans son répertoire Lookout (PRIMARY.LKP, dans
cet exemple). Quand la machine de réserve ne reçoit pas le signal
ordonnancé de surveillance de la machine principal, elle ferme
automatiquement le fichier de processus NETWORK.LKP et ouvre le
fichier PRIMARY.LKP. A cet instant, le nœud de réserve devient la
machine principale et est automatiquement reconnue comme telle par les
autres nœuds du Lookout.

Remarque Lors d’un échec (par exemple, quand l’ordinateur de réserve prend le
contrôle du processus), tous les liens Network DDE de Lookout entre les
autres ordinateurs et l’ordinateur principal sont automatiquement ré-
acheminés vers l’ordinateur de réserve.

Le troisième et dernier principe Standby ne demande pas de
configuration supplémentaire, mais il doit malgré tout être expliqué et
compris. Toute application autonome Lookout est chargée de la mise à
jour périodique de son propre fichier d’état. Cependant, avec la
configuration d’un système Standby, l’ordinateur principal met à jour
non seulement son propre fichier d’état mais aussi celui de l’ordinateur
de réserve. Ainsi, lors d’un échec, l’ordinateur de réserve prend le relais
exactement là où l’ordinateur principal s’est arrêté, ce qui assure le
transfert du contrôle en douceur.

Les scénarios d’échecs

L’ordinateur de réserve assume le contrôle du processus dans quatre
cas :

• La machine principale est à l’arrêt (par exemple, elle n’est pas
allumée, Windows pour Workgroups n’a pas démarré ou une faute
dans l’application a bloqué l’ordinateur).

• La machine principale est en marche mais n’a pas lancé Lookout.

• La machine principale a démarré Lookout mais n’a pas lancé le bon
fichier de processus.
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• La machine principale a démarré le bon fichier de processus dans
Lookout mais les deux machines ne peuvent pas communiquer sur le
réseau.

La fonction Standby a pour but de donner automatiquement la main au
second ordinateur. Elle ne revient pas automatiquement à son état
principal-de réserve une fois que les problèmes de réseau ou autres sont
corrigés. En fait, l’ordinateur de réserve REPASSE de l’état fichier de
processus Standby à l’état fichier de processus principal dès qu’il
constate que l’ordinateur principal fonctionne à nouveau. Cette
caractéristique est automatique. Cependant, l’utilisateur doit copier le
fichier d’état de l’ordinateur de réserve sur l’ordinateur principal avant
de relancer Lookout pour assurer un transfert en douceur.

Pour rétablir la configuration initiale du réseau Lookout (par exemple,
où la machine principale utilise son fichier PRIMARY.LKP et la
machine de réserve son fichier NETWORK.LKP file), effectuez d’abord
un transfert en douceur en recopiant le fichier d’état de la machine de
réserve sur la machine principale. Ceci doit se faire avant de redémarrer
la machine principale si vous souhaitez maintenir les paramètres
courants. Ensuite, ouvrez les bons fichiers .LKP  des deux ordinateurs.

La configuration de Standby
Suivez cette procédure générale pour établir la fonction Standby :

1. Définissez les paramètres réseau pour les deux ordinateurs.
Reportez-vous à La définition des paramètres réseau.

2. Vérifiez que l’ordinateur principal accède par réseau au répertoire
Lookout du disque dur de l’ordinateur de réserve. Reportez-vous à
L’activation du partage de fichiers.

 Vous devez activer le partage de fichiers pour que Lookout sur
l’ordinateur principal puisse mettre à jour le fichier d’état sur
l’ordinateur de réserve.
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3. Copiez le fichier de processus de l’ordinateur principal dans le
répertoire Lookout sur l’ordinateur de réserve (PRIMARY.LKP par
exemple).

4. Configurez les paramètres Standby de Lookout des deux ordinateurs.
Reportez-vous à la section intitulée La configuration des options
Standby.

Remarque Les procédures décrites dans ce document supposent que vous utilisez
Windows pour Workgroups, version 3.11. Si votre version de Windows
est différente, les procédures à suivre peuvent différer. Reportez-vous à
votre documentation Windows.

La définition des paramètres réseau

Pour les ordinateurs principal et de réserve :

1. Dans Microsoft Windows, sélectionnez l’icône
du panneau de configuration. Si vous utilisez
Windows 95, cliquez sur Démarrer, pointez vers
Paramètres et sélectionnez Panneau de
configuration.

2. Dans la fenêtre Panneau de configuration, sélectionnez l’icône du
réseau.

3. Dans la boîte de dialogue Réseau Microsoft Windows, affectez un
nom à l’ordinateur.

Panneau de configuration
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4. Vérifiez que les noms paramétrés dans Nom de l’ordinateur  pour
les ordinateurs principal et de réserve sont bien consécutifs. Affectez
à la machine principale le premier nom de la paire et à la machine de
réserve le second nom de la paire. Par exemple, “XXXA” et
“XXXB” ou “Système01” et “Système02.” Remarquez que les noms
sont identiques excepté le dernier caractère.

5. Vérifiez que les deux ordinateurs appartiennent au même
Workgroup .

6. Dans la boîte de dialogue Réseau Microsoft Windows, sélectionnez
Option au démarrage .

7. Dans la boîte de dialogue Paramètres de démarrage, vérifiez que la
case Activer réseau DDE  est bien cochée.

8. Sélectionnez OK pour accepter vos paramètres.

Si vous changez les paramètres, l’ordinateur vous demande de
redémarrer l’ordinateur.
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L’activation du partage de fichiers

1. Configurez l’ordinateur de réserve pour pouvoir partager des
fichiers :

a) Dans Microsoft Windows, sélectionnez
l’icône Installation de réseau.

b) Dans la boîte de dialogue Installation de
réseau, sélectionnez Partage.

c) Dans la boîte de dialogue Partage, vérifiez que la case
permettant l’accès aux fichiers par d’autres est bien cochée.

Si vous changez les paramètres, l’ordinateur vous demande de
relancer Windows.

2. Configurez l’ordinateur de réserve pour que le répertoire Lookout
sur son disque dur soit partagé avec l’ordinateur
principal :

a) Dans Microsoft Windows, sélectionnez
l’icône Gestionnaire de fichiers.

b) Dans la barre de menus de la fenêtre
Gestionnaire de fichiers, sélectionnez Disque→Partager sous...

Installation de réseau

Gestionnaire de fichiers
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c) Dans Chemin , entrez le nom de chemin du sous-répertoire
Lookout. Par exemple, entrez C:\LOOKOUT.

d) Dans Nom de partage , entrez le nom que vous souhaitez
affecter à ce répertoire. Affectez un nom simple, par exemple,
LOOKOUT.

e) Dans la boîte de dialogue Partager le répertoire (Share
Directory), vérifiez que la case activant Partager au démarrage
est bien cochée.

f) Dans la boîte de dialogue Partager le répertoire, vérifiez que la
case activant l’accès total est bien cochée et sélectionnez OK.

La configuration des options Standby

1. Sur l’ordinateur principal :

a) Dans la barre de menus Lookout, sélectionnez
Options→System… (Options→Système)

b) Dans la boîte de dialogue System Options, sélectionnez la case
Save state data every ___ minutes afin que Lookout
sauvegarde les données toutes les ___ minutes.

 Vous pouvez changer la fréquence selon vos besoins.
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c) Dans la boîte de dialogue System Options, sélectionnez le
bouton Standby…

 La boîte de dialogue Standby Options s’affiche.

d) Dans la boîte de dialogue Standby Options, sélectionnez
Primary computer  (ordinateur principal).

e) Dans le champ de données Save standby state in file
(sauvegarder l’état de réserve sur fichier), entrez le nom complet
du chemin où la copie du fichier d’état doit être sauvegardée sur
la machine de réserve. Les paramètres réseau du Workgroup ont
déjà été définis pour que le lecteur S:  de la machine principale
représente le lecteur C:  sur la machine de réserve.

 

f) Sélectionnez OK pour sauvegarder vos modifications.
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2. Sur l’ordinateur de réserve :

a) Dans Lookout, sélectionnez Options→System…

b) Dans la boîte de dialogue System Options, sélectionnez le
bouton Standby…

c) Dans la boîte de dialogue Standby Options, sélectionnez
Standby computer .

 

d) Dans le champ de données Load process file  (charger le fichier
de processus), entrez le nom complet du chemin où Lookout doit
automatiquement charger le fichier de processus en cas d’échec.

 Pour continuer, entrez C:\LOOKOUT\PRIMARY.LKP. Notez
que le nom du chemin est différent du chemin saisi à l’étape 1e.
Ceci du fait que vous êtes maintenant sur l’ordinateur de réserve
et référencez le disque dur local.

e) Dans le champ de données if no pulse from … (si pas de signal
de...), entrez la fréquence souhaitée de l’horloge de garde.
L’ordinateur de réserve chargera le fichier de processus précisé
et assumera le contrôle de votre processus s’il ne reçoit pas
d’impulsion de l’ordinateur principal pendant la période
déterminée.

f) Sélectionnez OK pour sauvegarder vos modifications.
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16. Commandes du menu Runtime
Ce chapitre décrit les commandes déroulantes de la barre de menus
Lookout disponibles en mode Normal (c’est-à-dire, pas en mode
Edition).

Commandes
déroulantes de

menu
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Chaque commande du menu comprend un niveau de sécurité
prédéterminé. Seuls les opérateurs qui détiennent un niveau de sécurité
égal ou supérieur à une commande particulière peuvent accéder à cette
commande du menu. Reportez-vous au chapitre 10 pour plus
d’informations sur la sécurité.

Les commandes du menu File

File→New…

Niveau de sécurité : 9
Touches de raccourci : CTRL+N

La commande File→New… (Fichier→Nouveau) est la première étape
dans la création d’un nouveau fichier de processus. Il est important de
savoir que la commande File→New… ne crée pas à elle seule un nouveau
fichier de processus. Vous devez utiliser la commande File→Save… ou
File→Save As… pour sauvegarder votre travail et créer un nouveau
fichier de processus.

File→Open…

Niveau de sécurité : 8
Touches de raccourci : CTRL+O

La commande File→Open… (Fichier→Ouvrir) vous permet d’ouvrir un
fichier de processus pour l’exploiter. Lookout ne peut exploiter qu’un
seul fichier de processus à la fois. Si un processus est déjà lancé,
Lookout vous demande si vous souhaitez arrêter le processus en cours
avant d’ouvrir un nouveau fichier de processus.

Quand vous sélectionnez File→Open…, une boîte de dialogue s’affiche
dans laquelle vous pouvez sélectionner le lecteur de disque dur ou le
répertoire en cours et parcourir une liste de fichiers de processus. Dès
que vous trouvez le fichier de processus que vous souhaitez ouvrir,
cliquez sur le nom du fichier dans la liste déroulante des fichiers ou
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tapez le nom du fichier et cliquez sur le bouton OK. Vous pouvez
également double-cliquer sur le nom du fichier dans la liste déroulante.

Si un fichier de processus est déjà ouvert quand vous sélectionnez un
nouveau fichier, une boîte d’avertissement s’affiche vous demandant si
vous souhaitez terminer le processus en cours. Le processus en cours
continue son exécution jusqu’à ce que votre réponse soit affirmative.

File→Close

Niveau de sécurité : 8
Touches de raccourci : aucune

La commande File→Close (Fichier→Fermer) arrête l’exécution du
fichier de processus qui est actuellement chargé. Si votre fichier de
processus a été modifié et que vous n’avez pas sauvegardé votre travail,
Lookout ne vous laisse pas fermer votre processus avant de l’avoir
sauvegardé.

Le processus continue jusqu’à ce que vous répondiez par l’affirmative
(Yes).
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Attention La commande File→Close arrête l’exécution du processus ; soyez
absolument certain de vouloir fermer avant de sélectionner cette
commande. Il se peut que votre application Lookout contrôle des
processus très importants et que son arrêt cause de graves problèmes.

File→Save

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande File→Save (Fichier→Enregistrer) sauvegarde sur disque
le processus en cours d’exécution. Lookout remplace l’ancien fichier de
processus sur disque par une nouvelle version qui reflète toutes les
modifications effectuées : objets nouveaux ou effacés, caractéristiques
d’affichage différentes, connexions d’E/S nouvelles ou modifiées,
réglages de consignes, etc. Ceci comprend également la sauvegarde des
modifications apportées aux fichiers .LKP , .LKS  et .LST  . Reportez-
vous au chapitre 3 pour plus d’informations sur ces fichiers.

Si vous créez un tout nouveau fichier de processus, la commande
File→Save invoque la boîte de dialogue Save Process File As… qui vous
demande des instructions pour nommer le fichier.
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File→Reopen

Niveau de sécurité : 8
Touches de raccourci : aucune

La commande File→Reopen recharge le processus en cours d’exécution
à partir du disque. Ceci efface toutes les alarmes de la fenêtre d’alarmes
; cependant, toutes les tendances et les consignes gardent leurs valeurs
précédentes.

e

File→Print →Alarms…
e

File→Print →Events…

Niveau de sécurité : 1
Touches de raccourci : aucune

Les commandes File→Print (Fichier→Imprimer) vous permettent
d’imprimer des rapports sur les alarmes et les événements. Quand vous
sélectionnez l’une de ces commandes, une boîte de dialogue s’affiche et
vous demande de spécifier la durée de l’impression. L’option Print
Range  vous permet de spécifier n’importe quelle durée conventionnelle
(en format de 24 heures). Observez que les boîtes de dialogue Alarm et
Event sont un peu différentes. Reportez-vous au chapitre 9 pour plus
d’informations sur l’impression des alarmes.
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File→Log on…

Niveau de sécurité : 1
Touches de raccourci : CTRL+L

La commande File→Log on… (Fichier→Ouvrir une session) vous permet
d’ouvrir une session Lookout en tant qu’opérateur/intégrateur actuel
avec votre nom d’utilisateur prédéfini et mot de passe bien que Lookout
n’exige pas toujours un mot de passe. Reportez-vous au chapitre 10 pour
plus d’informations sur la sécurité.

Une seule personne peut ouvrir une session à la fois. Vous pouvez
également initier cette commande en cliquant sur la case Account dans la
barre d’état en bas à gauche de l’écran, où le nom de l’utilisateur est
affiché.

File→Log  off

Niveau de sécurité : 1
Touches de raccourci : CTRL+L

La commande File→Log off (Fichier→Fermer la session) ferme
immédiatement la session de l’utilisateur en cours et ne laisse personne
(nobody) dans le système. Vous pouvez également initier cette
commande en cliquant sur la case Account en bas à gauche de l’écran,
où le nom de l’utilisateur est affiché. Quand la boîte de dialogue
Welcome to Lookout (Bienvenue dans Lookout) s’affiche, sélectionnez
le bouton Log Off. Reportez-vous au chapitre 10 pour plus
d’informations sur la sécurité.
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File→Password…

Niveau de sécurité : 1
Touches de raccourci : aucune

La commande File→Password… (Fichier→Mot de passe) autorise tout
utilisateur de Lookout à changer son mot de passe. Cette fonction permet
de changer facilement votre mot de passe selon les besoins. Lookout
vous permet également de connaître l’ancienneté d’un mot de passe.
Reportez-vous au chapitre 10 pour plus d’informations sur la sécurité.

File→Exit

Niveau de sécurité : 8
Touches de raccourci : aucune

La commande File→Exit (Fichier→Quitter) arrête le processus
d’exécution et sort de Lookout. Quand vous sélectionnez File→Exit,
Lookout donne l’occasion de sauvegarder le fichier de processus et vous
demande de vérifier que vous êtes absolument certain de vouloir arrêter
le processus en cours.

Attention La commande File→Exit arrête l’exécution du processus ; soyez
absolument certain de vouloir quitter avant de sélectionner cette
commande. Il se peut que votre application Lookout contrôle des
processus très importants et que son arrêt cause de graves problèmes.
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e  Les commandes du menu Edit

Edit →Edit Mode

Niveau de sécurité : 9
Touches de raccourci : CTRL+ESPACE

Les commandes du menu Edit (édition) ne sont disponibles que si
Lookout est en mode Edition. Vous pouvez utiliser le mode Edition pour
créer et/ou modifier un fichier de processus. Ceci se retrouve dans les
systèmes de développement de la concurrence. Notez que Lookout reste
en ligne, même en mode Edition ! Soyez très prudent quand vous
affectez des niveaux de sécurité 9 et 10 aux comptes du système car
toute personne bénéficiant de ces niveaux de sécurité peut accéder à
cette commande.

La barre de menus au-dessus de l’écran Lookout ajoute d’autres
commandes quand vous basculez en mode Edition. Utilisez ces
commandes pour la configuration du processus. Reportez-vous au
chapitre 17 pour plus d’informations sur les commandes du menu Edit.

Les commandes du menu Options

Options →System…

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Options→System… (Options→Système) sert à configurer
huit jeux de paramètres de fonctionnement dans le système. Le premier
paramètre, Startup Process File (fichier de processus au démarrage),
demande à Lookout de charger automatiquement un fichier de processus
prédéterminé chaque fois qu’il démarre. Cette commande, utilisée avec
la méthode décrite à la section Chargement automatique du processus au
chapitre 3, garantit que chaque fois que votre ordinateur est réinitialisé
ou que Windows redémarre, l’application appropriée est chargée. Vous
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pouvez également spécifier un panneau de contrôle particulier pour
l’agrandir au démarrage. Reportez-vous à la définition de l’objet Panel
(panneau) pour plus d’informations.

Le deuxième paramètre est l’option Log alarms to  (rapport des alarmes
sur) qui définit si les enregistrements d’alarmes doivent être envoyés à
l’imprimante à mesure qu’ils se produisent et à quel port. Les
enregistrements d’alarmes comprennent le déclenchement,
l’acquittement et la désactivation des alarmes. En général, réglez ce
paramètre sur None (aucun) et utilisez la commande
File→Print→Alarms… pour imprimer sur demande des rapports
personnalisés sur les alarmes.

Le troisième jeu de paramètres vous permet de définir les restrictions des
fenêtres selon le niveau de sécurité de l’utilisateur qui a ouvert la session
en cours. Reportez-vous au chapitre 10 pour plus d’informations sur la
sécurité.

Le quatrième paramètre sert à définir la fréquence de mise à jour du
fichier d’état de Lookout  (.LST ) . Le fichier d’état de Lookout
comprend des consignes et d’autres valeurs de données importantes qui
se trouvent dans les objets. Ce fichier est normalement actualisé quand
le fichier d’application Lookout est sauvegardé, fermé ou quitté.
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Cependant, le matériel sur lequel Lookout est installé peut être sensible
aux pannes de courant. Quand une panne de courant survient, Lookout,
comme tout autre logiciel, s’interrompt immédiatement. En pareille
circonstance, il ne peut pas actualiser le fichier d’état. Ce paramètre
demande que Lookout sauvegarde périodiquement les données sur le
fichier d’état. Lors du redémarrage, Lookout rétablit toutes les consignes
et autres valeurs de données importantes que le fichier d’état vient de
capturer.

Le cinquième jeu de paramètres, auquel vous accédez avec le bouton
Change Registration Info…, vous permet d’entrer les données du
registre, telles que votre code clef. Reportez-vous au chapitre 2 pour
plus d’informations sur le registre.

Le sixième jeu de paramètres, auquel vous accédez avec le bouton
Standby…, vous permet de configurer votre système pour la redondance
au niveau de l’ordinateur. Reportez-vous au chapitre 15 pour plus
d’informations sur la Redondance.

Le septième paramètre détermine le répertoire racine où Lookout
enregistre vos feuilles de calcul, la base de données historique Citadel,
les fichiers d’événements et les fichiers d’alarmes. Dans la figure, Data
files location  spécifie C:\DATA  comme répertoire racine dans lequel
commencent tous les enregistrements de données. Selon la technique
d’enregistrement établie, Lookout peut stocker des fichiers dans d’autres
sous-répertoires du répertoire racine précisé.

Le huitième paramètre est Time zone . Utilisez ce paramètre pour
vérifier que Lookout sauvegarde les données dans la base de données
historique Citadel avec des horodateurs internationaux (Greenwich).
Selon votre sélection, Lookout convertit automatiquement l’heure
internationale en heure locale quand il trace les tendances, afin que votre
base de données reflète la bonne heure locale toutes les fois que vous
l’utilisez. N’oubliez pas de sélectionner Daylight Savings Time  (heure
d’été) quand votre région passe aux heures d’été ou d’hiver.
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Options →Accounts…

Niveau de sécurité : 10
Touches de raccourci : aucune

La commande Options→Accounts… (Options→Comptes) vous permet
de créer, réviser et effacer les comptes utilisateur du système. Reportez-
vous au chapitre 10 pour plus d’informations sur les comptes.

Options →Modbus…

La commande Options→Modbus… n’apparaît que si un objet Modbus
existe dans le fichier de processus en cours d’exécution. Cette
commande affiche une boîte d’informations qui décrit les paramètres de
la version Modbus et fournit des données statistiques sur les
communications du protocole. Reportez-vous au chapitre 18 pour plus
d’informations sur la classe d’objets Modbus.

Options →Serial P orts …

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Options→ Serial Ports... (Options→Ports série) configure
la topologie de communications pour le port série de votre ordinateur.
Chaque port série peut avoir un paramètre unique : Hardwired, Dial up
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ou Radio. Reportez-vous au chapitre 6 pour plus d’informations sur les
communications en série.

Options →Import APT Database…

La commande Options→Import APT Database… (Options→Importer la
base de données APT) n’apparaît que si un objet Tiway existe dans le
fichier de processus en cours d’exécution. Sélectionnez cette commande
pour importer un fichier de variable APT et créer de nouvelles bases de
données membres pour l’objet Tiway sélectionné. Reportez-vous au
chapitre 5 pour plus d’informations sur les bases de données des objets
et au chapitre 18 pour plus d’informations sur la classe d’objets Tiway
et la base de données APT.
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Les commandes du menu Run

Run→Add…

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Run→Add… (Exécuter→Ajouter) ajoute jusqu’à dix
commandes du style DOS à la liste du sous-menu. Les opérateurs
appellent ces commandes en cliquant sur la souris sans quitter Lookout.
Par exemple, si vous souhaitez imprimer un rapport personnalisé sur
demande, chargez Excel et exécutez la commande macro DAILY.XLM ,
qui extrait les données historiques du lecteur de disque dur, les empile
dans un modèle de rapport préconfiguré et les envoie à l’imprimante.

Le paramètre Security Level  s’applique à la commande actuelle que
vous ajoutez ou révisez. Ainsi, vous pouvez configurer plusieurs
commandes dont seules quelques-unes peuvent être invoquées par des
opérateurs de haut niveau.
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Run→Revise…

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Run→Revise… (Exécuter→Modifier) modifie les
commandes d’exécution précédemment définies.

Run→Delete…

Niveau de sécurité : 9
Touches de raccourci : aucune

Run→Delete… (Exécuter→Supprimer) efface les commandes
d’exécution précédemment définies.
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Les commandes du menu Alarm

Alarms →Show

Niveau de sécurité : 1
Touches de raccourci : CTRL+A

La commande Alarms→Show (Alarmes→Afficher) affiche
immédiatement la fenêtre d’alarmes en style flottant si elle n’est pas déjà
affichée. Vous pouvez sélectionner cette commande quand vous
souhaitez trouver rapidement la fenêtre d’alarmes depuis n’importe quel
panneau de contrôle. Notez les touches de raccourci, CTRL+A. Vous
pouvez également afficher la fenêtre d’alarmes en cliquant sur la boîte
d’alarmes à l’extrême droite de la barre d’état en bas de l’écran.
Reportez-vous au chapitre 9 pour plus d’informations sur les alarmes.

Alarms →Display Options…

Niveau de sécurité : 1
Touches de raccourci : aucune

La commande Alarms→Display Options… (Alarmes→Afficher les
options) vous permet de changer le style d’affichage de la fenêtre
d’alarmes : Top (en haut), Bottom (en bas), Floating (flottante). Cette
commande vous permet également de modifier les formats d’affichage
des alarmes internes, c’est-à-dire la police de caractères, l’en-tête et
diverses autres informations sur l’alarme. Reportez-vous au chapitre 9
pour plus d’informations sur les alarmes.
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Alarms →Filter Options…

Niveau de sécurité : 2
Touches de raccourci : aucune

La commande Alarms→Filter Options… (Alarmes→Filtrer les options)
filtre les alarmes affichées dans la fenêtre d’alarmes par groupe, priorité
et occurrence. Reportez-vous au chapitre 9 pour plus d’informations sur
le filtrage des alarmes.
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e

Alarms →Print…

Niveau de sécurité : 1
Touches de raccourci : aucune

La commande Alarms→Print… (Alarmes→Imprimer) invoque une boîte
de dialogue qui vous permet de spécifier l’heure des alarmes que vous
souhaitez imprimer. Reportez-vous au chapitre 9 pour plus
d’informations sur l’impression des alarmes.

Alarms →Select A ll

Niveau de sécurité : 2
Touches de raccourci : aucune

La commande Alarms→Select All (Alarmes→Sélectionner tout) est un
raccourci qui sert à sélectionner toutes les alarmes visibles et non filtrées
à acquitter. Les alarmes qui ne sont pas visibles parce que filtrées ou
parce que la fenêtre d’alarmes est réduite ne sont pas sélectionnées. Ceci
est très utile si votre processus constate un nombre élevé d’alarmes. La
sélection individuelle de chaque alarme peut prendre beaucoup de temps.
Reportez-vous au chapitre 9 pour plus d’informations sur l’acquittement
des alarmes.
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Alarms →Deselect All

Niveau de sécurité : 2
Touches de raccourci : aucune

 (Alarmes→Désélectionner tout) Cette commande est un raccourci qui
sert à désélectionner toutes les alarmes qui sont actuellement
sélectionnées pour l’acquittement. Si vous souhaitez ne désélectionner
que certaines alarmes, cliquez sur la ligne de l’alarme en question.
Reportez-vous au chapitre 9 pour plus d’informations sur l’acquittement
des alarmes.

Alarms →Ack nowledge…

Niveau de sécurité : 2
Touches de raccourci : aucune

Les opérateurs sélectionnent la commande Alarms→Acknowledge…
(Alarmes→Acquitter) afin d’acquitter les alarmes sélectionnées pour
l’acquittement. Reportez-vous au chapitre 9 pour plus d’informations
sur l’acquittement des alarmes.

Les commandes du menu Window

Window →Arrange Icons

Window→Arrange Icons (Fenêtre→Réorganiser les icônes) dispose les
icônes du panneau de contrôle en colonnes et en rangées en bas de la
zone de travail Lookout. Lookout les dispose selon les paramètres
d’espacement établis dans le panneau de contrôle Windows.

Window →Minimize All

Window→Minimize All (Fenêtre→Réduire tout) réduit tous les panneaux
de contrôle et affiche leurs icônes en bas de la zone de travail Lookout.



Chapitre 16. Commandes du menu Runtime

289

Window →1 Panel1 Title

Les titres de tous les panneaux de contrôle apparaissent en bas du menu
Window. Vous pouvez trouver un panneau précis en cherchant son titre
dans la liste et en le sélectionnant. Lookout affiche le panneau dans la
zone de travail. Bien entendu, si le panneau n’est pas dans la partie
visible de la zone de travail, vous devrez parcourir la zone de travail
toute entière pour le trouver.

Window →More Windows…

Si vous avez trop de panneaux de contrôle pour le menu Window
(fenêtre), la commande More Windows (fenêtres supplémentaires)
apparaît en bas du menu Window. La commande Window→More
Windows affiche une boîte de dialogue déroulante qui vous permet de
parcourir les titres de panneaux de contrôle et de sélectionner celui que
vous souhaitez afficher en double-cliquant dessus.
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17.  Commandes du menu Edit Mode
e

Les commandes Edit Mode ne sont pas disponibles dans les
versions Runtime-Only de Lookout.

Le mode Edition vous permet de procéder à toute la configuration et aux
modifications du système. Pour basculer en mode Edition, sélectionnez
Edit→Edit Mode ou appuyez sur CTRL+ESPACE.

Quand vous basculez en mode Edition, Lookout ajoute quatre menus
déroulants à la barre de menus : Insert, Object, Arrange et Change. De
plus, il ajoute plusieurs commandes de sous-menus au menu déroulant
Edit. Ce chapitre décrit toutes les commandes accessibles en mode
Edition.

Remarque Lookout continue l’exécution du fichier de processus quand il est en
mode Edition. Depuis le début du développement d’un nouveau fichier de
processus, Lookout est en ligne et exécute la logique de contrôle que
vous avez configurée jusqu’à maintenant. Créez de nouveaux objets,
connexions ou expressions et Lookout les ajoute immédiatement à son
fichier de processus en cours d’exécution. Vu que Lookout reste toujours
en ligne, il n’est pas nécessaire de fermer le processus pour ajouter ou
effacer des contrôleurs, des points d’E/S ou pour modifier votre logique.

Avertissement Soyez très prudent quand vous affectez des niveaux de sécurité 9 et
10 aux noms d’utilisateurs. Ces deux niveaux de sécurité peuvent
accéder au mode Edition des fichiers de processus !
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Les commandes Edit

Edit →Undo

Niveau de sécurité : 9
Touches de raccourci : CTRL+Z

La commande Edit→Undo vous permet d’annuler les dix (10) dernières
modifications apportées au panneau de contrôle. Cependant, vous ne
pouvez pas annuler toutes les modifications. Vous ne pouvez annuler
que les modifications graphiques et non les modifications logiques ou les
objets sous-jacents. Par exemple, créez plusieurs objets et insérez-les
dans un panneau de contrôle. Ajoutez du texte et déplacez les objets sur
l’écran, effacez-les, changez la police de caractères et les couleurs, etc.,
avec la commande de menu Change. Lookout suit ces modifications
graphiques et les place dans une pile de dix éléments. Vous pouvez
ensuite sélectionner Edit→Undo et Lookout annule la modification la
plus récente. Sélectionnez Edit→Undo à nouveau et Lookout annule la
modification suivante, etc. Vous pouvez, entre autres, invoquer les
boîtes de dialogue de révision pour effacer toute la mémoire tampon de
Lookout. Ne soyez pas surpris si vous ne pouvez pas annuler une action
qui a eu lieu plusieurs étapes auparavant.

Edit →Cut

Niveau de sécurité : 9
Touches de raccourci : CTRL+X

La commande Edit→Cut enlève des éléments sélectionnés du panneau de
contrôle et les place dans le presse-papiers de Windows. Vous pouvez
recoller ces éléments sur le même panneau de contrôle ou sur un
panneau de contrôle différent.
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Edit →Copy

Niveau de sécurité : 9
Touches de raccourci : CTRL+C

La commande Edit→Copy copie des éléments sélectionnés du panneau
de contrôle dans le presse-papiers de Windows. Vous pouvez ensuite
coller ces éléments sur le même panneau de contrôle ou sur un panneau
de contrôle différent.

Edit →Paste

Niveau de sécurité : 9
Touches de raccourci : CTRL+V

La commande Edit→Paste récupère des informations coupées ou copiées
antérieurement du presse-papiers de Windows et les colle dans le
panneau de contrôle actif. Vous pouvez recoller plusieurs fois les mêmes
informations du presse-papiers jusqu’à la copie ou la coupe de nouveaux
éléments dans le presse-papiers.

Remarque Quand vous coupez ou copiez un élément dans un panneau de contrôle,
Lookout se souvient de sa position (coordonnée pixel X-Y) par rapport à
l’angle en haut à gauche du panneau de source. Quand vous collez
ensuite l’élément dans un autre panneau de contrôle, Lookout le colle à
cette position. Ainsi, quand vous collez un élément sur un panneau plus
petit, il peut ne pas être visible et peut être en dehors des dimensions du
panneau (à droite ou en dessous). Vous devez alors redimensionner le
panneau pour voir l’élément collé.

Edit →Delete

Niveau de sécurité : 9
Touches de raccourci : SUPPR

La commande Edit→Delete enlève la sélection courante d’un panneau de
contrôle. Cette commande est en gris si aucune sélection n’est faite.
Vous pouvez effacer des objets, des graphiques et des expressions ou
vous pouvez entourer de grands groupes d’éléments à effacer. Si vous
effacez un élément par erreur, sélectionnez la commande Edit→Undo et
l’élément effacé réapparaît sur le panneau de contrôle.
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Effacer un objet d’un panneau de contrôle n’efface que la représentation
graphique de cet objet et non l’objet en soi (reportez-vous à la
commande Object→Delete plus loin dans ce chapitre). Par exemple,
vous pouvez afficher sur un panneau de contrôle un compteur
d’impulsions dont le signal de sortie est relié à un autre objet. Si vous
effacez l’affichage du compteur de l’écran, l’objet compteur sous-jacent
continue de fonctionner à l’arrière-plan.

Edit →Select All

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Edit→Select All sélectionne toutes les entités affichées sur
le panneau de contrôle actif et les entoure.

Edit →Edit Mode

Niveau de sécurité : 9
Touches de raccourci : CTRL+ESPACE

Cette commande agit comme un interrupteur à bascule et vous permet de
basculer en mode Edition et d’en sortir. Lookout ne vous permet de
basculer que lorsqu’un fichier de processus est en cours d’exécution.
Quand Lookout est en mode Edition, la couleur de la barre d’état en bas
de la fenêtre Lookout passe du gris au jaune et la barre affiche des
informations différentes.
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Les commandes Insert

Insert →Displayable Object…

Niveau de sécurité : 9
Touches de raccourci : INSERER

La commande Insert→Displayable Object... invoque une liste déroulante
qui vous permet de sélectionner un objet existant pour l’afficher au
panneau de contrôle actif. Cette commande ne crée pas un objet
nouveau, elle insère simplement sur l’écran un élément d’affichage
représentant l’objet sélectionné.

Remarque  Quand vous cliquez sur le bouton OK, une seconde boîte de dialogue
apparaît immédiatement dans laquelle vous pouvez sélectionner les
caractéristiques de l’affichage de l’objet choisi. L’apparence de cette
boîte de dialogue dépend de la classe d’objets du nom de variable
sélectionné.
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Insert →Expression…

Niveau de sécurité : 9
Touches de raccourci : CTRL+E

La commande Insert→Expression... est une calculatrice flexible,
puissante et en temps réel. Elle crée, calcule et affiche le résultat de
formules au format tableur qui comprend un mélange de constantes et de
signaux des objets. Il existe plus de cinquante fonctions intégrées que
vous pouvez utiliser dans des expressions, dont les fonctions logiques,
mathématiques, statistiques, textuelles et trigonométriques. Reportez-
vous au chapitre 7 pour plus d’informations sur les expressions.

Insert →Text/Plate/Inset…

Niveau de sécurité : 9
Touches de raccourci : CTRL+T

Cette commande vous permet d’ajouter du texte et/ou des plaques
tridimensionnelles et des incrustations biseautées dans un panneau de
contrôle. Cette boîte de dialogue comprend deux fenêtres : une pour
entrer le texte souhaité (s’il existe) et une autre, plus grande, qui vous
permet de prévisualiser vos sélections courantes. La fenêtre de
prévisualisation vous montre les caractéristiques de l’affichage avant de
cliquer sur OK et d’insérer le texte, la plaque ou l’incrustation.
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Vous pouvez facilement créer des plaques et des incrustations en
sélectionnant l’option Background style appropriée sans entrer de texte.
Les plaques et les incrustations sont des outils qui servent à agencer le
panneau de contrôle. Elles sont particulièrement utiles pour grouper et
isoler des données. Prenez le temps de changer de polices de caractères,
de couleurs de texte, d’arrière-plan, etc. Lookout utilise cette
méthodologie dans plusieurs boîtes de dialogue.

Insert →Graphic…

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Insert→Graphic... affiche les fichiers graphiques
Windows Device-Independent Bitmap (.BMP) et Window Metafile
(.WMF) sur un panneau de contrôle. Cette boîte de dialogue liste tous les
bitmaps et les métafichiers qui se trouvent dans le sous-répertoire
GRAPHICS sous le répertoire racine LOOKOUT. Reportez-vous au
chapitre 8 pour plus d’informations sur les graphiques.
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Insert →Scale…

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Insert→Scale... invoque une boîte de dialogue qui sert à
créer votre propre échelle personnalisée en quelques secondes
seulement. Les échelles sont utiles avec les graphes à barres, les
glissières et les graphes de tendances.

Cliquez sur l’option Orientation  souhaitée et spécifiez les valeurs
Minimum  et Maximum  de l’échelle. L’option Major unit  spécifie le
nombre d’unités entre les coches les plus importantes. Seules les unités
importantes sont étiquetées. Vous pouvez enlever toutes les étiquettes de
votre échelle en désélectionnant la case Labels . L’option Minor unit
spécifie le nombre d’unités entre les coches les moins importantes. Vous
pouvez enlever les coches les moins importantes en désélectionnant la
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case Minor tick marks . Les options Color , Label format  et Label font
créent des effets spéciaux. Ci-dessous figurent quelques exemples
d’échelles.

Insert →Control Panel…

Niveau de sécurité : 9
Touches de raccourci : CTRL+P

Cette commande vous permet d’ajouter des panneaux de contrôle à votre
processus. Les panneaux de contrôle sont des objets et doivent avoir des
noms Tag uniques. Cependant, vous pouvez répéter l’option Title  d’un
panneau de contrôle toutes les fois que vous le souhaitez. Title  ne doit
pas nécessairement suivre toutes les règles strictes requises pour les
noms de variables. Reportez-vous au chapitre 18 pour plus
d’informations sur les objets Control Panel.
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Insert →Positions…

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Insert→Positions... indique à Lookout où
placer la prochaine insertion sur un panneau de
contrôle. La direction et la distance spécifiées par cette
boîte de dialogue sont relatives à l’élément
actuellement sélectionné sur le panneau de contrôle
actif.

L’exemple suivant démontre comment les paramètres de positionnement
fonctionnent en général.

Un graphe à barres est
sélectionné.

Le prochain élément est
inséré 10 pixels à la droite
de l’élément sélectionné.
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Les commandes Object

Object →Create…

Niveau de sécurité : 9
Touches de raccourci : CTRL+INSERER

La commande Object→Create... invoque la
boîte de dialogue Select Object Class. Cette
liste déroulante affiche toutes les classes
d’objets disponibles en ordre alphabétique.
Vous pouvez sélectionner une classe
d’objets avec la souris en cliquant sur le
bouton OK, ou en double-cliquant sur la
classe. Reportez-vous au chapitre 18 pour
plus d’informations sur les classes
d’objets.

Après la sélection d’une classe
d’objets, Lookout affiche une boîte
de dialogue qui vous permet de
définir les paramètres de cet objet.
Spécifiez les paramètres répondant à
vos besoins et cliquez sur OK.
Reportez-vous au chapitre 18 pour
plus d’informations sur les classes
d’objets.
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Quand vous cliquez sur le bouton OK, Lookout crée un nouvel objet
avec les connexions spécifiées, si elles existent. Lookout n’a pas besoin
d’afficher les objets sur un panneau de contrôle, car ils peuvent exister
“derrière le panneau”.
Cependant, certains objets vous
demandent immédiatement de
sélectionner les caractéristiques
d’affichage avant d’être insérés
dans un panneau de contrôle
(c’est le cas de l’objet
Pushbutton [bouton-poussoir]).

Si vous cliquez sur Cancel
(annuler), Lookout n’affiche pas
l’objet que vous venez de créer,
Reset_Pb, bien que l’objet existe toujours. Vous pouvez afficher
Reset_Pb  plus tard avec la commande Insert→Displayable Object...

Object →Modify…

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Object→Modify...
modifie tous les objets existants,
quelle que soit leur classe. Cette
commande invoque une boîte de
dialogue avec une liste alphabétique
de tous les noms de variables
existants.

Sélectionnez un nom de variable et
cliquez sur OK, ou double-cliquez sur
le nom.
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Une boîte de dialogue pour l’objet
identifié est affichée avec les paramètres
existants. Vous pouvez modifier l’objet
en changeant ses paramètres, ou même
son nom de variable. Reportez-vous à la
section intitulée Les raccourcis de
configuration, au chapitre 3, pour plus
d’informations sur la modification
d’objets.

Remarque Changer le nom de variable ne crée pas
un autre objet, ceci remplace simplement
le nom de variable courant par un
nouveau nom. De plus, tous les autres
objets “connectés” reflètent
immédiatement le nouveau nom de
variable.

Object →Delete…  

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Object→Delete...
sélectionne un objet précis d’une liste
alphabétique et l’efface. La boîte de
dialogue Select Object (sélectionner un
objet) apparaît, vous demandant de
choisir un nom de variable à effacer.

Si vous sélectionnez un objet employé
par un autre objet (un autre objet y est
connecté) ou qui est affiché sur un
panneau de contrôle, Lookout ne vous
permet pas de l’effacer et vous en avertit.
Vous devez d’abord effacer toutes les
références et l’affichage de l’objet à
effacer.



Partie 3. Référence

304

Supposons que l’on essaie d’effacer Reset_Pb , mais que le signal
logique du bouton-poussoir soit relié au paramètre Reset  de plusieurs
objets compteurs dans Lookout. Vu que les compteurs utilisent et
dépendent du signal émis par le bouton-poussoir, il faut d’abord modifier
les objets compteurs (effacer le signal du bouton-poussoir), puis effacer
le bouton-poussoir du panneau de contrôle avant d’effacer l’objet lui-
même.

Les objets ne sont pas les seuls éléments qui peuvent dépendre d’autres
objets. Les expressions qui utilisent le nom de variable d’un objet à
effacer engendrent également des problèmes de dépendance.

Remarque Si vous pensez avoir effacé toutes les dépendances d’un objet et que la
boîte d’avertissement est encore affichée, regardez le fichier source de
votre processus (.LKS  file). Vous pouvez ensuite exécuter une
commande de recherche avec l’éditeur de texte ou le traitement de texte
pour trouver toutes les occurrences du nom de variable à problème.

Object →Edit Connections…

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Object →Edit Connections… relie les signaux aux
données membres écrites d’un objet. En général, vous utilisez cette
commande pour connecter des signaux aux sorties des contrôleurs et
d’autres appareils sur site (API, téléterminaux, contrôleurs par boucle,
etc.). D’autres classes d’objets comme les Pot (potentiomètre) et les
Panel (panneau) utilisent également cette fonction. Reportez-vous au
chapitre 5 pour plus d’informations sur la connexion d’objets.
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Quand vous sélectionnez Object→Edit Connections… vous constaterez
que plusieurs noms de variables ne sont pas listés. Lookout n’affiche que
les objets qui acceptent des signaux et supprime le reste. Reportez-vous
au chapitre 5 pour plus d’informations.

Object →Edit Datab ase…

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Object→Edit Database… définit les paramètres de la base
de données membres d’un objet. Ces paramètres comprennent les
pseudonymes, les descriptions, les paramètres d’alarme, les paramètres
de mise à l’échelle, les paramètres d’enregistrement, etc. Cette
commande vous permet aussi d’importer et d’exporter des bases de
données. En général, vous utilisez cette commande avec les objets
DataTables (tableau de données) et Driver. Reportez-vous au chapitre 5
pour plus d’informations sur l’édition de la base de données.

Les commandes Arrange
Les commandes Arrange sont extrêmement utiles pour créer rapidement
des panneaux de contrôle d’apparence professionnelle. Apprenez et
maîtrisez ces fonctions et aptitudes, car elles facilitent l’élaboration de
vos écrans et améliorent leur apparence et leur emploi. Bien que ce
manuel explique la fonctionnalité de chaque commande, nous vous
conseillons de les pratiquer séparément pour mieux les maîtriser.



Partie 3. Référence

306

Arrange →Align

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Align dispose un groupe d’objets sélectionnés sur un
panneau de contrôle. Cette commande s’utilise souvent avec la
commande Arrange→Space Evenly. Sélectionnez ou entourez d’abord
les objets que vous souhaitez aligner. Ensuite, sélectionnez la commande
d’alignement appropriée (voir le tableau suivant).

Commande Description Touches de
raccourci

Left Aligne les symboles sélectionnés à
gauche du champ sélectionné

CTRL+GAUCHE

Right Aligne les symboles sélectionnés à
droite du champ sélectionné

CTRL+DROITE

Top Aligne les symboles sélectionnés au-
dessus du champ sélectionné

CTRL+HAUT

Bottom Aligne les symboles sélectionnés au-
dessous du champ sélectionné

CTRL+BAS

Vert. Center Aligne verticalement les symboles
sélectionnés par rapport au centre du
champ sélectionné

F9

Horiz. Center Aligne horizontalement les symboles
sélectionnés par rapport au centre du
champ sélectionné

MAJ+F9

Les exemples suivants démontrent comment les diverses commandes
d’alignement affectent un groupe d’objets.
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Remarque Au lieu d’entourer un groupe entier d’objets, vous pouvez sélectionner
plusieurs objets en maintenant enfoncée la touche MAJ tandis que vous
les sélectionnez séparément. Cette technique vous permet de sauter des
objets qui autrement seraient sélectionnés au sein du champ sélectionné.

Arrange →Space Evenly

Niveau de sécurité : 9

Cette commande est extrêmement utile quand vous souhaitez aligner et
espacer uniformément une série d’objets sur un panneau de contrôle.
Lookout espace uniformément les objets sélectionnés, par rapport au
centre du champ sélectionné dans le sens vertical ou horizontal. Cette
commande est souvent utilisée avec la commande Align.
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Commande Description Touches de
raccourci

Across Espace uniformément et
horizontalement les objets
sélectionnés, dans le champ
sélectionné

ALT+DROITE

Down Espace uniformément et
horizontalement les objets
sélectionnés, en bas du champ
sélectionné

ALT+BAS

Voici quelques utilisations de cette commande.

Arrange →Group

Niveau de sécurité : 9
Touches de raccourci : CTRL+G

La commande Arrange→Group combine les objets sélectionnés
séparément, y compris le texte, en un seul symbole. En général, cette
commande sert à combiner ou à grouper plusieurs objets associés pour
améliorer l’alignement. Vous pouvez aussi créer des sous-groupes (c’est-
à-dire, des groupes à l’intérieur d’autres grands groupes).
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Arrange →Ungroup

Niveau de sécurité : 9
Touches de raccourci : CTRL+U

La commande Arrange→Ungroup sépare les groupes sélectionnés en
divers éléments. Cette commande ne fonctionne qu’avec un groupe à la
fois. Ainsi, si vous avez des couches de sous-groupes, vous pouvez les
séparer couche par couche. Notez que si deux groupes séparés sont
sélectionnés dans un seul ensemble, la commande Arrange→Ungroup
n’est pas disponible.

Arrange →Move to F ront

Niveau de sécurité : 9
Touches de raccourci : CTRL+F

La commande Arrange→Move to Front dessine le(s) élément(s)
sélectionné(s) au-dessus de tous les autres et place tous les autres
éléments affichés à l’arrière-plan.

Arrange →Move to B ack

Niveau de sécurité : 9
Touches de raccourci : CTRL+B

La commande Arrange→Move to Back dessine le(s) élément(s)
sélectionné(s) derrière tous les autres éléments et rapproche tous les
autres éléments affichés au premier plan.
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Les fonctions de modification
Les fonctions de modification permettent de modifier l’apparence du
texte, des graphes à barres, des représentations numériques et à glissière
des objets Pot et des autres éléments d’affichage à l’écran. Cet outil est
efficace pour apporter rapidement des modifications globales à plusieurs
éléments en même temps (par exemple, modifier la couleur du texte pour
tous les éléments actuellement sélectionnés). C’est également la seule
façon de changer la couleur d’arrière-plan d’une glissière.

Change →Font…  

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Change→Font… invoque une boîte de dialogue qui
modifie la police de caractères de tous les éléments actuellement
sélectionnés.
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Change →Text Color…   

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Change→Text Color… invoque une boîte de dialogue qui
vous permet to modifier la couleur du texte de tous les éléments
actuellement sélectionnés. Cette commande affecte également la couleur
des barres (premier plan) des graphes à barres.

Change →Background Color…   

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Change→Background Color… invoque une boîte de
dialogue qui permet de modifier la couleur d’arrière-plan de tous les
éléments actuellement sélectionnés.
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Change →Numeric Format… ^tx2520  

Niveau de sécurité : 9
Touches de raccourci : aucune

La commande Change→Numeric Format… invoque une boîte de
dialogue qui permet de modifier le format numérique de tous les
éléments actuellement sélectionnés. Reportez-vous à la section intitulée
Les données membres numériques, au chapitre 5, pour plus
d’informations sur les formats numériques.

Change →Justify Text  

Niveau de sécurité : 9
Touches de raccourci : aucune

Les sous-commandes Change→Justify modifient l’alignement du texte
de tous les éléments textuels actuellement sélectionnés. Cette commande
s’applique également aux données affichées numériquement.

Commande Description Touches de
raccourci

Left Aligne le texte et les données
sélectionnés à gauche

aucune

Right Aligne le texte et les données
sélectionnés à droite

aucune

Center Centre le texte et les données
sélectionnés

aucune
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18. Définitions des classes
d’objets

Ce chapitre décrit les nombreuses classes d’objets de Lookout. Il liste les
définitions par ordre alphabétique. La syntaxe correcte des paramètres
d’entrée et toutes les données membres sont présentées pour chaque
classe d’objets. Une description de la fonctionnalité de chaque classe
d’objets est fournie, ainsi qu’un exemple d’utilisation.

Remarque Lookout vous aide à élaborer des affichages graphiques toutes les fois
que c’est possible. Notez que la plupart des classes d’objets supportent
des données membres implicites et/ou sont affichables. Immédiatement
après la création d’un objet qui supporte l’une de ces deux options,
Lookout invoque automatiquement une autre boîte de dialogue. Si l’objet
est affichable (Pots [potentiomètres], Switches [booléens] et Trends
[tendances], entre autres), la boîte de dialogue Display Parameter
appropriée s’affiche, vous demandant de sélectionner un type
d’affichage. Si l’objet n’est pas affichable mais qu’il supporte un signal
implicite (Counters [compteurs], LatchGates [portes à gachette] et
OneShots, entre autres), Lookout invoque automatiquement la boîte de
dialogue Insert Expression et colle le nom de variable approprié dans la
fenêtre. Vous pouvez ensuite cliquer sur OK pour afficher le résultat du
signal en tant qu’expression sur un panneau de contrôle.

Souvenez-vous que vous pouvez, à tout moment, choisir de ne pas
afficher un objet ou son signal en cliquant sur le bouton Cancel. Si vous
changez d’avis, vous pouvez afficher l’objet ou son signal via les
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commandes Insert→Displayable Object… ou Insert→Expression…,
respectivement.

Certaines classes d’objets ne comprennent pas d’affichage membre ou de
signal implicite mais ont plusieurs données membres. Dans ce cas,
Lookout n’invoque pas automatiquement une seconde boîte de dialogue.
Cependant, si vous souhaitez afficher le résultat de l’une des données
membres logiques ou numériques de l’objet sur un panneau de contrôle,
vous pouvez utiliser la commande Insert→Expression… et sélectionner
le nom de variable approprié ainsi que les données membres.

Reportez-vous au chapitre 5 pour plus d’informations sur la création
d’objets, la modification de leurs bases de données et leur connexion.

AB_PLC5
AB_SLC500

Les classes d’objets AB permettent à Lookout de communiquer avec la
famille de contrôleurs PLC d’Allen-Bradley.

Lookout peut communiquer avec un membre de la famille PLC-5 de la
manière suivante :

• Via une connexion directe Ethernet au port AUI de l’API.

• Via une connexion directe Data Highway Plus (DH+) avec le
module 1784-KT AB installé dans l’ordinateur.

• Via une connexion directe DH+ avec une carte d’interface de lien
direct 5136-SD S-S Technologies installée dans l’ordinateur.

• Via le port série de l’ordinateur et un module AB KF2 qui assure la
conversion série de DF1 en DH+.

• Via une connexion série DF1 au port de programmation de l’API.
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 Lookout peut communiquer avec un membre de la famille SLC-500 de la
façon suivante :

• Via le port série de l’ordinateur avec une carte AB 1747-KE qui
s’enfiche dans le châssis SLC et convertit DF1 en DH 485.

• Via le port série de l’ordinateur avec un module autonome
d’interface de communication 1770-KF3 qui convertit DF1 en
DH 485.

• Via une connexion série directe DF1 à un port de programmation
SLC 5/03 ou SLC 5/04.

• Via une connexion directe DH+ à un SLC 5/04 (avec un module AB
KT ou une carte S-S SD installé dans l’ordinateur).

 Des familles API et des moyens de communication supplémentaires
seront supportés très prochainement.

 

 Boîte de dialogue des paramètres de définition AB_SLC500 configurés pour des
communications en série
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 L’option PLC Address paramètre l’adresse du nœud du réseau API
selon sa configuration sur l’appareil physique. Même si des appareils
partagent une Interface  commune, ils ont besoin d’une adresse unique.
Quand vous utilisez le protocole DF1 (communications en série), les
adresses valables vont de 0 à 254 décimal. Quand vous utilisez DH+, les
adresses valables vont de 0 à 77 octal.

 PLC Model spécifie le type particulier de l’API ou du SLC que vous
représentez avec cet objet. L’option PLC Model que vous sélectionnez
détermine quelles sont les données membres natives qui forment l’objet.

 PollRate est une expression numérique qui détermine combien de fois
interroger l’appareil. Lookout interroge l’appareil à l’intervalle spécifié.
Normalement, ceci est une simple constante temporelle telle que 0:01
(une seconde). Reportez-vous à la section intitulée Les données membres
numériques, au chapitre 5, pour plus d’informations sur la saisie de
constantes temporelles.

 Poll est l’expression logique qui, quand elle passe de Faux à Vrai, fait
que Lookout interroge l’appareil. Ceci peut être une simple expression
comme le signal d’un bouton-poussoir ou un algorithme complexe.

 Communication alarm priority  détermine le niveau de priorité des
alarmes générées par l’objet AB.

 Retry attempts spécifie le nombre de fois consécutives que Lookout
essaie d’établir des communications avec un appareil quand il n’obtient
pas de réponse valable. Suite au nombre d’essais spécifiés par l’option
Retry attempts , l’objet génère une alarme et commence à exécuter
l’option Skip every n poll requests after comm failure (sauter des
interrogations toutes les n fois suite à un échec de communication). Une
fois que Lookout rétablit les communications, il interroge l’appareil
selon le cycle régulier défini par PollRate .

 Receive timeout  est la durée pendant laquelle Lookout attend la réponse
d’un appareil avant de renouveler la requête.
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 Interface identifie le type de matériel de communication que vous
utilisez. La sélection que vous faites ici détermine les paramètres de
protocole que vous devez spécifier. Les paragraphes suivants décrivent
les paramètres de protocoles spécifiques à l’interface.

 Les paramètres d’interface de port série

 La sélection Interface  KE/KF/Serial  permet la communication par
port série via une carte KE, un module KF3 ou un module KF2. Quand
vous utilisez le port série de votre ordinateur, Lookout utilise le
protocole duplex complet (égal à égal) DF1 d’Allen-Bradley. Le
diagramme précédent représente un AB_SLC500 configuré pour les
communications en série.

 Serial port spécifie quel port RS-232C l’objet utilise pour communiquer
avec un appareil physique.

 Data rate , Parity  et Error detection sont les paramètres du dispositif
matériel. Les classes d’objets AB supportent la détection d’erreurs par
BCC (vérification en bloc des caractères) et CRC (vérification cyclique
de la redondance). BCC fournit un niveau moyen de sécurité des
données et CRC un niveau supérieur. Sélectionnez les paramètres selon
la configuration de votre API ou SLC.

 Phone number  spécifie le numéro à composer si le paramètre du port
série présente une configuration Dial-up. Ce numéro ne s’applique qu’à
l’objet individuel. Reportez-vous à Options→Serial Ports pour plus
d’informations.

 Les paramètres d’interface DH+

Remarque  Quand vous configurez un élément AB_PLC5 ou AB_SLC500 pour DH+,
Lookout crée un fichier nommé ALLBRAD.INI . Ce fichier contient les
paramètres de configuration que vous entrez pour votre ou vos carte(s)
KT. Si vous pensez exécuter le fichier de processus sur Lookout Runtime
System, veillez à copier le fichier INI avec votre fichier de processus
(.LKP) sur la machine souhaitée.
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 Les sélections Interface  1784-KT  et S-S  5136-SD  permettent la
connexion directe de votre ordinateur au réseau DH+. Le diagramme
suivant représente un élément AB_PLC5 configuré pour les
communications DH+.

 
 Boîte de dialogue des paramètres de définition AB_PLC5 configurés pour des
communications DH+

Remarque  Si vous utilisez une carte SS, vous devez exécuter la version 1.05 ou
supérieure de KT Emulation Module (sdipds ).

 Card number  vous permet de sélectionner la carte d’interface de réseau
que l’API connectera si votre ordinateur comprend plusieurs cartes KT
ou S-S.

 Card DH+ node address  identifie l’adresse de la carte d’interface dans
le réseau DH+. Les adresses valables vont de 0 à 77 octal. L’adresse du
nœud de la carte doit être unique, c’est-à-dire qu’elle ne doit pas être la
même que celle d’un autre appareil sur le réseau DH+.
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 Memory address  spécifie l’adresse de l’emplacement de base de la
mémoire de la carte d’interface sélectionnée. Votre sélection doit
correspondre aux paramètres sur la carte. Si vous utilisez plusieurs cartes
d’interface, vérifiez que chaque carte a une adresse unique.

 Les cartes d’interfaces de réseau utilisent une mémoire à double accès.
Si vous utilisez un gestionnaire de mémoire comme EMM386, il est
important d’ajouter une déclaration d’exclusion de mémoire au fichier
CONFIG.SYS de votre ordinateur. Le tableau de la page suivante liste
les adresses de mémoire de base et les exclusions correspondantes.

 Certaines cartes d’interface, comme la carte 1784-KT, comprennent des
résistances de terminaison de réseau intégrées. Si vous utilisez cette
carte et si votre ordinateur est le dernier nœud sur le réseau, cochez la
case Enable link termination resistor .

 La case Card exists in this computer  vous permet d’établir si Lookout
doit ou non chercher la carte d’interface dans l’ordinateur. Vérifiez que
cette case est bien cochée avant d’interroger vos API. Quand vous
cochez cette case et sélectionnez OK, Lookout initialise la carte, active
l’auto-test et charge son logiciel Driver. Puis, l’interrogation commence.

 Ne cochez pas la case Card exists in this computer  (son paramètre par
défaut) si la carte n’est pas dans votre ordinateur ou si vous ne souhaitez
pas interroger des API reliés à la carte.

Avertissement  Quand la case Card exists in this computer  n’est pas cochée, les
communications via cette carte d’interface avec tous les API et les SLC
qui y sont connectés sont désactivées.
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 Adresse
mémoire

 AB 1784-KT
exclut

 *SS 5136-SD
exclut

 
 Remarques

 A000  A300-A400  A000-A3FF  

 A400  A700-A800  A400-A4FF  Souvent utilisés par les drivers
VGA

 A800  AB00-AC00  A000-ABFF  A utiliser quand aucune autre
option n’est disponible

 AC00  AF00-B000  AC00-AFFF  

 B000  B300-B400  B000-B3FF  

 B400  B700-B800  B400-B4FF  Souvent utilisés par les drivers
MDA et CGA

 B800  BB00-BC00  B000-BBFF  A utiliser si l’option Dxxx n’est
pas disponible

 BC00  BF00-C000  BC00-BFFF  

 C000  C300-C400  C000-C3FF  

 C400  C700-C800  C400-C4FF  Souvent utilisés par le BIOS

 C800  CB00-CC00  C000-CBFF  A utiliser si l’option Dxxx n’est
pas disponible

 CC00  CF00-D000  CC00-CFFF  

 D000  D300-D400  D000-D3FF  

 D400  D700-D800  D400-D4FF  Normalement disponibles

 D800  DB00-DC00  D000-DBFF  Essayez d’utiliser ceux-ci
d’abord

 DC00  DF00-E000  DC00-DFFF  

 *Les exclusions de mémoire 5136-SD recommandées ci-dessus se basent sur un
mapping de 16K de mémoire. Vu que vous utilisez la carte SS pour émuler la
carte KT, l’utilisation de l’accès mémoire de 32K ne présente aucun avantage.

 IRQ (all cards)  vous permet d’identifier le paramètre d’interruption de
toutes les cartes d’interface DH+ installées dans l’ordinateur. Cette
sélection doit correspondre aux paramètres IRQ sur toutes les cartes
d’interface.

 Les performances générales d’un ordinateur sont quelque peu améliorées
quand vous affectez une interruption à la ou aux carte(s) d’interface.
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Toutes les fois qu’une des cartes reçoit une entrée, elle génère une
interruption reconnue par Lookout.

Avertissement Vérifiez qu’aucun autre driver ou carte n’est mappé à l’adresse mémoire
sélectionnée ou utilise la même interruption.

 Les paramètres d’interface Ethernet

 La sélection Interface Ethernet  permet la communication directe
entre votre ordinateur et un API via un réseau standard Ethernet. Le
diagramme suivant représente un élément AB_PLC5 configuré pour les
communications Ethernet.

 
 Boîte de dialogue des paramètres de définition AB_PLC5 configurés pour des
communications Ethernet

 IP address  spécifie l’adresse du protocole Internet de l’API. Une
adresse de protocole Internet comprend quatre chiffres, séparés par des
points. Chaque chiffre s’étend de zéro à 255 décimal. Une adresse
Internet typique peut donc être 128.7.9.231. Vérifiez que l’adresse IP
address  que vous entrez correspond à l’adresse du protocole Internet de
l’API que votre objet représente.
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 Les données membres

 Chaque objet AB contient un grand nombre de données. Tous les
membres écrits et lus (entrées/sorties) sont conditionnés avec l’objet.
Ainsi, dès que vous créez un objet AB, vous accédez immédiatement à
toutes les données membres de cet objet.

Remarque  Les classes d’objets AB génèrent automatiquement un schéma efficace
de lecture-écriture bloquante en se basant sur les entrées et les sorties
que vous utilisez dans votre fichier de processus. Vous ne devez pas
forcément construire votre propre table bloquante d’E/S. Cependant,
vous pouvez optimiser le rendement en disposant les données de votre
API en groupes adjacents.

 Données membres de la classe d’objets AB_SLC500
 Le tableau suivant liste les données membres supportées par la classe
d’objets AB_SLC500 :

 Données membres de la classe d’objets AB_SLC500

 Donnée membre  Type  Lecture  Ecriture  Description

 B:0 - B255:255  Numérique  Oui  Oui  Mot signé binaire 16 bits s’étendant de
-32 768 à +32 768

 B:0_0-B255:255_15  Logique  Oui  Oui  Un bit dans un mot binaire 16 bits

 B_0 - B255_4095  Logique  Oui  Oui  Un bit dans un fichier de données
précis. Par exemple, B3_32 spécifie le
fichier de données 3, mot 2, bit 1

 C:0.ACC -
C255:255.ACC

 Numérique  Oui  Oui  Valeur accumulée par compteur. Mot
signé de deux octets s’étendant de
-32 768 à +32 768

 C:0.PRE -
C255:255.PRE

 Numérique  Oui  Oui  Valeur compteur préétablie. Mot signé
de deux octets s’étendant de -32 768
à +32 768

 C:0_CD -
C255:255_CD

 Logique  Oui  Oui  Bit de validation compteur
décrémental

 C:0_CU -
C255:255_CU

 Logique  Oui  Oui  Bit de validation compteur incrémental

 C:0_DN -
C:255:255_DN

 Logique  Oui  Oui  Bit de fin de comptage
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 Données membres de la classe d’objets AB_SLC500 (suite)

 Donnée membre  Type  Lecture  Ecriture  Description

 C:0_OV -
C255:255_OV

 Logique  Oui  Oui  Bit de débordement du compteur

 C:0_UA -
C255:255_UA

 Logique  Oui  Oui  Bit d’accumulation de mise à jour du
compteur (HSC dans le contrôleur fixé
uniquement)

 C:0_UN -
C255:255_UN

 Logique  Oui  Oui  Bit de dépassement négatif du
compteur

 CommFail  Logique  Oui  Non  Signal généré par l’objet activé si,
pour quelque raison que ce soit,
Lookout ne peut pas communiquer
avec le SLC

 F:0-F255:255  Numérique  Oui  Oui  Valeur à virgule flottante
 I:1 - I:30  Numérique  Oui  Oui  Valeur d’entrée non signée 16 bits

s’étendant de 0 à 65 535
 I:1_0 - I:30_15  Logique  Oui  Oui  Un bit dans un mot d’entrée 16 bits
 N:0 - N255:255  Numérique  Oui  Oui  Valeur entière signée 16 bits

s’étendant de -32 768 à +32 768
 N:0_0 -
N255:255_15

 Logique  Oui  Oui  Un bit dans un mot entier signé 16 bits

 O:1 - O:30  Numérique  Oui  Oui  Valeur de sortie non signée 16 bits
s’étendant de 0 à 65 535

 O:1_0 - O:30_15  Logique  Oui  Oui  Un bit dans un mot de sortie 16 bits
 Poll  Logique  Non  Oui  Quand il passe de Faux à Vrai, l’objet

Lookout interroge l’appareil SLC
 PollRate  Numérique  No  Oui  Spécifie à quelle fréquence l’objet

Lookout interroge l’appareil SLC
 R:0.LEN -
R255:255.LEN

 Numérique  Oui  Oui  Entier signé de contrôle “durée”
s’étendant de -32 768 à 32 768

 R:0.POS -
R255:255.POS

 Numérique  Oui  Oui  Entier signé de contrôle “position”
s’étendant de -32 768 à 32 768

 R:0_DN -
R255:255_DN

 Logique  Oui  Oui  Indicateur logique de contrôle
“achevé” de bit unique

 R:0_EM -
R255:255_EM

 Logique  Oui  Oui  Indicateur logique de contrôle “vide”
de bit unique
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 Données membres de la classe d’objets AB_SLC500 (suite)

 Donnée membre  Type  Lecture  Ecriture  Description

 R:0_EN -
R255:255_EN

 Logique  Oui  Oui  Indicateur logique de contrôle “activer”
de bit unique

 R:0_ER -
R255:255.ER

 Logique  Oui  Oui  Indicateur logique de contrôle “erreur”
de bit unique

 R:0_EU -
R255:255_EU

 Logique  Oui  Oui  Indicateur logique de contrôle “activer
le déchargement” de bit unique

 R:0_FD -
R255:255_FD

 Logique  Oui  Oui  Indicateur logique de contrôle “trouvé”
de bit unique

 R:0_IN -
R255:255.IN

 Logique  Oui  Oui  Indicateur logique de contrôle drapeau
“invalider la comparaison” de bit
unique

 R:0_UL -
R255:255_UL

 Logique  Oui  Oui  Indicateur logique de contrôle
“décharger” de bit unique

 S:0 - S:96  Numérique  Oui  Oui  Fichier d’état SLC comprenant un
nombre entier signé s’étendant de -32
768 à 32 768 (reportez-vous à la
documentation d’Allen-Bradley)

 S:0_0 - S:96_15  Logique  Oui  Oui  Bits d’état du SLC Individuel (reportez-
vous à la documentation d’Allen-
Bradley)

 T:0.ACC -
T255:255.ACC

 Numérique  Oui  Oui  Valeur accumulée d’horloge
s’étendant de -32 768 à +32 768

 T:0.PRE -
T255:255.PRE

 Numérique  Oui  Oui  Valeur préétablie d’horloge s’étendant
de -32 768 à +32 768

 T:0_DN -
T255:255_DN

 Logique  Oui  Oui  Indicateur logique d’horloge “achevée”
de bit unique

 T:0_EN -
T255:255_EN

 Logique  Oui  Oui  Indicateur logique d’horloge “activée”
de bit unique

 T:0_TT -
T255:255_TT

 Logique  Oui  Oui  Indicateur logique d’horloge
“chronomètre” de bit unique

 Update  Logique  Oui  No  Signal généré par l’objet qui produit
une impulsion chaque fois que l’objet
interroge l’appareil
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 Données membres de la classe d’objets AB_PLC5
 Le tableau suivant liste les données membres supportées par la classe
d’objets AB_PLC5 :

 Données membres de la classe d’objets AB_PLC5

 Donnée membre  Type  Lecture  Ecriture  Description

 B:0 - B999:999  Numérique  Oui  Oui  Mot signé binaire 16 bits s’étendant
de -32 768 à +32 768

 B:0_0-B999:999_15  Logique  Oui  Oui  Un bit dans un mot binaire 16 bits

 B_0 - B999_15999  Logique  Oui  Oui  Un bit dans un fichier de données
précis. Par exemple, B3_32 spécifie
le fichier de données 3, mot 2, bit 1

 C:0.ACC -
C999:999.ACC

 Numérique  Oui  Oui  Valeur accumulée par compteur.
Mot signé de deux octets s’étendant
de -32 768 à +32 768

 C:0.PRE -
C999:999.PRE

 Numérique  Oui  Oui  Valeur compteur préétablie. Mot
signé de deux octets s’étendant de
-32 768 à +32 768

 C:0_CD -
C999:999_CD

 Logique  Oui  Oui  Bit de validation du compteur
décrémental

 C:0_CU -
C999:999_CU

 Logique  Oui  Oui  Bit de validation du compteur
incrémental

 C:0_DN -
C:999:999_DN

 Logique  Oui  Oui  Bit de fin de comptage

 C:0_OV -
C999:999_OV

 Logique  Oui  Oui  Bit de débordement du compteur

 C:0_UA -
C999:999_UA

 Logique  Oui  Oui  Bit d’accumulation du compteur
(HSC dans le contrôleur fixé
uniquement)

 C:0_UN -
C999:999_UN

 Logique  Oui  Oui  Bit de débordement négatif du
compteur

 CommFail  Logique  Oui  Non  Signal généré par l’objet activé si,
pour quelque raison que ce soit,
Lookout ne peut pas communiquer
avec l’API

 F:0-F999:999  Numérique  Oui  Oui  Valeur à virgule flottante
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 Données membres de la classe d’objets AB_PLC5 (suite)

 Donnée membre  Type  Lecture  Ecriture  Description

 I:0 - I:277  Numérique  Oui  Oui  Valeur d’entrée non signée 16 bits
s’étendant de 0 à to 65 535

 I:0_0 - I:277_17  Logique  Oui  Oui  Un bit dans un mot d’entrée 16 bits
(octal)

 N:0 - N999:999  Numérique  Oui  Oui  Valeur entière signée 16 bits
s’étendant de -32 768 à +32 768

 N:0_0 -
N999:999_15

 Logique  Oui  Oui  Un bit dans un mot entier signé
16 bits

 O:0 - O:277  Numérique  Oui  Oui  Valeur de sortie non signée 16 bits
s’étendant de 0 à 65 535

 O:0_0 - O:277_17  Logique  Oui  Oui  Un bit dans un mot de sortie 16 bits
(octal)

 Poll  Logique  Non  Oui  Quand il passe de Faux à Vrai, l’objet
Lookout interroge l’appareil API

 PollRate  Numérique  Non  Oui  Spécifie à quelle fréquence l’objet
Lookout interroge l’appareil API

 R:0.LEN -
R999:999.LEN

 Numérique  Oui  Oui  Entier signé de contrôle “durée”
s’étendant de -32 768 à 32 768

 R:0.POS -
R999:999.POS

 Numérique  Oui  Oui  Entier signé de contrôle “position”
s’étendant de -32 768 à 32 768

 R:0_DN -
R999:999_DN

 Logique  Oui  Oui  Indicateur logique de contrôle
“achevé” de bit unique

 R:0_EM -
R999:999_EM

 Logique  Oui  Oui  Indicateur logique de contrôle “vide”
de bit unique

 R:0_EN -
R999:999_EN

 Logique  Oui  Oui  Indicateur logique de contrôle
“activer” de bit unique

 R:0_ER -
R999:999.ER

 Logique  Oui  Oui  Indicateur logique de contrôle
“erreur” de bit unique

 R:0_EU -
R999:999_EU

 Logique  Oui  Oui  Indicateur logique de contrôle “activer
le déchargement” de bit unique

 R:0_FD -
R999:999_FD

 Logique  Oui  Oui  Indicateur logique de contrôle
“trouvé” de bit unique
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 Données membres de la classe d’objets AB_PLC5 (suite)

 Donnée membre  Type  Lecture  Ecriture  Description

 R:0_IN -
R999:999.IN

 Logique  Oui  Oui  Indicateur logique de contrôle
drapeau “invalider la comparaison”
de bit unique

 R:0_UL -
R999:999_UL

 Logique  Oui  Oui  Indicateur logique de contrôle
“décharger” de bit unique

 S:0 - S:127  Numérique  Oui  Oui  Fichier d’état API comprenant un
nombre entier signé s’étendant de
-32 768 à 32 768 (reportez-vous à la
documentation d’Allen-Bradley)

 S:0_0 - S:127_15  Logique  Oui  Oui  Bits d’état de l’API Individuel
(reportez-vous à la documentation
d’Allen-Bradley)

 T:0.ACC -
T999:999.ACC

 Numérique  Oui  Oui  Valeur accumulée d’horloge
s’étendant de -32 768 à +32 768

 T:0.PRE -
T999:999.PRE

 Numérique  Oui  Oui  Valeur préétablie d’horloge
s’étendant de -32 768 à +32 768

 T:0_DN -
T999:999_DN

 Logique  Oui  Oui  Indicateur logique d’horloge
“achevée” de bit unique

 T:0_EN -
T999:999_EN

 Logique  Oui  Oui  Indicateur logique d’horloge
“activée” de bit unique

 T:0_TT -
T999:999_TT

 Logique  Oui  Oui  Indicateur logique d’horloge
“chronomètre” de bit unique

 Update  Logique  Oui  Non  Signal généré par l’objet qui produit
une impulsion chaque fois que
l’objet interroge l’appareil API



Partie 3. Référence

328

  Les messages d’erreurs

 Les classes d’objets AB communiquent les états des commandes émises
aux appareils AB. Quand Lookout reçoit une réponse d’un appareil AB,
il lit l’octet d’état (STS) et, si nécessaire, l’octet d’état étendu (EXT
STS) pour vérifier que l’appareil exécute correctement la commande de
Lookout. Si la commande n’est pas correctement exécutée, Lookout
communique cet échec sous forme d’alarme en précisant le code d’état et
sa signification. Voyez l’exemple ci-dessous :

 EXT STS = 0F: not enough levels in address

 (EXT STS = 0F : pas assez de niveaux dans l’adresse)

 Les classes d’objets AB peuvent également générer des alarmes en
interne. La liste suivante présente les alarmes AB générées par Lookout,
leurs descriptions et les réponses possibles.

 5136-SD card must be loaded with sdipds KT emulation module
 (La carte 5136SD doit être chargée avec le module d’émulation sdipds KT)

 La carte Sutherland-Schultz 5136-SD n’est pas configurée pour émuler
une carte KT. Vous devrez peut-être installer le module du logiciel
sdipds  (version 1.05 ou supérieure). Pour charger ce module, entrez
une commande comme “SDINST IPDS\SDIPDS  250  D400 5 16K
int_en ” dans votre fichier AUTOEXEC.BAT. Reportez-vous au Guide
d’utilisateur de SS-Technologies pour en savoir plus sur le contenu et la
syntaxe exacts de la commande.

 KT card dual-ported memory test failed at location xxxx
 (Echec au test de mémoire à double accès de la carte KT à l’emplacement xxxx)

 La carte d’interface a échoué au test de mémoire au démarrage. Le test
de mémoire lit, écrit et relit la mémoire à double accès pour assurer
l’accès de la carte à la mémoire. Vérifiez que la carte est bien configurée
pour l’adresse de mémoire que vous avez spécifiée. Vérifiez que votre
gestionnaire de mémoire (par exemple, EMM386) exclut la portion de
mémoire appropriée. Vérifiez aussi que votre carte n’essaie pas d’utiliser
le même emplacement de mémoire qu’une autre carte. Vous devrez peut-
être réinitialiser la carte en invoquant la boîte de dialogue de définition
de l’objet AB et en sélectionnant OK. Si cette solution ne résout pas le
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problème, réinitialisez l’ordinateur. Parmi les autres raisons possibles,
citons les conflits de mémoire, une carte d’interface défectueuse ou un
driver capricieux.

 KT card CTC test failed with status code xx
 (Echec au test CTC de la carte KT avec le code d’état xx)

 La carte d’interface a échoué au test Counter Timer Circuit au
démarrage. Ce test vérifie la bonne fonctionnalité des modes
compteur/timer de la carte sur tous les canaux CTC. Vous devrez peut-
être réinitialiser, réinstaller ou remplacer la carte d’interface.

 KT card failed with status code xx while loading protocol (or timed out)
 (Echec de la carte KT avec le code d’état xx lors du chargement du protocole
[ou délai d’arrêt])

 Lookout n’a pas pu envoyer un fichier chargeur à la carte ni charger le
logiciel du protocole de la carte. Essayez de redémarrer la carte
d’interface en invoquant la boîte de dialogue de définition de l’objet AB
et en sélectionnant OK. Si cette solution ne résout pas le problème,
réinitialisez l’ordinateur.

 KT card is no longer responding
 (La carte KT ne répond plus)

 L’objet AB de Lookout n’a pas perçu d’impulsion de la carte d’interface
depuis une seconde. Normalement, la carte génère une impulsion chaque
fois qu’elle reçoit le jeton du réseau DH+. Si l’alarme n’est pas
désactivée dans les 30 secondes qui suivent, essayez de redémarrer la
carte d’interface en invoquant la boîte de dialogue de définition de
l’objet AB et en sélectionnant OK. Si cette solution ne résout pas le
problème, réinitialisez l’ordinateur.

 KT card’s memory address conflicts with card n
 (L’adresse mémoire de la carte KT est en conflit avec la carte n)

 Lookout a trouvé une autre carte d’interface ayant la même adresse
mémoire. Vérifiez que l’adresse mémoire sur chaque carte d’interface
est différente et que l’option Memory Address dans l’objet Lookout
correspond à l’adresse de la carte.
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 KT card not present in this computer
 (La carte KT ne figure pas dans cet ordinateur)

 La case Card exists in this computer  n’est pas cochée (le paramètre par
défaut). Sélectionnez Object→Modify pour extraire la boîte de dialogue
des paramètres de définition de l’API et cochez la case Card exists in
this computer , puis sélectionnez OK pour initialiser la carte.

 KT card RAM test failed with status code xx (or timed out)
 (Echec au test RAM de la carte KT avec le code xx [ou délai d’arrêt])

 La carte d’interface a échoué au test de mémoire au démarrage. Le test
de mémoire écrit un modèle sur la RAM intégrée et lit son contenu pour
vérifier le bon fonctionnement de la mémoire de la carte. Vous devrez
peut-être réinitialiser, réinstaller ou remplacer la carte.

 KT card signature test failed
 (Echec au test de signature de la carte KT)

 L’objet AB ne reconnaît pas la carte. Vérifiez que la carte d’interface est
actuellement installée dans l’ordinateur et que vous avez spécifié la
bonne adresse mémoire dans Lookout. Vous devrez peut-être réinstaller
la carte ou la réparer. Vérifiez également que vous n’avez pas identifié
plus de cartes dans l’option Card Numbers  que les cartes physiques.

 KT card SI0 test failed with status code xx
 (Echec au test SIO de la carte KT avec le code d’état xx)

 La carte d’interface a échoué au test Serial Input Output au démarrage.
Vous devrez peut-être réinitialiser, réinstaller ou remplacer la carte
d’interface.
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 NACK response received
 (Réponse NACK reçue)

 L’objet AB a reçu une réponse NACK (pas d’acquittement) quand il a
interrogé l’appareil. L’appareil a reçu une commande de Lookout mais
n’a pas accepté le message. La commande que l’appareil a reçue peut
être incomplète ou contenir des anomalies occasionnées par un mauvais
fonctionnement du réseau. Si votre port série est configuré pour radio,
vous devrez peut-être ajuster le paramètre RTS delay off . Pensez
également à augmenter le nombre spécifié de Retry attempts .

 No response -- no ACK for our transmission
 (Pas de réponse – pas d’ACK pour notre transmission)

 Lookout n’obtient aucune réponse de l’appareil. Les causes peuvent être
nombreuses et variées. Vérifiez d’abord que les paramètres Data rate ,
Parity  et Error detection de l’objet sont les mêmes que les paramètres
sur l’appareil. Vérifiez ensuite que vous utilisez le paramètre approprié
Serial port sur votre ordinateur et que le module d’interface de
l’appareil et d’autre équipement du réseau sont bien connectés et
fonctionnent correctement. Si vous utilisez un modem, vérifiez que les
paramètres Phone number  de votre objet et les paramètres Dial-up du
port série sont corrects. Cette erreur peut être également occasionnée par
du bruit de bas niveau, ou des reflets sur le bus informatique, ou par un
circuit marginal sur une carte.

 No response within timeout period
 No response received after receiving ENQ
 (Pas de réponse dans un délai d’arrêt)
(Pas de réponse reçue après avoir reçu une ENQ)

 L’objet AB a reçu de l’appareil l’acquittement de son interrogation.
L’appareil a accepté la commande de Lookout. Cependant, l’appareil ne
semble pas renvoyer sa réponse. Vous devrez peut-être augmenter les
paramètres de Receive timeout  pour vérifier que Lookout alloue
suffisamment de temps à la réception du message.
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 Response message garbled -- bad CRC or bad BCC
 Response message garbled -- no DLE EXT
 Response message garbled -- bad DLE follower
 (Message de réponse embrouillé -- CRC ou BCC mauvais) (Message de réponse
embrouillé – pas de DLE EXT) (Message de réponse embrouillé – mauvaise
suite au DLE)

 L’objet AB reçoit des messages de l’appareil, mais il se peut que ces
messages échouent au test d’intégrité des données sélectionnées.
Vérifiez que le paramètre Error detection de l’objet est le même que les
paramètres de l’appareil. Une autre raison peut être que la dernière partie
du message a été coupée avant qu’il ne se termine. Vous devrez peut-être
augmenter les paramètres Receive gap  du port série pour vérifier que
Lookout reçoit le message en entier. Si votre port série est configuré
pour radio, il se peut qu’une des raisons soit un bruit à la fin d’une
transmission radio. Vous devrez peut-être ajuster les paramètres RTS
delay off  ou CTS timeout . Pensez également à augmenter le nombre
d’essais dans Retry attempts .

 KT card failed to find resources
 KT card receive mailbox is in an invalid state
 KT card send mailbox is in an invalid state
 Unexpected data response length
 Unexpected response
 (La carte KT n’a pas trouvé les ressources) (La boîte à lettres de réception de la
carte KT est en état non valable) (La boîte à lettres de transmission de la carte
KT est en état non valable) (Durée inattendue de la réponse de données)
(Réponse inattendue)

 Il est fort probable que vous ne verrez jamais ces alarmes. Si malgré tout
vous les rencontrez, appelez le support technique de National
Instruments.
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 Accumulator
 L’objet Accumulator (accumulateur) est un totalisateur. Il échantillonne
l’option Input numérique chaque fois que la valeur Sample  passe d'Off
(désactivé) à On (activé) et ajoute chaque nouvel échantillon au montant
précédent. Il remet à zéro cette valeur totale quand Reset passe d'Off à On.

 

 Boîte de dialogue des paramètres de définition Accumulator

 Input est une expression numérique tandis que Sample  et Reset sont des
expressions logiques.

 Le schéma HyperTrend suivant représente la relation entre Input ,
Sample  et Reset .
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  Remarque  La classe d’objets Accumulator (accumulateur) n’a pas de boîte de 

dialogue pour les paramètres d’affichage. Cependant, vous pouvez 
facilement afficher le résultat de son signal de sortie en l’invoquant 
dans une expression.

 Données membres d’Accumulator

 Données
membres

 Type  Lecture  Ecriture  Description

 (implicites)  Numérique  Oui  Non  Valeur totale actuelle, accumulée depuis le
plus récent signal Reset. Mise à jour au taux
défini par Sample.

   Commentaires Reset peut être un intervalle d’impulsions régulières créé par une 
horloge Pulse, comme indiqué dans la boîte de dialogue à la page 
précédente.

 La classe d’objets Counter (compteur) accumule le nombre 
d’événements logiques et la classe d’objets Integral accumule les 
taux. Utilisez Accumulator pour additionner toutes les variables 
numériques.

 

  Objets associés  Average (moyenne), Minimum, Maximum, Sample (échantillon)

 

 Echantillon

 Remise à
zéro

 Sortie

 Entrée
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 AdvantechPCL
 La classe d’objets AdvantechPCL permet à Lookout de communiquer
avec la carte Advantech PC-MultiLab, modèle PCL-711B. La carte
MultiLab s’installe dans votre ordinateur et fournit une sortie
analogique, huit entrées analogiques, 16 entrées numériques et 16 sorties
numériques.

 

 Boîte de dialogue des paramètres de définition AdvantechPCL

 Card I/O port address indique l’adresse du port de base d’E/S que vous
avez sélectionnée avec le réglage des interrupteurs DIP sur la carte. La
carte Advantech utilise 16 emplacements consécutifs d’adresse de port
d’E/S dans votre ordinateur. Donc, si vous précisez une adresse de base
220 (hex), la carte utilise les adresses 220 à 22F. Les adresses de base
valables s’étendent de 000 à 3F0. Si votre ordinateur n’a pas de carte
Advantech installée, sélectionnez no  card .

Remarque Les ports d’E/S spécifient à l’unité centrale l’emplacement des
composants système de base comme les ports série, les cartes vidéo et
les contrôleurs de disque. Reportez-vous aux manuels qui
accompagnent le matériel et aux configurations des cartes
complémentaires pour être sûr que vous affectez une adresse unique de
port d’E/S à la carte Advantech.

 Scanning interval est un paramètre numérique qui détermine combien
de fois Lookout scrute la carte pour vérifier quelles valeurs ont été
modifiées. Les intervalles valables s’étendent de 10 à 1000
millisecondes.
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 AI gain spécifie les gains d’amplification de l’entrée de tous les signaux
d’entrées analogiques (AI0 - AI7). Pour la meilleure résolution possible,
amplifiez les signaux d’entrée pour que la plage maximale de tension
soit égale à la plage maximale d’entrée. Le tableau suivant liste les
réglages recommandés.

 Si la plage maximale de la
tension est …

 utilisez AI gain…

 ± 5V  1

 ± 2,5V  2X

 ± 1,25V  4X

 ± 0,625V  8X

 ± 0,3125V  16X

 Communication alarm priority  détermine le niveau de priorité des
alarmes générées par la classe d’objets AdvantechPCL.
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 Le tableau suivant liste les données membres supportées par la classe
d’objets AdvantechPCL :

 Données membres de la classe d’objets AdvantechPCL

 Donnée membre  Type  Lecture  Ecriture  Description

 AI0 - AI7  Analogique  Oui  Non  Entrée analogique où AI0 représente
A/D 0 (broche 1 sur CN1) et AI7
représente A/D 7 (broche 15 sur CN1).
Chaque entrée est un nombre entier de
12 bits, s’étendant de 0 à 4095

 AO0  Analogique  Non  Oui  Sortie analogique où AO0 représente
D/A (broche 17 sur CN1). Cette sortie
est un nombre entier de 12 bits,
s’étendant de 0 à 4095 (+5V ou +10V,
selon le cavalier JP1)

 CommFail  Logique  Oui  Non  Signal généré par l’objet qui est activé
si, pour quelque raison que ce soit,
Lookout ne peut pas communiquer
avec la carte

 DI0 - DI15  Logique  Oui  Non  Entrée numérique où DI0 représente la
broche 1 et DI15 représente la broche
16 sur CN4. Rend Faux quand un
signal surveillé est ouvert (>2,0V), et
Vrai quand le signal est court-circuité
(<0,8V)

 DO0 - DO15  Logique  Non  Oui  Sortie numérique où DO0 représente la
broche 1 et DO15 représente la broche
16 sur CN3

 Update  Logique  Oui  Non  Signal généré par l’objet qui produit
une impulsion chaque fois qu’il scrute
l’appareil
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 Alarm
 La classe d’objets Alarm (alarme) est une classe flexible et puissante qui
vous permet de créer diverses alarmes provoquées par des valeurs
logiques et numériques et qui sont affichées dans la fenêtre d’alarmes.

Remarque Lisez d’abord le chapitre 9 sur le système d’alarmes de Lookout pour
élaborer le mieux possible le système d’alarmes le plus efficace pour
votre application.

 

 Paramètres typiques pour une alarme de style logique

 Il existe deux types d’alarmes de base : logique et numérique. Quand
vous sélectionnez Logical alarm , Lookout vous demande d’entrer une
expression logique dans le champ Condition . Il utilise ensuite la
Condition  logique pour déclencher et réenclencher l’alarme. Si la
Condition  de l’alarme est Vrai, l’alarme est activée et si la condition est
Faux, l’alarme est désactivée. Vous pouvez également connecter un
fichier son Wave à des alarmes logiques séparées. Reportez-vous à
Playwave dans ce chapitre pour plus d’informations.
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 Quand vous sélectionnez l’alarme Numeric , le nom du champ Condition
devient Signal . Le système vous demande d’entrer une expression
numérique dans le champ qui établit la consigne de vos seuils d’alarme.
Hi-Hi , Hi, Lo  et Lo-Lo  sont des expressions numériques. Rate of change
génère une alarme quand le signal change selon la quantité spécifiée
pour la durée entre deux impulsions Sample . Le paramètre Unit time
détermine les unités de temps pour le taux de changement.

 

 Paramètres typiques pour une alarme de style numérique

 Groupe d’alarmes spécifie le nom du groupe associé à l’objet Alarm
(alarme). Tous les groupes déjà définis apparaissent dans la liste
déroulante et peuvent être sélectionnés avec la souris.

 Priority s’étend de 1 à 10 où 10 est la priorité la plus élevée et la plus
importante.

 Message est une expression textuelle dont le résultat est affiché dans la
fenêtre d’alarmes quand cet objet génère une alarme. Si le style d’alarme
est numérique, le déclenchement pertinent de l’alarme précède votre
message (par exemple, niveau HiHi : “Alarm message”). Reportez-vous
au chapitre sur les alarmes pour plus d’informations.
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 Données membres Alarm

 Donnée
membre

 
Type

 
Lecture

 
Ecriture

 
Description

 active  Logique  Oui  Non  Résultat de l’état d’une alarme logique. Vrai si
l’alarme est active et Faux si l’alarme est inactive

 hi  Logique  Oui  Non  Résultat de l’état des données membres Hi (haut)
de l’alarme numérique

 hihi  Logique  Oui  Non  Résultat de l’état des données membres Hihi
(haut-haut) de l’alarme numérique

 lo  Logique  Oui  Non  Résultat de l’état des données membres Lo (bas)
de l’alarme numérique

 lolo  Logique  Oui  Non  Résultat de l’état des données membres Lolo
(bas-bas) de l’alarme numérique

 rate  Logique  Oui  Non  Résultat de l’état des données membres Rate
(taux) de l’alarme numérique

Commentaire Une condition d’alarme courante survient quand une valeur mesurée sort
de la plage acceptable. Par exemple, un réservoir dont le niveau est trop
bas ou trop haut peut générer plusieurs alarmes :

Hihi: Tank level is out of range
(Haut-haut : Le niveau du réservoir a dépassé ses limites)

ou

Lo: Tank level is out of range
(Bas : Le niveau du réservoir a dépassé ses limites).

Si vous utilisez le style numérique d’alarme pour déclencher l’alarme et
si le niveau du réservoir fluctue ou “oscille” autour des paramètres
établis pour le seuil de l’alarme, un nouvel enregistrement d’alarme est
généré dans la fenêtre d’alarme chaque fois que le niveau du réservoir
est juste au-dessus ou au-dessous des paramètres de seuil établis. Pour
résoudre cette difficulté, utilisez un objet Neutralzone (hystérésis) pour
filtrer les légères fluctuations du réservoir.
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Remarque Comme expliqué aux chapitres 5 et 9, les alarmes peuvent également
être définies via le paramétrage des données membres d’un objet. C’est
très souvent la méthode la plus efficace pour définir et créer des
conditions d’alarme. Pour plus d’informations, reportez-vous à la section
du chapitre 9 intitulée Les alarmes générées par la base de données, et
à la section du chapitre 5 intitulée L’édition des bases de données
d’objets.

 $Alarm
 $Alarm est une classe d’objets globaux. Elle représente des données
globales comme le nombre d’alarmes actuellement activées (ce chiffre
n’est pas membre d’un objet particulier). A la différence des autres
classes d’objets, où vous pouvez créer plusieurs objets de même classe,
vous ne pouvez pas créer ou effacer plusieurs objets $Alarm. Il n’y a
qu’un seul objet dans cette classe. Son nom de variable est $Alarm (par
souci de simplicité).

 Utilisez les données membres $Alarm de la même façon que les données
membres d’autres objets : quand vous insérez une expression, vous
pouvez afficher le nombre d’alarmes activées dans un groupe précis. Ou
encore, si vous connectez un bouton-poussoir à des données membres
d’acquittement, acquittez les alarmes avec un bouton-poussoir.

 Supposons que vous souhaitiez créer un bouton-poussoir qui acquitte
toutes les alarmes. Créez un objet Pushbutton (bouton-poussoir), puis
utilisez la commande Object→Edit Connections… et connectez le
bouton-poussoir (Pb1) aux données membres.ack  de $Alarm. Cette
connexion est représentée en page suivante.
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 Boîte de dialogue Edit Connections

 La simple expression(Pb1) acquitte toutes les alarmes activées chaque
fois que le bouton-poussoir est enfoncé. Elaborez des connexions
similaires pour acquitter des groupes d’alarmes séparés.

 Les utilisateurs définissent les nouveaux groupes d’alarmes via les objets
Alarm (alarme) et en modifiant les paramètres de la base de données de
l’objet. A mesure que vous créez un nouveau groupe d’alarmes, Lookout
ajoute de nouvelles données membres écrites et lisibles à l’objet $Alarm.
Les données membres $Alarm sont décrites dans le tableau suivant.
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 Données membres $Alarm

 Donnée membre  Type  Lecture  Ecriture  Description

 ack  Logique  Non  Oui  Quand elle passe de Faux à Vrai,
acquitte toutes les alarmes

 Active  Numérique  Oui  Non  Nombre total d’alarmes
actuellement activées  (c’est-à-
dire, conditions d’alarme qui
existent encore)

 ActivatePanel  Logique  Non  Oui  Invoque la fenêtre d’alarmes quand
elle passe de Faux à Vrai, et
l’affiche à l’écran

 Groupname.active  Numérique  Oui  Non  Nombre d’alarmes actuellement
activées au sein du groupe spécifié

 Groupname.unacked  Numérique  Oui  Non  Nombre d’alarmes non acquittées
au sein du groupe spécifié

 Groupname.ack  Logique  Non  Oui  Quand elle passe de Faux à Vrai,
acquitte toutes les alarmes au sein
du groupe spécifié

 MinimizePanel  Logique  Non  Oui  Ferme la fenêtre d’alarmes quand
elle passe de Faux à Vrai et se
transforme en icône

 Priority01.active -
Priority10.active

 Numérique  Oui  Non  Nombre d’alarmes actuellement
activées de la priorité spécifiée

 Priority01.unacked -
Priority10.unacked

 Numérique  Oui  Non  Nombre d’alarmes non acquittées
de la priorité spécifiée

 Unacked  Numérique  Oui  Non  Nombre total d’alarmes non
acquittées (c’est-à-dire, des
conditions d’alarme non
acquittées)

Commentaires La valeur Groupname du tableau précédent représente le nom de tout
groupe d’alarmes spécifié. L’objet $Alarm contient des données
membres .active , .unacked  et .ack  pour chaque groupe
d’alarmes.
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 Animator
 La classe d’objets Animator (animateur) fournit une animation
graphique complète avec mouvement horizontal et vertical,
redimensionnement et visibilité dynamiques et séquencement dynamique
des symboles.

 

 Le fichier graphique que vous sélectionnez détermine les images qui
vont figurer à l’écran. Vous profilez les images en divisant le fichier
graphique en une grille de rows  et columns . L’exemple ci-dessus
représente une colonne unique de 48  pixels Wide et des rangées de 28
pixels High chacune. Bien que la grille puisse contenir jusqu’à 32,000
cellules, une disposition de 100 cellules est plus pratique.

 Chaque cellule de la grille est une image cinématographique. Au niveau
interne, l’objet Animator affecte un numéro de cellule à chaque image.
Normalement, il “passe” le film en défilant de gauche à droite et du haut
en bas, depuis le numéro de cellule le plus bas jusqu’au numéro de
cellule le plus haut.
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 La sélection Rate (cellules/sec)  vous permet de spécifier la vitesse de
l’objet Animator à mesure qu’il passe d’une image de cellule à la
suivante. La valeur de ce débit peut être positive ou négative et peut
s’étendre de 0,0000005  (une trame tous les 23 148 jours) à 100
trames par seconde.

 Si la valeur du débit est négative, Animator passe le film en sens inverse,
en commençant par la dernière cellule. Un effet que se réservent les
profs très branchés qui souhaitent exhiber une famille qui mange à
l’envers !

 La sélection Cell  dans la boîte de dialogue de définition vous permet de
préciser un numéro de cellule particulier à afficher. Utilisez cette
sélection, par exemple, pour afficher une image précise quand un
registre API est égal à une certaine valeur.

 Les paramètres X et Y spécifient les positions horizontale et verticale
respectives de l’image. Ces paramètres numériques s’étendent de 0 à
100 et fournissent tous la position X-Y de l’image en tant que
pourcentage de la dimension de l’objet Animator sur un panneau de
contrôle.

 Size est un paramètre numérique qui s’étend de 0 à 100  pour cent, où
100  pour cent est la taille maximale d’une cellule selon la spécification
W et H.

 Visible est un paramètre logique qui fait apparaître l’image quand elle
passe à Vrai et la fait disparaître quand elle passe à Faux.

 Les paramètres Transparent pixel  vous permettent de spécifier les
pixels du graphique qui seront transparents dans Lookout. Quand vous
entrez une paire de coordonnées X et Y, le pixel correspondant devient
transparent, ainsi que tous les autres pixels de la même couleur. 0,0  est
le pixel situé en haut à gauche du graphique.
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 Données membres Animator

 Donnée membre  Type  Lecture  Ecriture  Description

 aucune     Les objets Animator n’ont pas de
données membres

Commentaires  Pensez à utiliser un objet Integral au lieu d’une combinaison
Counter/Pulse quand vous souhaitez obtenir une animation de qualité.

Objets associés Multistate (multi-états), Pipe (tuyau), Gauge (jauge), Spinner (disque
rotatif), DialGauge (cadran jauge)

 Average
 L’objet Average (moyenne) calcule activement la valeur moyenne de
Data sur une période de temps. L’objet Average n’est actif que si
l’expression Enable est Vrai et se remet à zéro quand l’expression Reset
passe d'Off à On. Cet objet maintient également un éventail de 35
valeurs dont les moyennes ont déjà été établies. Si le champ Enable est
vide, l’objet calcule toujours la moyenne activement.

 

 Boîte de dialogue des paramètres de définition Average

 Data est une expression numérique tandis que Reset et Enable sont des
expressions logiques.

Remarque L’objet Average n’a pas de boîte de dialogue pour les paramètres
d’affichage. Cependant, vous pouvez facilement afficher le résultat de
son signal de sortie en l’invoquant dans une expression.
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 Données membres Average

 Donnée
membre

 Type  Lecture  Ecriture  Description

 (implicite)  Numérique  Oui  Non  Moyenne actuelle calculée depuis le signal
Reset le plus récent. Mise à jour une fois
par seconde à peu près

 1 - 35  Numérique  Oui  Non  Valeurs moyennes précédentes. Signal 1
est la moyenne la plus récente depuis que
le signal Reset a atteint un haut niveau

 DataReset  Logique  Non  Oui  Quand elle passe de Faux à Vrai, remet à
zéro toutes les données membres, y
compris la moyenne actuelle et toutes les
moyennes précédentes

Commentaires L’expression Reset peut être un intervalle régulier d’impulsion créé par
une horloge TimeOfxxxx, de façon à ce que l’impulsion soit
synchronisée avec le début de l’heure ou du jour. Si vous souhaitez par
exemple calculer la vitesse quotidienne du débit, utilisez le signal de
sortie d’une horloge TimeOfDay ou un objet Spreadsheet (feuille de
calcul) quotidien pour remettre à zéro le calcul de la moyenne en début
de journée. Si vous souhaitez calculer le débit moyen seulement quand la
pompe est en marche, utilisez le signal d’entrée du relais du moteur de la
pompe dans le paramètre Enable .

Objets associés Minimum, Maximum, Sample (échantillon)
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 Counter
 L’objet Counter (compteur) compte le nombre de fois que l’expression
Count passe d'Off à On. L’affichage numérique indique le nombre
d’impulsions comptées et se met à jour environ une fois par seconde. Le
compteur peut cependant recevoir et compter plusieurs impulsions au
cours d’une seconde. Ainsi, il peut compter jusqu’à près de
4 503 600 000 000 000 d’impulsions ou les impulsions émises pendant
142 710 années à la vitesse d’une impulsion par seconde. Quand
l’expression Reset passe d'Off à On, le compteur se remet à zéro.

 

 Boîte de dialogue des paramètres de définition Counter

 Count et Reset sont des expressions logiques.

Remarque L’objet Counter n’a pas de boîte de dialogue pour les paramètres
d’affichage. Cependant, vous pouvez facilement afficher le résultat de
son signal de sortie en l’invoquant dans une expression.

 Données membres Counter

 Donnée
membre

 Type  Lecture  Ecriture  Description

 (implicite)  Numérique  Oui  Non  Total numérique du nombre
d’impulsions

Commentaires N’utilisez pas les objets Counter pour compter des signaux d’impulsions
externes dont le cycle dépasse une fois par seconde. Pour des taux plus
élevés, utilisez les fonctions de l’accumulateur intégrées dans votre API.

Objets associés Accumulator (accumulateur), Integral
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 DataTable
 Les objets DataTable (tableau de données) sont utilisés dans les
applications suivantes :

• Multiplexe plusieurs sources de données en un modèle d’affichage
unique.

• Importation et exportation de grandes quantités de données à
d’autres applications via DDE. (Cette fonction est identique à
DdeTable excepté que cette fonction fournit des communications
DDE bidirectionnelles. Reportez-vous à DdeTable.)

• Mise en réseau de plusieurs nœuds de Lookout (reportez-vous au
chapitre 14).

 Un objet DataTable (tableau de données) contient une matrice de
rangées et de colonnes, comme une feuille de calcul. Chaque colonne est
représentée par une lettre (A-IV) et chaque rangée est représentée par un
chiffre (1-1000). Les combinaisons de lettres et de chiffres représentent
les intersections des rangées et des colonnes et sont appelées des
cellules. Toute cellule comprend une valeur. La valeur d’une cellule peut
être numérique, logique ou textuelle.

Remarque Les objets DataTable sont des outils avancés qui demandent des
connaissances approfondies en bases de données d’objets Lookout.
Familiarisez-vous d’abord avec l’édition, les connexions et l’utilisation des
bases de données d’objets avant de créer un objet DataTable. Reportez-
vous au chapitre 5 pour plus d’informations sur les bases de données
d’objets.
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 La boîte de dialogue suivante apparaît quand vous créez un objet
DataTable (tableau de données) :

 

 Spécifiez les paramètres DDE si vous souhaitez utiliser DataTable pour
importer de grandes quantités de données d’une source externe. Les
sources externes typiques comprennent d’autres DataTable dans une
application Lookout mise en réseau ou un éventail de données de feuille
de calcul. Reportez-vous au chapitre 14 pour plus d’informations sur la
gestion de réseau.

 Spécifiez Local si vous utilisez DataTable pour exporter de grandes
quantités de données de Lookout. Spécifiez également Local si vous
utilisez DataTable pour multiplexer plusieurs signaux en un seul
affichage ou modèle graphique.

 Multiplexer des affichages et des graphiques

 Vous pouvez utiliser DataTable pour multiplexer des signaux en un seul
panneau de contrôle, ou “modèle”. Supposons que vous avez neuf
stations de pompes identiques et qu’un seul API par site surveille la
pression, le débit et l’état de deux pompes. Vous contrôlez une sortie
analogique avec une consigne d’opérateur depuis Lookout. Au lieu de
développer neuf panneaux de contrôle identiques dans Lookout, vous
élaborez un panneau seulement et multiplexez les signaux des neuf sites
en un jeu unique de graphiques.
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Remarque Les exercices suivants servent à expliquer le fonctionnement de
DataTable (tableau de données). Nous supposons donc que vous
comprenez déjà le fonctionnement d’éléments tels que les pseudonymes
et la connexion de signaux aux bases de données d’objets et qu’il n’est
pas nécessaire de les expliquer ici.

 La figure suivante est une représentation graphique d’un objet DataTable
montrant les connexions existantes. Notez les noms de variables des neuf
API (PLC1,  PLC2...), les rangées auxquelles les signaux sont connectés
et les pseudonymes donnés à leurs entrées (press,  flow,  pmp1,
pmp2). La colonne A est connectée à la valeur textuelle appropriée de
chaque cellule. Un objet unique Pot (potentiomètre) nommé Setpoint
est connecté à la colonne D et non aux cellules individuelles. De cette
façon, Lookout change la valeur d’une cellule de la colonne D seulement
quand le curseur se trouve dans cette rangée. Les cellules individuelles
de la colonne D (D1 à D9) sont connectées aux bons registres de
stockage (sorties) sur leurs API respectifs. Par exemple, Table1.D1
est connecté aux données membres appropriées de PLC1 ; Table1.D2
est connecté aux données membres appropriées de PLC2, etc.

Remarque Connectez les entrées de l’API ou du téléterminal aux cellules
individuelles et les consignes d’opérateurs (sorties) aux colonnes.

 

 

 
Représentation graphique d’un DataTable avec les connexions

Consigne
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 DataTable (nommé Table1 ) est terminé et vous pouvez commencer à
construire un panneau de contrôle unique qui permet de multiplexer les
données des neuf sites. C’est très simple : au lieu d’utiliser des
expressions invoquant les valeurs actuelles des objets Driver, utilisez les
noms des colonnes de Table1 . Par exemple, le graphe à barres pour
Pressure (pression) représente l’expression Table1.B . La valeur
actuelle pour Table1.B  dépend de l’emplacement actuel du curseur.
Du fait que dans l’exemple suivant le curseur est sur la rangée 4, toutes
les expressions rendront la valeur dans leurs colonnes respectives à la
rangée 4. La figure suivante explique comment le panneau de contrôle a
été élaboré. Toutes les expressions sont simples, sauf Pot
(potentiomètre) et DataTable (tableau de données), qui sont des objets
affichables.

 

 

 En bas à droite du panneau de contrôle s’affiche l’objet DataTable
(Table1)  sous forme d’une plaque qui ressemble à un bouton-
poussoir. Pour multiplexer un nouveau site dans le panneau de contrôle
(c’est-à-dire, pour déplacer le curseur sur une rangée différente et donc
sélectionner un API différent), cliquez sur Table1  et la boîte de
dialogue suivante apparaît.

 Table1.C

Table1.B

Table1.B

Table1.E.logique

Table1.F.logique

Table1

Potentiomètre connecté à Table1.D
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 La connexion de signaux à DataTable

 Pour connecter une valeur à une cellule particulière ou à une colonne
dans DataTable, utilisez la commande Object→Edit Connexions…
Sélectionnez les données membres spécifiques à écrire de DataTable et
identifiez les données membres de l’objet source.

 La connexion aux cellules
 Supposons que vous souhaitez écrire la valeur de PLC1.press  dans la
cellule B1 et que cette valeur est numérique. Sélectionnez B1 et non
B1.logical  ou B1.txt .

 La liste déroulante obtient les noms des
rangées de la colonne A dans DataTable.
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 Boîte de dialogue Edit Connections

 Une fois que la connexion à une cellule est établie, la valeur dans la
cellule change toutes les fois que l’expression change. Ainsi, toutes les
fois que la valeur de PLC1.press  change, la valeur dans la cellule B1
change.

 La connexion aux colonnes
 Supposons que vous souhaitez connecter la valeur d’un potentiomètre
nommé Setpoint  à la colonne D. Vu que vous souhaitez écrire une
valeur numérique dans cette colonne, vous sélectionnez D et non
D.logical  ou D.txt .
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 Boîte de dialogue Edit Connections

 Une fois que la connexion à une colonne est établie, la valeur dans la
cellule de la rangée actuellement sélectionnée change toutes les fois que
l’expression change. Ainsi, si le curseur est sur la rangée 4 et la valeur
de Setpoint  change, la valeur dans la cellule D4 change. Ceci
n’affecte aucune autre cellule jusqu’à ce que le curseur se déplace sur
une autre rangée et que l’opérateur ajuste le potentiomètre.

Remarque Quand vous connectez un Pot
(potentiomètre), Switch (booléen), ou
Pushbutton (bouton-poussoir) à une
colonne, configurez l’objet avec le
paramètre Remote  réglé de manière à
relire la valeur à laquelle vous vous
connectez. Reportez-vous à l’exemple
suivant.

 Cet exemple reprend l’exemple
précédent où un potentiomètre nommé
Setpoint  est connecté à
Table1.D . En configurant votre
potentiomètre avec le paramètre
approprié Remote , vous êtes sur qu’il  
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s’ajustera automatiquement pour suivre la valeur dans n’importe quelle
cellule (dans la colonne spécifiée) quand le curseur se déplace sur une
nouvelle rangée.

 La sélection de rangées à multiplexer

 Sélectionnez les valeurs des cellules dans une rangée donnée sous forme
de groupe en déplaçant le curseur sur la rangée désirée. Le curseur n’est
rien de plus qu’un pointeur que vous déplacez de rangée en rangée. Il
existe plusieurs façons de contrôler l’emplacement du curseur :

• Connectez une expression numérique à la donnée membre cursor .
Connectez, par exemple, un potentiomètre (minimum = 1, maximum
= le nombre de rangées dans une table, résolution = 1) au curseur.

• Connectez des expressions logiques aux numéros de rangée
appropriés. Créez, par exemple, un bouton-poussoir pour chaque
rangée et ensuite connectez-les à leurs numéros de rangée respectifs.

• Utilisez l’affichage (liste déroulante) qui fait partie de l’objet
DataTable. L’instance précédente est un exemple typique où des
valeurs textuelles sont connectées aux cellules de la colonne A et
affichées ensuite dans la table sous forme de plaque.

L'exemple suivant est la représentation graphique d’un objet DataTable
(nommé Table1 ) montrant des valeurs typiques dans ses diverses
cellules. Créez un effet multiplexe dans Lookout en invoquant les noms
des colonnes et en sélectionnant ensuite la rangée dont vous souhaitez
utiliser les informations. Si vous invoquez les noms des colonnes (au
lieu de cellules individuelles) DataTable ne produit que les valeurs dans
la rangée actuellement sélectionnée. Si vous invoquez les cellules
séparément, DataTable produit la valeur actuelle dans la cellule, sans
tenir compte de l’emplacement du curseur.
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Sorties = Site3 57.3 480 78  0  1

DataTable avec le curseur sur la rangée 3 et les sorties correspondantes

La valeur de la cellule B3 est actuellement 57,3. Ainsi, les données
membres Table1.B  sont également 57,3. Si vous déplacez le curseur
sur la rangée 7, la valeur de Table1.B  passe à 92,1, comme indiqué ci-
dessous.

Sorties = Site7 92.1 530 63  1  0

DataTable avec le curseur sur la rangée 7 et les sorties correspondantes
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L’utilisation de plusieurs curseurs
La description précédente suppose que vous n’utilisez qu’un seul
curseur, mais un objet DataTable peut comprendre jusqu’à 20 curseurs.
Plusieurs curseurs permettent de sélectionner simultanément plusieurs
rangées. Quand vous utilisez plusieurs curseurs, vous utilisez également
plusieurs noms pour chaque colonne. Dans une colonne, chaque nom est
associé à un curseur précis. Si vous utilisez deux curseurs de l’exemple
précédent (cursor  et cursor.2 ), vous pouvez invoquer le nom d’une
colonne précise de la façon suivante :

Noms de colonnes Table1

A B C D E F

cursor A.txt B C D E.logical F.logical

cursor.2 A.txt.2 B.2 C.2 D.2 E.logical .2 F.logical .2

Avec un seul curseur, vous avez connecté la valeur d’un potentiomètre
nommé Setpoint  à la colonne D. Ensuite, la valeur de Setpoint  a
été écrite dans la cellule de la rangée sélectionnée par le curseur. Avec
plusieurs curseurs, vous devez sélectionner le curseur sur lequel écrire.
Ainsi, selon l’objectif de votre table, vous pouvez connecter le
potentiomètre à Table1.D  et à Table1.D.2 .
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Données membres DataTable

Donnée membre Type Lecture Ecriture Description

(implicite) DdeTable Non Non N’est pas affichable dans Lookout,
mais peut être invoquée via un lien
DDE à une autre application

A1 - IV16384 Numérique Oui Oui Cellule spécifiée interprétée comme
valeur numérique

A1.logical

IV16384.logical

Logique Oui Oui Cellule spécifiée interprétée comme
valeur logique

A1.txt -

IV16384.txt

Texte Oui Oui Cellule spécifiée interprétée comme
valeur textuelle

Cursor.1 -
Cursor.20

Numérique Oui Oui Spécifie la rangée actuellement
sélectionnée du curseur indiqué

1.1-1000.20 Logique Non Oui Spécifie la rangée (1, 2, 3, …1000)
ou spécifie rangée.curseur (par
exemple, 24,2 est le sélecteur de la
rangée 24, curseur 2). Quand elle
passe de Faux à Vrai, déplace le
curseur spécifié à la rangée spécifiée

A.1-IV.20 Numérique Oui Oui Spécifie les noms des colonnes (par
exemple, A, B, C…IV) ou les noms
des colonnes et les numéros des
curseurs associés (par exemple, A.1,
B.1, A.2, B.2, etc.)

Lecture : rend une valeur numérique
de la cellule spécifiée par la colonne
et la rangée actuellement
sélectionnées du curseur indiqué

Ecriture : écrit une valeur numérique
dans la cellule spécifiée par la
colonne et la rangée actuellement
sélectionnées du curseur indiqué
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Données membres DataTable (suite)

Donnée membre Type Lecture Ecriture Description

A.logical.1 -
IV.logical.20

Logique Oui Oui Spécifie les noms des colonnes (par
exemple, A.logical, B.logical,
C.logical, …IV.logical) ou spécifie les
noms des colonnes et les numéros
des curseurs associés (par exemple,
A.logical.1, B.logical.1, A.logical.2,
B.logical.2, etc.)

Lecture : rend une valeur logique de
la cellule spécifiée par la colonne et
la rangée actuellement sélectionnées
du curseur indiqué

Ecriture : écrit une valeur logique
dans la cellule spécifiée par la
colonne et la rangée actuellement
sélectionnées du curseur indiqué

A.txt - IV.txt Texte Oui Oui Spécifie les noms des colonnes (par
exemple, A.txt, B. txt, C. txt, …IV. txt)
ou les noms des colonnes et les
numéros des curseurs associés (par
exemple, A. txt.1, B. txt.1, A. txt.2, B.
txt.2, etc.)

Lecture : rend une valeur textuelle de
la cellule spécifiée par la colonne et
la rangée actuellement sélectionnées
du curseur indiqué

Ecriture : écrit une valeur textuelle
dans la cellule spécifiée par la
colonne et la rangée actuellement
sélectionnées du curseur indiqué

Update Logique Oui Non Emet une impulsion chaque fois que
le curseur change de rangée.
S’utilise souvent pour invoquer un
panneau de contrôle

Objets associés DdeTable, DdeLink
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DdeLink
DdeLink crée un lien unidirectionnel Dynamic Data Exchange (DDE)
vers une autre application, laquelle peut être ouverte sur le même
ordinateur ou sur un autre ordinateur dans un réseau. Les objets DdeLink
facilitent l’importation de valeurs distantes dans Lookout. Reportez-
vous au chapitre 13 pour plus d’informations sur DDE. Pour chaque
objet DdeLink que vous définissez, Lookout crée un lien séparé à l’autre
application. Si vous souhaitez importer de grandes quantités de données,
nous vous conseillons d’utiliser un objet DdeTable ou DataTable
(tableau de données). Reportez-vous à DdeTable et DataTable pour plus
d’informations.

Remarque DdeLink n’a pas de boîte de dialogue pour les paramètres d’affichage.
Cependant, vous pouvez facilement afficher le résultat de son signal de
sortie en invoquant ses données membres dans une expression.

Le lien DdeLink sur un même ordinateur

Si vous importez des valeurs d’une autre application ouverte sur le
même ordinateur, vos paramètres DDE auront l’apparence suivante.

Boîte de dialogue des paramètres de définition DdeLink (même ordinateur)

Service spécifie le nom de l’application, Topic spécifie le fichier et
Item indique la valeur individuelle (r1c1 se rapporte à la cellule de la
rangée1, colonne1. Malheureusement, Excel ne supporte pas la méthode
de référence plus simple A1 avec DDE).
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Le lien DdeLink à un ordinateur à distance

Si vous importez des valeurs d’une autre application ouverte sur un
ordinateur à distance, vos paramètres auront l’apparence suivante.

Boîte de dialogue des paramètres de définition DdeLink (ordinateur à distance)

Notez les différences des paramètres Service , Topic  et Item . Les barres
obliques inverses (\\) et les symboles dollar ($) s’imposent pour établir
des connexions sur réseau dans Windows pour Workgroups.
ComputerName  spécifie le nom de réseau de l’ordinateur auquel vous
vous connectez. Si vous vous connectez à une valeur dans une autre
application Lookout, ProcessFile  est le nom du fichier Lookout
ouvert sur l’ordinateur à distance et Tagname est le nom de variable
auquel vous vous reliez.

Données membres DdeLink

Donnée membre Type Lecture Ecriture Description

(implicite) Numérique Oui Non Lien DDE interprété comme valeur
numérique

Logical Logique Oui Non Lien DDE interprété comme valeur
logique

Txt Texte Oui Non Lien DDE interprété comme valeur
textuelle

Hot Logique Oui Non Etat du lien DDE

Objets associés DdeTable, DataTable (tableau de données)
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e   DdeTable
DdeTable crée un lien unidirectionnel Dynamic Data Exchange (DDE)
vers une autre application, laquelle peut être ouverte sur le même
ordinateur ou sur un autre ordinateur dans un réseau. Reportez-vous au
chapitre 13 pour plus d’informations sur DDE. Vous pouvez utiliser
DdeTable pour importer de grandes quantités de données provenant
d’autres applications. Le format Table est beaucoup plus efficace lors du
transfert de données que le format Link parce que Table peut contenir
des centaines, voire des milliers, de points de données partageant tous un
lien unique. Par ailleurs, le format Link ne peut transférer qu’une valeur
unique par lien ; chaque lien exige une certaine activité supplémentaire
de la part de l’unité centrale. Cependant, si vous n’importez qu’une
petite quantité de données, la technique DdeLink est plus facile à établir.

Remarque DdeTable n’a pas de boîte de dialogue pour les paramètres d’affichage.
Cependant, vous pouvez facilement afficher le résultat de son signal de
sortie en invoquant ses données membres dans une expression.

Le lien DdeTable sur un même ordinateur

Si vous importez des valeurs d’une autre application ouverte sur le
même ordinateur, vos paramètres DDE auront l’apparence suivante.

Boîte de dialogue des paramètres de définition DdeTable (même ordinateur)

Service spécifie le nom de l’application, Topic spécifie le fichier et
Item spécifie le nom de l’article de la donnée.
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L’exemple suivant représente une feuille de calcul Excel où la section
mise en surbrillance s’appelle Data.

N’importe quelle valeur peut être affichée dans le domaine Data avec
l’objet DdeTable de Lookout créé ci-dessus. Notez la valeur sélectionnée
dans Lookout et la méthode de référence dans la barre d’état. Bien
entendu, il n’est pas nécessaire d’afficher chaque valeur de notre feuille
de calcul Excel.

DdeTable au même ordinateur
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Le lien DdeTable à un ordinateur à distance

L’emploi de l’objet DdeTable dans un réseau diffère légèrement de
l’exemple précédent.

Boîte de dialogue des paramètres de définition DdeTable (ordinateur à distance)

Notez les différences des paramètres Service , Topic  et Item . Les barres
obliques inverses (\\) et les symboles dollar ($) s’imposent pour établir
des connexions sur réseau dans Windows pour Workgroups.
ComputerName  spécifie le nom de réseau de l’ordinateur auquel vous
vous connectez. Si vous vous connectez à DdeTable ou DataTable dans
une autre application Lookout, ProcessFile  est le nom du fichier
Lookout ouvert sur l’ordinateur à distance et LocalTable1  se
rapporte à l’objet DdeTable ou DataTable auquel vous vous reliez.

Données membres DdeTable

Donnée membre Type Lecture Ecriture Description

(implicite) Numérique Oui Non Cellule A1 interprétée comme une
valeur numérique

A1 - IV16384 Numérique Oui Non Cellule spécifiée interprétée comme
une valeur numérique

A1.logical -
IV16384.logical

Logique Oui Non Cellule spécifiée interprétée comme
une valeur logique

A1.txt -
IV16384.txt

Texte Oui Non Cellule spécifiée interprétée comme
une valeur textuelle

hot Logique Oui Non Etat du lien DDE

Objets associés DataTable (tableau de données), DdeLink
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DelayOff
DelayOff est une horloge de retard réglable. Quand un signal On/off
signal  est désactivé, l’horloge Timer delay commence le comptage
décrémental. A la fin du comptage décrémental, le signal de sortie est
désactivé. On/off signal  doit rester inactif pendant la durée du retard
pour que le signal de sortie soit désactivé. La sortie est activée dès que le
signal On/off signal  est activé.

Timer delay s’étend de 0,0 seconde à plusieurs années. La résolution
effective est de 0,1 seconde sur toute la gamme. L’affichage de l’horloge
représente de façon numérique la durée du retard restante et il est mis à
jour environ une fois par seconde. Si On/off signal  est haut, l’affichage
de l’horloge indique “on” (activé). Si la durée Timer delay  a expiré,
l’affichage indique “off” (désactivé).

Boîte de dialogue des paramètres de définition DelayOff

On/off signal  est une expression logique tandis que Timer delay  est une
expression numérique. Lookout convertit la valeur numérique de Timer
delay en un signal temporel qui représente les jours et les fractions de
jour. C’est, en général, une simple constante temporelle comme 0:20,
c’est-à-dire vingt secondes. Reportez-vous à la section intitulée Les
données membres numériques, au chapitre 5, pour plus d’informations
sur la saisie des constantes temporelles.
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Boîte de dialogue des paramètres d’affichage DelayOff

Données membres DelayOff

Donnée
membre

Type Lecture Ecriture Description

(implicite) Logique Oui Non Valeur logique d’horloge

Commentaires L’horloge DelayOff peut empêcher une pompe de fonctionner en courts
cycles.

Objets associés DelayOn, Interval, OneShot, Pulse, TimeOf

DelayOn
DelayOn est une horloge de retard réglable. Quand un signal On/off
signal  est activé, Timer delay commence le comptage décrémental. A la
fin du comptage décrémental, le signal de sortie est activé. On/off signal
doit rester actif pendant la durée du retard pour que le signal de sortie
soit activé. La sortie est désactivée dès que le signal On/off signal  est
désactivé.

Timer delay  s’étend de 0,0 seconde à plusieurs années. La résolution
effective est de 0,1 seconde sur toute la gamme. L’affichage de l’horloge
indique de façon numérique la durée du retard restante et il est mis à jour
environ une fois par seconde. L’affichage de l’horloge indique “off”
(désactivé) quand On/off signal  est bas. Si la durée Timer delay  a
expiré, l’affichage indique “on” (activé).
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Boîte de dialogue des paramètres de définition DelayOn

On/off signal  est une expression logique tandis que Timer delay  est une
expression numérique. Lookout convertit la valeur numérique de Timer
delay  en un signal temporel qui représente les jours et les fractions de
jour. C’est, en général, une simple constante temporelle comme 0:20,
c’est-à-dire vingt secondes. Reportez-vous à la section intitulée Les
données membres numériques, au chapitre 5, pour plus d’informations
sur la saisie des constantes temporelles.

Boîte de dialogue des paramètres d’affichage DelayOn
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Données membres DelayOn

Donnée
membre

Type Lecture Ecriture Description

(implicite) Logique Oui Non Valeur logique d’horloge

Commentaires L’horloge DelayOn peut servir à empêcher les pompes de fonctionner en
courts cycles pour permettre à une opération de se terminer avant qu’une
autre ne commence ou pour exiger qu’une condition existe pendant un
certain temps avant le déclenchement d’une alarme.

Objets associés DelayOff, Interval, OneShot, Pulse, TimeOf

DeltaTau
DeltaTau est une classe d’objets Protocol driver (driver de protocole) qui
permet à Lookout de communiquer avec les contrôleurs de mouvement
Delta Tau Data Systems PMAC. Créez un objet DeltaTau pour chaque
carte installée dans l’ordinateur.

Cette classe d’objets communique avec les cartes Delta Tau PMAC via
une mémoire à double accès ; assurez-vous que votre matériel PMAC
comprend l’option RAM à double accès.

Comme les autres objets Driver de protocole, les objets DeltaTau
contiennent un grand volume de données. Tous les membres lus et écrits
(entrées/sorties), les instructions d’interrogation, etc. sont groupés avec
l’objet. Ainsi, dès que vous créez un objet DeltaTau, vous pouvez
immédiatement accéder à toutes les données membres de cet objet.
Reportez-vous à la liste des données membres ci-après.
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Dans cet exemple, la carte est configurée pour utiliser la mémoire du
PC en commençant par l’adresse D000.

Card base address spécifie le début de l’emplacement de la mémoire
de l’adresse RAM à double accès. Elle doit correspondre aux paramètres
de la carte.

Scanning Interval vous permet d’identifier à quelle fréquence l’objet
DeltaTau dans Lookout interroge le contrôleur de mouvement PMAC.
Les intervalles s’étendent de 10 ms à 1 000 ms.

Le tableau ci-après liste les données membres de l’objet DeltaTau.

Données membres DeltaTau

Donnée membre Type Lecture Ecriture Description

DS0-DS8190 Numérique Oui Oui Mot signé 32 bits s’étendant de
-2 147 483 648 à 2 147 483 647

DW0-DW8190 Numérique Oui Oui Mot de précision double 32 bits
s’étendant de 0 à 4 294 967 295

F0-F8188 Numérique Oui Oui Mot à virgule flottante IEEE 32 bits

S0-S8190 Numérique Oui Oui Mot signé 16 bits s’étendant de
-32 768 à 32 767

Update Logique Oui Non Signal généré par le driver qui émet
une impulsion chaque fois que Lookout
scanne la carte du contrôleur de
mouvement PMAC

W0-W8190 Numérique Oui Oui Mot 16 bits s’étendant de 0 à 65 535

W0.0-W8190.15 Logique Oui Oui 1 bit dans un mot 16 bits
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Derivative
L’objet Derivative (dérivé) peut également être désigné comme l’objet
“vitesse de changement” car il ne calcule que la vitesse de changement
du signal d’entrée numérique. Vous pouvez utiliser cette classe d’objets
pour calculer la vitesse de remplissage ou de vidange d’un réservoir ou
pour convertir la valeur changeante du débit total en une vitesse de débit.
Les unités de sortie sont exprimées en Input Units/Time Unit.

Boîte de dialogue des paramètres de définition Derivative

L’exemple ci-dessus calcule la vitesse de changement du niveau de l’eau
dans un réservoir. Lookout interroge toutes les 5 minutes le téléterminal
connecté au transmetteur de niveau du réservoir ; c’est pourquoi nous
utilisons la donnée membre de mise à jour du téléterminal comme
impulsion Update (mise à jour) de l’objet Derivative. Le niveau du
réservoir est mesuré en pieds et l’unité Time est 1 minute : d’où un
résultat de sortie en pieds par minute.

Input est l’expression numérique que nous surveillons pour observer la
vitesse de changement.

Update peut être une expression logique ou une constante numérique. Si
vous spécifiez Update comme constante numérique, cette option crée
une horloge d’impulsion interne avec un temps d’impulsion spécifié et
une durée d’impulsion de zéro. Reportez-vous à la section intitulée Les
données membres numériques, au chapitre 5, pour plus d’informations
sur la saisie de constantes temporelles. Si vous spécifiez Update comme
variable logique, la variable émet une impulsion à la fréquence désirée.
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L’expression Update déclenche le calcul d’une nouvelle vitesse de
changement selon la valeur Input lors de la mise à jour précédente et la
valeur Input actuelle. La valeur Input actuelle est ensuite stockée en tant
que valeur Input précédente pour le calcul suivant. La période Update
doit être supérieure à la vitesse de rafraîchissement du signal entrant ; ou
si Input est généré directement par les E/S externes, la donnée membre
de mise à jour générée par l’objet PLC (API) doit être employée. Si la
période Update est inférieure à la vitesse de rafraîchissement Input, le
calcul de la vitesse de changement produit des fluctuations irrégulières
entre zéro et une valeur élevée.

Time unit est une expression numérique qui sert de base pour l’unité de
temps du signal Input. Par exemple, si la vitesse de changement doit être
en pieds par minute, le signal Input doit être en pieds et le délai Time
unit doit être une minute (entrée comme 1:00). En général, l’unité Time
unit est d’une seconde (0:01), une minute (1:00), une heure (1:00:00) ou
un jour (1:00:00:00). Cependant, vous pouvez spécifier une unité
quelconque, comme 5:23 (une vitesse de changement en unités Input de
cinq minutes et 23 secondes).

Remarque Derivative n’a pas de boîte de dialogue pour les paramètres d’affichage.
Cependant, vous pouvez facilement afficher le résultat de son signal de
sortie en invoquant ses données membres dans une expression.

Données membres Derivative

Donnée
membre

Type Lecture Ecriture Description

(implicite) Numérique Oui Non Vitesse de changement

Commentaires L’objet Derivative produit la fonction inverse de Integral, c’est-à-dire
que vous pouvez, en théorie, passer un signal à travers un objet Integral
et ensuite un objet Derivative (ou vice versa) et revenir au signal
d’origine. (La numérisation des calculs temporels par l’ordinateur peut
rendre le signal d’origine et final légèrement différents.)

Tenez compte de la résolution de la variable du processus mesurée par
l’API quand vous déterminez la période Update pour cet objet. Par
exemple, si un transmetteur de pression connecté à un API a une
résolution de 0,5 psi seulement et que vous souhaitez mesurer la vitesse
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jusqu’à 1 psi/minute, l’impulsion Update doit être supérieure à 30
secondes même si l’API est interrogé une fois par seconde (c’est-à-dire,
0,5 psi / 1 psi/min. = 30 sec.). Pour cette application, l’impulsion devrait
être probablement de deux minutes.

Objets associés Integral

DialGauge
La classe d’objets DialGauge (cadran jauge) affiche un signal numérique
sous la forme d’une aiguille de balayage sur une jauge analogique ou un
cadran.

Boîte de dialogue des paramètres de définition DialGauge

Signal  est une expression
numérique.

Starting angle  indique la position
de l’aiguille quand Signal  est sur
sa valeur Minimum . Comme
indiqué ici, vous spécifiez le point
de départ de l’aiguille en comptant
les degrés depuis l’emplacement
vertical dans le sens des aiguilles d’une montre.

0

90

180

270

225º
Angle initial

par défaut
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Rotational sweep spécifie, en degrés,
le déplacement de l’aiguille vers la
droite pendant que Signal  approche sa
valeur Maximum . Comme l’indique
ce diagramme, vous comptez la valeur
de balayage Rotational sweep  en
degrés dans le sens des aiguilles d’une
montre à partir de l’angle initial
Starting angle .

Une fois que vous avez spécifié les paramètres de définition de
DialGauge (cadran jauge), Lookout présente une boîte de dialogue des
paramètres d’affichage,
illustrée ci-contre. Cette boîte
de dialogue vous permet de
spécifier la couleur, la
grosseur et la longueur d’une
aiguille.

Needle thickness  définit la
grosseur de l’aiguille. La
grosseur s’étend d’un pixel
(ultra-fin) à 10 pixels.

Needle length  spécifie la longueur de
l’aiguille en tant que pourcentage du
rayon. A 30 pourcent, par exemple, seule
la pointe de l’aiguille est visible : la
section de l’aiguille la plus proche de sa
source n’est pas visible. A 100 pourcent,
l’aiguille atteint le centre du cercle.

270
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180

270

Balayage
rotationnel
par défaut

Angle
initial

    
Boîte de dialogue des paramètres

d’affichage DialGauge

30%
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Données membres DialGauge

Donnée
membre

Type Lecture Ecriture Description

(implicite) Numérique Oui Non Valeur actuelle du paramètre du signal

CommentairesLa classe d’objets DialGauge (cadran
jauge) n’affiche qu’une aiguille. Si vous
voulez l’agrémenter d’une échelle ou
d’un cadran, comme sur le diagramme,
vous pouvez les créer en les important
d’un progiciel de graphiques. Reportez-
vous à La création de graphiques
personnalisés au chapitre 8 pour plus
d’informations.

Remarque Si vous choisissez d’importer une échelle ou un cadran d’un progiciel
externe, nous vous conseillons d’utiliser un bitmap au lieu d’un fichier
méta. Le rafraîchissement en sera plus clair au moment où l’aiguille
changera d’emplacement.

Objets associés Expression, Gauge (jauge)
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DL205
DL405

DL205 et DL405 sont des classes d’objets Protocol driver (driver de
protocole) qui permettent à Lookout de communiquer avec les API Koyo
205 et 405 et autres appareils utilisant le protocole CCM.

Koyo vend les modèles 205 et 405 sous des marques privées.
PLCDirect™ offre cet équipement sous la forme d’API DirectLOGIC
205 et 405 et Siemens offre le modèle 405 comme série TI405™.

Les classes d’objets DL205 et DL405 supportent le protocole natif de
Koyo, CCM, nommé aussi DirectNET™de PLCDirect et HostLink™ de
Siemens. Nous utiliserons le terme CCM pour ce protocole.

Les classes d’objets DL205 et DL405 supportent les configurations point
à point et multipoints. Vous pouvez connecter Lookout au port de
programmation d’un API, au port intégré DirectNET/HostLink ou au
module de communication de données DCM de l’API. Ces ports de
communication API utilisent deux versions différentes du protocole
CCM : K-sequence et N-sequence. Lookout supporte les deux.

Les paramètres de l’objet

Interface identifie le port CCM que vous utilisez pour communiquer
avec l’appareil. Si vous envisagez de connecter Lookout à un API unique
dans une configuration point à point, sélectionnez UPPER PORT (k)  à
Interface et utilisez le port de programmation de l’API. Il supporte CCM
K-sequence. Cette version du protocole CCM vous permet d’écrire
directement vers les sorties logiques.

Si vous envisagez de mettre sur réseau plusieurs API dans une
configuration multipoints où Lookout est l’ordinateur hôte, vous devrez
utiliser le port intégré DirectNET/HostLink de l’API ou son DCM.
Sélectionnez LOWER PORT (n)  ou DCM (n)  comme Interface . Ces
ports supportent CCM N-séquence. Le protocole CCM N-séquence ne
permet pas l’écriture directe vers les données membres logiques.
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Paramètres de définition DL205 configurés pour un API dans une configuration
multipoints

Remarque Avec Lookout, vous pouvez connecter des signaux logiques aux données
membres telles que Y0 ; cependant, chaque fois que vous tenterez
d’écrire sur cette donnée membre avec le protocole CCM
N-séquence, la requête sera ignorée. (Ceci est dû aux limitations très
restrictives du protocole CCM N-séquence, et non à Lookout.) Si vous
devez écrire une valeur logique avec N-séquence, pensez à décomposer
l’adresse VU correspondante en un chiffre binaire et à régler le bit désiré
en écrivant un nombre entier décimal correspondant. Si vous écrivez un
zéro ou 65 535 à l’emplacement correspondant de la mémoire VU, vous
n’écrirez que des zéros ou des uns sur chaque bit du registre.

PLC Address est une adresse esclave qui se rapporte au paramètre de
l’adresse telle qu’elle est établie dans l’appareil physique. Si vous vous
connectez au port de programmation de l’API, réglez PLC Address
sur 1. Si plusieurs appareils partagent une ligne commune, entrez les
adresses uniques de l’appareil (1 à 255).

Model vous permet de choisir le modèle d’API désiré. Si vous utilisez un
modèle qui n’est pas sur la liste, sélectionnez un modèle dont le jeu de
données se rapproche le plus du modèle que vous utilisez.
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Serial port spécifie le port de communication de votre ordinateur que
l’objet utilisera pour communiquer avec l’API. Ceci ne spécifie pas le
type de communication. Le type de communication est déterminé par la
commande Options→Serial Ports…

Data rate , Parity , Data bits  et Stop bits  doivent correspondre aux
paramètres de l’API.

Phone number  spécifie le numéro à composer si le port série
sélectionné est configuré pour Dial-up. Ce numéro ne sert que pour
l’objet de protocole individuel.

PollRate est une expression numérique qui détermine la fréquence
d’appel de l’appareil. Lookout convertit la valeur numérique de PollRate
en un signal temporel qui représente les jours et les fractions de jour.
Ensuite, l’objet interroge l’appareil à l’intervalle de temps spécifié. En
général, c’est une simple constante temporelle comme 0:01 (une
seconde). Reportez-vous à la section intitulée les données membres
numériques, au chapitre 5, pour plus d’informations sur la saisie de
constantes temporelles.

Poll est une expression logique dont le passage de Faux à Vrai provoque
l’appel de l’appareil par Lookout. Ceci peut être une simple expression,
comme le signal d’un bouton-poussoir, ou un algorithme complexe.

Communication alarm priority  détermine le niveau de priorité des
alarmes générées par l’objet. En général, ces alarmes sont associées aux
communications avec l’appareil physique.

Retry attempts spécifie le nombre de tentatives consécutives entreprises
par Lookout pour communiquer avec un appareil qui ne produit pas de
réponse valable. Une fois que l’objet essaie à nouveau d’établir la
communication le nombre de fois spécifié, il génère une alarme de
communication et Lookout passe au prochain appareil dans la queue
d’interrogation (si elle existe). Reportez-vous au chapitre sur les
communications pour plus d’informations.

Receive timeout est la durée pendant laquelle Lookout attend une
réponse d’un appareil avant de renouveler la requête.
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Le paramètre Skip every… demande à Lookout de ne pas interroger
l’appareil avec lequel il n’a pas pu établir de communication au cours
des interrogations programmées. Ainsi, Lookout saute cet appareil
pendant le cycle d’interrogation. Une fois que les communications sont
rétablies, l’appareil est interrogé au cours de son cycle normal.

Les données membres

Les objets Protocol driver (driver de protocole) contiennent un grand
volume de données. Les adresses mémoire V, les registres, les entrées et
les sorties sont tous groupés avec l’objet. Ainsi, dès que vous créez un
objet DL205, vous accédez immédiatement au jeu complet des données
membres de cet objet (reportez-vous à la liste des données membres ci-
dessous).

Comme c’est le cas pour tous les drivers de Lookout, vous pouvez
accéder aux points d’E/S et à d’autres données via les données membres.
Les classes d’objets DL205 et DL405 génèrent automatiquement des
structures de blocage efficaces de Lecture/Ecriture selon les entrées et
les sorties utilisées dans votre fichier de processus. Vous n’avez pas
besoin de créer votre propre tableau de blocage d’E/S. Quand Lookout
interroge un appareil, il optimise l’échange des trames selon la longueur
des données exigée et l’activité supplémentaire. La taille maximum de
trames de données exigées par ces drivers est 256 octets de données. Les
drivers utilisent la vérification d’erreurs de parité et LRC pour valider
les données.

La table suivante liste les données membres actuellement supportées par
la classe d’objets DL205 et DL405.
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Données membres DL205 et DL405

Donnée membre Type Lecture Ecriture Description

C0 - C737 Logique Oui Oui Relais de contrôle ; adressés en
octaux et mappés à V40600 - V40617

CommFail Logique Oui Non Signal généré par l’objet qui est activé
si, pour quelque raison que ce soit,
Lookout ne peut pas communiquer
avec l’appareil

CT0 - CT177 Logique Oui Oui Bits d’état du compteur ; adressés en
octaux et mappés à V41140 - V41147

Poll Logique Non Oui Expression Lookout qui exige que
l’appareil soit interrogé quand elle
passe de Faux à Vrai

PollRate Numérique Non Oui Expression Lookout qui détermine
combien de fois interroger l’appareil

S0 - S577 Logique Oui Oui Etapes ; adressés en octaux et
mappés à V41000 - V41037

SPA0 - SPA177 Logique Oui Oui Relais particuliers inférieurs ; adressés
en octaux

SPB320 - SPB617 Logique Oui Oui Relais particuliers supérieurs ;
adressés en octaux

T0 - T177 Logique Oui Oui Bits d’état de l’horloge ; adressés en
octaux et mappés à V41100 - V41107

Update Logique Oui Non Signal généré par l’objet qui émet une
impulsion basse chaque fois qu’il
interroge l’appareil

V0 - V41230 Numérique Oui Oui Registre signé de mémoire V
comprenant un entier 16 bits
s’étendant de -32 768 à 32 767 déc.

V0.0 - V41230.17 Logique Oui Non Bits individuels au sein des registres
de mémoire V ; le bit le moins
significatif est 0 et le plus significatif
est 17 (octal)

VD0 - VD41227 Numérique Oui Oui Double ; lit deux registres adjacents
de mémoire V comme nombre entier
unique 32 bits s’étendant de 0 à 4 294
967 296
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Donnée membre Type Lecture Ecriture Description

VF0 - VF41227 Numéri-
que

Oui Oui Flottant ; lit deux registres adjacents de
mémoire V comme valeur unique 32 bits
à virgule flottante

VU0 - VU41230 Numéri-
que

Oui Oui Non signé ; registre de mémoire V
contenant un nombre entier non signé
16 bits s’étendant de 0 à 65 535

X0 - X177* Logique Oui Oui Points d’entrée discrets ; adressés en
octaux et mappés à V40400 - V40407

Y0 - Y177* Logique Oui Oui Points de sortie discrets ; adressés en
octaux et mappés à V40500 - V40507

* Les API série 205 se limitent à un total de 128 points d’entrée et de sortie. Vous pouvez combiner ces adresses selon
vos besoins, mais sachez que Y17 et X17 se rapportent au même emplacement de mémoire sur les DL205.

Les messages d’état

No response within timeout period
(Pas de réponse pendant la temporisation)
Lookout n’a pas reçu la réponse attendue pendant la temporisation
Receive timeout . L’objet a envoyé une requête et a reçu un
acquittement, mais l’appareil n’a pas envoyé de réponse comme
envisagé. La réponse a peut-être été interrompue. Vous devrez alors
augmenter la temporisation Receive timeout .

No return inquiry response from secondary unit
(Pas de réponse à la requête faite à l’unité secondaire)
Lookout n’a reçu aucune réponse de l’appareil pendant la temporisation
Receive timeout . L’objet Driver utilise le port de communication, mais
quand il interroge l’appareil, celui-ci agit comme s’il n’existait pas : il ne
répond pas. Vous devrez peut-être augmenter la temporisation Receive
timeout  pour être sûr que Lookout alloue suffisamment de temps à la
réponse. Vérifiez également les paramètres de transmission, les
connexions des câbles, l’alimentation, les paramètres de configuration,
les paramètres du port de communication et les adresses d’interrogation.
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Bad LRC
(Mauvais LRC)
L’objet reçoit une réponse de l’appareil, mais ne peut pas déchiffrer la
réponse parce qu’elle est embrouillée. Vérifiez que tous les appareils
connectés au port de communication ont des adresses uniques. Il se peut
que la dernière partie du message soit coupée avant la fin. Pensez à
augmenter le nombre de tentatives dans Retry attempts . Vous devrez
peut-être augmenter le paramètre port série Receive gap  pour être sûr
que Lookout reçoit le message entier. Si votre port série est configuré
pour radio, cette erreur peut être due à un bruit à la fin de la transmission
radio. Essayez d’ajuster RTS delay off  et CTS timeout .

No acknowledgment for header frame
(Pas d’acquittement pour la trame d’en-tête)
Vous avez envoyé une requête correcte et des données Ecriture ou
Lecture mais l’appareil n’en a pas tenu compte. En fait, l’objet attendait
un acquittement pour une trame d’instruction et ne l’a pas reçu. Il se peut
que l’adresse de mémoire ne soit pas valable. Revérifiez la configuration
de l’adresse de la mémoire de votre API. Vérifiez également que le port
communication de l’API supporte l’Interface CCM que vous avez
sélectionnée.

Invalid request frame
(Trame de requête non valable)
Vous essayez probablement d’utiliser une adresse mémoire non valable.
Revérifiez la configuration de l’adresse de votre API.

Dynamic
Dynamic est une classe d’objets Protocol driver (driver de protocole) qui
permet à Lookout de communiquer avec des équipements comme des
contrôleurs de logique programmable (API), des téléterminaux ou tout
autre matériel qui utilise Dynamic comme protocole de communication.

Les objets Protocol driver contiennent un volume important de données.
Tous les membres lus et écrits (entrées/sorties), les instructions
d’interrogation, la lecture/écriture bloquante, l’utilisation des ports série,
etc. sont groupés avec l’objet. Ainsi, dès que vous créez un objet
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Dynamic, vous accédez immédiatement à toutes les données membres de
cet objet (reportez-vous à la liste des données membres ci-dessous).

Le driver supporte actuellement la lecture et l’écriture de tout type de
points de données prédéfinis dont, entre autres, les entrées analogiques,
les entrées logiques, les entrées de comptage d’impulsions, les entrées de
durée d’impulsions, les entrées de période d’impulsions, les entrées
d’accumulateur haute vitesse, les sorties logiques, les sorties
d’impulsions, les sorties analogiques et les données AGA.

Le driver configure automatiquement la base de données du téléterminal
pour correspondre aux points de données invoqués dans le fichier de
processus Lookout et vérifie que ces points existent effectivement sur le
téléterminal. Si vous invoquez des points indéfinis ou non disponibles, le
driver émet un message d’alarme dans le système d’alarmes de Lookout.

Le driver de protocole Dynamic exploite automatiquement la capacité du
téléterminal en matière de signalisation des écarts pour augmenter
l’efficacité des communications. Le driver exige que le téléterminal soit
réglé pour l’adressage de points physiques. Reportez-vous au manuel des
caractéristiques techniques du matériel du téléterminal pour plus
d’informations sur les emplacements des interrupteurs Dipswitch qui
règlent ce paramètre.

Remarque Les objets Protocol driver de Lookout génèrent automatiquement une
structure efficace de la lecture/écriture bloquante selon les entrées et les
sorties utilisées dans votre fichier de processus. Vous n’avez pas besoin
de créer votre propre table de blocage d’E/S.

Le driver de protocole Dynamic a été élaboré pour les téléterminaux de
Texas Instruments modèle 8635, 8640 et 8641 munis de EPROM RTX
5.41. Les versions antérieures des RTX comportent des anomalies et ne
fonctionnent pas correctement avec le driver Dynamic de Lookout.
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Dans cet exemple, Lookout est connecté à un téléterminal de langage Dynamic
avec 7 comme adresse. Nous utilisons un port série 1 (déjà configuré pour les
communications Dial-up) et nous composons le numéro spécifié. Chaque
interrogation aura lieu toutes les heures ou quand l’opérateur appuiera sur
Pushbutton7.

Address est le paramètre de l’adresse de l’API ou du téléterminal qui
correspond aux interrupteurs Dipswitch de l’appareil. Si des appareils
partagent une ligne, leurs adresses doivent être uniques (1 à 255).

Serial port spécifie le port que l’objet utilise pour communiquer avec
l’appareil externe, mais pas le type de communication. Celui-ci est
déterminé par la commande Options→Serial Ports…

Data rate , Parity , Data bits  et Stop bits  sont les paramètres de
l’appareil.

Le bouton Defaults remplace les paramètres actuels par leurs valeurs par
défaut.

Alarm priority détermine le niveau de priorité des alarmes générées par
Dynamic.

Phone number spécifie le numéro à composer si le paramètre port série
est configuré pour Dial-up. Ce numéro ne s’applique qu’à l’objet de
protocole individuel.
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PollRate est une expression numérique qui détermine la fréquence
d’appel de l’appareil. Lookout convertit la valeur numérique de PollRate
en un signal temporel qui représente les jours et les fractions de jour.
Ensuite, l’objet interroge l’appareil à l’intervalle de temps spécifié. En
général, c’est une simple constante temporelle comme 0:01 (une
seconde). Reportez-vous à la section intitulée Les données membres
numériques, au chapitre 5, pour plus d’informations sur la saisie de
constantes temporelles.

Poll est une expression logique dont le passage de Faux à Vrai provoque
l’appel de l’appareil par Lookout. Ceci peut être une simple expression,
comme le signal d’un bouton-poussoir, ou un algorithme complexe.

Comme c’est le cas de tous les drivers de Lookout, vous pouvez accéder
aux points d’E/S et à d’autres données via les données membres. La
table ci-dessous liste les données membres actuellement supportées par
la classe d’objets Dynamic (dynamique).

Données membres Dynamic

Donnée membre Type Lecture Ecriture Description

AI0 - AI239 Numérique Oui Non Entrées analogiques ; rend une valeur
numérique normalisée qui s’étend de
0 à 32 000 et couvre l’éventail complet
d’entrées analogiques

AO0 - AO239 Numérique Non Oui Sorties analogiques ; établit le niveau
de voltage des sorties analogiques et
accepte un chiffre normalisé de 0 à
32 000

btu1 - btu4 AGA Oui Non Données AGA

dp1 - dp4 AGA Oui Non Pression différentielle (psi). 1-4
spécifie la longueur en mètres
invoquée

HSA0 - HSA127 Numérique Oui Non Entrées accumulateur de haute
vitesse ; compte le nombre
d’impulsions numériques d’une entrée
HSA. Le dépassement est
automatiquement détecté par le driver
et le nombre maximum d’impulsions
est donc 4,5x1015
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Données membres Dynamic (suite)

Donnée membre Type Lecture Ecriture Description

MeterCode1 -
MeterCode4

AGA - texte Non Oui Les 8 premiers caractères de cette
chaîne de texte servent à créer un
nom de fichier avec l’extension .csv.
La chaîne entière sert de champ dans
le fichier .csv file. 1-4 spécifie la
longueur en mètres invoquée

NoComm Logique Oui Non Signal généré par le driver qui est
activé si Lookout, pour quelque raison
que ce soit, ne peut pas
communiquer avec l’appareil

PCI0 - PCI239 Numérique Oui Non Entrées numériques du nombre
d’impulsions ; compte le nombre de
fois qu’une entrée numérique d’état
passe de l’état désactivé à l’état
activé. Le dépassement est détecté
automatiquement par le driver et le
nombre maximum d’impulsions est
donc environ 4,5 x 1015

PDI0 - PDI239 Numérique Oui Non Entrées numériques de durée des
impulsions ; mesure une impulsion
périodique au rythme d’une résolution
de 10 millisecondes. La période
d’impulsion doit être toutes les 15
secondes ou moins. Le temps rendu
est exprimé en unités standard
Lookout de fraction d’un jour

Poll Logique Non Oui Expression Lookout qui, lorsqu’elle
passe de Faux à Vrai, fait que
l’appareil est interrogé

PollRate Numérique Non Oui Expression Lookout qui détermine à
quelle fréquence l’appareil est
interrogé

PPI0 - PPI239 Numérique Oui Non Entrées numériques de période
d’impulsion ; mesure la période d’une
impulsion avec une résolution de 10
millisecondes. La période d’impulsion
doit être de 15,1 secondes ou moins. Le
temps rendu est exprimé en unités
standard Lookout de fraction d’un jour
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Données membres Dynamic (suite)

Donnée membre Type Lecture Ecriture Description

ReadHistory Logique Non Oui Expression Lookout qui, lorsqu’elle
passe de Faux à Vrai, fait que
l’appareil est interrogé et que l’AGA
historique est lue depuis le
téléterminal et stockée sur disque

Qe1 - Qe4 AGA Oui Non Taux d’énergie 1-4 qui spécifie la
longueur en mètres

Qsum_month1 -
Qsum_month4

AGA Oui Non Débit accumulé les 30 derniers jours
(pieds cubiques - CF). 1-4 spécifie la
longueur en mètres

Qsum_yesterday1-
Qsum_yesterday4

AGA Oui Non Débit accumulé les 24 dernières
heures (pieds cubiques - CF). 1-4
spécifie la longueur en mètres

Qsum1 - Qsum4 AGA Oui Non Débit accumulé les 60 dernières
minutes (pieds cubiques - CF). 1-4
spécifie la longueur en mètres

Qv1 - Qv4 AGA Oui Non Débit d’écoulement instantané (pieds
cubiques/heure - CFH). 1-4 spécifie la
longueur en mètres

sp1 - sp4 AGA Oui Non Pression statique (psi). 1-4 spécifie la
longueur en mètres

tf1 - tf4 AGA Oui Non Température écoulée (degrés F). 1-4
spécifie la longueur en mètres

SI0 - SI239 Logique Oui Non Entrées numériques d’état

SO0 - SO239 Logique Non Oui Sorties numériques d’état. Sur le
8 635, les sorties d’état et
d’impulsions sont mappées aux points
programmables d’E/S (PIO) et
s’étendent de SO8 à SO15

Update Logique Oui Non Signal généré par le driver qui émet
une impulsion chaque fois qu’il
interroge l’appareil
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ElapsedTime
ElapsedTime (temps écoulé) est un compteur de temps écoulé ou
“compteur d’heures” qui additionne toute la durée d’activation de
l’expression Enable . Si Enable est la constante logique ON (activé), le
compteur indique le temps écoulé depuis le début du processus. Si
l’expression Reset est spécifiée, le compteur se remet à zéro dès que
Reset passe de désactivé à activé. L’affichage indique toujours le temps
écoulé ; il est mis à jour environ une fois par seconde.

Remarque ElapsedTime (temps écoulé) n’a pas de boîte de dialogue pour les
paramètres d’affichage. Cependant, vous pouvez facilement afficher le
résultat de son signal de sortie en invoquant ses données membres dans
une expression.

Données membres ElapsedTime

Donnée
membre

Type Lecture Ecriture Description

(implicite) Numérique Oui Non Temps total écoulé ; mis à jour une fois par
seconde pendant que le compteur est en
marche

Commentaires Les compteurs ElapsedTime (temps écoulé) servent principalement à
enregistrer la durée de fonctionnement des pièces de l’équipement. Il est
facile d’établir une alarme afin qu’elle se déclenche quand un appareil a
fonctionné pendant un certain temps et doit donc être révisé. L’opérateur
de l’installation peut alors effectuer l’entretien et remettre le compteur
ElapsedTime à zéro à l’aide d’un bouton-poussoir.
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ElapsedTime (temps écoulé) peut également enregistrer le temps de
fonctionnement quotidien d’un appareil, durée que vous pouvez reporter
sur une feuille de calcul quotidienne. Le signal de mise à jour de la
feuille de calcul peut alors servir à remettre le compteur
automatiquement à zéro une fois que la donnée est enregistrée de façon
permanente.

e   Event
Event (événement) est une classe d’objets flexible et puissante qui vous
permet de définir les messages d’événements déclenchés par une
expression logique définie par l’utilisateur. Lookout enregistre ces
événements dans le fichier d’enregistrement EVENT.DAT, et vous
pouvez ensuite les imprimer et les archiver. Reportez-vous au chapitre
11 pour plus d’informations sur l’enregistrement d’événements.

Paramètres typiques pour un événement

Quand le résultat de l’expression logique Trigger passe de Faux à Vrai,
le résultat de l’expression Trigger hi text est enregistré en tant
qu’événement dans le fichier EVENT.DAT. Quand le résultat de
l’expression Trigger passe de Vrai à Faux, le résultat de l’expression
Trigger lo text est enregistré en tant qu’événement.
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Données membres Event

Donnée
membre

Type Lecture Ecriture Description

aucune Les objets Event (événement) n’ont pas de données
membres

Commentaires Pour chaque événement enregistré, Lookout enregistre la date et l’heure,
le nom de l’utilisateur en session et le texte de l’expression.

Bien que les messages d’événement soient affichés pour Trigger hi text
et Trigger lo text , vous n’avez pas besoin d’ajouter du texte dans les
deux champs.

Expression
Les objets Expression sont des calculatrices flexibles, puissantes et en
temps réel. Elles créent et calculent le résultat des formules de style
feuille de calcul qui comprennent un mélange de constantes et de
signaux provenant d’autres objets. Il existe plus de cinquante fonctions
intégrées pour les expressions, y compris les fonctions logiques,
mathématiques, statistiques, textuelles et trigonométriques. Reportez-
vous au chapitre 7 pour plus d’informations sur les expressions et les
fonctions d’expressions.

Les expressions peuvent être courtes et simples ou extrêmement
compliquées avec plusieurs entrées de signal, des appels de fonction et
plusieurs niveaux de parenthèses. Une expression unique peut contenir
des calculs textuels, logiques et numériques. Le type de variable rendu
par la fonction ou l’opérateur le plus à l’extérieur de l’expression
détermine le type de signal généré par l’expression.
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Remarque En général, vous utilisez des objets Expression quand vous souhaitez
définir une condition unique qui sera utilisée plusieurs fois dans
l’application.

Quand vous définissez un objet Expression (au lieu d’insérer une
expression intrinsèque), vous créez un nom de variable unique pour
votre expression et pouvez donc invoquer le signal de sortie généré
comme résultat de l’expression dans d’autres expressions et/ou objets.
Au lieu de définir la même expression dans plusieurs endroits, vous
pouvez la créer une bonne fois pour toutes et utiliser son nom de
variable toutes les fois que la condition le permet.

Remarque Un objet Expression n’a pas de boîte de dialogue des paramètres
d’affichage. Cependant, vous pouvez facilement afficher le résultat du
signal de sortie en invoquant ses données membres dans une
expression intrinsèque.

Données membres Expression

Donnée
membre

Type Lecture Ecriture Description

(implicite) Numérique,
Logique ou
Textuelle

Oui Non Valeur d’expression. Le type de variable
rendu par la fonction ou l’opérateur le plus à
l’extérieur de l’expression détermine le type
de signal généré par l’expression
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FisherROC
FisherROC™ est une classe d’objets Protocol driver (driver de protocole)
qui permet à Lookout de communiquer avec un contrôleur d’opérations
télécommandées ROC364 (Remote Operations Controller) fabriqué par
Fisher Controls. Pour communiquer avec le ROC364, connectez-vous
directement à son port COM1 ou COM2. Selon la configuration de
l’appareil, ces ports peuvent être configurés pour des communications
modem RS-232, RS-422/485 ou Bell 202.

Créez un objet FisherROC pour chaque ROC364. Cette classe d’objets
comprend de nombreuses données. Tous les types de points, les entrées,
les sorties, les PID, les AGA, les objets Tank (réservoir), etc., et leurs
signaux de configuration sont groupés avec l’objet. Pour cette raison, dès
que vous créez un objet FisherROC, vous accédez immédiatement au jeu
complet des données membres (reportez-vous à la liste des données
membres ci-dessous).

Group est le code de groupe auquel la station ROC est affectée. En
général, ce paramètre est réglé sur 2, mais il peut être configuré avec le
logiciel de configuration GV101.
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Address est le code d’unité (paramètre adresse) de la station ROC tel
qu’il est défini avec le logiciel de configuration GV101. Si plusieurs
ROC sont membres du même groupe, il leur faut des adresses uniques
(de 0 à 255). Group 0, Address 1 est affecté à l’ordinateur Lookout, car
c’est la station hôte.

Controller model identifie le type d’opérations télécommandées du
contrôleur Fisher représenté par l’objet. Cette classe d’objets supporte
ROC364.

Serial port spécifie le port de communication sur l’ordinateur hôte
utilisé par Lookout pour communiquer avec l’appareil externe, mais pas
le type de communication. Celui-ci est déterminé par la commande
Options→Serial Ports….

Data rate , Parity , Data bits  et Stop bits  se rapportent aux paramètres de
l’appareil physique.

Phone number  spécifie le numéro à composer si le port série
sélectionné est configuré pour Dial-up. Ce numéro ne s’applique qu’à
l’objet Protocol.

PollRate est une expression numérique qui détermine la fréquence
d’appel de l’appareil. Lookout convertit la valeur numérique de PollRate
en un signal temporel qui représente les jours et les fractions de jour.
Ensuite, l’objet interroge l’appareil à l’intervalle de temps spécifié. En
général, c’est une simple constante temporelle comme 0:01 (une
seconde). Reportez-vous à la section intitulée Les données membres
numériques, au chapitre 5, pour plus d’informations sur la saisie de
constantes temporelles.

Poll est une expression logique dont le passage de Faux à Vrai provoque
l’appel de l’appareil par Lookout. Ceci peut être une simple expression,
comme le signal d’un bouton-poussoir, ou un algorithme complexe.

Communication alarm priority  détermine le niveau de priorité des
alarmes générées par l’objet. En général, ces alarmes sont associées aux
communications avec l’appareil physique.
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Retry attempts spécifie le nombre de tentatives consécutives entreprises
par Lookout pour communiquer avec un appareil qui ne produit pas de
réponse valable. Une fois que l’objet essaie à nouveau d’établir la
communication le nombre de fois spécifié dans Retry attempts , il
génère une alarme et affranchit le port de communication au sous-
système COMSUB de communication qui passe ensuite au prochain
appareil dans la queue d’interrogation (si elle existe). Reportez-vous au
chapitre sur les communications pour plus d’informations.

Receive timeout est la durée pendant laquelle Lookout attend une
réponse d’un appareil avant de renouveler la requête.

Le paramètre Skip every… demande à Lookout de ne pas interroger
l’appareil avec lequel il n’a pas pu établir de communication au cours
des interrogations programmées. Ainsi, Lookout saute cet appareil
pendant le cycle d’interrogation. Une fois que les communications sont
rétablies, l’appareil est interrogé au cours de son cycle normal.
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Données membres FisherROC

Donnée membre Type Lecture Ecriture Description

AGA1.ha - AGA5.ha Numérique Oui Oui Alarme haute au format Ingénieur de
AGA

AGA1.la - AGA5.la Numérique Oui Oui Alarme basse au format Ingénieur de
AGA

AGF1.btud - AGF5.btud Numérique Oui Non Débit AGA en unités MMBTU/Jour

AGF1.btut - AGF5.btut Numérique Oui Non MMBTU d’écoulement AGA
aujourd’hui

AGF1.btuy - AGF5.btuy Numérique Oui Non MMBTU d’écoulement AGA hier

AGF1.mcfd -
AGF5.mcfd

Numérique Oui Non Débit AGA en unités MCF/jour

AGF1.mcft - AGF5.mcft Numérique Oui Non MCF d’écoulement AGA aujourd’hui

AGF1.mcfy - AGF5.mcfy Numérique Oui Non MCF d’écoulement AGA hier

AI:A1.adh - AI:D16.adh Numérique Oui Oui 100% A/N ajusté de l’entrée
analogique

AI:A1.adl - AI:D16.adl Numérique Oui Oui 0% A/N ajusté de l’entrée analogique

AI:A1.dla - AI:D16.dla Numérique Oui Oui Alarme delta au format ingénieur de
l’entrée analogique

AI:A1.euh - AI:D16.euh Numérique Oui Oui Lecture haute au format ingénieur de
l’entrée analogique

AI:A1.eul - AI:D16.eul Numérique Oui Oui Lecture basse au format ingénieur
de l’entrée analogique

AI:A1.feu - AI:D16.feu Numérique Oui Oui Valeur filtrée au format ingénieur de
l’entrée analogique

AI:A1.flt - AI:D16.flt Numérique Oui Oui Filtre de l’entrée analogique

AI:A1.ha - AI:D16.ha Numérique Oui Oui Limite haute d’alarme de l’entrée
analogique

AI:A1.hha - AI:D16.hha Numérique Oui Oui Limite haute-haute (très haute)
d’alarme de l’entrée analogique

AI:A1.la - AI:D16.la Numérique Oui Oui Limite basse d’alarme de l’entrée
analogique

AI:A1.lla - AI:D16.lla Numérique Oui Oui Limite basse-basse (très basse)
d’alarme de l’entrée analogique
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Données membres FisherROC (suite)

Donnée membre Type Lecture Ecriture Description

AI:A1.raw - AI:D16.raw Numérique Oui Non Valeur brute A/N de l’entrée
analogique

AO:A1.adh -
AO:D16.adh

Numérique Oui Oui 100% A/N ajusté de la sortie
analogique

AO:A1.adl - AO:D16.adl Numérique Oui Oui 0% A/N ajusté de la sortie analogique

AO:A1.eu - AO:D16.eu Numérique Oui Oui Valeur de sortie au format ingénieur
de la sortie analogique

AO:A1.euh -
AO:D16.euh

Numérique Oui Oui Lecture haute au format ingénieur de
la sortie analogique

AO:A1.eul - AO:D16.eul Numérique Oui Oui Lecture basse au format ingénieur de
la sortie analogique

CommFail Logique Oui Non Signal généré par l’objet qui est activé
si pour une raison quelconque,
Lookout ne peut pas communiquer
avec la station ROC

DI:A1.acc - DI: D16.acc Numérique Oui Oui Valeur accumulée de l’entrée discrète

DI:A1.flt - DI: D16.flt Logique Oui Oui Filtre de l’entrée discrète

DI:A1.ha - DI: D16.ha Numérique Oui Oui Alarme haute de l’entrée discrète

DI:A1.hha - DI: D16.hha Numérique Oui Oui Alarme haute-haute (très haute) de
l’entrée discrète

DI:A1.la - DI: D16.la Numérique Oui Oui Alarme basse de l’entrée discrète

DI:A1.lla - DI: D16.lla Numérique Oui Oui Alarme basse-basse (très basse) de
l’entrée discrète

DI:A1.sts - DI: D16.sts Logique Oui Non Etat (valeur) de l’entrée discrète

DO:A1.acc - DO:
D16.acc

Numérique Oui Oui Valeur accumulée de la sortie discrète

DO:A1.cth - DO:
D16.cth

Numérique Oui Oui Comptage 100% de la sortie discrète

DO:A1.ctl - DO: D16.ctl Numérique Oui Oui Comptage 0% de la sortie discrète

DO:A1.ctm - DO:
D16.ctm

Numérique Oui Oui Durée du cycle de la sortie discrète

DO:A1.eu - DO: D16.eu Numérique Oui Oui Valeur de sortie au format ingénieur
de la sortie discrète
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Données membres FisherROC (suite)

Donnée membre Type Lecture Ecriture Description

DO:A1.rdh - DO:
D16.rdh

Numérique Oui Oui Lecture haute au format ingénieur de la
sortie discrète

DO:A1.rdl - DO: D16.rdl Numérique Oui Oui Lecture basse au format ingénieur de la
sortie discrète

DO:A1.sts - DO: D16.sts Logique Oui Oui Etat (valeur) de la sortie discrète

DO:A1.to - DO: D16.to Numérique Oui Oui Durée d’activation de la sortie discrète

FST1.rg1 - FST8.rg10 Numérique Oui Oui Valeur du registre table de séquence des
fonctions

FST1.rrg - FST8.rrg Numérique Oui Oui Registre du résultat table de séquence
des fonctions

FST1.tm1 - FST8.tm4 Numérique Oui Oui Valeur du compteur table de séquence
des fonctions

PID1.eu - PID16.eu Numérique Oui Oui Valeur au format ingénieur de la sortie
PID

PID1.ost - PID16.ost Numérique Oui Oui Consigne sw OVR du PID

PID1.pst - PID16.pst Numérique Oui Oui Consigne sw PRI du PID

PID1.set - PID16.set Numérique Oui Oui Valeur de la consigne du PID

PL:A1.acc - PL: D16.acc Numérique Oui Oui Valeur accumulée de l’entrée d’impulsion

PL:A1.crt - PL: D16.crt Numérique Oui Non Taux actuel de l’entrée d’impulsion

PL:A1.dla - PL: D16.dla Numérique Oui Oui EU d’alarme delta de l’entrée d’impulsion

PL:A1.eu - PL: D16.eu Numérique Oui Oui Valeur de l’entrée d’impulsion en unités
d’ingénierie

PL:A1.ha - PL: D16.ha Numérique Oui Oui Valeur au format ingénieur d’alarme
haute de l’entrée d’impulsion

PL:A1.hha - PL:
D16.hha

Numérique Oui Oui Valeur au format ingénieur d’alarme
haute-haute (très haute) de l’entrée
impulsion

PL:A1.la - PL: D16.la Numérique Oui Oui Valeur au format ingénieur d’alarme
basse de l’entrée d’impulsion

PL:A1.lla - PL: D16.lla Numérique Oui Oui Valeur au format ingénieur d’alarme
basse-basse (très basse) de l’entrée
d’impulsion
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Données membres FisherROC (suite)

Donnée membre Type Lecture Ecriture Description

PL:A1.rpd - PL: D16.rpd Numérique Oui Oui Période de taux de l’entrée
d’impulsion

Poll Logique Non Oui Expression Lookout qui, quand elle
passe de Faux à Vrai exige que
l’appareil soit interrogé

PollRate Numérique Non Oui Expression Lookout qui détermine
combien de fois interroger l’appareil

SPT1.d1 - SPT32.d20 Numérique Oui Oui Nombre de données du paramètre
Soft point

TNK1.cfl - TNK8.cfl Numérique Oui Non Niveau du liquide actuel dans le
réservoir

TNK1.dis - TNK8.dis Numérique Oui Non Barils évacués du réservoir

TNK1.dla - TNK8.dla Numérique Oui Oui Format ingénieur d’alarme delta du
réservoir

TNK1.lsl - TNK8.lsl Numérique Oui Non Dernier niveau de scanning du
réservoir

TNK1.man - TNK8.man Numérique Oui Oui Entrée manuelle du réservoir ; barils

TNK1.ttl - TNK8.ttl Numérique Oui Non Total de barils évacués du réservoir

TNK1.tvl - TNK8.tvl Numérique Oui Non Volume du réservoir aujourd’hui

TNK1.yvl - TNK8.yvl Numérique Oui Non Volume du réservoir hier

Update Logique Oui Non Signal généré par l’objet qui émet
une impulsion basse chaque fois
qu’il interroge l’appareil

AGA = American Gas Association
MMBTU = Million British Thermal Units (million de kilowattheures)
TCF = Thousand Cubic Feet (terapieds cubiques)
OVR = Overflow (débordement)
PRI = Primary (principal)
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Commentaires Pour lire la valeur brute d’une entrée analogique se trouvant dans le
paquet 9 du module d’E/S de la troisième rampe de montage, entrez
TAGNAME.AI:C9.raw , où

AI:C  9 .raw

Messages d’état

No response within timeout period
(Pas de réponse pendant la temporisation)
Lookout n’a reçu aucune réponse de l’appareil ROC pendant la
temporisation Receive timeout . L’objet Driver peut utiliser le port de
communication, mais quand il interroge l’appareil, il agit comme s’il
n’existait pas : il ne répond pas. Vous devrez peut-être augmenter la
temporisation Receive timeout  pour être sûr que Lookout alloue
suffisamment de temps à la réponse. Vérifiez également les paramètres
de transmission, les connexions des câbles, l’alimentation, les
paramètres de configuration, les paramètres du port de communication et
les adresses d’interrogation.

Message Garbled—Bad CRC
(Message embrouillé : mauvais CRC)
L’objet reçoit une réponse de l’appareil, mais ne peut pas déchiffrer la
réponse parce qu’elle est embrouillée. Vérifiez que tous les appareils
connectés au groupe d’appareils ont des codes uniques. Il se peut que la
dernière partie du message soit coupée avant la fin. Pensez à augmenter
le nombre de tentatives dans Retry attempts . Vous devrez peut-être
augmenter le paramètre port série Receive gap  pour être sûr que
Lookout reçoit le message entier. Si votre port série est configuré pour
radio, cette erreur peut être provoquée par un bruit à la fin de la
transmission radio. Essayez d’ajuster RTS delay off  et CTS timeout .

Type de signal

Rampe de montage (A, B, C ou D)

paramètre

Numéro du paquet (1-16)
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Unexpected data response length
(Réponse trop longue)
L’objet reçoit une réponse de l’appareil, mais la réponse est trop longue.
Vérifiez que tous les appareils connectés au port de communication et
qui partagent le même groupe d’appareils ont des codes uniques. Il se
peut que des appareils avec des adresses identiques essayent de répondre
en même temps. Vérifiez également les paramètres de protocole de
l’appareil.

Response too short
(Réponse trop courte)
L’objet reçoit des données dont la longueur est en dehors de la limite
minimum de la trame. Vérifiez les paramètres de protocole de l’appareil.
Vous devrez peut-être augmenter la valeur Receive timeout .

Return unit address incorrect
Return group address incorrect
(Adresse de retour incorrecte au niveau de l’unité ou du groupe)
L’objet a envoyé une requête de données Ecriture ou Lecture, mais la
station ROC n’a pas répondu. Il se peut que l’adresse mémoire
demandée ne soit pas valable. Revérifiez la configuration de l’adresse
ROC.

Invalid module or point requested
(Module ou point demandé valable)
Les types de données que vous avez demandés ne correspondent pas. Par
exemple, vous avez peut-être tenté d’écrire ou de lire une valeur
analogique d’un/vers un paquet d’E/S d’une rampe où un module discret
est installé ou vice versa. C’est une anomalie d’adresse. Vérifiez que le
type d’E/S du paquet désiré correspond au type de signal de l’adresse
identifiée dans les données membres où vous essayez d’écrire.
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Unexpected opcode in response: xx
(Code op inattendu dans la réponse: xx)
L’objet reçoit une réponse de l’appareil, mais aucune réponse n’était
attendue. Ceci peut survenir si l’objet reçoit une réponse après
l’expiration de la temporisation Receive timeout . Vous devrez peut-être
augmenter la valeur Receive timeout . Ou il se peut que la station ROC
tente une communication non sollicitée. La classe d’objets FisherROC
ne supporte pas actuellement le rapport par exception non sollicité.

Flipflop
Flipflop bascule son signal de sortie logique entre “activé” et
“désactivé” ou vice versa quand le signal Input passe sur High (haut). Le
signal de sortie ne change pas quand le signal passe sur Low (bas). Input
est une expression logique.

Boîte de dialogue des paramètres de définition Flipflop

Données membres Flipflop

Donnée
membre

Type Lecture Ecriture Description

(implicite) Logique Oui Non Etat actuel

Commentaires Flipflop peut être utilisé pour alterner le fonctionnement de deux
pompes. Quand cet objet est connecté à un bouton-poussoir, il sert
d’appareil de contrôle Marche/Arrêt.

Objets associés LatchGate (porte à gachette)
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Gauge
Gauge (jauge) affiche l’expression Signal en format numérique ou dans
un graphe à barres. Les paramètres d’affichage d’un objet Gauge (jauge)
changent selon les valeurs établies dans Conditional expressions .
Gauge détermine les couleurs affichées selon l’ordre et l’état actuel de
vos expressions conditionnelles. Par exemple, si plusieurs expressions
conditionnelles sont VRAI en même temps, Gauge affiche la couleur
associée avec la première expression VRAI.

Boîte de dialogue des paramètres de définition Gauge
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Conditional expressions  et Flash when  sont des expressions logiques
tandis que Signal  est une expression numérique. L’option Fast
commande à l’objet Gauge de clignoter plus rapidement lorsqu’il est
activé que lorsqu’il est désactivé.

Boîte de dialogue des paramètres d’affichage Gauge

Données membres Gauge

Donnée
membre

Type Lecture Ecriture Description

(implicite) Numérique Oui Non Valeur numérique de Gauge

Commentaires Utilisez un objet Gauge quand vous avez besoin d’un graphe à barres ou
d’un affichage numérique pour changer les couleurs et/ou le
clignotement sous certaines conditions. Si vous n’avez pas besoin de ces
fonctions, affichez un graphe à barres ou une valeur numérique à l’aide
de la commande Insert→Expression…
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GE_Series6
GE_Series6 est une classe d’objets Protocol driver (driver de protocole)
qui permet à Lookout de communiquer avec les API GE Series Six™ et
autres équipements qui utilisent des protocoles de communication CCM.
Ce driver considère les configurations point à point et multipoints en
mode CCM et peut être connecté aux modules de contrôle de
communication CCM2 ou CCM3 via les ports série de communication
RS-232 ou RS-422.

Remarque Utilisez un objet Modbus si vous souhaitez communiquer avec un API GE
Série 6 en mode téléterminal.

La classe d’objets GE_Series6 génère automatiquement des structures de
lecture/écriture bloquantes efficaces selon les entrées et les sorties
utilisées dans votre fichier de processus. Vous n’avez donc pas besoin de
créer votre propre table d’E/S. Quand Lookout interroge un appareil, il
optimise l’échange de trames selon la longueur des données exigées et le
temps supplémentaire. La taille maximum des trames de données exigée
par ces drivers est 256 octets de données. Les drivers utilisent la
vérification d’erreurs de parité et LRC pour valider les données.
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PLC Address est une adresse esclave qui se rapporte au paramètre de
l’adresse telle qu’elle est établie sur les interrupteurs Dipswitch de
l’appareil physique. Si les appareils partagent une ligne, ils exigent des
adresses uniques (de 1 à 255).

Model vous permet de choisir entre les modèles API suivants : 60 , 600 ,
6000 , Plus  et Plus II . Si vous utilisez un modèle qui n’est pas sur
la liste, sélectionnez un modèle dont les données ressemblent le plus au
modèle que vous utilisez.

Protocol identifie le protocole de communication que vous utiliserez
pour communiquer avec l’appareil. CCM est actuellement le seul
protocole disponible pour cette classe d’objets.

Serial port spécifie le port de communication utilisé par l’objet pour
communiquer avec l’appareil externe, mais pas le type de
communication. Celui-ci est déterminé par la commande Options→Serial
Ports…

Data rate , Parity , Data bits  et Stop bits  se rapportent aux paramètres de
l’appareil physique.
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Phone number  spécifie le numéro à composer si le port série
sélectionné est configuré pour Dial-up. Ce numéro ne sert que pour
l’objet de protocole individuel.

PollRate est une expression numérique qui détermine la fréquence
d’appel de l’appareil. Lookout convertit la valeur numérique de PollRate
en un signal temporel qui représente les jours et les fractions de jour.
Ensuite, l’objet interroge l’appareil à l’intervalle de temps spécifié. En
général, c’est une simple constante temporelle comme 0:01 (une
seconde). Reportez-vous à la section intitulée Les données membres
numériques, au chapitre 5, pour plus d’informations sur la saisie des
constantes temporelles.

Poll est une expression logique dont le passage de Faux à Vrai provoque
l’appel de l’appareil par Lookout. Ceci peut être une simple expression,
comme le signal d’un bouton-poussoir, ou un algorithme complexe.

Communication alarm priority  détermine le niveau de priorité des
alarmes générées par l’objet. En général, ces alarmes sont associées aux
communications avec l’appareil physique.

Retry attempts spécifie le nombre de tentatives consécutives entreprises
par Lookout pour communiquer avec un appareil qui ne produit pas de
réponse valable. Une fois que l’objet essaie à nouveau d’établir la
communication le nombre de fois spécifié dans Retry attempts , il
génère une alarme et affranchit le port de communication au sous-
système COMSUB de communication qui passe ensuite au prochain
appareil dans la queue d’interrogation (si elle existe). Reportez-vous au
chapitre sur les communications pour plus d’informations.

Receive timeout est la durée pendant laquelle Lookout attend une
réponse d’un appareil avant de renouveler la requête.

Le paramètre Skip every… demande à Lookout de ne pas interroger
l’appareil avec lequel il n’a pas pu établir de communication au cours
des interrogations programmées. Ainsi, Lookout saute cet appareil
pendant le cycle d’interrogation. Une fois que les communications sont
rétablies, l’appareil est interrogé au cours de son cycle normal.
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Cet objet Protocol driver contient de nombreuses données. Les tables de
registre et les tables d’entrées et sorties sont groupées avec l’objet.
Ainsi, dès que vous créez un objet GE_Series6, vous accédez
immédiatement au jeu complet des données membres de cet objet
(reportez-vous à la liste des données membres ci-dessous).

Comme c’est le cas pour tous les drivers de Lookout, vous pouvez
accéder aux points d’E/S et à d’autres données via les données membres.
La table ci-dessous liste les données membres actuellement supportées
par la classe d’objets GE Série 6.

Données membres GE_Series6

Donnée membre Type Lecture Ecriture Description

CommFail Logique Oui Non Signal généré par l’objet qui est actif si, pour une
raison quelconque, Lookout ne peut pas
communiquer avec l’appareil

I1 - I4096 Logique Oui Non Entrées discrètes

O1-O4096 Logique Oui Oui Sorties discrètes

Poll Logique Non Oui Expression Lookout qui exige que l’appareil soit
interrogé quand elle passe de Faux à Vrai

PollRate Numérique Non Oui Expression Lookout qui détermine combien de fois
interroger l’appareil

R1 - R16384 Numérique Oui Oui Signée. Registre 16 bits encodé comme nombre
entier signé s’étendant de -32 767 à +32 768

R1.0 -
R16384.15

Logique Oui Non Bits individuels dans des registres ; lit les valeurs
logiques Marche/Arrêt. Le bit le moins significatif
est 1 et le plus significatif est 15

RD1 - RD16383 Numérique Oui Oui Double. Registre non signé 32 bits ; lit deux
registres adjacents comme un numéro unique 32
bits s’étendant de 0 à 4 294 967 296

RF1 - RF16383 Numérique Oui  Oui Flottante. Registre à virgule flottante IEEE 32 bits ;
lit deux registres adjacents comme valeur à virgule
flottante 32 bits

RU1 - RU16384 Numérique Oui Oui Non signée. Registres 16 bits maintenant des
entiers non signés s’étendant de 0 à 65 535

Update Logique Oui Non Signal généré par l’objet qui émet une impulsion
basse chaque fois qu’il interroge l’appareil
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Les messages d’état

No response within timeout period
(Pas de réponse pendant la temporisation)
Lookout n’a reçu aucune réponse pendant la temporisation Receive
timeout . L’objet a envoyé une requête et a reçu un acquittement, mais
l’appareil n’a pas envoyé de réponse. C’est peut-être parce que la
réponse a été interrompue. Vous devrez peut-être augmenter la
temporisation Receive timeout .

No return inquiry response from secondary unit
(Pas de réponse à la requête faite à l’unité secondaire)
Lookout n’a reçu aucune réponse de l’appareil pendant la temporisation
Receive timeout . L’objet Driver peut utiliser le port de communication,
mais quand il interroge l’appareil, ce dernier agit comme s’il n’existait
pas : il ne répond pas. Vous devrez peut-être augmenter la temporisation
Receive timeout  pour être sûr que Lookout alloue suffisamment de
temps à la réponse. Vérifiez également les paramètres de transmission,
les connexions des câbles, l’alimentation, les paramètres de
configuration, les paramètres du port de communication et les adresses
d’interrogation.

Bad LRC
(Mauvais LRC)
L’objet reçoit une réponse de l’appareil, mais ne peut pas déchiffrer la
réponse parce qu’elle est embrouillée. Vérifiez que tous les appareils
connectés au port de communication ont des adresses uniques. Il se peut
que la dernière partie du message soit coupée avant la fin. Pensez à
augmenter le nombre de tentatives dans Retry attempts . Vous devrez
peut-être augmenter le paramètre port série Receive gap  pour être sûr
que Lookout reçoit le message entier. Si votre port série est configuré
pour radio, cette erreur peut être provoquée par un bruit à la fin de la
transmission radio. Essayez d’ajuster RTS delay off  et CTS timeout .
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No acknowledgment for header frame
(Pas d’acquittement à la trame en-tête)
Vous avez envoyé une requête correcte et des données Ecriture ou
Lecture, mais l’appareil vous ignore. L’objet attendait un acquittement
pour une trame d’instruction et ne l’a pas reçu. Il se peut que l’adresse
de mémoire ne soit pas valable. Revérifiez la configuration de l’adresse
de votre API. Le langage de cette classe d’objets est N Sequence CCM.
Si vous êtes connecté à un port PLC qui est normalement utilisé pour la
programmation, il se peut que le port soit configuré pour le langage K
Sequence CCM. Essayez un autre port si disponible. Sinon, reconfigurez
le port de l’API pour N Sequence CCM.

Invalid request frame
(Trame de requête non valable)
Vous essayez probablement d’utiliser une adresse mémoire non valable.
Revérifiez la configuration de l’adresse de votre API.

GE_Series90
GE_Series90 est une classe d’objets Protocol driver (driver de protocole)
qui permet à Lookout de communiquer avec les contrôleurs de logique
programmable (API) GE Series 90-30 et GE Series 90-70 via SNPX, un
protocole de la série Ninety (90).

Remarque Cette classe d’objets est disponible avec la version 3.6 et ultérieures. Il
n’est pas compatible avec des versions antérieures.
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Boîte de dialogue des paramètres de définition GE_Series90

Paramètres GE_Series90

PLC Address est une adresse esclave qui se rapporte au paramètre de
l’adresse configurée sur l’appareil. L’adresse peut comprendre jusqu’à
huit caractères ASCII.

Model vous permet de choisir entre 90-30 et 90-70.

Interface vous permet de sélectionner le protocole. Le choix est simple
car seul SNPX est actuellement supporté.

Serial port spécifie le port de communication utilisé par l’objet pour
communiquer avec l’appareil externe, mais pas le type de
communication. Celui-ci est déterminé par la commande Options→Serial
Ports….
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Data rate , Parity , Data bits  et Stop bits  se rapportent aux paramètres de
l’appareil physique.

Phone number  spécifie le numéro à composer si le port série
sélectionné est configuré pour Dial-up. Ce numéro ne sert que pour
l’objet de protocole individuel.

PollRate est une expression numérique qui détermine la fréquence
d’appel de l’appareil. Lookout convertit la valeur numérique de PollRate
en un signal temporel qui représente les jours et les fractions de jour.
Ensuite, l’objet interroge l’appareil à l’intervalle de temps spécifié. En
général, c’est une simple constante temporelle comme 0:01 (une
seconde). Reportez-vous à la section intitulée Les données membres
numériques, au chapitre 5, pour plus d’informations sur la saisie de
constantes temporelles.

Poll est une expression logique dont le passage de Faux à Vrai provoque
l’appel de l’appareil par Lookout. Ceci peut être une simple expression,
comme le signal d’un bouton-poussoir, ou un algorithme complexe.

Communication alarm priority  détermine le niveau de priorité des
alarmes générées par l’objet (0-10).

Retry attempts spécifie le nombre de tentatives consécutives entreprises
par Lookout pour communiquer avec un appareil qui ne produit pas de
réponse valable. Une fois que l’objet GE_Series90 essaie à nouveau
d’établir la communication le nombre de fois spécifié dans Retry
attempts , il génère une alarme et affranchit le port de communication au
sous-système COMSUB de communication qui passe ensuite au
prochain appareil dans la queue d’interrogation (si elle existe).
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L’objet met le port de communication à l’état d’arrêt pendant 10
caractères temporels puis annule l’arrêt. Cette annulation exige un 0x00
unique écrit hors du port. Ceci ne se fait pas sur le Lookout 32 bits car le
port est rétabli dès que l’état d’arrêt est annulé (incroyable !). Reportez-
vous au chapitre sur les communications pour plus d’informations.

Receive timeout est la durée pendant laquelle Lookout attend une
réponse d’un appareil avant de renouveler la requête.

Le paramètre Skip every… demande à Lookout de ne pas interroger
l’appareil avec lequel il n’a pas pu établir de communication au cours
des interrogations programmées. Ainsi, Lookout saute cet appareil
pendant le cycle d’interrogation. Une fois que les communications sont
rétablies, l’appareil est interrogé au cours de son cycle normal.

Données membres  GE_Series90

Cet objet Protocol driver contient de nombreuses données. Tous les
membres écris et lus (entrées/sorties), les instructions d’interrogation, la
lecture/écriture bloquante, l’utilisation du port série, etc., sont regroupés
avec l’objet. Ainsi, dès que vous créez un objet GE_Series90, vous
accédez immédiatement au jeu complet des données membres de cet
objet (reportez-vous à la liste des données membres ci-dessous).

Remarque Les objets Protocol driver de Lookout génèrent automatiquement une
structure de lecture/écriture bloquante selon les entrées et les sorties
utilisées par votre fichier de processus. Vous n’avez pas besoin de créer
votre propre table de blocage d’E/S.
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Données membres GE_Series90

Donnée
membre

Type Lecture Ecriture Description

AI1-AI64 Numérique Oui Oui Entrées analogiques 16 bits encodées
comme nombre entiers binaires non signés
s’étendant de 0 à 65 535

AQ1-AQ64 Numérique Oui Oui Sorties analogiques 16 bits encodées
comme nombre entiers binaires non signés
s’étendant de 0 à 65 535

CommFail Logique Oui Non Signal généré par l’objet qui est actif si, pour
une raison quelconque, Lookout ne peut pas
communiquer avec l’API

I1-I512 Logique Oui Non Entrées discrètes à bit unique

Poll Logique Non Oui Expression Lookout qui exige que l’appareil
soit interrogé quand elle passe de Faux à
Vrai

PollRate Numérique Non Oui Expression Lookout qui détermine combien
de fois interroger l’appareil

M1-M1024 Logique Oui Oui Bit unique discret (registre interne)

Q1-Q512 Logique Oui Oui Sorties discrètes à bit unique

R1-R1024 Numérique Oui Oui Registres de maintien 16 bits encodés
comme nombre entiers binaires non signés
s’étendant de 0 à 65 535

Update Logique Oui Non Signal généré par l’objet qui émet une
impulsion chaque fois que le driver interroge
l’appareil

Messages d’état

No response within timeout period
(Pas de réponse pendant la temporisation)
Lookout n’a pas reçu la réponse attendue pendant la temporisation
Receive timeout . L’objet a envoyé une requête et a reçu un
acquittement, mais l’appareil n’a pas envoyé de réponse comme prévu.
La réponse a peut-être été interrompue. Vous devrez peut-être augmenter
la temporisation Receive timeout .
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No return inquiry response from secondary unit
(Pas de réponse à la requête faite à l’unité secondaire)
Lookout n’a reçu aucune réponse de l’appareil pendant la temporisation
Receive timeout . L’objet Driver utilise le port de communication, mais
quand il interroge l’appareil celui-ci agit comme s’il n’existait pas : il ne
répond pas. Vous devrez peut-être augmenter la temporisation Receive
timeout  pour être sûr que Lookout alloue suffisamment de temps à la
réponse. Vérifiez également les paramètres de transmission, les
connexions des câbles, l’alimentation, les paramètres de configuration,
les paramètres du port de communication et les adresses d’interrogation.

Bad LRC or BCC
(Mauvais LRC ou BCC)
L’objet reçoit une réponse de l’appareil, mais ne peut pas la déchiffrer
parce qu’elle est embrouillée. Vérifiez que tous les appareils connectés
au port de communication ont des adresses uniques. Il se peut que la
dernière partie du message soit coupée avant la fin. Pensez à augmenter
le nombre de tentatives dans Retry attempts . Vous devrez peut-être
augmenter le paramètre port série Receive gap  pour être sûr que
Lookout reçoit le message entier. Si votre port série est configuré pour
radio, cette erreur peut être due à un bruit à la fin de la transmission
radio. Essayez d’ajuster RTS delay off  et CTS timeout .

No attach response within timeout period
(Pas de réponse attachée pendant la temporisation)
Le système a essayé d’établir la communication avec l’API mais n’a pas
obtenu de réponse. Vérifiez votre câblage et vos sélections de port de
communication, l’alimentation électrique, les paramètres de
configuration et les adresses d’interrogation.

Invalid response [x]
(Réponse non valable [x])
Une erreur de structure dans une trame de réponse a été détectée. Il se
peut que deux API aient la même adresse.



Chapitre 18. Définitions des classes d’objets

415

Incorrect response length [x]
(Durée de réponse incorrecte [x])
Une réponse de longueur inattendue a été reçue. Vous devrez peut-être
augmenter le paramètre port série dans Receive gap  pour être sûr que
Lookout reçoit le message entier.

Incorrect response Address
(Adresse de réponse incorrecte)
Une réponse a été reçue dont l’adresse ne correspond pas à l’adresse de
l’objet. Deux appareils maîtres sont peut-être sur le réseau.

SNPX ERROR - Major code: x Minor code: x
(ERREUR SNPX - Code majeur : x Code mineur : x)
Le message de réponse contient une erreur de code SNPX. Reportez-
vous à votre documentation GE pour connaître la signification de cette
erreur.

Histogram
La classe d’objets Histogram (histogramme) est l’un des outils de
contrôle du processus statistique (Statistical Process Control : SPC) de
Lookout et peut jouer un rôle important dans le programme du contrôle
total de la qualité (Total Quality Management : TQM)  de votre
entreprise. Cette classe d’objets affiche graphiquement la distribution
et/ou distribution relative d’une valeur de signal. Elle représente la
tendance centrale et la variabilité des données échantillonnées.
Histogram calcule également le rapport d’aptitude du processus (Process
Capability Ratio : PCR), l’intervalle de fiabilité PCR, la moyenne, la
variance et l’écart-type.
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Boîte de dialogue des paramètres de définition Histogram

Sampled signal  identifie la value que vous surveillez statistiquement.
Histogram lit et classifie la valeur Sampled signal toutes les fois que
Sample trigger passe d’Arrêt à Marche.

Vous pouvez soit classifier avec Categorize  tous les échantillons depuis
que le palier Reset  est passé d’Arrêt à Marche, soit classifier avec
Categorize  une fenêtre glissante des 2-1000 échantillons les plus
récents.

Bin Settings vous permet de définir le nombre dans Number  de
rubriques désirées. La différence entre Minimum  et Maximum  détermine
la largeur de chaque conteneur ou rubrique.

Les paramètres pour le graphe Histogram ci-dessous demandent huit
conteneurs. Etant donné que la différence entre Minimum et Maximum
est de 80 et qu’il y a huit conteneurs, chaque intervalle de classe aura
une gamme de 10 (80 / 8 conteneurs = 10). Donc conteneur1 contient des
valeurs d’échantillons s’étendant de zéro à moins de 10 ; conteneur2

contient des valeurs d’échantillons s’étendant de 10 à moins de 20, etc.

Conteneur0 (donnée membre f0 ) contient toutes les valeurs
d’échantillons inférieures au Minimum  et conteneur9 contient toutes les
valeurs d’échantillons supérieures ou égales à Maximum .
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Ce graphe a été créé en insérant dix diagrammes à barres d’expressions
numériques (données membres f0 à f9 comme indiqué) et deux échelles.

LSL et USL identifient les limites inférieure et supérieure de
spécification. En général, ces limites définissent la gamme des valeurs
d’échantillons acceptables. Histogram utilise LSL  et USL pour calculer
les rapports d’aptitude du processus (PCR et PCRk).

Le palier Confidence level  vous permet d’exprimer avec quel degré de
certitude ou de probabilité la valeur PCR actuelle (rapport de l’aptitude
du processus) tombe dans l’intervalle de fiabilité (c’est-à-dire, entre
PCRL et PCRU). Une valeur typique est 95 pour cent. Plus le niveau
Confidence level  est bas, plus l’intervalle est étroit.

f1

f3

f4

f6 f8 f9f7
f5

f2

f0

Distribution actuelle de la fréquence

conteneur 8

maximumminumum

conteneur 1
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Remarque Histogram n’a pas de boîte de dialogue des paramètres d’affichage.
Cependant, vous pouvez facilement afficher le résultat de ses signaux de
sortie en les invoquant dans des expressions.

Données membres Histogram

Donnée membre Type Lecture Ecriture Description

f0 - f201 Numérique Oui Non Fréquence des valeurs des signaux
échantillonnés faisant partie du
conteneur identifié

LSL Numérique Oui Non Limite inférieure de spécification

mean Numérique Oui Non Moyenne des valeurs
échantillonnées, où

x

x

n

i
i

n

= =
∑

1

PCR Numérique Oui Non Rapport de la capacité du processus
mesurant l’uniformité ou la variabilité
du signal échantillonné utilisant des
limites de spécification supérieure et
inférieure. Ce rapport mesure
l’aptitude potentielle. Si l’écart-type =
0, PCR = 0. Sinon

PCR
USL LSL= −

6σ
PCRk Numérique Oui Non Rapport unilatéral de la capacité du

processus pour processus décentré.
Ce rapport prend en compte le
centrage du processus, mesurant la
capacité réelle.

PCR
x LSL USL x

K = − −





min ,
3 3σ σ

PCRL Numérique Oui Non Limite inférieure de l’intervalle de
fiabilité

PCRU Numérique Oui Non Limite supérieure de l’intervalle de
fiabilité
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Données membres Histogram (suite)

Donnée membre Type Lecture Ecriture Description

rf0 - rf201 Numérique Oui Non Fréquence relative (pourcentage) des
valeurs des signaux échantillonnés
faisant partie des conteneurs
identifiés

samples Numérique Oui Non Nombre de valeurs de signaux
échantillonnés, n

sdev Numérique Oui Non Echantillon de l’écart-type, où

( )
σ =

−

−
=
∑ x x

n

i
i

n 2

1

1
USL Numérique Oui Non Limite de spécification supérieure

variance Numérique Oui Non Echantillon de variance, où

( )
σ 2

2

1

1
=

−

−
=
∑ x x

n

i
i

n

Commentaires L’intervalle de fiabilité est la gamme des valeurs déterminée par les
limites PCRL et PCRU.

Objets associés XBarR, Average (moyenne), Maximum, Minimum, Sample (échantillon)

Fonctions ass. Avg, Max, Min, Stdev, Stdevp, Sum, Var, Varp
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e   HyperTrend ™

Un objet HyperTrend affiche un graphe de tendance sur un panneau de
contrôle où il trace toutes les courbes de tendance logiques et
numériques.

Les objets HyperTrend assurent l’accès immédiat aux données en temps
réel et historiques dans un seul graphe. Chaque ligne de tracé représente
ces deux types de données côte à côte en une seule ligne ininterrompue.
Pour plus d’informations, reportez-vous à la section intitulée
L’enregistreur de la base de données historique Citadel, au chapitre 11.

Ces objets font un gros plan des axes X et Y, ce qui assure l’ajustement
dynamique des résolutions verticales et horizontales de chaque tracé sur
le graphe. Vous pouvez utiliser cette fonction pour faire le zoom d’une
zone donnée de la tendance.

Le graphe défile de droite à gauche et les signaux actuels sont tracés en
temps réel sur le bord droit du graphe.

Une barre d’outils permet d’avancer ou de reculer dans le temps le
graphe de tendance. Elle fournit un accès immédiat aux données qui ne
sont plus affichées à l’extrémité gauche du graphe (c’est-à-dire, les
données historiques stockées dans la base de données Citadel).

La barre d’outils comprend des flèches de défilement, un bouton curseur,
la date, l’heure, un feu rouge/vert. Les flèches de défilement  vous
permettent de reculer et d’avancer dans le temps ; la taille des flèches est
proportionnelle au fil du temps. Les flèches de défilement fonctionnent
également comme une glissière horizontale. Cliquez dessus et déplacez
la souris de gauche à droite tout en maintenant enfoncé le bouton de la
souris. Plus vous éloignez le curseur du point mort et plus la tendance
défile vite dans cette direction.

Barre d’outils
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Les indicateurs date et l’heure vous permettent de choisir un mois, un
jour, une heure, une minute ou une seconde. Si vous cliquez sur la partie
inférieure de l’heure, par exemple, le graphe recule d’une heure.

Si vous cliquez sur la partie supérieure de l’heure, le graphe avance
d’une heure.

La méthode est la même pour les mois, les jours, les années, les minutes
et les secondes.

Le feu rouge/vert sur la barre d’outils est rouge ou vert. Un feu vert
indique que le bord droit de la fenêtre de tendance est l’heure actuelle,
qui, bien sûr, change sans cesse.

Quand vous reculez dans le temps ou que vous cliquez sur le feu quand il
est vert, il devient rouge et indique que la tendance est temporairement
gelée. La date et l’heure apparaissent dans la barre d’outils indiquant
l’heure exacte à droite de la fenêtre de tendance. Les données et l’heure
changent à mesure que vous reculez ou avancez dans le temps.

Si vous cliquez sur le feu quand il est rouge, la tendance revient au
présent et commence à défiler pendant qu’elle trace les valeurs en temps
réel.

Remarque La base de données Citadel continue d’enregistrer des données sans
tenir compte de l’état de HyperTrend. Vous ne perdez pas de données
quand Citadel est en mode “historique” (c’est-à-dire, quand HyperTrend
ne défile pas en temps réel).

Point mort

Flèches de défilement

Bouton curseur

Feu
rouge/vert
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Quand vous cliquez sur le bouton  curseur , une barre curseur verticale
apparaît au centre du graphe avec la boîte de dialogue Curseur associée.
La boîte de dialogue indique la valeur de chaque courbe de tendance à
l’emplacement du curseur. A mesure que vous glissez la barre curseur de
gauche à droite sur le graphe de tendance, les valeurs du panneau local
changent pour indiquer le nouvel emplacement du curseur.

Vous pouvez sélectionner le format d’affichage des valeurs de la courbe
de tendance dans le menu de contrôle de la boîte de dialogue.

Boîte de dialogue Curseur pour HyperTrend

Time  indique l’emplacement actuel de la barre du curseur. Les boutons
d’incrémentation/de décrémentation à côté du champ vous permettent de
déplacer le curseur de gauche à droite dans le graphe de tendance.
Sélectionnez la taille du mouvement par incréments en cliquant sur la
partie désirée de la date et de l’heure. La portion de l’heure est
sélectionnée dans l’exemple ci-dessus ; chaque fois que vous cliquez sur
le bouton incrémentation/décrémentation, la barre curseur recule ou
avance d’une heure. Il en est de même pour la date et l’heure.

La zone déroulante Find  vous permet de rechercher une rupture dans la
courbe de tendance, le pic ou le creux d’un signal ou une valeur précise.
Par exemple, vous pouvez savoir quand a eu lieu la dernière instance de
dépassement de la limite du contrôle du processus. Pour ce faire,
sélectionnez la courbe de tendance souhaitée en cliquant dessus dans la
liste défilante, puis choisissez Value  dans la zone déroulante Find ,
entrez la valeur désirée et appuyez sur le bouton de défilement arrière.

Glissez la barre curseur vers la
gauche et vers la droite pour voir
les valeurs désirées.

Cliquez sur l’icône du menu de
contrôle pour changer le format
numérique.

Cliquez sur les boutons
d’incrémentation/de
décrémentation
pour déplacer le curseur.

Cliquez sur les boutons arrière et
avant pour trouver les valeurs
recherchées.

Sélectionnez le signal
pour la recherche des
valeurs.
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La boîte de dialogue de définition de HyperTrend est illustrée ci-après.

Boîte de dialogue HyperTrend

Trend width  est l’étendue temporelle par défaut de l’axe X du graphe.
Les graphes peuvent avoir une largeur, ou une étendue temporelle, par
défaut de n’importe quelle valeur entre deux secondes et quatre ans. La
valeur Trend width  par défaut dans la boîte de dialogue de l’exemple
indique une étendue temporelle de 1:00:00, soit une heure. Reportez-
vous à la section intitulée Les données membres numériques, au chapitre
5, pour plus d’informations sur la saisie des constantes temporelles.
Après avoir créé l’objet HyperTrend, vous pouvez ajuster la largeur de la
tendance en connectant un signal numérique aux données membres
TrendWidth  de l’objet.

L’option Show button bar  vous permet de cacher ou de montrer la barre
d’outils de tendance sur le panneau de contrôle. Vous pouvez afficher la
barre d’outils de façon dynamique en connectant un signal logique aux
données membres UseButtonBar .

Les paramètres Trendlines permettent d’ajouter, de modifier ou
d’effacer des expressions du graphe de tendance. En général, ces
expressions représentent des valeurs à enregistrer dans la base de
données Citadel. Reportez-vous aux chapitres 5 et 11 pour plus
d’informations sur l’enregistrement de données dans la base de données
Citadel. Entrez les expressions logiques et numériques à tracer dans le
champ de données à droite du bouton Accept. Sélectionnez Logical ou
Numeric pour correspondre au résultat de l’expression actuelle.

Line color  spécifie la couleur de la courbe de tendance pour l’expression
actuelle.
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Les paramètres Minimum et Maximum déterminent où sera tracée
l’expression sur le graphe de tendance. Minimum  correspond au bas du
graphe tandis que Maximum correspond au haut, quelle que soit la
gamme de l’expression. Ces paramètres créent une échelle verticale
imaginaire et affectent indépendamment chaque expression.

Par exemple, prenez deux expressions numériques qui s’étendent de 0 à
50. Réglez les paramètres Minimum et Maximum sur 0 et 100 pour la
première expression et sur -50 et 50 pour la seconde. La première
expression est tracée dans la moitié inférieure du graphe tandis que la
seconde expression est tracée dans la moitié supérieure, bien que les
deux varient entre 0 et 50.

Cette figure montre l’échelle imaginaire de la première expression (où min.=0
et max.=100). Vu que l’expression s’étend de 0 à 50, elle est tracée dans la
moitié inférieure du graphe.

Ce graphe HyperTrend
n’affiche pas sa barre
d’outils
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Cette figure montre l’échelle imaginaire de la seconde expression (où min. .=-
50 et max.=50). Vu que l’expression s’étend de 0 à 50, elle est tracée dans la
moitié supérieure du graphe.

Entrer les deux expressions dans un seul graphe de tendance produit
l’effet suivant. Notez les échelles personnalisées ajoutées à chaque
extrémité du graphe.

Si vous sélectionnez Logical comme type d’expression, les paramètres
minimum et maximum changent en Position  et Height . Ces deux valeurs
représentent maintenant un chiffre entre 0 % et 100 % et déterminent
l’emplacement de la ligne de base de la courbe de tendance ainsi que la
hauteur de son unité quand l’expression passe à Vrai.
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Position = 10 et Hauteur = 10 pour ce tracé d’une valeur logique

Après avoir entré ou modifié les paramètres de la courbe de tendance,
appuyez sur le bouton Accept, ce qui ajoute l’expression dans la liste
Trendlines . Utilisez le bouton Delete pour enlever l’expression actuelle
du graphe de tendance. Les boutons Previous et Next vous permettent de
basculer dans une liste de toutes les expressions étiquetées pour l’objet
de tendance actuel.

Notez qu’un numéro est affecté à chaque courbe de tendance. Après
avoir créé l’objet HyperTrend, vous pouvez faire en sorte que les
paramètres Minimum et Maximum de chaque courbe de tendance
numérique et les paramètres Position  et Height  de courbe de tendance
logique soient réglables en connectant des signaux numériques aux
données membres Max, Min , Pos et Height  de l’objet. Vous pouvez,
par exemple, connecter un potentiomètre à Max1 pour que le haut du
graphe soit réservé à Trendline 1.

Vous pouvez afficher des graphes de tendance HyperTrend en plusieurs
couleurs, différents styles de ligne temporelle et pas de grille, comme
indiqué en page suivante.

Timeline labels  détermine où et comment la date et l’heure sont
affichées sur le graphe de tendance.

Major increments spécifie le nombre de lignes horizontales épaisses
dans un graphe de tendance. Cette valeur est indépendante de la gamme
des expressions de tendance.
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Boîte de dialogue des paramètres d’affichage HyperTrend

Minor increments spécifie le nombre de lignes horizontales fines entre
les grandes lignes de grille d’augmentation dans un graphe de tendance.
Cette valeur est indépendante de la gamme des expressions de tendance.

Données membres HyperTrend

Donnée
membre

Type Lecture Ecriture Description

Height1 -
Height999

Numérique Oui Oui Spécifie l’amplitude ou la hauteur de la
courbe de tendance identifiée (distance
depuis la ligne de base) quand
l’expression logique passe à Vrai. La
hauteur doit se situer entre 2 et (100
moins la position)

Max1 -
Max999

Numérique Oui Oui Spécifie le haut du graphe pour la courbe
de tendance numérique identifiée (la
valeur de la courbe sous tendance quand
elle est 100 pourcent de l’axe Y)

Min1 - Min999 Numérique Oui Oui Spécifie le bas du graphe pour la courbe
de tendance numérique identifiée (la
valeur de la courbe sous tendance quand
elle est 0 pourcent de l’axe Y)

Pos1 - Pos999 Numérique Oui Oui Spécifie l’emplacement de la ligne de
base pour la courbe de tendance logique
identifiée. La position de la ligne de base
doit s’étendre de 1 à 98 (pos1 est
associée avec la courbe de tendance 1)
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Données membres HyperTrend (suite)

Donnée
membre

Type Lecture Ecriture Description

TrendWidth Numérique Oui Oui Spécifie l’étendue temporelle couverte
par l’axe X de la tendance

UseButtonBar Logique Oui Oui Quand la valeur est Vrai, la barre d’outils
de HyperTrend devient visible sur le
panneau de contrôle. Quand c’est Faux,
elle est invisible. La valeur par défaut est
Vrai

Visible Logique Oui Oui Quand la valeur est Vrai, HyperTrend
devient visible sur le panneau de
contrôle. Quand c’est Faux, cet objet est
invisible. La valeur par défaut est Vrai

Commentaires Les objets HyperTrend accèdent aux données de la base de données
Citadel. Pensez à ces objets comme à des “fenêtres” donnant sur votre base
de données historique. Même si vous n’avez pas spécifié un point de
données précis à enregistrer dans la base de données, vous pouvez évoquer
son nom de variable dans un objet HyperTrend. Dans ce cas, Lookout
maintient automatiquement le nom de variable dans la base de données
Citadel pendant au moins deux fois l’étendue temporelle du graphe de
tendance. Par exemple, si votre largeur trend width  est 1:00:00 (1 heure),
Lookout maintient automatiquement au moins les deux dernières heures de
données dans la base de données historique ; même si le nom de variable
n’a pas été spécifié pour stockage dans Citadel. Reportez-vous aux
chapitres 5 et 11 pour plus d’informations sur la spécification d’un point à
enregistrer dans la base de données Citadel.

Les HyperTrend peuvent être mis à jour une fois par seconde, selon la
résolution de l’écran, la taille du graphe et le paramètre width  de la
tendance. Les ordinateurs munis d’adaptateurs d’affichage plus lents
peuvent ralentir considérablement les affichages d’un grand graphe de
tendance. Pour les machines à cartes d’affichage lent (sans coprocesseur
pour graphes), limitez la taille de vos HyperTrend à moins d’un quart de
l’écran.

Vous pouvez afficher un nombre illimité de courbes de tendance sur un
HyperTrend particulier.
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Integral
Integral est un “totalisateur” qui additionne le signal numérique Input .
Cette classe d’objets sert normalement à totaliser un débit mesuré.

Boîte de dialogue des paramètres de définition Integral

Input est l’expression numérique que vous souhaitez totaliser ou
intégrer.

Update peut être une expression logique ou une constante numérique. Si
vous spécifiez Update en tant que constante numérique, cette option
crée un compteur d’impulsion interne dont la période d’impulsion est
spécifiée et la durée d’impulsion est zéro. Reportez-vous à la section
intitulée Les données membres numériques, au chapitre 5, pour plus
d’informations sur la saisie des constantes temporelles. Si vous
spécifiez Update en tant que variable logique, la variable émet une
impulsion à la fréquence désirée.

L’expression Update provoque l’extrapolation d’un total temporaire à
partir du total actuel et de la valeur Input la plus récente. Le total
temporaire est ensuite envoyé comme sortie du totalisateur. Le total est
calculé selon une technique d’intégration numérique trapézoïdale.
Ensuite, il est corrigé chaque fois que le signal entrant est rafraîchi.

Time unit est une expression numérique qui sert de base à l’unité de
temps du signal Input. Par exemple, si la vitesse Input est exprimée en
unités de gallons par minute, l’unité de temps doit être entrée comme
étant une minute (1:00) pour que le débit totalisé soit exprimé en
gallons. Normalement, l’unité de temps est une seconde (0:01), une
minute (1:00), une heure (1:00:00), ou un jour (1:00:00:00), mais vous
pouvez spécifier n’importe quelle unité, telle que 5:23 (une vitesse de
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changement en unités Input toutes les cinq minutes et 23 secondes).

Reset est une expression logique qui rétablit la valeur du totalisateur à
zéro quand elle passe de Marche à Arrêt.

Remarque Integral n’a pas de boîte de dialogue pour les paramètres d’affichage.
Cependant, vous pouvez facilement afficher le résultat de son signal de
sortie en évoquant ses données membres dans une expression.

Données membres Integral

Donnée membre Type Lecture Ecriture Description

(implicite) Numérique Oui Non Valeur totalisée

Commentaires L’impulsion Update fait que le total calculé continue de changer entre
les mises à jour du signal Input. Par exemple, si un téléterminal à
distance qui surveille le débit est interrogé toutes les dix minutes,
l’impulsion Update peut être établie sur cinq secondes afin que
l’opérateur puisse voir le débit totalisé changer continuellement sur
l’écran en tant que valeur extrapolée. La valeur totalisée révisée est
calculée chaque fois que le signal Input est rafraîchi ; dans ce cas-là,
toutes les dix minutes.

Si des valeurs totalisées sont enregistrées tous les jours dans une feuille
de calcul, par exemple, et que le total doit être remis à zéro en fin de
journée, utilisez l’impulsion de mise à jour générée par l’objet
Spreadsheet (feuille de calcul) pour remettre à zéro le total, ceci pour
garantir l’enregistrement du total avant la remise à zéro. L’exemple de la
page précédente totalise le débit horaire pour l’enregistrement permanent
des données par un objet Spreadsheet (feuille de calcul) nommé
HourlySheet. Notez que l’impulsion de mise à jour de la feuille de calcul
sert à remettre à zéro le totalisateur.

Objets associés Accumulator (accumulateur), Counter (compteur), Derivative (dérivé)
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e   Interpolate
La classe d’objets Interpolate (insertion) exécute une interpolation
linéaire entre un jeu de coordonnées X,Y pour déterminer la sortie d’une
entrée particulière. Un simple objet Interpolate (insertion) peut contenir
jusqu’à 1 000 paires de coordonnées. Bien que cette classe d’objets
puisse être utilisée pour tout calcul à interpolation linéaire, elle est
particulièrement utile pour les applications Tank Strapping.

Boîte de dialogue des paramètres de définition Interpolate

Le diagramme suivant représente la fonctionnalité de base de l’objet
Interpolate (insertion) et du jeu de paires de coordonnées telles qu’elles
sont enregistrées ci-dessus.

En se basant sur la représentation graphique de notre objet, il est facile
de voir comment différentes entrées X produisent les sorties Y
correspondantes. Notez également qu’une entrée X de 5,5 produit une
sortie Y de 2,5, bien que notre dernière paire de coordonnées soit (5,3).
Lookout utilise l’extrapolation linéaire aux deux points extrêmes, la
pente étant déterminée par les deux dernières paires de coordonnées.
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(0,1)
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Entrées (X)

Sorties (Y)

Les champs du paramètre New entry  permettent d’ajouter, de modifier et
d’effacer des paires de coordonnées Input(x)  et Output(y) . Input(x)  et
Output(y)  sont des paramètres numériques. A mesure que vous ajoutez
de nouvelles paires de coordonnées X, Y, une barre de défilement
apparaît dans la liste défilante des entrées quand le nombre d’entrées
dépasse la taille de la liste.

Input format  et Output format  définissent le format numérique des
paires de coordonnées Input(x)  et Output(y)  affichées dans la boîte de
dialogue de définition.

Sort order (inputs)  spécifie si la boîte de dialogue liste des paires de
coordonnées X,Y en ordre croissant Increasing  ou décroissant
Decreasing . Le type de triage n’affecte pas les calculs de sortie ou les
valeurs des données membres écrites de l’objet.

Paire de
coordonnées X,Y
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Input(x) multiplier  et Output(y) multiplier  sont des expressions
numériques. Ces deux paramètres sont utiles pour les calculs élaborés
comme ceux des applications Tank Strapping. Ils servent aux facteurs de
température, de pression, de densité et de correction du produit. Comme
leurs noms l'indiquent, Lookout multiplie la valeur Input/Output
correspondante par le multiplicateur associé. Si nous spécifions Input(x)
multiplier , l’objet multiplie l’entrée par le multiplicateur approprié
avant de calculer la sortie interpolée. Si nous spécifions Output(y)
multiplier , l’objet multiplie une sortie temporaire par le multiplicateur
approprié avant de calculer la valeur de sortie finale.

Etudions un simple exemple utilisant le diagramme ci-dessus pour mieux
comprendre le principe. Utilisez un Input(x) multiplier  de 1,5 et un
Output(y) multiplier  de 2. Supposez que l’entrée variable soit
actuellement de 2. L’objet commence par multiplier 2 par 1,5 pour
rendre 3. Ensuite, il utilise nos paires de coordonnées pour trouver la
valeur de sortie correspondant à l’entrée de 3. Notre sortie temporaire est
donc 3,5. Mais puisque nous avons spécifié un multiplicateur de sortie, il
doit d’abord multiplier 3,5 par 2 pour fournir une sortie finale de 7.

Il se peut que vous souhaitiez que des entrées multiples passent par un
seul objet Interpolate, résultant en sorties multiples. Lookout connecte
plusieurs entrées à un seul objet et lit les sorties correspondantes au lieu
de créer un objet Interpolate pour chaque entrée. Les entrées sont des
données membres écrites (X0-X999). Chaque entrée a sa propre sortie
lisible (Y0-Y999 respectivement). Dans le diagramme ci-dessous, nous
connectons un signal numérique nommé TankLevel  à une entrée, X0.
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L’objet Interpolate (insertion) multiplie maintenant l’entrée X0 par
Input(x) multiplier , recherche les paramètres des deux paires de
coordonnées qui comprennent X0, effectue l’interpolation et multiplie la
sortie temporaire par Output(y) multiplier . Ensuite, il envoie le résultat
à la donnée membre lisible Y0.

Remarque La classe d’objets Interpolate n’a pas de boîte de dialogue des
paramètres d’affichage. Cependant, vous pouvez afficher facilement le
résultat de ses signaux de sortie en évoquant ses données membres
dans les expressions.

Données membres Interpolate

Donnée membre Type Lecture Ecriture Description

X0-X999 Numérique Oui Oui Valeur d’entrée

Y0-Y999 Numérique Oui Oui Valeur de sortie. Pour une entrée
donnée, Xn, l’objet produit le résultat
de l’interpolation comme valeur
correspondante Yn

Commentaires Si vous souhaitez effectuer l’interpolation d’une autre entrée avec les
mêmes paramètres et multiplicateurs de la paire de coordonnées (c’est-à-
dire, le même objet Interpolate), connectez-vous à une autre entrée telle
que X23 et lisez sa sortie correspondante, Y23.

Vu que les données membres Xn et Yn sont sujettes à la lecture et à
l’écriture, l’objet peut également exécuter une interpolation
bidirectionnelle. Par exemple, nous pouvons connecter un signal
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numérique à une donnée membre Yn et lire la donnée membre Xn
interpolée correspondante. Prenons en exemple une anomalie dans le
lien d’un réservoir. Normalement, vous utilisez le niveau d’un réservoir
comme entrée à X0 et lisez la sortie interpolée Y0 en tant que volume
correspondant du réservoir. Ainsi, nous commençons avec un niveau et
terminons avec un volume. Mais si vous voulez surveiller le volume et
utiliser cette valeur pour calculer un niveau correspondant, notre objet
Interpolate doit être bidirectionnel. Si Y0 change, l’objet divise Y0 par
le multiplicateur Output(y), s’insère entre les deux paramètres Output(y)
les plus proches, calcule une valeur d’entrée correspondante en se basant
sur les deux paramètres Input(x) les plus proches, la divise par le
multiplicateur Input(x) et force la valeur résultante de la donnée membre
X0.

Interval
Interval est une horloge de temporisation ajustable. Quand un signal
On/off signal  est activé, l’horloge Timer delay commence le comptage
décrémental. A la fin du comptage de temporisation, le signal de sortie
est désactivé. Si le signal On/off signal  est abandonné, le signal de sortie
est désactivé et l’horloge est remise à zéro.

Timer delay s’étend de 0,0 seconde à plusieurs années et la résolution
effective est de 0,1 seconde sur toute la gamme. L’affichage de l’horloge
représente de façon numérique la durée de temporisation restante ; il est
mis à jour environ une fois par seconde. Si On/off signal  est bas, ou la
période de temporisation expire, l’affichage indique “off” (Arrêt).

Boîte de dialogue des paramètres de définition Interval
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On/off signal  est une expression logique tandis que Timer delay  est une
expression numérique. Lookout convertit la valeur numérique de Timer
delay  en un signal temporel qui représente les jours et les fractions de
jour. C’est, en général, une simple constante temporelle comme 0:20,
c’est-à-dire vingt secondes. Reportez-vous à la section intitulée Les
données membres numériques, au chapitre 5, pour plus d’informations
sur la saisie des constantes temporelles.

Boîte de dialogue des paramètres d’affichage Interval

Données membres Interval

Donnée membre Type Lecture Ecriture Description

(implicite) Logique Oui Non Valeur logique d’horloge

Commentaires L’horloge Interval peut servir à appliquer une durée maximum du
fonctionnement d’une pompe.

Objets associés DelayOff, DelayOn, OneShot, Pulse, TimeOf
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e   Junction
Junction reçoit jusqu’à neuf valeurs numériques et chacune peut être le
résultat d’une expression numérique complexe. Cet objet produit la
valeur du dernier paramètre Additional input  qui a changé
(événementiel). Notez, cependant, qu’il ne produit pas de valeur si
Initializing input  ne change pas. Ensuite, tout changement d’entrée
s’affiche immédiatement.

Boîte de dialogue des paramètres de définition Junction

Données membres Junction

Donnée
membre

Type Lecture Ecriture Description

(implicite) Numérique Oui Non La valeur de l’entrée la plus récemment
changée

Commentaires Junction est l’une des rares classes d’objets à n’utiliser qu’en de rares
occasions.

Objets associés Aucun
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$Keyboard
L’objet $Keyboard est un objet global dont les données membres
représentent les touches des fonctions du clavier. A la différence
d’autres classes d’objets où vous pouvez créer plusieurs objets d’une
même classe, vous ne pouvez pas créer ou effacer d’objets $Keyboard,
mais vous pouvez utiliser celui qui est fourni.

L’objet global $Keyboard évoque un panneau de contrôle particulier,
active une séquence en lots ou acquitte les alarmes quand vous appuyez
sur une touche.

Les données membres $Keyboard (représentant les touches de fonctions
sur le clavier) agissent comme les boutons-poussoirs de Lookout. Vous
connectez une donnée membre $Keyboard à la donnée membre active
d’un panneau de la même façon que vous connectez un bouton-poussoir
à la donnée membre active d’un panneau. La figure ci-dessous illustre
cette connexion :

Boîte de dialogue Edit Connections

L’expression logique $Keyboard.F1  affiche Panel1 toutes les fois
qu’un utilisateur appuie sur la touche F1 du clavier. Des connexions
similaires peuvent être faites à d’autres panneaux ou vous pouvez
connecter un panneau différent à chaque touche de fonction.
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Vous pouvez connecter également une touche de fonction à un
déclencheur de processus de traitement par lots. Quand la touche est
enfoncée, (c’est-à-dire, quand la donnée membre $Keyboard passe à
Vrai) le lot est activé : d’où la lecture des ingrédients du lot à partir d’un
objet Recipe (recette), l’ouverture et la fermeture de valves, le
démarrage de mélangeurs, la mise en bouteille du produit final, etc.

Vous pouvez aussi connecter une touche de fonction à l’acquittement
d’un objet $Alarm.ack, pour acquitter des alarmes par simple frappe
d’une touche.

$Keyboard contient 72 données membres lisibles, chacune représentant
une séquence de touches unique, comme indiqué dans le tableau suivant.

Données membres $Keyboard

Donnée
membre

Type Lecture Ecriture Description

F1

à

F24

Logique Oui Non Chacune de ces 24 données membres
représente une touche de fonction de F1 à
F24. Une donnée membre particulière rend
une valeur logique Vrai quand sa touche de
fonction est enfoncée et Faux quand la
touche n’est plus enfoncée

Shift-F1

à

Shift-F24

Logique Oui Non Chacune de ces 24 données membres
représente une touche de fonction de F1 à
F24, quand elle est enfoncée simultanément
avec la touche MAJ. Une donnée membre
particulière rend une valeur logique Vrai
quand la touche MAJ et la touche de fonction
sont enfoncées simultanément et Faux quand
les touches ne sont plus enfoncées

Ctrl-F1

à

Ctrl-F24

Logique Oui Non Chacune de ces 24 données membres
représente une touche de fonction de F1 à
F24, quand elle est enfoncée simultanément
avec la touche Ctrl. Une donnée membre
particulière rend une valeur logique Vrai
quand la touche Ctrl et la touche de fonction
sont enfoncées simultanément et Faux quand
les touches ne sont plus enfoncées
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Commentaires Les touches de fonctions $Keyboard sont globales. Toutes les fois que
vous appuyez sur F1, le signal $keyboard.F1 passe à Vrai sans tenir
compte du panneau affiché. Si vous souhaitez qu’une touche de fonction
ne serve que pour un seul panneau, utilisez la donnée membre de touche
de fonction de la classe d’objets Panel (panneau). Reportez-vous à la
définition de la classe d’objets Panel, au chapitre 18, pour plus
d’informations.

Objets associés Pushbutton

LatchGate
LatchGate bascule entre Marche et Arrêt par deux signaux d’entrée. Il
maintient l’état du signal le plus récemment passé à haut, sans tenir
compte de l’état de l’autre signal. Quand le signal Turn Off  passe de
Marche à Arrêt, la sortie de LatchGate est inactive jusqu’à ce que le
signal Turn On  passe d’Arrêt à Marche. Le signal de sortie ne change
pas quand l’un des deux signaux d’entrée passe de Marche à Arrêt. Turn
Off  et Turn On  sont des expressions logiques.

Boîte de dialogue des paramètres de définition LatchGate
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Données membres LatchGate

Donnée
membre

Type Lecture Ecriture Description

(implicite) Logique Oui Non Valeur du signal de sortie logique

Commentaires Deux boutons-poussoirs connectés aux expressions Turn On  et Turn Off
de LatchGate créent des contrôles de démarrage et d’arrêt du bouton-
poussoir pour une pompe ou tout autre appareil.

Objets associés Flipflop

Maximum
L’objet Maximum calcule activement la valeur maximale de Data au fil
du temps. Il n’est actif que si l’expression Enable est Vrai et se remet à
zéro quand l’expression Reset passe d’Arrêt à Marche. Maximum
maintient également un répertoire contenant jusqu’à 35 valeurs
maximales précédentes. Si le champ Enable est vide, l’objet calcule
toujours le maximum. Data est une expression numérique tandis que
Reset et Enable sont des expressions logiques.

Remarque Maximum n’a pas de boîte de dialogue des paramètres d’affichage.
Cependant, vous pouvez facilement afficher Maximum en l’évoquant
dans une expression.
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Donnée
membre

Type Lecture Ecriture Description

(implicite) Numérique Oui Non Valeur maximale actuelle

1 - 35 Numérique Oui Non Valeurs maximales précédentes. Signal 1 est
le maximum précédent le plus récent depuis
que l’expression Reset est passée à haut

DataReset Logique Non Oui Au passage de Faux à Vrai, toutes les
données membres se remettent à zéro, y
compris la valeur maximale actuelle et les
valeurs maximales précédentes

Commentaires L’intervalle Reset peut être un intervalle régulier d’impulsion créé par
un compteur TimeOfxxxx, de façon à ce que l’impulsion soit
synchronisée avec le début de l’heure ou de la journée. Par exemple, si
vous souhaitez calculer le débit quotidien maximal, utilisez le signal de
sortie d’un compteur TimeOfDay ou un objet Spreadsheet (feuille de
calcul) quotidien pour remettre à zéro le calcul maximum au début de
chaque jour.

Objets associés Minimum, Average (moyenne), Sample (échantillon), SampleText
(échantillon de texte)

Minimum
L’objet Minimum calcule la valeur minimale de Data au fil du temps. Il
n’est actif que si l’expression Enable est Vrai et se remet à zéro quand
l’expression Reset passe d’Arrêt à Marche. Minimum maintient
également un répertoire contenant jusqu’à 35 valeurs minimales
précédentes. Si le champ Enable est vide, l’objet calcule toujours le
minimum. Data est une expression numérique tandis que Reset et
Enable sont des expressions logiques.
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Remarque Minimum n’a pas de boîte de dialogue des paramètres d’affichage.
Cependant, vous pouvez facilement afficher Minimum en l’évoquant dans
une expression.

Donnée
membre

Type Lecture Ecriture Description

(implicite) Numérique Oui Non Valeur minimale actuelle

1 - 35 Numérique Oui Non Valeurs minimales précédentes. Signal 1
est le minimum précédent le plus récent
depuis que l’expression Reset est passée à
haut

DataReset Logique Non Oui Au passage de Faux à Vrai, toutes les
données membres se remettent à zéro, y
compris la valeur minimale actuelle et les
valeurs minimales précédentes

Commentaires L’intervalle Reset peut être un intervalle régulier d’impulsion créé par
un compteur TimeOfxxxx, de façon à ce que l’impulsion soit
synchronisée avec le début de l’heure ou de la journée. Par exemple, si
vous souhaitez calculer le débit quotidien minimal, utilisez le signal de
sortie d’un compteur TimeOfDay ou un objet Spreadsheet quotidien
pour remettre à zéro le calcul minimum au début de chaque jour.

Objets associés Maximum, Average, Sample, SampleText
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Modbus  
ModbusMOSCAD

Modbus™ et ModbusMOSCAD sont des classes d’objets Protocol driver
(driver de protocole) qui permettent à Lookout de communiquer avec des
équipements tels que les automates programmables industriels (API), des
téléterminaux à distance ou tout autre équipement doté de protocoles de
communication Modbus Serial (ASCII ou téléterminal) ou Modbus Plus.

La classe d’objets Modbus contient des adresses d’usage général,
comme le registre de maintien 40001, et sert à communiquer avec
presque tous les appareils Modbus, y compris le téléterminal TeleSAFE®

de Control Microsystems.

La classe d’objets ModbusMOSCAD fonctionne avec les API et les
téléterminaux Motorola MOSCAD. Elle utilise également le protocole
de communication Modbus Serial (ASCII ou téléterminal) ou Modbus
Plus, bien que ses données membres reflètent l’adresse des appareils
MOSCAD de Motorola.

Ces objets Protocol driver contiennent de nombreuses données. Tous les
membres lisibles et écrits (entrées/sorties), les instructions
d’interrogation, la lecture/écriture bloquante, l’utilisation des ports série,
etc., sont groupés avec l’objet. Ainsi, dès que vous créez un objet
Modbus ou ModbusMOSCAD, vous accédez immédiatement à toutes les
données membres de cet objet (reportez-vous à la liste des données
membres ci-dessous).

Remarque Les objets Protocole driver de Lookout génèrent automatiquement une
structure efficace de lecture/écriture bloquante selon les entrées et les
sorties utilisées dans votre fichier de processus. Vous n’avez pas besoin
de créer votre propre table de blocage d’E/S.

En tant que drivers de protocole, les deux classes d’objets suivent les
spécifications dans le manuel de référence Modicon Modbus Protocol
Reference Guide PI-MBUS-300 Rev. C. Les drivers supportent les
modes de transmission ASCII et téléterminal, ainsi que Modbus Plus.
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Dans cet exemple, Lookout est connecté à un API de langage Modbus avec une
adresse de 5. Nous utilisons le port série 1 (configuré pour des communications
Hardwired) et interrogeons l’appareil chaque dixième de seconde.

Paramètres Modbus

Modbus Serial  indique que le langage de l’appareil esclave est Modbus
ASCII ou Modbus téléterminal. Quand vous sélectionnez cette option,
Lookout tente d’abord de communiquer en format téléterminal. Si cette
tentative échoue, il continue en format ASCII (un peu plus lent). Si votre
réseau a souvent des problèmes de communication et s’ils ralentissent
considérablement le scanning, vous devrez peut-être empêcher Lookout
d’utiliser les deux formats. Certes, ceci accélérera les tentatives de
communication de Lookout mais ne résoudra pas pour autant les
problèmes. Appelez National Instruments pour apprendre comment
empêcher Lookout d’essayer de communiquer dans les deux formats.

Modbus Plus Network  indique que l’appareil esclave est connecté à
l’ordinateur Lookout via une carte de réseau Modbus Plus.
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Remarque Le logiciel de gestion de réseau basé NetBIOS utilise normalement
l’interruption de logiciel 5C. C’est également l’interruption de logiciel par
défaut qu’utilise le driver de carte Modbus Plus Network. Si vous ne
pouvez pas utiliser Modbus Plus et Windows pour Workgroups
simultanément, il existe probablement un conflit d’interruption de
logiciels. Changez l’interruption du logiciel Modbus Plus de 5C à 5D, 5E,
ou 5F. Reportez-vous à votre documentation Modicon pour des
instructions sur la modification des paramètres d’interruption de logiciel.

Si vous sélectionnez Modbus Serial , vous devez spécifier Address ,
Serial Port , Data Rate , Parity , Data Bits  et Stop Bits . Si vous utilisez
un modem Dial-up connecté à votre port de communication, vous devez
spécifier également un numéro à composer dans Phone Number .

Si vous sélectionnez Modbus Plus Network , vous ne devez spécifier
que l’adresse de l’appareil à distance dans Address .

Address est une adresse esclave et se rapporte au paramètre d’adresse
de l’API ou du téléterminal établi sur les interrupteurs Dipswitch de
l’appareil physique. Si les appareils utilisent la même ligne, ils doivent
avoir des adresses uniques (1 à 255).

Serial port spécifie le port de communication que l’objet utilise pour
communiquer avec l’appareil externe, mais ne spécifie pas le type de
communication. Le type de communication est déterminé par la
commande Options→Serial Ports…

Data rate , Parity , Data bits  et Stop bits  se rapportent aux paramètres de
l’appareil du matériel.

Le bouton Defaults remet les paramètres actuels à leurs valeurs par
défaut.

Alarm priority  détermine le niveau de priorité des alarmes générées par
Modbus.

Phone number  spécifie le numéro à composer si le port série
sélectionné est configuré pour Dial-up. Ce numéro ne sert que pour
l’objet Protocol individuel.
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PollRate est une expression numérique qui détermine la fréquence
d’appel de l’appareil. Lookout convertit la valeur numérique de PollRate
en un signal temporel qui représente les jours et les fractions de jour.
Ensuite, Modbus interroge l’appareil à l’intervalle de temps spécifié. En
général, c’est une simple constante temporelle comme 0:01 (une
seconde). Reportez-vous à la section intitulée Les données membres
numériques, au chapitre 5, pour plus d’informations sur la saisie des
constantes temporelles.

Poll est une expression logique dont le passage de Faux à Vrai provoque
l’appel de l’appareil par Lookout. Ceci peut être une simple expression,
comme le signal d’un bouton-poussoir, ou un algorithme complexe.

Retry attempts spécifie le nombre de tentatives consécutives entreprises
par Lookout pour communiquer avec un appareil qui ne produit pas de
réponse valable. Une fois que l’objet essaie à nouveau d’établir la
communication le nombre de fois spécifié dans Retry attempts , il
génère une alarme et affranchit le port de communication au sous-
système COMSUB de communication qui passe ensuite au prochain
appareil dans la queue d’interrogation (si elle existe). Reportez-vous au
chapitre sur les communications pour plus d’informations.

Receive timeout est la durée pendant laquelle Lookout attend une
réponse d’un appareil avant de renouveler la requête.

Les paramètres Advanced Modbus

Le driver Modbus essaie de bloquer les lectures et écritures des registres,
et des registres d’entrées et de maintien en groupes afin d’optimiser
l’efficacité des communications. Via la boîte de dialogue Advanced
Modbus Options, vous pouvez contrôler les tailles maximales de blocs
que le driver utilise. En fait, si votre appareil ne supporte pas les tailles
de blocs par défaut, vous devrez peut-être spécifier des blocs plus petits.

Le bouton Advanced… invoque la boîte de dialogue Advanced Modbus
Options et personnalise des options spécifiques au sein du protocole
Modbus.
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La classe d’objets Modbus utilise les codes de fonction Modbus 01, 02,
03, 04, 05, 06, 15 et 16 ; elle s’attend à ce que l’appareil d’E/S à distance
supporte ces codes tels que spécifiés par Modbus. Le driver peut
communiquer avec 247 appareils esclaves Modbus sur chaque port série.

Les paramètres Maximum values per message  spécifient le maximum
d’éléments que Lookout essaie de lire (fc 1 -fc 4 ) ou d’écrire (fc 15 et fc
16) en un seul message Modbus. Les valeurs par défaut représentent le
maximum d’éléments que le protocole peut transmettre en un seul
message et fournissent la vitesse optimale. Cependant, certains appareils
ne peuvent pas traiter le maximum d’éléments ; dans ce cas, vous devez
établir les valeurs spécifiées dans la documentation fournie avec ces
appareils.

Si l’option Immediately write outputs est ON (activée), Lookout
interroge immédiatement l’appareil toutes les fois qu’une valeur change.
Si cette option est OFF (désactivée), Lookout attend la prochaine
interrogation programmée pour écrire les valeurs modifiées.

Le paramètre Skip every… demande à Lookout de ne pas interroger
l’appareil avec lequel il n’a pas pu établir de communication au cours
des interrogations programmées. Ainsi, Lookout saute cet appareil
pendant le cycle d’interrogation. Une fois que les communications sont
rétablies, l’appareil est interrogé au cours de son cycle normal.
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L’option Daniel option dépend de l’appareil et demande à Lookout de
traiter les registres de maintien comme des valeurs flottantes IEEE 32
bits au lieu de valeurs 16 bits. Si vous établissez cette variable, vous
devez également régler votre appareil pour qu’il traite les registres de
maintien comme des valeurs 32 bits flottantes. La plupart des appareils
ne supportent pas cette option contrairement aux téléterminaux Bristol-
Babcock et aux compteurs de flux Daniel.   

Remarque Activer l’option Daniel option désactive toutes les données membres du
registre de maintien Modbus (sur cet appareil) sauf pour 40001-49999 et
4000001-465000. Si vous essayez de lire D40001, par exemple, la valeur
rendue est 0 et Lookout n’essaie pas d’écrire D40001 vers le
téléterminal. Bien entendu, dans le cas des appareils qui ne supportent
pas cette option, vous pouvez toujours lire et écrire deux registres de
maintien adjacents comme valeur à virgule flottante avec les données
membres Modbus F40001-F4999. En fait, cette solution est plus usitée
que l’option Daniel car vous pouvez aussi lire des bits et des valeurs de
mot hors des registres de maintien.

Modbus 32-bit floating point order  vous permet de sélectionner si les
caractères dans les registres à virgule flottante (données membres
F40001-F49999 et F400001-F465000) sont en format “petit endian” ou
“grand endian”. Quand cette option est sélectionnée, Lookout utilise le
format petit endian, conformément à certains API Modicon Quantum.
Ceci signifie que le premier caractère transmis est l’octet le plus
significatif (MSB) et que le dernier caractère transmis est l’octet le
moins significatif (LSB), comme indiqué ci-dessous.

Format petit endian (option sélectionnée) :

00001011 01110001 01011100 11011011

Quand cette option est désélectionnée, Lookout utilise le format grand
endian. Ceci signifie que le premier caractère transmis est le moins
significatif (LSB) et que le dernier caractère transmis est le plus
significatif (MSB), comme indiqué ci-dessous.

LSBMSB

Premier caractère
transmis
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Format grand endian (option désélectionnée) :

00001011 01110001 01011100 11011011

Les statistiques du protocole Modbus

Le driver surveille les statistiques du protocole Modbus. Ces données
sont contenues au sein des données membres lisibles de l’objet Modbus
et vous pouvez les voir dans la boîte de dialogue Modbus Protocol
Statistics. Pour afficher la boîte de dialogue, sélectionnez
Options→Modbus… et cliquez sur Statistics…

Remarque L’option Options→Modbus… n'est visible dans le menu Options que si un
objet Modbus a déjà été créé dans votre application Lookout.

La colonne Count contient le total des messages reçus de l’appareil
sélectionné dans Device qui appartiennent à chacune des rubriques
depuis la dernière fois que le bouton Reset a été enfoncé. La colonne de
pourcentages (%) indique le pourcentage des messages reçus qui
appartiennent à chaque rubrique depuis la dernière fois que le bouton
Reset a été enfoncé.

LSBMSB

Premier caractère
transmis
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Quand vous relâchez le bouton Reset, la donnée membre ResetCounts
passe à Vrai. De ce fait, toutes les valeurs statistiques sont remises à
zéro. Lookout enregistre la date et l’heure de la dernière remise à zéro
dans le champ de données Since last reset .

Les données membres Modbus

La classe d’objets Modbus supporte les adresses à 5 et 6 chiffres. Quand
vous utilisez une adresse à 6 chiffres, le chiffre à l’extrême gauche
représente le type d’adresse suivant :

Codage des adresses à 6 chiffres

Premier chiffre Type d’adresse

0 Registres à bit
unique

1 Entrées discrètes

3 Registres
d’entrées

4 Registres de
maintien

Les 5 chiffres restants représentent l’adresse actuelle du registre ou du
registre d’entrée ou de maintien.

Remarque Quand vous évoquez l’adresse 000001 et l’adresse 1, vous évoquez le
même point, mais 40001 et 040001 ne se rapportent pas au même point.
Etant donné que zéro est le chiffre à l’extrême gauche de l’adresse à 6
chiffres, 040001 se rapporte au registre à bit unique 40001er et 40001 se
rapporte au premier registre de maintien.
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Données membres Modbus

Donnée membre Type Lecture Ecriture Description
000001 - 065000 Logique Oui Oui Adresses à 6 chiffres des registres à bit

unique
1 - 9999 Logique Oui Oui Registres à bit unique
10001 - 19999 Logique Oui Non Entrées discrètes à bit unique
100001 - 165000 Logique Oui Non Adresses à 6 chiffres d’entrées

discrètes à bit unique
30001 - 39999 Numérique Oui Non Registres d’entrées 16 bits encodés

comme nombres entiers binaires non
signés s’étendant de 0 à 65 535

300001 - 365000 Numérique Oui Non Adresses à 6 chiffres de registres
d’entrées16 bits encodés comme
nombres entiers binaires non signés
s’étendant de 0 à 65 535

40001 - 49999 Numérique Oui Oui Registres de maintien 16 bits encodés
comme entiers binaires non signés
s’étendant de 0 à 65 535

400001 - 465000 Numérique Oui Oui Registres de maintien 16 bits encodés
comme entiers binaires non signés
s’étendant de 0 à 65 535

40001.1 -
49999.16

Logique Oui Oui Accès aux bits individuels hors des
registres de maintien et lecture comme
valeur logique Marche/Arrêt. Le bit le
moins significatif est 1 et le plus
significatif 16

400001.1 -
465000.16

Logique Oui Oui Adresse à 6 chiffres pour accéder aux
bits individuels hors des registres de
maintien et lecture comme valeur
logique Marche/Arrêt. Le bit le moins
significatif est 1 et le plus significatif 16

BadCRC Numérique Oui Non Nombre de réponses de l’appareil dont
le message n’a pas réussi la
vérification de redondance cyclique
(CRC) ou la vérification de redondance
longitudinale (LRC)
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Données membres Modbus (suite)

Donnée membre Type Lecture Ecriture Description
BCD30001 -
BCD39999

Numérique Oui Non Registres d’entrées 16 bits encodés
comme nombres entiers décimaux à
code binaire s’étendant de 0 à 9 999

BCD300001 -
BCD365000

Numérique Oui Non Adresses à 6 chiffres de registres
d’entrées 16 bits encodés comme
nombres entiers décimaux à code
binaire s’étendant de 0 à 9 999

BCD40001 -
BCD49999

Numérique Oui Oui Registres de maintien16 bits encodés
comme nombres entiers décimaux à
code binaire s’étendant de 0 à 9 999

BCD400001 -
BCD465000

Numérique Oui Oui Adresses à 6 chiffres de registres de
maintien 16 bits encodés comme
entiers décimaux à code binaire
s’étendant de 0 à 9 999

CommFail Logique Oui Non Signal généré par le driver qui est
activé si, pour quelque raison que ce
soit, Lookout ne peut pas communiquer
avec l’appareil

D400001 -
D465000

Numérique Oui Oui Adresses à 6 chiffres du registre de
maintien 32 bits non signés ; lit deux
registres de maintien adjacents comme
un numéro 32 bits s’étendant de 0 à 4
294 967 296

D40001 -
D49999

Numérique Oui Oui Registre de maintien 32 bits non
signés ; lit deux registres de maintien
adjacents comme un numéro 32 bits
s’étendant de 0 à 4 294 967 296

Exceptions Numérique Oui Non Nombre de réponses de l’appareil dont
le message était compris par le driver
mais qui indiquait un code d’erreur de
l’appareil

F40001 -
F49999

Numérique Oui Oui Registre à virgule flottante IEEE 32
bits ; lit deux registres de maintien
adjacents comme une valeur à virgule
flottante unique 32 bits
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Données membres Modbus (suite)

Donnée membre Type Lecture Ecriture Description
F400001 -
F465000

Numérique Oui  Oui Adresses à 6 chiffres de registre à
virgule flottante IEEE 32 bits ; lit deux
registres de maintien adjacents comme
une valeur à virgule flottante unique 32
bits

Garbled Numérique Oui Non Nombre de réponses de l’appareil dont
le message n’était pas compris par le
driver

NoResponse Numérique Oui Non Nombre d’interrogations générées par
le driver sans réponse de l’appareil

OffHook Logique Non Oui Quand Vrai, cette variable dicte à l’objet
Modbus de maintenir un usage exclusif
du port de communication affecté

Poll Logique Non Oui Expression de Lookout qui, passant de
Faux à Vrai, provoque l’interrogation de
l’appareil

PollRate Numérique Non Oui Expression de Lookout qui détermine la
fréquence d’interrogation de l’appareil

ProtocolErrors Numérique Oui Non Nombre total de messages incorrects
reçus de l’appareil interrogé

ResetCounts Logique Non Oui Remet à zéro le nombre dans les
données membres suivantes :
ValidFrame, NoResponse, TooShort,
BadCRC, Garbled, Exceptions et
ProtocolErrors

S40001 -
S49999

Numérique Oui Oui Registres de maintien 16 bits encodés
comme entiers binaires signés
s’étendant de -32 767 à +32 768

S400001 -
S465000

Numérique Oui Oui Adresses à 6 chiffres de registres de
maintien 16 bits encodés comme
entiers binaires signés s’étendant de
-32 767 à +32 768

TooShort Numérique Oui Non Nombre de réponses de l’appareil dont
le message était trop court
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Données membres Modbus (suite)

Donnée membre Type Lecture Ecriture Description
Update Logique Oui Non Signal généré par le driver qui émet

une impulsion chaque fois que le driver
interroge l’appareil

ValidFrame Numérique Oui Non Nombre de messages corrects reçus
de l’appareil interrogé

Commentaires Utilisez la donnée membre OffHook pour améliorer les communications
quand vous utilisez la classe d’objets Modbus avec des modems Dial-up.
Quand OffHook est Vrai et que le port série est relié à un modem Dial-
up, l’objet Modbus ne raccroche pas le modem si l’interrogation est
achevée, mais garde “décroché” le téléphone et l’usage exclusif du port
série. Tant que OffHook est Vrai, l’objet Modbus continue à interroger
le même API sans raccrocher le modem.

Dès que OffHook passe à Faux, l’objet renvoie le port série au
COMSUB, qui passe à la prochaine requête d’interrogation de la queue
si elle existe. L’objet libère également le port si la communication des
données est interrompue pour quelque raison que ce soit (par exemple, si
le mode de l’API rompt la connexion).

Quand vous utilisez OffHook, pensez à définir la valeur PollRate de
l’objet driver pour que les interrogations soient rapides quand OffHook
est Vrai et normales quand OffHook est Faux. Pour ce faire, vous pouvez
relier un objet Switch (booléen) à la donnée membre écriture OffHook.
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Les données membres ModbusMOSCAD

Données membres ModbusMOSCAD

Donnée membre Type Lecture Ecriture Description
AI0r0c0-
AI30r255c7

Numérique Oui Non Chaque adresse représente une entrée
analogique 16 bits encodée comme nombre
entier non signé s’étendant de 0 à 65 535

AO0r0c0-
AO30r255c7

Numérique Oui Oui Chaque adresse représente une sortie
analogique 16 bits encodée comme nombre
entier non signé s’étendant de 0 à 65 535

DI0r0c0.0-
DI30r255c7.15

Logique Oui Non Chaque adresse représente une entrée
discrète individuelle lue comme valeur logique
Marche/Arrêt. Le bit le moins significatif est 0
et le plus significatif est 15

DO0r0c0.0-
DO30r255c7.15

Logique Non Oui Chaque adresse représente une entrée
discrète individuelle lue comme valeur logique
Marche/Arrêt. Le bit le moins significatif est 0
et le plus significatif est 15

BadCRC Numérique Oui Non Nombre de réponses de l’appareil dont le
message n’a pas réussi la vérification de
redondance cyclique (CRC) ou la vérification
de redondance longitudinale (LRC)

CommFail Logique Oui Non Signal généré par le driver qui est activé si,
pour quelque raison que ce soit, Lookout ne
peut pas communiquer avec l’appareil

Exceptions Numérique Oui Non Nombre de réponses de l’appareil dont le
message était compris par le driver mais qui
indiquait un code d’erreur de l’appareil

Garbled Numérique Oui Non Nombre de réponses de l’appareil dont le
message n’était pas compris par le driver

NoResponse Numérique Oui Non Nombre d’interrogations générées par le
driver sans réponse de l’appareil
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Données membres ModbusMOSCAD (suite)

Donnée membre Type Lecture Ecriture Description
Poll Logique Non Oui Expression de Lookout qui, passant

de Faux à Vrai, provoque
l’interrogation de l’appareil

PollRate Numérique Non Oui Expression de Lookout qui détermine
la fréquence d’interrogation de
l’appareil

ProtocolErrors Numérique Oui Non Nombre total de messages incorrects
reçus de l’appareil interrogé

ResetCounts Logique Non Oui Remet à zéro le nombre dans les
données membres suivantes :
ValidFrame, NoResponse, TooShort,
BadCRC, Garbled, Exceptions et
ProtocolErrors

TooShort Numérique Oui Non Nombre de réponses de l’appareil
dont le message était trop court

Update Logique Oui Non Signal généré par le driver qui émet
une impulsion chaque fois que le
driver interroge l’appareil

ValidFrame Numérique Oui Non Nombre de messages corrects reçus
de l’appareil interrogé

Commentaires Pour spécifier l’adresse d’une entrée analogique située dans la rangée
22, colonne 1 de la table 12, entrez AI12r22c1, où

AI 12 r22 c1

Type de signal

Numéro de table

Numéro de colonne dans la table

Numéro de rangée dans la table
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ModbusSlave
ModbusSlave est une classe d’objets qui permet à Lookout d’agir
comme esclave d’équipements tels que les API, les systèmes de
contrôle/commande distribués (SDC) ou tout autre appareil agissant
comme maître du Modbus. L’objet ModbusSlave permet à Lookout de
répondre aux messages non sollicités générés par d’autres appareils sur
un réseau à protocole Modbus.

Les applications comprennent :

• Les API et/ou téléterminaux appellent une application Lookout sur
une ligne non dédiée quand une alarme ou un événement doit être
signalé (rapport par exception non sollicité).

• Deux programmes Lookout communiquent par radio. Un programme
utilise un objet Modbus et l’autre utilise un objet ModbusSlave.

• Lookout, directement relié à un réseau Modbus, répond aux
interrogations d’un SDC en tant qu’esclave Modbus.

Prenez l’objet ModbusSlave comme un API virtuel dans Lookout. Il peut
lire et écrire sur un réseau à protocole Modbus. Tout comme l’objet
Modbus, l’objet ModbusSlave contient une collection de données
membres lisibles et écrites, créées quand vous définissez l’objet
ModbusSlave.

Vous pouvez créer un objet unique ModbusSlave pour chaque API
“maître”, ou vous pouvez créer un objet unique ModbusSlave pour
plusieurs API maîtres. Dans ce cas, un maître peut écrire sur un groupe
de registres dans l’objet ModbusSlave et un autre maître peut écrire sur
un autre groupe de registres dans l’objet ModbusSlave.
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Address est un chiffre (de 1 à 255) qui évoque l’adresse occupée par cet
objet ModbusSlave. Quoique cet objet n’existe que dans le logiciel, les
autres appareils physiques ne le savent pas. Ils communiquent avec cet
objet via une ligne de communication physique et ont besoin de l’adresse
de l’esclave.

Serial port spécifie le port de communication de l’API que le maître
Modbus utilise pour communiquer avec ModbusSlave dans Lookout.

Data rate , Parity , Data bits  et Stop bits sont les paramètres de
l’appareil maître du matériel.

Le bouton Defaults remet les paramètres actuels à leurs valeurs par
défaut.

Données membres ModbusSlave

Donnée
membre

Type Lecture Ecriture Description

1 - 9999 Logique Oui Oui Registres à bit unique
10001 - 19999 Logique Oui Oui Entrées discrètes à bit unique
30001 - 39999 Numérique Oui Oui Registres d’entrées 16 bits encodés

comme entiers binaires non signés
s’étendant de 0 à 65 535
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Données membres ModbusSlave (suite)

Donnée
membre

Type Lecture Ecriture Description

40001 - 49999 Numérique Oui Oui Registres de maintien 16 bits encodés
comme nombres entiers binaires non
signés s’étendant de 0 à 65 535

BCD30001 -
BCD39999

Numérique Oui Oui Registres d’entrées 16 bits encodés
comme nombres entiers décimaux à code
binaire s’étendant de 0 à 9 999

BCD40001 -
BCD49999

Numérique Oui Oui Registres de maintien 16 bits encodés
comme nombres entiers décimaux à code
binaire s’étendant de 0 à 9 999

D40001 -
D49999

Numérique Oui Oui Registre de maintien 32 bits non signés ;
lit deux registres de maintien adjacents
comme un numéro 32 bits s’étendant de
0 à 4 294 967 296

F40001 -
F49999

Numérique Oui  Oui Registre à virgule flottante IEEE 32 bits ;
lit deux registres de maintien adjacents
comme une valeur à virgule flottante
unique 32 bits

H40001.f1 -
H49999.f16

Logique Oui Oui Accès aux bits individuels hors des
registres de maintien et lecture comme
valeur logique Marche/Arrêt. Le bit le
moins significatif est F1 et le plus
significatif F16

S40001 -
S49999

Numérique Oui Oui Registres de maintien 16 bits encodés
comme nombres entiers binaires signés
s’étendant de -32 767 à +32 768
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Multistate
Multistate affiche différents graphiques sur un panneau de contrôle selon
les valeurs de Conditional expressions . Jusqu’à six fichiers Graphic
files sont permis avec un minimum d’un. Multistate détermine le
graphique à afficher selon l’ordre et l’état actuel de vos expressions
Conditional expressions . Si plusieurs Conditional expressions sont
Vrai simultanément, Multistate affiche le graphique associé avec la
première expression Vrai.

Conditional expressions doit produire des valeurs logiques (Vrai ou
Faux). Reportez-vous au chapitre Graphiques pour plus d’informations
sur la sélection des fichiers Graphic files  et l’utilisation de Pixels
transparents .
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Données membres Multistate

Donnée
membre

Type Lecture Ecriture Description

Aucune Les objets Multistate (multi-états) n’ont pas de
données membres

Commentaires Pour des images graphiques représentant une séquence d’événements,
Multistate peut servir à créer des séquences animées sur les panneaux de
contrôle comme les pistons hydrauliques qui montent et qui descendent.
En général, Multistate sert pour les voyants lumineux tricolores, où vert
représente le fonctionnement, rouge représente l’arrêt et jaune représente
un échec, par exemple.

e   Neutralzone
Neutralzone est un contrôleur Marche/Arrêt. Il agit comme le thermostat
de climatisation d’une maison. Si la température dépasse un certain
niveau, la donnée membre supérieure passe à Vrai (démarre la
climatisation) et quand elle est en dessous d’une température plus basse,
la donnée membre inférieure passe à Vrai (arrête la climatisation).

Quand la valeur d’entrée Signal est supérieure aux seuils Low limit  et
High limit , la donnée membre supérieure est activée et la donnée
membre inférieure est désactivée. Quand la valeur d’entrée Signal est
inférieure aux seuils Low limit  et High limit , la donnée membre
supérieure est désactivée et la donnée membre inférieure est activée. Les
données membres supérieure et inférieure ne changent pas d’état quand
la valeur du signal est comprise entre les deux seuils (dans l’hystérésis).
Signal , High limit  et Low limit sont des expressions numériques.
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Boîte de dialogue des paramètres de définition Neutralzone

Nous avons sélectionné ci-dessus une constante numérique pour les deux
seuils. Cependant, nous aurions pu utiliser des signaux de consigne
variable des objets Pot pour que l’opérateur puisse régler le
comportement de l’hystérésis de façon dynamique.

Remarque Neutralzone n’a pas de boîte de dialogue des paramètres d’affichage.
Cependant, vous pouvez facilement afficher le résultat des signaux de
sortie de Neutralzone en évoquant ses données membres dans une
expression.

Données membres Neutralzone

Donnée
membre

Type Lecture Ecriture Description

supérieure Logique Oui Non Activé si le signal est supérieur aux deux seuils,
désactivé si le signal est inférieur aux deux
seuils, ne change pas s’il se trouve entre les
deux seuils

inférieure Logique Oui Non Activé si le signal est inférieur aux deux seuils,
désactivé si le signal est supérieur aux deux
seuils, ne change pas s’il se trouve entre les
deux seuils

Commentaires Vous pouvez utiliser cet objet pour activer et désactiver des pompes et
pour ouvrir et fermer des valves selon les lignes de pression ou les
niveaux dans les réservoirs. Neutralzone évite que le cyclage des pompes
se base sur une consigne unique, de la même façon que votre thermostat
empêche que la climatisation démarre et s’arrête continuellement.
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Le terme “zone morte ” est souvent abusivement utilisé pour indiquer
une hystérésis. En fait, les zones mortes représentent le nombre de
changements qu’une valeur numérique doit traverser en sens inverse
avant que la valeur numérique de sortie ne commence à changer.

OneShot
OneShot est une horloge de temporisation ajustable. Quand un signal
On/off signal  est activé, le signal de sortie passe à Vrai et l’horloge
Timer delay commence le comptage décrémental. A la fin du comptage
décrémental, le signal de sortie passe à Faux.

A la différence de l’horloge Interval, la sortie de l’horloge OneShot reste
active pendant la durée de Timer delay quand On/off signal passe à
Faux. Ainsi, une horloge OneShot ne demande qu’un signal momentané
pour démarrer la période Timer delay . Impulser On/off signal  pendant
la période de temporisation n’augmente pas la période de temporisation
de l’horloge OneShot.

Boîte de dialogue des paramètres de définition OneShot

On/off signal  est une expression logique tandis que Timer delay  est une
expression numérique. Lookout convertit la valeur numérique de Timer
delay en un signal temporel qui représente les jours et les fractions de
jour. C’est, en général, une simple constante temporelle comme 0:20,
c’est-à-dire vingt secondes. Reportez-vous à la section intitulée Les
données membres numériques, au chapitre 5, pour plus d’informations
sur la saisie des constantes temporelles.

Timer delay peut s’étendre de 0,0 seconde à plusieurs années. La
résolution efficace est 0,1 seconde sur toute la gamme.
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L’objet est représenté sur un panneau de contrôle par l’affichage de la
temporisation restante dans le format défini par le paramètre Display
format . Il est mis à jour environ une fois par seconde. Si la
temporisation expire, “off ” s’affiche.

Boîte de dialogue des paramètres d’affichage OneShot

Données membres OneShot

Donnée
membre

Type Lecture Ecriture Description

(implicite) Logique Oui Non Valeur logique de l’horloge

Commentaires Utilisez l’horloge OneShot pour garder ouverte une valve pendant une
période déterminée une fois qu’un bouton-poussoir est enfoncé, ou pour
empêcher les démarrages successifs trop fréquents d’une pompe.

Objets associés DelayOff, DelayOn, Interval, Pulse, TimeOf
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Optomux
Optomux™ est une classe d’objets Protocol driver (driver de protocole)
qui permet à Lookout de communiquer avec les appareils d’E/S Opto 22
et tout équipement utilisant le protocole de communication Optomux.

Cet objet Protocol driver utilise le protocole Optomux 2 voies sans parité
et avec huit bits de données et zéro bits d’arrêt. Il vous permet de
sélectionner entre les modes de correction d’erreur CRC16 et BCC ainsi
que le débit de données.

Plusieurs appareils physiques Optomux peuvent avoir une configuration
cascadée ou multipoints sur un réseau ASCII. Avec Lookout, vous créez
un seul objet Optomux qui représente tous les appareils connectés au
même port de communication.

Un objet Optomux contient de nombreuses données. Il représente tous
les appareils et ses canaux associés. Il supporte la lecture et l’écriture de
tous les types de points de données prédéfinis, y compris l’entrée
analogique, l’entrée discrète, la sortie analogique, la sortie discrète, le
compteur, l’option bascule, l’option sans bascule et la température.
Quand vous créez un objet Optomux, vous accédez immédiatement à
toutes les données membres de l’objet (reportez-vous à la liste des
données membres ci-dessous).
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Serial port spécifie le port que l’objet utilise pour communiquer avec
l’appareil externe, mais pas le type de communication. Celui-ci est
déterminé par la commande Options→Serial Ports….

Protocol Select  spécifie le type de mode de correction d’erreurs utilisé
par le téléterminal. Le mode Enhanced  utilise la vérification d’erreurs
CRC16. Le mode Standard  utilise BCC (parité horizontale). Le mode
Enhanced est le mode par défaut recommandé.

Data rate  indique le débit en bauds que Lookout utilise pour
communiquer avec l’appareil physique. Ce paramètre doit correspondre
à la sélection effectuée sur l’appareil physique.

Phone number spécifie le numéro à composer si le paramètre port série
est configuré pour Dial-up. Ce numéro ne s’applique qu’à l’objet de
protocole individuel.

PollRate est une expression numérique qui détermine la fréquence
d’appel de l’appareil. Lookout convertit la valeur numérique de PollRate
en un signal temporel qui représente les jours et les fractions de jour.
Ensuite, l’objet interroge l’appareil à l’intervalle de temps spécifié. En
général, c’est une simple constante temporelle comme 0:01 (une
seconde). Reportez-vous à la section intitulée Les données membres
numérique, au chapitre 5, pour plus d’informations sur la saisie des
constantes temporelles.
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Poll est une expression logique dont le passage de Faux à Vrai provoque
l’appel de l’appareil par Lookout. Ceci peut être une simple expression,
comme le signal d’un bouton-poussoir, ou un algorithme complexe.

Communication alarm priority  détermine le niveau de priorité des
alarmes générées par l’objet Optomux. En général, ces alarmes sont
associées aux communications avec l’appareil physique.

Retry attempts spécifie le nombre de tentatives consécutives entreprises
par Lookout pour communiquer avec un appareil qui ne produit pas de
réponse valable. Une fois que l’objet essaie à nouveau d’établir la
communication le nombre de fois spécifié dans Retry attempts , il
génère une alarme et affranchit le port de communication au sous-
système COMSUB de communication qui passe ensuite au prochain
appareil dans la queue d’interrogation (si elle existe). Reportez-vous au
chapitre sur les communications pour plus d’informations.

Receive timeout est la durée pendant laquelle Lookout attend une
réponse d’un appareil avant de renouveler la requête.

Le paramètre Skip every… demande à Lookout de ne pas interroger
l’appareil avec lequel il n’a pas pu établir de communication au cours
des interrogations programmées. Ainsi, Lookout saute cet appareil
pendant le cycle d’interrogation. Une fois que les communications sont
rétablies, l’appareil est interrogé au cours de son cycle normal.

Comme c’est le cas pour tous les autres drivers de Lookout, vous pouvez
accéder aux points d’E/S et aux autres données par l’intermédiaire des
données membres. La table suivante liste les données membres
supportées par la classe d’objets Optomux.
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Données membres Optomux

Donnée membre Type Lecture Ecriture Description

AI0.1 - AI255.16 Numérique Oui Non Entrée analogique. Mot 12 bits
comprenant un entier non signé
s’étendant de 0 à 4 095

AO0.1 - AO255.16 Numérique Oui Oui Sortie analogique. Mot 12 bits
comprenant un entier non signé
s’étendant de 0 à 4 095

CNT0.1 -
CNT255.16

Numérique Oui Non Compteur. Rend le comptage cumulé
pour les entrées spécifiées

CommFail Logique Oui Non Signal généré par l’objet qui est actif
si, pour quelque raison que ce soit,
Lookout ne peut pas communiquer
avec un (ou des) appareil(s)

DI0.1 - DI255.16 Logique Oui Non Entrée discrète

DO0.1 - DO255.16 Logique Oui Oui Sortie discrète

LAT0.1 -
LAT255.16

Logique Oui Non Rend un état activé pour les entrées
avec bascule

LTC0.1 -
LTC255.16

Logique Oui Non Rend un état activé pour les entrées
avec bascule et enlève la bascule

Update Logique Oui Non Signal généré par l’objet qui émet une
impulsion chaque fois qu’il interroge
l’appareil

Commentaires Pour spécifier l’adresse d’une entrée analogique située sur le canal 4 du
module 3, entrez AI3.4, où

AI 3  . 4

Remarque Le protocole Optomux peut effectuer des vérifications limitées de type
valeurs selon votre matériel. C’est-à-dire qu'il peut lire les données d’une
entrée analogique provenant d’un module discret, mais les données
rendues peuvent être arbitraires (ou égales à zéro).

Type de signal

Numéro du module ou adresse
Numéro de canal
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Messages d’état

No response within timeout period
(Pas de réponse dans la temporisation)
Lookout n’a pas reçu la réponse attendue pendant la temporisation
Receive timeout . L’objet Optomux a envoyé une requête et a reçu un
acquittement, mais l’appareil n’a pas envoyé de réponse comme prévu.
La réponse a peut-être été interrompue. Vous devrez peut-être augmenter
la temporisation Receive timeout  (et Poll Rate ). Cette augmentation
n’affecte pas le processus de Lookout, mais se base seulement sur Data
rate  et sur le nombre d’appareils cascadés. Vérifiez également les
paramètres de transmission, les connexions des câbles, l’alimentation,
les paramètres de configuration, les paramètres du port de
communication et les adresses d’interrogation.

Invalid data request from module
(Requête de données non valable du module)
Vous avez essayé de lire à partir d’un module qui n’existe pas ou le type
de données ne correspond pas. Par exemple, vous avez peut-être essayé
de lire une valeur discrète d’un module analogique. Cette
correspondance erronée du type de données est indiquée par l’analyseur
de données comme une trame comprenant des points d’interrogation.
C’est peut-être une anomalie de l’adresse. Vérifiez que le type d’E/S du
canal désiré correspond au type de signal de l’adresse identifiée dans la
donnée membre sur laquelle vous écrivez.
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Message Garbled--Bad CRC or BCC
(Message embrouillé : mauvais CRC ou BCC)
L’objet Optomux reçoit une réponse de(s) l’appareil(s), mais ne peut pas
déchiffrer la réponse. Vérifiez que la structure de correction d’erreurs
sélectionnée dans Protocol Select est la même que pour tous les
appareils physiques. Vérifiez également que les appareils connectés au
port de communication ont des adresses uniques. Il se peut que la
dernière partie du message soit coupée avant la fin. Pensez à augmenter
le nombre de tentatives dans Retry attempts . Vous devrez peut-être
augmenter le paramètre port série Receive gap  pour être sûr que
Lookout reçoit le message en entier. Si votre port série est configuré
pour radio, cette erreur peut être provoquée par un bruit à la fin de la
transmission radio. Essayez d’ajuster RTS delay off  et CTS timeout .

Unexpected data response length
(Réponse trop longue)
L’objet Optomux reçoit une réponse de l’appareil, mais la réponse est
trop longue. Vérifiez que tous les appareils connectés au port de
communication et qui partagent le même groupe d’appareils ont des
codes uniques. Il se peut que des appareils avec des adresses identiques
essaient de répondre en même temps.

Response too short
(Réponse trop courte)
L’objet Optomux reçoit des données dont la longueur ne satisfait pas les
exigences de longueur minimum de la trame. C’est peut-être parce que
l’appareil est configuré pour un protocole 4 voies au lieu de 2. Lookout
utilise un protocole de 2 voies. Vérifiez les paramètres de protocole de
l’appareil.
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Panel
Panel est une classe d’objets unique qui accepte les affichages membres
d’autres objets. Les objets Panel (panneau de contrôle) sont une fenêtre
donnant sur votre processus et assurent la surveillance et le contrôle de
votre système en basculant des interrupteurs, en activant des boutons-
poussoirs et en tournant des boutons.

Vous pouvez créer dans Lookout un nombre infini de panneaux de
contrôle et d’objets/graphiques à afficher sur un panneau précis. Les
panneaux de contrôle peuvent être de n’importe quelle taille et peuvent
s’afficher de différentes façons dans la zone de travail de Lookout
(tailles maximum, normale et minimum).

Vous pouvez créer des panneaux de contrôle avec la commande
Object→Create… ou avec la commande Insert→Control panel… Ces
deux commandes donnent le même résultat.

Boîte de dialogue des paramètres d’affichage et de définition Panel

Paramètres Panel

Il existe trois types de panneaux : Normal , Popup  et Popup no icon .

Un panneau de contrôle Normal peut être de taille maximum, normale
ou minimum (icône) au sein de la zone de travail de Lookout. Quand
vous activez un panneau Normal il est affiché selon les dimensions
définies par ses paramètres Height et Width . Quand vous agrandissez un
panneau Normal , il occupe toute la zone de travail de Lookout. Quand
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vous réduisez un panneau Normal , il est représenté par une icône.
L’option Normal est habituellement sélectionnée pour les panneaux de
contrôle.

Les panneaux de contrôle Popup peuvent être en état ouvert/local ou
iconique (ils ne peuvent pas être agrandis). Quand vous activez un
panneau Popup, il s’affiche selon les dimensions définies par ses
paramètres Height et Width . Quand un panneau de contrôle Popup est
activé, il reste superposé à tous les autres panneaux jusqu’à ce qu’il soit
réduit. Quand vous réduisez un panneau Popup, il est représenté par une
icône.

Les panneaux de contrôle Popup no icon  sont identiques aux panneaux
Popup  sauf qu’ils ne sont pas représentés par des icônes quand ils sont
réduits. Quand vous réduisez un panneau Popup no icon,  il disparaît de
la zone de travail de Lookout.

Remarque Vu que les panneaux de contrôle Popup no icon  ne sont pas
représentés par des icônes, ils utilisent moins de mémoire. (Microsoft
Windows affecte une quantité fixe de mémoire à chaque icône de la
fenêtre.) Si vous constatez des anomalies de mémoire quand vous
exécutez une application de Lookout qui comprend un grand nombre de
panneaux de contrôle, pensez à convertir vos panneaux Popup  en
Popup no icon .

Les panneaux normaux et les panneaux locaux peuvent être sélectionnés
par leur icône, avec la commande du menu Window. Ceci n’est pas le cas
pour les panneaux de contrôle Popup no icon  car on ne peut y accéder
qu’en déclenchant leur donnée membre d’activation.

Les paramètres Security levels  sont appliqués globalement à un
panneau de contrôle particulier. Le niveau de sécurité Control
fonctionne avec tous les niveaux de sécurité des objets de ce panneau.
Le niveau de sécurité supérieur détermine si un opérateur détient le
contrôle d’un objet. Prenez, par exemple, un objet Switch (booléen)
unique dont le niveau de sécurité est 4 et qui est affiché dans deux
panneaux. Le niveau de contrôle du premier panneau est 6 et celui du
second panneau est 2. Seuls les opérateurs de niveau 6 ou plus peuvent
basculer l’interrupteur du premier panneau tandis que les opérateurs de
niveau 4 et plus peuvent basculer le même interrupteur du second
panneau.
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L’option de sécurité Viewing  masque des panneaux de contrôle entiers
aux opérateurs de bas niveau. Ce paramètre affecte tout le panneau de
contrôle. A titre d’exemple, utilisons un panneau de contrôle dont le
niveau de sécurité d’affichage est 6. Si un opérateur de niveau 5 (ou
moins) ouvre une session, il ne peut pas voir le panneau de contrôle et ne
sait même pas qu’il existe car il n’est pas listé dans le menu Window et
son icône n’est pas affichée. Si un opérateur de niveau 6 (ou plus) ouvre
une session, le panneau de contrôle est immédiatement disponible. Cette
fonction est utile pour masquer des panneaux rarement utilisés ou dont
les informations sont délicates.

Cet exemple représente un panneau de contrôle Normal  dans un état normal et
un panneau de contrôle Popup  dans un état réduit. Le panneau Normal  peut
être facilement réduit ou agrandi en appuyant sur le bouton à flèche
correspondant.

L’exemple suivant est un scénario typique avec des panneaux de
contrôle qui occupent tout l’écran et plusieurs panneaux locaux affichés
simultanément.
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Cette configuration augmente la quantité d’informations que vous
pouvez afficher simultanément et permet l’affichage de différentes
combinaisons de panneaux de contrôle.

Cet exemple représente un panneau de contrôle Normal  agrandi et deux
panneaux de contrôle Popup simultanés.

La manipulation de panneaux

Les panneaux de contrôle de Lookout utilisent les techniques standard
Multiple Document Interface (MDI) de Microsoft. Pour déplacer un
panneau de contrôle sur l’écran, cliquez sur sa barre de titres et
glissez le panneau vers son nouvel emplacement. Double-cliquer sur le
tiret  en haut à gauche d’un panneau augmente sa taille, tandis qu’un
seul clic sur le tiret invoque un menu déroulant. Cliquer sur la flèche
d’agrandissement  en haut à droite d’un panneau agrandit le panneau
de contrôle tandis que cliquer sur la flèche de réduction réduit le
panneau. Notez que les panneaux de contrôle locaux n’ont pas de flèche
d’agrandissement. Quand un panneau normal est agrandi, ses boutons



Partie 3. Référence

476

fléchés se rassemblent en un bouton unique de flèches d’agrandissement
et de réduction . Appuyer sur ce bouton remet le panneau de contrôle à
son état normal.

Passer d’un panneau à un autre

Il arrive très souvent d’avoir plusieurs, voire des douzaines de panneaux
de contrôle. La méthode pour passer d’un panneau à un autre peut être
aussi simple ou aussi compliquée que vous le souhaitez. Une méthode
efficace consiste à utiliser des boutons-poussoirs qui invoquent d’autres
panneaux de contrôle. Vous connectez le signal de sortie du bouton-
poussoir à la donnée membre qui active ou agrandit le(s) panneau(x) de
contrôle désiré(s). Quand le signal du bouton passe à Haut, le panneau
correspondant apparaît.

Nous avons créé dans l’exemple suivant un bouton-poussoir unique et
avons connecté son signal de sortie à deux panneaux de contrôle Popup .
Le bouton-poussoir est inséré dans un troisième panneau agrandi.
Reportez-vous à la commande Object→Edit Connections… au chapitre
17 pour plus d’informations sur la connexion de données membres aux
signaux/expressions.
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Quand nous sortons du mode Edition et appuyons sur le bouton, les deux
panneaux de contrôle Popup  apparaissent immédiatement, comme
indiqué ci-dessous. Nous aurions pu connecter aussi le bouton-poussoir à
un autre panneau Normal et celui-ci se serait affiché comme le nouveau
panneau agrandi.
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A vrai dire, il n’existe pas de limite quant au nombre de connexions
possibles entre les signaux et les panneaux de contrôle. Vous pouvez
créer des expressions/alarmes complexes qui affichent automatiquement
certains panneaux de contrôle.

Une autre méthode consiste à utiliser des touches de fonctions. Comme
c’est le cas pour l’objet $Keyboard, chaque panneau comprend son
propre jeu de données membres représentant les touches de fonctions de
F1 à F24. Nous avons connecté, dans l’exemple de la page suivante, la
donnée membre F2 de Panel1 à la donnée membre d’activation de
Panel2. Ensuite, nous avons connecté la donnée membre F2 de Panel2 à
la donnée membre d'activation de Panel3. L’opérateur peut ainsi appuyer
sur F2 pour “la page suivante” de plusieurs panneaux.
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F1 F2 F1 F2 F1 F2

Panel3

Panel3Panel2

Panel1

Panel1

Sur le même principe, nous avons connecté la donnée membre F1 de
Panel3 à la donnée membre d’activation de Panel2 et la donnée membre
F1 de Panel2 à la donnée membre d’activation de Panel1. Ainsi,
Panel2.activate = Panel1.F2 or Panel3.F1 . L’opérateur
peut maintenant appuyer sur F2 pour avancer d’une page dans les
panneaux de contrôle et sur F1 pour reculer d’une page.

Les considérations spéciales pour le panneau d’origine
(Home Panel)

Pour éviter que les utilisateurs ne se perdent quand ils se déplacent
parmi les panneaux, vous pouvez définir un panneau comme panneau de
contrôle maître, ou “panneau d’origine” ou “menu principal”. Vous
pouvez connecter la donnée membre d’activation de votre panneau
d’origine à $Keyboard.Maj.F1, ou à un objet Pushbutton (bouton-
poussoir). Si vous le connectez à une touche de fonction, toutes les fois
que l’utilisateur appuie sur MAJ-F1 (sans tenir compte du panneau
affiché), le panneau d’origine est évoqué, et l’opérateur revient à un
panneau de contrôle familier.

Vous pouvez souhaiter également que le panneau d’origine soit agrandi
au démarrage. Si vous avez déjà créé un bouton-poussoir pour évoquer le
panneau d’origine, vous pouvez le connecter à la donnée membre qui
agrandit le panneau, comme indiqué en page suivante.
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Le point d’exclamation (!) dicte à Lookout d’utiliser la valeur contraire
du bouton-poussoir. Au démarrage, le bouton-poussoir n’est pas enfoncé
et sa valeur est donc Faux. Mais vu que nous utilisons la valeur contraire
du bouton-poussoir, Panel1.maximize est Vrai au démarrage. Toutes les
fois qu’un utilisateur appuie sur CallHomePb après la connexion, rien ne
se produit jusqu’à ce que le bouton-poussoir soit relâché ; c’est à ce
moment-là que le panneau est appelé.

e

L’impression du panneau

Les panneaux de contrôle sont facilement imprimés via la fonction Print
Panel. Cette fonction s’utilise de la même façon pour les types de
panneaux Normaux et locaux.

Imprimez le contenu d’un panneau en cliquant sur la boîte de menu de
contrôle du panneau  en haut à gauche puis sur Print Panel, ou en
connectant une expression logique à la donnée membre Print du panneau
de contrôle désiré. Un panneau ne doit pas nécessairement être affiché
pour être imprimé.

Remarque L’impression de certains fichiers méta peut différer de leur affichage.
Ceci signifie que certaines parties d’objets en couches ont parfois une
apparence opaque sur l’écran et une apparence translucide sur papier.
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Boîte de menu de contrôle

Remarque Quand vous imprimez un panneau Normal , il s’imprime selon les
paramètres Height  et Width  définis. Ainsi, si vous définissez un panneau
dont les paramètres Height  et Width  sont par défaut de 400 x 300
pixels, agrandissez le panneau et ajoutez les éléments graphiques au
panneau complet ; les éléments hors de la plage par défaut (400 x 300
pixels) ne seront pas visibles quand le panneau s’imprime. Pour imprimer
tous les éléments d‘un panneau agrandi, modifiez les paramètres Width
et Height  du panneau pour qu'ils correspondent aux dimensions du
panneau sur tout l’écran.

Vous pouvez modifier un panneau de contrôle existant en passant en
mode Edition et en cliquant avec le bouton droit de la souris sur sa barre
de titres. Vous pouvez également modifier, comme avec tout autre objet,
un panneau avec la commande de menu Object→Modify…

Commande Print Panel
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Données membres Panel

Donnée
membre

Type Lecture Ecriture Description

active Logique Oui Non Rend Vrai quand le panneau est le
panneau actuellement sélectionné (c’est-
à-dire, qu’il est actif)

activate Logique Non Oui Au passage de FAUX à VRAI, demande
au panneau de s’ouvrir (popup)

maximize Logique Non Oui Au passage de FAUX à VRAI, agrandit le
panneau de contrôle, remplaçant le
panneau de contrôle actuellement
agrandi

minimize Logique Non Oui Au passage de FAUX à VRAI, réduit le
panneau de contrôle sous forme d’icône

F1 - F24 Logique Oui Non Chacune de ces 24 données membres
représente une touche de fonction, de F1
à F24. Rend VRAI quand le panneau est
actif et sa touche de fonction associée est
enfoncée

Shift-F1

à

Shift-F24

Logique Oui Non Chacune de ces 24 données membres
représente une touche de fonction, de F1
à F24 quand la touche est enfoncée
simultanément avec la touche Maj. Rend
VRAI quand le panneau est actif et sa
touche de fonction associée est enfoncée
simultanément avec la touche Maj

Ctrl-F1 - Ctrl-F24 Logique Oui Non Chacune de ces 24 données membres
représente une touche de fonction, de F1
à F24 quand la touche est enfoncée
simultanément avec la touche Ctrl. Rend
VRAI quand le panneau est actif et sa
touche de fonction associée est enfoncée
simultanément avec la touche Ctrl

print Logique Non Oui Au passage de FAUX à VRAI, envoie le
panneau de contrôle à Windows Print
Manager
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Commentaires Les graphiques et les panneaux de contrôle de Lookout ont une
apparence différente selon l’ordinateur que vous utilisez et la résolution
du driver de l’écran. Quand vous placez un graphique (ou tout autre
élément d’affichage) sur un panneau de contrôle, Lookout identifie la
position sélectionnée en enregistrant la position précise du pixel dans le
graphique (un pixel est le point le plus petit sur l’écran). En fait,
Lookout compte le nombre de pixels du graphique en commençant en
haut à gauche de l’écran. Ultérieurement tard, quand vous évoquez un
panneau, Lookout sait exactement où placer le graphique.

Il est important de noter que différents drivers d’écrans ont des
résolutions différentes. Les écrans VGA sont de 640 x 480 pixels. En
général, les écrans Super VGA s’étendent de 800 x 600 pixels à 1024 x
768 pixels. Un panneau créé avec une résolution de 640 x 480 pixels
n’occupera pas tout l’écran d’un moniteur super VGA de 1024 x 768
pixels, tandis qu’un panneau créé avec une résolution de 1024 x 768
pixels débordera l’écran d’un moniteur VGA de 640 x 480 pixels.

Nous vous conseillons de créer vos panneaux avec la résolution du
driver d’affichage de la machine réservée à Lookout. Si vous créez des
panneaux sur plusieurs ordinateurs, pensez à développer des panneaux
avec la résolution du driver d’affichage de la machine dont la résolution
est la plus courante (si vous avez une douzaine de machines Super VGA
et une machine VGA, développez vos panneaux en Super VGA et non
VGA). Vous devrez ensuite modifier les panneaux pour qu’ils s’adaptent
aux machines dont la résolution est moins courante.

En général, vous pouvez changer la résolution de votre écran de VGA à
Super VGA via les paramètres système dans le programme de
configuration (Setup) de Windows. Reportez-vous à votre manuel
Windows pour plus d’informations.
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Pareto
La classe d’objets Pareto est un des outils de maîtrise statistique du
processus (Statisticial Process Control : SPC) de Lookout et peut jouer
un rôle important dans le programme de gestion de qualité totale (Total
Quality Management : TQM) de votre entreprise. Cette classe d’objets
affiche la distribution de la fréquence des occurrences par rubrique. Elle
identifie les anomalies les plus fréquentes ou les défauts de votre
processus.
La classe d’objets Pareto affiche des graphes déroulants d’analyse Pareto
pondéréé et/ou non pondéréé. Les graphes d’analyse peuvent être interactifs,
automatiques, ou un mélange des deux. Une ligne de pourcentage
optionnelle, indiquant les pourcentages cumulés des facteurs, peut s’afficher.
Pour cela, l’utilisateur sélectionne le nombre de facteurs à afficher, pouvant
être inférieur au nombre total de facteurs définis. La couleur d’arrière-plan
du graphe déroulant, ainsi que l’étiquette, la pondération et la couleur de
chaque facteur, peuvent être définies par l’utilisateur.
La boîte de dialogue de définition de l’objet du graphe déroulant
d’analyse Pareto est représentée ci-dessous.

Boîte de dialogue des paramètres de définition Pareto
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Reset  est une expression logique qui, au passage de Faux à Vrai, remet à
zéro tous les comptages des facteurs.

Allow Interactive Choice  vous permet de spécifier si l’opérateur peut
augmenter (ou diminuer) les comptages des facteurs en cliquant avec le
curseur souris sur l’objet du graphe d’analyse Pareto.

Allow Decrement Count  spécifie si l’opérateur peut diminuer les
comptages des facteurs quand vous activez le choix interactif.

Bins to display  est le nombre de binaires de facteurs à afficher dans le
graphe d’analyse Pareto. Ceci peut être une constante ou une expression
numérique.

Les paramètres Bins ajoutent, modifient ou effacent des facteurs depuis
et vers le graphe d’analyse Pareto. Label  est le titre descriptif du facteur
et peut être une constante ou une expression textuelle. Weight  est la
polarisation que vous appliquez au facteur si vous souhaitez afficher un
graphe d’analyse Pareto pondérée. Ceci peut être une constante ou une
expression numérique. Color  est la couleur de la barre pour le facteur.
Factor ID  est un chiffre généré par l’objet qui fournit une identité unique
au comptage actuel du facteur quand il est enregistré ou restauré depuis
le fichier d’état de Lookout. C’est une représentation visuelle indiquant à
l’utilisateur qu’un comptage de facteur est associé à un Facteur ID
particulier et non à une étiquette (Label).

La boîte de dialogue d’affichage Pareto est représentée ci-dessous.

Boîte de dialogue des paramètres d’affichage Pareto
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Show percentage line  affiche une ligne de pourcentage cumulatif dans
la couleur sélectionnée dans Line color .

Weighted Pareto vous permet de choisir si le graphe est affiché comme
graphe d’analyse Pareto pondérée ou non.

Les graphes d’analyse pondérée et non pondérée

Avec le même objet Pareto, vous pouvez afficher des graphes d’analyse
Pareto pondérée et/ou non pondérée. Une analyse Pareto non pondérée
représente simplement les facteurs qui surviennent le plus souvent. Si les
facteurs ont à peu près la même importance, un graphe d’analyse non
pondérée indique les anomalies rencontrées.

Graphe d’analyse Pareto non pondérée

Si certains facteurs sont beaucoup plus graves que d’autres, un graphe
d’analyse Pareto pondérée est un outil plus efficace pour déterminer le
coût ou l’exposition d’un facteur et identifier les anomalies. Par
exemple, dans le graphe d’analyse Pareto non pondérée ci-dessus, le
facteur 1 et facteur 5 pris ensemble représentent 50 % des occurrences
défectueuses. Cependant, comme le graphe d’analyse Pareto pondérée
ci-dessous l’indique, le facteur 4 représente à lui seul 60,8 % du total de
tous les défauts.
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Graphe d’analyse Pareto pondérée

Augmenter le comptage de facteurs

L’objet Pareto Chart (analyse Pareto) permet d’augmenter
interactivement et/ou automatiquement le comptage de facteurs. A vrai
dire, l’objet peut accepter n’importe quelle combinaison d’entrées
automatiques et interactives.

Si vous sélectionnez l’option Allow Interactive Choice  dans la boîte de
dialogue de définition de l’objet, l’opérateur peut manuellement
augmenter le comptage de facteurs. A cet effet, l’opérateur clique avec le
curseur de la souris sur le graphe d’analyse Pareto et une boîte locale
apparaît avec tous les facteurs disponibles. Le facteur spécifié par le
curseur quand l’opérateur clique sur le graphe d’analyse détermine le
facteur à mettre en évidence quand la boîte de dialogue est affichée.
Dans cet exemple, le curseur de la souris était sur le casier de facteur 2.
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Si vous sélectionnez l’option Allow Decrement Count  dans la boîte de
dialogue de définition de l’objet, le bouton Decrement (diminuer) est
affiché dans la liste locale et l’opérateur peut diminuer un comptage de
facteur. Ainsi, les opérateurs éprouvés peuvent corriger des erreurs si
nécessaire.

L’objet Pareto permet également les connexions externes pour
déclencher automatiquement le comptage de facteurs. Vous pouvez
connecter un bouton-poussoir, une alarme, une expression, une sortie
API, etc., à un déclencheur de facteur pour augmenter le comptage de
facteurs quand cet élément passe de Faux à Vrai. La liste suivante
contient les données membres de la classe d’objets Pareto.

Données membres Pareto

Donnée membre Type Lecture Ecriture Description

visible Logique Oui Oui Quand Vrai, le graphe d’analyse
Pareto est visible sur le panneau de
contrôle. Quand Faux, il est invisible.
La valeur par défaut est Vrai

total Numérique Oui Non Le total de tous les comptages de
facteurs non pondérés dans tous les
facteurs définis

total.shown Numérique Oui Non Le total de tous les comptages de
facteurs non pondérés dans tous les
facteurs actuellement affichés

total.weighted Numérique Oui Non Le total de tous les comptages de
facteurs pondérés dans tous les
facteurs définis
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Données membres Pareto (suite)

Donnée membre Type Lecture Ecriture Description

total.shown.weight
ed

Numérique Oui Non Le total de tous les comptages de
facteurs pondérés dans tous les
facteurs actuellement affichés

facteur1-1000 Logique Non Oui Au passage de Faux à Vrai, augmente
le comptage de facteur respectif de 1

count1-1000 Numérique Oui Non Le comptage dans le casier de
facteurs respectif non trié

count.sorted1-
1000

Numérique Oui Non Le comptage dans le casier de
facteurs respectif trié par comptage

count.weighted1-
1000

Numérique Oui Non Le comptage pondéré dans le casier
de facteurs respectif non trié

count.weighted.
sorted1-1000

Numérique Oui Non Le comptage pondéré dans le casier
de facteurs respectif trié par comptage
pondéré

label1-1000 Texte Oui Non L’étiquette du casier de facteurs
respectif non trié

label.sorted1-1000 Texte Oui Non L’étiquette du casier de facteurs
respectif trié par comptage

label.weighted.
sorted1-1000

Texte Oui Non L’étiquette du casier de facteurs
respectif trié par comptage pondéré

percent1-1000 Numérique Oui Non Le pourcentage du comptage total
dans le casier de facteurs respectif
non trié

percent.sorted1-
1000

Numérique Oui Non Le pourcentage du comptage total
dans le casier de facteurs respectif trié
par comptage

percent.weighted1
-1000

Numérique Oui Non Le pourcentage du comptage total
pondéré dans le casier de facteurs
respectif non trié

percent.weighted.
sorted1-1000

Numérique Oui Non Le pourcentage du comptage total
pondéré dans le casier de facteurs
respectif trié par comptage pondéré
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PID
L’objet PID compare la valeur Process Variable  à une consigne
Setpoint . S’il existe une différence, il calcule l’erreur et adapte sa sortie
pour compensation jusqu’à ce que Process Variable  soit égal à
Setpoint .

PID est l’acronyme de “Proportional-Integral-Derivative” (dérivatif
intégral-proportionnel). Ce sont trois facteurs dans l’équation qui
peuvent être apposés à l’erreur calculée. Vous spécifiez Gain  (le facteur
proportionnel), Reset  (le facteur intégral) et Rate (le facteur dérivatif)
pour définir comment l’objet réagit à l’erreur.

Remarque Comment l’objet PID réagit à votre processus varie largement selon les
paramètres introduits et le processus sous contrôle. Le réglage d’une
boucle PID n’est pas abordé dans ce manuel.

Boîte de dialogue des paramètres de définition PID

Type  sélectionne le contrôle de la position ou de la vitesse. Ces deux
modes de contrôle sont décrits ci-après.
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Process Variable  (PV) est en général le signal numérique du champ que
vous souhaitez contrôler. L’équation de boucle PID ne s’attend pas à ce
que cette valeur soit normalisée vu que l’objet PID effectue la mise à
l’échelle des valeurs d’entrée et de sortie en boucle au format ingénieur.

Setpoint  (SP) est en général la valeur de l’objet Pot, une valeur
numérique constante, ou le signal de sortie d’un autre objet PID en
boucle cascadée. Comme la variable de processus, la consigne peut être
mise à l’échelle de façon interne par l’objet PID.

Setpoint Min et Max sont des constantes numériques qui spécifient la
portée de SP et PV au format ingénieur.

Manual Output  est un paramètre numérique qui spécifie la sortie de
l’objet en mode manuel, c’est-à-dire quand l’expression Automatic
Enable  passe à Faux. En général, les utilisateurs entrent une constante
ou le nom d’un objet Pot dans ce champ.

Output Min et Max sont des constantes numériques qui spécifient la
portée du signal de sortie de l’objet. La sortie est souvent nommée
manipulated variable (MV) (variable manipulée).

Sample Pulse  indique la fréquence d’exécution de l’objet PID. Ce
champ de paramètre peut contenir une constante numérique ou une
variable logique. Si vous utilisez une constante numérique (comme
0:01  pour une seconde), l’objet calcule une nouvelle valeur de sortie
selon la fréquence définie. Si vous utilisez une variable logique, la
variable doit émettre une impulsion selon la fréquence désirée. Toutes
les fois que l’impulsion passe de Faux à Vrai, l’objet calcule une
nouvelle valeur de sortie. Il est très important de ne pas trop
échantillonner vos données. Commencez par un taux d’échantillonnage
assez lent.

Gain  (Kc) est un paramètre numérique qui détermine la sensibilité
générale de la boucle PID aux changements d’erreurs. Une valeur de
gain de 1,00 fait que l’incrément proportionnel de l’équation PID change
de 50 % quand il y a un changement d’erreur de 50 %. Une valeur de
gain de 0,25 fait que l’incrément proportionnel change de 12,5 % avec
50 % de changement dans l’erreur.
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Reset  (Ti), ou temps intégral, est un paramètre numérique qui spécifie la
durée nécessaire pour que la somme intégrale de l’incrément de
l’équation de boucle PID réagisse à un changement d’erreur donné. Par
exemple, si l’erreur change soudainement de 20 % et la valeur de Reset
= 0:10 (10 secondes), l’incrément intégral de la boucle PID augmente à
un taux de 0,5 % par seconde jusqu’à ce qu’il change de 20 % après 40
secondes. Cette contribution de 20 % est multipliée par le gain, et donc
si le gain est 2,0, le terme intégral contribue 40 % à la sortie de la boucle
dans cet exemple. Autrement dit, plus le temps Reset est court, plus
rapide est la réaction de la sortie de l’objet quand un changement PV ou
SP a lieu.

Rate (Td), ou temps dérivé, est un paramètre numérique qui ralentit la
réponse de la boucle. Il est calculé selon le taux de changement de PV et
ajoute un incrément à la sortie essayant d’anticiper et de ralentir le
changement dans PV. Par exemple, si PV est augmenté de 10 % par
minute, et rate est 0:30 (0,5 minutes), l’incrément dérivé est calculé en
tant que -(10 %/min. x 0,5 minutes)= -5 % (ou -0,05). Ainsi, le terme
dérivé contribue de -5 % à la sortie si le gain est 1,0.

Automatic Enable  spécifie si le contrôleur de boucle est en mode
automatique ou en mode manuel. Quand il est activé, le contrôleur
fonctionne en mode automatique et le signal de sortie est calculé selon
l’algorithme PID. En mode manuel, le signal de sortie est égal au signal
d’entrée du paramètre Manual Output .

L’objet PID assure le passage en douceur du mode manuel au mode
automatique : quand le contrôleur passe de manuel à automatique, sa
sortie commence à changer à partir du paramètre actuel de la sortie
manuelle. Contrastez cette action avec un contrôleur de boucle sans
passage en douceur. Quand ce contrôleur est en mode manuel, le terme
intégral continue d’accumuler. Quand le contrôleur passe en mode
automatique, le contrôleur de boucle passe immédiatement à une sortie
haute ou basse.

Add proportional increment  spécifie si l’équation de boucle ajoute
l’incrément proportionnel de l’équation PID à MV. En général, cette
valeur est activée.
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Freeze Enable  spécifie si le biais de la boucle est immobilisé ou
activement rétrocalculé quand le signal de sortie du contrôleur est hors
gamme. Dans les deux cas, le contrôleur de boucle est protégé du
remontage intégral, mais si Freeze Enable est désactivé (le paramètre
recommandé), le biais est activement rétrocalculé pour empêcher le
dépassement du contrôleur quand PV revient dans sa gamme.

Vous pouvez sélectionner l’une des deux options suivantes pour que
l’objet PID soit protégé du remontage intégral : en immobilisant le terme
biais quand la sortie du contrôleur est hors gamme, ou en rétrocalculant
activement le biais pour que le contrôleur réagisse en douceur et risque
moins le dépassement quand sa sortie revient dans sa gamme.

Output Time  est une constante numérique qui spécifie le domaine
temporel de la sortie du contrôleur quand il fonctionne en mode vitesse.
Par exemple, si la sortie de l’objet contrôle une valeur exprimée en
pouces par minute, le temps de sortie est 1:00 (une minute).

Low Limit Enable  est utilisé en mode de contrôle vitesse. C’est un
signal logique optionnel qui coupe la sortie PID à une valeur supérieure
ou égale à zéro quand c’est sur Vrai. Cette entrée peut notifier au
contrôleur que l’interrupteur du seuil Low dans l’appareil sous contrôle
est activé.

High Limit Enable  est utilisé en mode de contrôle vitesse. C’est un
signal logique optionnel qui coupe la sortie PID à une valeur inférieure
ou égale à zéro quand c’est sur Vrai. Cette entrée peut notifier au
contrôleur que l’interrupteur du seuil High dans l’appareil sous contrôle
est activé.
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Contrôle de la position

Quand vous sélectionnez Position , l’objet PID calcule la sortie de la
façon suivante :

MV=  Kc (en + sommen intégrale - Td / dT (Pvn - Pvn-1))

où :
dT =incrément de temps entre les calculs actuel et 

  précédent
MV =sortie contrôleur (variable manipulée)
Kc =gain contrôleur (unités: % sortie / % erreur)
en =erreur à l’échantillonn (erreur = SP - Pvn)
sommen intégrale =somme n-1 intégrale + dT / Ti (en - en-1) 

  également nommée “biais”
Td =taux ou temps dérivé
Pvn - Pvn-1 =changement dans PV produit par les calculs 

  précédents jusqu’aux calculs actuels

Contrôle de la vitesse

La sortie de la forme de la vitesse de l’équation PID est la vélocité ou la
vitesse de changement du signal de sortie. Avis aux mathématiciens : la
forme de vitesse de l’équation PID est la première dérivée de la forme de
position de l’équation PID par rapport au temps, et le résultat est le taux
de changement de la position du contrôleur.

Quand vous sélectionnez Velocity , l’objet calcule la sortie de la
façon suivante :

dMV  = MV n  - MVn-1

          = Kc ((en - en-1) + Tsen / Ti  + Td/Ts ( Pvn - 2PVn-1 + PVn-2))

où :
MV =position de la sortie du contrôleur (variable

manipulée)
dMV =vitesse de la sortie du contrôleur
Kc =gain du contrôleur (unités : % sortie / % erreur)
en =erreur à l’échantillon n (erreur = SP - Pvn)
Td =taux ou temps dérivé
PV =variable du processus
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Données membres PID

Donnée
membre

Type Lecture Ecriture Description

Error Numérique Oui Non Différence entre Setpoint (SP) et Process
Variable  (PV)

Output Numérique Oui Non Valeur de sortie du contrôleur PID, nommée
également MV, ou la variable manipulée.
Cette valeur est le résultat de l’équation de la
boucle PID ou la sortie Manual Output ,
selon l’état spécifié dans Automatic
Enable

Commentaires Le terme proportionnel de l’équation PID fournit un montant à la sortie
égal à l’erreur multipliée par le gain GAIN, ce qui compense
immédiatement la sortie quand la valeur d’erreur change.

Le terme intégral de l’équation PID calcule un total cumulé des erreurs
additionnées (ou intégrées) dans le temps ; pensez-y comme à la somme
sous la courbe qui trace l’erreur comparée au temps. Tant que SP est
supérieur à PV, le terme intégral augmente, et tant que PV est supérieur à
SP, le terme intégral diminue. La sensibilité de la sortie intégrale est
établie par le gain et par les variables Reset. L’action intégrale peut être
éliminée par réglage plus élevé de Reset . Cependant, un minimum
d’action intégrale est exigé pour que le contrôleur de boucle fonctionne
correctement avec un ajustement de biais. Si vous n’utilisez pas d’option
intégrale, une condition “offset” peut survenir là où la sortie est ajustée
pour compenser l’erreur, mais pas assez pour la corriger.

Le terme dérivée de l’équation PID agit pour diminuer le changement
dans PV en ajoutant une valeur négative pour un PV positif et une valeur
positive pour un PV négatif. Vu que pour une grande partie des boucles
de processus, PV est sensible aux petits changements soudains et au bruit
du signal, l’action de dérivation peut créer des réactions erratiques de la
boucle. Rate peut être réglé sur 0, spécialement lors du réglage initial de
la boucle, afin d’éliminer l’action de dérivation. L’action de dérivation
diminue l’effet des boucles de processus qui oscillent autour de la
consigne et améliore la réponse de la boucle. Des boucles qui changent
rapidement, pour le contrôle du débit d’écoulement d’un tuyau par
exemple, ne bénéficient pas toujours de l’action de dérivation, mais les
boucles plus lentes qui tendent à acquérir de la vitesse, comme les
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contrôles de température, bénéficient de l’action de dérivation en évitant
le dépassement et en atténuant l’action oscillatoire.

Pipe
L’objet Pipe (tuyau) affiche des rectangles (tuyaux) de couleurs
différentes dans un panneau de contrôle selon les définitions paramétrées
dans Conditional expressions . L’objet Pipe détermine le rectangle en
couleur à afficher selon l’ordre et l’état actuel de vos expressions
Conditional expressions . Si plusieurs Conditional expressions sont
Vrai simultanément, Pipe affiche la couleur associée à la première
expression Vrai. Les expressions Conditional expressions doivent
rendre des valeurs logiques.

Boîte de dialogue des paramètres de définition Pipe
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Donnée
membre

Type Lecture Ecriture Description

Aucune L’objet Pipe n’a pas de données membres

Commentaires Vous pouvez facilement créer une structure complexe d’un réseau de
tuyaux (agrémenté de plusieurs couleurs changeantes) avec un seul objet
Pipe. Affichez l’objet dans un panneau de contrôle et copiez l’affichage
par la méthode <MAJ>-déplacer pour créer d’autres tuyaux munis des
mêmes paramètres. Vous pouvez ensuite déplacer, redimensionner et
grouper les tuyaux selon vos besoins.

Playwave
L’objet Playwave connecte des fichiers d’ondes standard de Microsoft
(.WAV) à des événements de Lookout. Playwave diffuse le fichier audio
spécifié par Wave file quand Play when passe d’Arrêt à Marche. Play
when est une expression logique activée par un simple bouton-poussoir,
une entrée numérique provenant d’un API ou une alarme générée dans
Lookout. Vous pouvez également créer vos propres fichiers audio
personnalisés avec divers logiciels. Ainsi, vous pouvez connecter des
alarmes individuelles à des fichiers d’ondes personnalisés qui sont
diffusés chaque fois qu’une alarme passe à Vrai.

Boîte de dialogue des paramètres de définition de Playwave
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Données membres Playwave

Donnée
membre

Type Lecture Ecriture Description

aucune Playwave n’a pas de données membres

Commentaires Beaucoup d'ordinateurs ne sont pas équipés de haut-parleurs intégrés de
haute qualité. Si tel est le cas, vos fichiers d’ondes peuvent émettre un
son déformé, voire imperceptible. Si vous souhaitez exploiter la fonction
Playwave, vous devrez peut-être acheter le matériel nécessaire : une
carte adaptable au son de Microsoft Windows (avec un driver Windows)
et des haut-parleurs externes.

Pot
L’objet Pot (potentiomètre) est un potentiomètre qui change facilement
les valeurs numériques des consignes. Vous pouvez afficher des
potentiomètres dans un panneau de contrôle sous forme de bouton,
glissière verticale, glissière horizontale, bouton-poussoir
d’incrémentation/de décrémentation ou comme entrée numérique. Vous
pouvez également utiliser les potentiomètres comme des interrupteurs à
plusieurs positions.

Boîte de dialogue des paramètres de définition de Pot
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Minimum est le signal de valeur le plus bas généré par le potentiomètre.

Maximum  est le signal de valeur le plus élevé généré par le
potentiomètre.

Resolution est l’incrément de changement le plus petit, ou l’espacement
de cliquet que le potentiomètre supporte.

Position source détermine où réside la “valeur” du potentiomètre.
Local indique la valeur du potentiomètre au sein même de l’objet dans le
panneau de contrôle.

Les potentiomètres Remote obtiennent leurs valeurs d’une source à
distance, le plus souvent le registre d’un contrôleur auquel ils sont reliés.
Le fait d’ajuster le potentiomètre change la valeur dans le registre et le
fait de changer la valeur dans le registre ajuste le potentiomètre. En
effet, le potentiomètre traque une valeur à distance. Ceci est
particulièrement utile quand vous souhaitez éviter que Lookout change
la valeur des consignes ou des registres au cours de l’initialisation ou de
la reconnexion des communications interrompues. Utiliser ce
potentiomètre crée une sorte de signal bouclé. La moitié de la boucle est
formée quand vous connectez le registre du contrôleur au potentiomètre
avec l’expression Position et la seconde quand vous reliez le signal de
sortie du potentiomètre au registre du contrôleur. Position est une
expression numérique. N’oubliez pas de terminer la seconde moitié de la
boucle avec la commande Object→Edit Connections…

Comme les potentiomètres à distance Remote, les potentiomètres DDE
(Dynamic Data Exchange [échange dynamique de données]) obtiennent
leurs valeurs d’une source à distance. Ceci peut être une cellule dans une
feuille de calcul, une autre application sensible au DDE ou une autre
copie de Lookout mise en réseau. Les derniers paramètres DDE d’un
objet deviennent automatiquement la valeur par défaut de tout objet
DDE nouveau. Reportez-vous au chapitre 13 pour plus d’informations
sur les paramètres Service , Topic  et Item .

Control security level spécifie le niveau de sécurité minimum des
opérateurs souhaitant accéder à cet objet particulier et le contrôler.
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L’option Log events crée une analyse rétrospective permanente de
l’objet : qui a fait quoi et quand. Tous les ajustements du potentiomètre
sont enregistrés dans le disque, y compris l’heure d’ajustement, le nom
de l’utilisateur et l’ajustement effectué. Reportez-vous au chapitre 11
pour plus d’informations sur l’enregistrement d’événements.

Boîte de dialogue des paramètres d’affichage de Pot

Remarque Vous pouvez modifier la couleur d’arrière-plan des glissières verticale et
horizontale avec la commande de menu Change→Background color...
Vous pouvez modifier la police de caractères ainsi que sa couleur dans
les potentiomètres numériques avec les commandes Change.

Données membres Pot

Donnée
membre

Type Lecture Ecriture Description

(implicite) Numérique Oui Non Valeur actuelle
decrement Logique Non Oui Quand la valeur de cette donnée membre

passe de Faux à Vrai, la valeur implicite
de l’objet Pot diminue de la quantité de la
résolution du potentiomètre

increment Logique Non Oui Quand la valeur de cette donnée membre
passe de Faux à Vrai, la valeur implicite
de l’objet Pot augmente de la quantité de
la résolution du potentiomètre

visible Logique Non Oui Quand Faux, l’objet Pot n’est pas visible
sur l’écran de contrôle. Quand Vrai, le
potentiomètre est visible et contrôlable
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Commentaires Le potentiomètre est un des objets les plus souvent utilisés dans la
stratégie de contrôle du processus. Ils permettent à l’opérateur de
changer les consignes avec la souris et ils sont également utiles comme
interrupteurs M-A-A. Pour créer un interrupteur MAA avec un
potentiomètre, spécifiez 1 comme minimum, 3 comme maximum et 1
comme résolution. La section Tour d’horizon du développeur présente
un exemple de potentiomètre utilisé comme interrupteur MAA.

Les données membres d’incrémentation et de décrémentation assurent la
connexion rapide d’objets Pot aux touches de fonction $Keyboard et
Panel ainsi qu’aux boutons-poussoirs des écrans. Ils sont souvent utilisés
pour contrôler des objets Pot quand Lookout fonctionne sur une plate-
forme informatique industrielle à fonctionnalité limitée ou sans souris.

Pulse
Pulse est une horloge qui génère une impulsion périodique pendant une
durée donnée. Quand On/off signal passe sur Marche, le signal de sortie
est activé pendant la durée d’impulsion et désactivé le reste du temps. Le
signal de sortie est immédiatement désactivé quand On/Off signal passe
à Low.

Timer period  est l’intervalle de temps du cycle complet d’impulsion et
Timer duration  est la largeur de chaque impulsion. Ces paramètres
peuvent s’étendre de 0,0 seconde à plusieurs années et la résolution
efficace est 0,1 seconde sur toute la gamme. Timer duration  doit
toujours être inférieur à Timer period .

L’objet est représenté dans un panneau de contrôle en affichant le temps
restant avant que la sortie ne change d’état. Le format de sa
représentation est défini par le paramètre Display format . Il est mis à
jour environ une fois par seconde. Si On/Off signal  est faux, il indique
“off ”.
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Boîte de dialogue des paramètres de définition de Pulse

On/off signal est une expression logique tandis que Timer period  et
Timer duration  sont des expressions numériques. Lookout convertit les
valeurs numériques de Timer period  et Timer duration  en signaux
temporels qui représentent des jours et des fractions de jour. En général,
ce sont des constantes temporelles simples telles que 0:20 (vingt
secondes). Reportez-vous à la section intitulée Les données membres
numériques, au chapitre 5, pour plus d’informations sur la saisie des
constantes temporelles.

Boîte de dialogue des paramètres d’affichage de Pulse
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Données membres Pulse

Donnée
membre

Type Lecture Ecriture Description

(implicite) Logique Oui Non Valeur logique de l’horloge

Commentaires Pulse peut être utilisé pour ouvrir périodiquement une valve pendant une
durée spécifiée. Cette donnée membre peut également agir comme un
clignotant qui active et désactive les signaux graphiques selon les
besoins d’affichage.

Objets associés DelayOff, DelayOn, Interval, OneShot, TimeOf

Pushbutton
L’objet Pushbutton (bouton-poussoir) génère un signal logique pour la
réception par d’autres objets. Un bouton-poussoir change d’état quand
vous placez le curseur dessus et que vous appuyez sur un bouton de la
souris, un trackball, un écran tactile ou la barre d’espacement. Le
bouton-poussoir reste enfoncé et le signal de sortie reste High jusqu’à ce
que vous relâchiez le bouton. Si un message de vérification Verify on  est
défini, l’opérateur doit d’abord acquitter le message, puis le signal de
sortie passe à High, mais pendant un moment seulement.
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Boîte de dialogue des paramètres de définition de Pushbutton

Button text affiche le texte spécifié sur le bouton-poussoir.

Verify on vous permet de créer une expression textuelle dynamique à
afficher dans la boîte de dialogue de message. Reportez-vous au chapitre
10 pour plus d’informations sur la sécurité.

Boîte de dialogue du message de vérification

Position source détermine où réside la “valeur” du bouton-poussoir.
Local indique que la valeur du bouton-poussoir se trouve au sein même
du bouton-poussoir, dans le panneau de contrôle. Si le bouton-poussoir
n’est pas enfoncé, son signal est Off, s’il est enfoncé son signal est On.
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Les boutons-poussoirs Remote obtiennent leurs valeurs d’une source à
distance et le plus souvent du registre d’un contrôleur auquel ils sont
reliés. Le fait d’enfoncer le bouton-poussoir change l’état du registre et
le fait de changer l’état du registre enfonce le bouton-poussoir.

L’option Remote est particulièrement utile quand vous souhaitez éviter
que Lookout change la valeur des consignes ou des registres au cours de
l’initialisation ou de la reconnexion des communications interrompues.
Utiliser ce bouton-poussoir crée une sorte de signal bouclé. La moitié de
la boucle est formée quand vous connectez le registre du bouton-
poussoir avec l’expression Position et la seconde quand vous reliez le
signal de sortie du bouton-poussoir au registre du contrôleur. Position
est une expression numérique. N’oubliez pas de terminer la seconde
moitié de la boucle avec la commande Object→Edit Connections…

Quand vous sélectionnez l’option Remote , vous pouvez choisir si le
bouton-poussoir bascule sa sortie. La case à cocher Latch output
configure rapidement Lookout pour contrôler un relais à gachette.

Quand un utilisateur clique sur un bouton-poussoir avec gachette
sélectionnée, le bouton-poussoir reste enfoncé et envoie un signal Activé
(Vrai ou High) jusqu’à ce que le signal Remote Position passe à Activé.
Supposez qu’un opérateur clique sur MotorStartPb, configuré
précédemment. Le bouton-poussoir reste enfoncé, envoyant un signal
Vrai, jusqu’à ce que PLC.C101 passe à Vrai. Dès que PLC.C101 passe à
Vrai, le bouton-poussoir est relâché.

Comme les boutons-poussoirs à distance Remote, les boutons-poussoirs
DDE (Dynamic Data Exchange [échange dynamique de données)
obtiennent leurs valeurs d’une source à distance. Il peut s'agir d'une
cellule dans une feuille de calcul, d'une autre application sensible au
DDE ou d'une autre copie de Lookout mise en réseau. Les derniers
paramètres DDE d’un objet deviennent automatiquement la valeur par
défaut de tout objet DDE nouveau. Reportez-vous au chapitre 13 pour
plus d’informations sur les paramètres Service , Topic , et Item .

Control security level spécifie le niveau de sécurité minimum des
opérateurs souhaitant accéder à cet objet particulier et le contrôler.
Reportez-vous au chapitre 10 pour plus d’informations sur la sécurité.



Partie 3. Référence

506

L’option Log events crée une analyse rétrospective permanente de
l’objet : qui a fait quoi et quand. Tous les ajustements du potentiomètre
sont enregistrés dans le disque, y compris l’heure d’ajustement, le nom
de l’utilisateur et l’ajustement effectué. Reportez-vous au chapitre 11
pour plus d’informations sur l’enregistrement d’événements.

Boîte de dialogue des paramètres d’affichage de Pushbutton

Données membres Pushbutton

Donnée
membre

Type Lecture Ecriture Description

(implicite) Logique Oui Non Valeur de l’objet (Vrai quand le bouton est
enfoncé)

visible Logique Non Oui Quand Faux, le bouton-poussoir n’est pas
visible dans le panneau d’affichage. Quand
Vrai, le bouton peut être vu et contrôlé

Recipe
Les objets Recipe (recette) représentent une méthode efficace pour
importer des grands tableaux de données (c’est-à-dire des recettes et
leurs ingrédients) dans Lookout via une feuille de calcul Excel (.XLS ).
Une fois que la recette est créée et appliquée, l’opérateur peut changer la
recette courante aisément et rapidement en cliquant sur la souris pour
sélectionner une nouvelle liste d’ingrédients.

La meilleure manière de décrire le fonctionnement de la classe Recipe
est de passer par un exemple. Supposez que vous êtes fabricant de
gâteaux secs.



Chapitre 18. Définitions des classes d’objets

507

La création et l’application d’un objet recette se passent en deux temps.
D’abord, vous définissez vos recettes et leurs ingrédients respectifs dans
un tableur tel qu'Excel (tous les programmes produisant un fichier.XLS
sont appropriés, y compris Lotus 123). Vous pouvez définir jusqu’à 1
000 recettes dans un seul fichier.XLS . Chaque recette peut comprendre
jusqu’à 255 ingrédients. Nous définissons trois recettes de gâteaux secs
dans notre feuille de calcul.

La première rangée de la feuille de calcul est réservée aux noms des
ingrédients. Ces noms d’ingrédients commencent dans la colonne B et
deviennent plus tard les pseudonymes des données membres de l’objet
Recipe. Il faut donc que les noms des ingrédients soient uniques. Ils ne
peuvent pas partager le même nom que la donnée membre native (d'A à
IV) et vous ne pouvez pas nommer un ingrédient “manquant” car ce mot
est réservé. Les caractères valables dans le nom d’un ingrédient
s’étendent de A à Z, de 0 à 9 et comprennent le symbole $ et le point (.).
Si vous entrez “Hi_@#!!There” en tant que nom d’ingrédient, Lookout
affecte le pseudonyme “HiThere.” Les noms des pseudonymes doivent
respecter l’usage des majuscules et des minuscules.
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En commençant par la rangée 2, la colonne A liste les noms des
différentes recettes. Les recettes suivent les mêmes conventions de
nomenclature que les ingrédients. Chaque recette est suivie de ses
valeurs uniques d’ingrédients.

Les valeurs d’ingrédients peuvent représenter les entrées, les paramètres
et les sorties du processus. En général, les entrées du processus
représentent les matières premières et les autres entrées utilisées dans le
processus par lots. Des exemples comprennent la quantité d’œufs, de
farine, d’énergie utilisée, voire le nombre d’heures requises ou les coûts
fixes identifiables absorbés.

Un autre type de valeur d’ingrédient est un paramètre de processus. Les
paramètres de processus identifient les paramètres opérationnels tels que
le délai de refroidissement d’une chaudière, une consigne de pression
d’air ou une limite d’alarme basse du pH. Les paramètres de processus
peuvent également comprendre l’identification d’équipements
spécifiques à utiliser lors du processus par lots.

Le troisième type de valeur d’ingrédient est la sortie du processus. Une
telle valeur d’ingrédient peut représenter le nombre de gâteaux secs
fabriqués par lot, la quantité de sous-produits attendus ou un calcul des
différences des coûts basé sur la recette sélectionnée.

Les quantités des valeurs d’ingrédients doivent être spécifiées comme
constantes ou comme des équations basées sur d’autres paramètres de
préparation tels que la taille du lot.

La seconde partie de la définition d’une recette concerne la définition
d’un objet recette dans Lookout.

Boîte de dialogue des paramètres de définition de Recipe
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La première boîte de dialogue de recette définit la sécurité et
l’enregistrement de données de l’événement.

Le paramètre concernant le niveau de sécurité dans Choose recipe
spécifie le niveau de sécurité minimum nécessaire aux opérateurs pour
sélectionner une recette de la liste dans le fichier tableur sélectionné.

Le paramètre concernant le niveau de sécurité dans Load recipe file
spécifie le niveau de sécurité minimum nécessaire aux opérateurs pour
sélectionner un autre fichier tableur.

L’option d’enregistrement des événements crée une analyse
rétrospective permanente pour l’objet : qui a fait quoi et quand. Toute
sélection d’une autre recette ou d’un autre ficher de recette est
enregistrée dans le disque, y compris l’heure de cette action et le nom
d’utilisateur. Reportez-vous au chapitre 11 pour plus d’informations sur
l’enregistrement d’événements.

Après avoir défini la sécurité et l’enregistrement de données
événementielles, Lookout affiche une boîte de dialogue de sélection des
fichiers.

Nous avons sélectionné le fichier tableur COOKIES.XLS car il contient
nos trois recettes par lots.

Une fois que le fichier est sélectionné, Lookout affiche une liste de
recettes.
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Comme vous pouvez le constater, les noms des recettes proviennent de
la colonne A dans la feuille de calcul chargée. Vous pouvez utiliser les
boutons Previous (précédent) et Next (suivant) pour identifier une
recette dans la liste, ou taper le nom dans le champ d’entrées de données
au-dessus de la liste. (Cette même boîte de dialogue apparaît quand un
opérateur clique sur le bouton-poussoir représentant cet objet.) Cliquez
sur OK pour identifier la recette désirée. Nous avons sélectionné la
recette Oatmeal cookies (gâteaux aux flocons d’avoine).

Le bouton de chargement Load du fichier de recettes invoque la liste
déroulante des fichiers décrite précédemment. Cliquez sur ce bouton
pour sélectionner un nouveau fichier.XLS .

Remarque Si la recette est modifiée dans la feuille de calcul, la modification sera
notée dans la boîte de dialogue des recettes mais les valeurs qui résident
actuellement dans les données membres de l’objet restent intactes.
L’opérateur doit recharger la feuille de calcul pour mettre à jour la copie
du ficher de recettes de Lookout. Si vous choisissez de charger un
nouveau fichier.XLS  et que vous appuyez sur le bouton d’annulation
Cancel, la mise à jour n’aura pas lieu. Vous devrez sélectionner OK pour
que la recette soit effectivement chargée.

Après avoir chargé la feuille de calcul, Lookout affiche une case des
paramètres d’affichage.
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Case des paramètres d’affichage de l’objet Recipe

Une fois que vous avez sélectionné les paramètres d’affichage de l’objet,
vous pouvez le coller dans le panneau.

Voyons cette procédure.

Dans la figure suivante, le bouton-poussoir indique que “Oatmeal”
(flocons d’avoine) est la recette actuellement sélectionnée. Les valeurs
de la farine, des œufs et du beurre indiquées avec le bouton-poussoir ne
sont que des expressions comprenant les données membres respectives
de l’objet Recipe. Passez maintenant à la recette Chocolate Chip
(copeaux de chocolat). Quand vous cliquez sur le bouton-poussoir
représentant la recette, une liste de recettes s’affiche.

  

Etape 1 Etape 2        Etape 3
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Quand nous sélectionnons une nouvelle recette, Lookout écrit les valeurs
des ingrédients pour la recette sélectionnée dans les données membres
correspondantes de l’objet.

Le nombre actuel de données membres d’un objet Recipe est basé sur
son nombre d’ingrédients. La boîte de dialogue Insert Expression
l’explique plus clairement.

Notez qu’il existe quatre données membres pour chaque ingrédient
défini. Les noms actuels des données membres de l’objet varient selon
les ingrédients de votre recette. (Peut-être n’utilisez-vous pas de sucre
roux.) Cependant, les quatre types de données membres lisibles de
chaque ingrédient sont cohérents.
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Données membres Recipe

Donnée
membre

Type Lecture Ecriture Description

(implicite) Texte Oui Non Nom de la recette actuellement
sélectionnée

B - IV Numérique Oui Non Chaque lettre, de B à IV, représente une
colonne dans la feuille de calcul. La valeur
de la donnée membre est la quantité
numérique de l’ingrédient pour la recette
actuellement sélectionnée

B.logical

à

IV.logical

Logique Oui Non Chaque lettre, de B à IV, représente une
colonne dans la feuille de calcul. Rend Vrai
(Marche) si la quantité de l’ingrédient dans
la cellule de la feuille de calcul pour la
recette sélectionnée est supérieure à zéro.
Rend Faux si la quantité spécifiée pour
l’ingrédient est égale à zéro

B.txt - IV.txt Texte Oui Non Chaque lettre, de B à IV, représente une
colonne dans la feuille de calcul. La valeur
de la donnée membre est la quantité
textuelle de l’ingrédient pour la recette
actuellement sélectionnée

B.unavail

à

IV.unavail

Logique Oui Non Chaque lettre, de B à IV, représente une
colonne dans la feuille de calcul. Rend Vrai
si la cellule de la feuille de calcul est vide.
Rend Faux si la cellule contient des
données

pick1

à

pick1000

Logique Non Oui Au passage de Faux à Vrai, sélectionne la
recette respective dans la feuille de calcul.
Quand elle est utilisée avec des objets
Pushbutton, cette donnée membre peut
éliminer l’usage d’une liste déroulante de
recettes

Commentaires L’objet Recipe lit un bloc de colonnes contiguës. Ainsi, les noms des
ingrédients doivent former une liste contiguë dans la rangée 1. Si une
recette n’utilise pas l’un des ingrédients, laissez vide la cellule
respective.
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Quand Lookout trouve une cellule vide dans la colonne A, il ignore toute
la rangée. Ainsi, nous pouvons facilement annoter nos recettes en
laissant vide une cellule de la colonne A et en ajoutant du texte dans la
cellule de la colonne B dans la même rangée.

e   Run
Les objets Run (éxecution) démarrent un fichier de programme externe
au sein de Lookout. Quand le résultat de l’expression logique Run when
passe à Vrai, l’objet exécute Command line .

Boîte de dialogue des paramètres de définition de Run

Dans cet exemple, Lookout exécute une commande macro Excel
nommée REPORT1.XLM quand la valeur logique rendue par Timer1
passe à Vrai. Timer1  est un objet TimeofDay (heuredujour) qui
déclenche l’exécution d’un rapport à 8 heures tous les matins.

L’expression textuelle Command line  doit figurer entre guillemets,
comme indiqué dans la figure. Notez que notre exemple comprend le
nom de chemin complet pour le fichier d’exécution. Vérifiez que la ligne
de commande satisfait bien les exigences syntaxiques de DOS. Vu que
c’est un champ de données d’expression, la commande pourrait être le
résultat d’une expression textuelle.

Avec les sélections Start program , vous pouvez spécifier l’affichage
d’une application quand vous l’activez. Si vous sélectionnez Normal , la
fenêtre de l’application apparaît par dessus la fenêtre de Lookout quand
celui-ci est activé. Si vous souhaitez que l’application soit représentée
sous forme d’icône chaque fois que vous la démarrez, sélectionnez
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Iconic . Si vous sélectionnez Maximized , la fenêtre de l’application
remplace la fenêtre de Lookout à l’écran. (Lookout est toujours exécuté
mais invisible. Appuyez sur ALT+TAB pour passer d’une application à
l’autre.)

Données membres Run

Donnée
membre

Type Lecture Ecriture Description

aucune Run n’a pas de données membres

Commentaires Si l’application ne s’arrête pas automatiquement, il se peut que plusieurs
itérations coexistent. Avec le temps, l’effet cumulatif peut
considérablement ralentir la performance de Windows.

Si vous souhaitez exécuter des commandes DOS au sein de Lookout,
placez les commandes dans un fichier DOS par lots (.BAT ) et identifiez
ensuite ce fichier dans la ligne de commande.

Sample
L’objet Sample (échantillon) est un objet Sample-and-hold
(échantillonneur-bloqueur) : l’expression Data est échantillonnée et
stockée toutes les fois que l’expression Reset passe d’Arrêt à Marche et
que l’expression Enable est Vrai. Sample maintient un tableau contenant
jusqu’à 35 échantillons précédents. Si le champ Enable est vide, le
système suppose que cette expression est Vrai. Data est une expression
numérique tandis que Reset et Enable sont des expressions logiques.
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Remarque Sample n’a pas de boîte de dialogue des paramètres d'affichage.
Cependant, vous pouvez facilement afficher le résultat du signal de sortie
de Sample en évoquant sa donnée membre dans une expression.

Donnée
membre

Type Lecture Ecriture Description

(implicite) Numérique Oui Non Valeur actuelle de Data : traque la valeur
d’entrée de Data. Si vous avez besoin de
cette valeur, utilisez le signal de l’entrée
actuelle

1 - 35 Numérique Oui Non Echantillons précédents. Signal 1 est
l’échantillon le plus récent depuis que
Reset est passé à High

DataReset Logique Non Oui Au passage de Faux à Vrai, remet à zéro
toutes les données membres, y compris la
valeur actuelle et tous les échantillons
précédents

Commentaires L’expression Reset peut être une impulsion régulière créée par une
horloge TimeOfxxxx. Par exemple, si vous souhaitez échantillonner la
température toutes les heures, utilisez le signal de sortie d’une horloge
TimeOfHour dans l’expression Reset pour échantillonner la température
au début de chaque heure.

Objets associés Minimum, Maximum, Average (moyenne), SampleText



Chapitre 18. Définitions des classes d’objets

517

SampleText
L’objet SampleText est un objet Sample-and-hold (échantillonneur-
bloqueur). Il échantillonne et stocke l’expression Data toutes les fois que
l’expression Reset passe d’Arrêt à Marche et que l’expression Enable
est Vrai. Sample maintient un tableau contenant jusqu’à 35 échantillons
précédents. Si le champ Enable est vide le système suppose que cette
expression est Vrai.

Boîte de dialogue des paramètres de définition de SampleText

Data est une expression textuelle tandis que Reset et Enable sont des
expressions logiques.

Remarque SampleText n’a pas de boîte de dialogue des paramètres d'affichage.
Cependant, vous pouvez facilement afficher le résultat du signal de sortie
Sample en évoquant sa donnée membre dans une expression.
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Données membres SampleText

Donnée
membre

Type Lecture Ecriture Description

(implicite) Texte Oui Non Valeur actuelle de Data : traque la valeur
d’entrée de Data. Si vous avez besoin de cette
valeur, utilisez le signal de l’entrée actuelle

1 - 35 Texte Oui Non Echantillons précédents. Signal 1 est
l’échantillon le plus récent depuis que Reset
est passé à High

DataReset Logique Non Oui Au passage de Faux à Vrai, remet à zéro
toutes les données membres, y compris la
valeur actuelle et tous les échantillons
précédents

Objets associés Sample, TextEntry

Scale
La classe d’objets Scale (échelle) crée des échelles dynamiques, c’est-à-
dire des échelles dont les gammes et les divisions peuvent changer selon
les expressions numériques des paramètres.

Remarque Si vous souhaitez créer une échelle simple qui ne change pas de façon
dynamique (ce qui est normalement le cas), utilisez la commande
Insert→Scale... décrite au chapitre 17.

Boîte de dialogue des paramètres de définition de Scale

Absolute Minimum  et Absolute Maximum  sont des constantes
numériques. Elles définissent la gamme la plus complète possible que
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l’échelle peut montrer. Ces valeurs agissent comme des bornes qui
limitent Minimum et Maximum .

Minimum  et Maximum sont des expressions numériques qui permettent
de changer les valeurs maximum et minimum de l’échelle. Dans
l’exemple ci-dessus, la valeur la plus élevée de l’échelle (Maximum ) est
400 si Pot1  est inférieur à 400, 1600 si Pot1  est supérieur à 1 600 (à
cause de Absolute Maximum ), ou elle est égale à la valeur de Pot1.

Major unit  spécifie le nombre d’unités entre les coches principales.
Minor unit  spécifie le nombre d’unités entre les coches les moins
importantes.

Quand vous cliquez sur OK, la boîte de dialogue Display Scale apparaît.

Boîte de dialogue des paramètres d’affichage de Scale

Spécifiez Orientation , Color , Label format  et Label font  selon vos
besoins.

Vous pouvez enlever les coches les moins importantes en
désélectionnant la case à cocher Minor tick marks  et vous pouvez
enlever les numéros des étiquettes de votre échelle en désélectionnant la
case à cocher Labels . (Seules les unités majeures ont des étiquettes
numériques.)
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Données membres Scale

Donnée
membre

Type Lecture Ecriture Description

visible Logique Non Oui Quand Vrai, l’objet Scale devient visible dans
le panneau de contrôle. Quand Faux, il est
invisible. La valeur par défaut est Vrai

Commentaires Cette classe d’objets est souvent utilisée avec les objets HyperTrends
configurés pour un axe variable Y. Les paramètres Minimum et
Maximum  de l’objet Scale sont configurés selon les mêmes valeurs que
les données membres Max et Min  de l’objet HyperTrend.

SiemensTI505
SiemensTI505 est une classe d’objets Protocol driver (driver de
protocole) Ethernet qui permet à Lookout de communiquer avec les API
Siemens SIMATIC™ TI505™ munis de CP1431 NIM.

Conçue pour fonctionner avec la bibliothèque de classes d’objets
SINEC™ TF, cette classe d’objets utilise le protocole SINEC H1 et est à
100 % conforme à la couche d’application de la pile de protocole SINEC
H1-TF de Siemens.

Votre ordinateur doit être doté d’une carte de communication Siemens
CP 1413 Ethernet et du logiciel Siemens TF-NET 1413. Reportez-vous à
Configuration H1-TF ci-dessous pour des instructions sur l’installation
du driver H1.
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Boîte de dialogue de définition de la classe d’objets SiemensTI505

PLC Model spécifie le numéro de modèle de l’API pour l’appareil
requis. La liste comprend les API SIMATIC TI545, TI555 et TI565.

Application association identifie le nom d’une application que vous
définissez avec le programme SINEC COM1413T.EXE . Ce nom
identifie l’appareil physique que votre objet représente. Reportez-vous à
Configuration H1-TF ci-dessous pour plus d’informations.

PollRate est une expression numérique qui détermine la fréquence
d’appel de l’appareil. Lookout convertit la valeur numérique de PollRate
en un signal temporel qui représente les jours et les fractions de jour.
Ensuite, SiemensTI505 interroge l’appareil à l’intervalle de temps
spécifié. En général, c’est une simple constante temporelle comme 0:01
(une seconde). Reportez-vous à la section intitulée Les données membres
numériques, au chapitre 5, pour plus d’informations sur la saisie des
constantes temporelles.

Poll est une expression logique dont le passage de Faux à Vrai provoque
l’appel de l’appareil par Lookout. Ceci peut être une simple expression,
comme le signal d’un bouton-poussoir, ou un algorithme complexe.
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Retry attempts spécifie le nombre de tentatives consécutives entreprises
par Lookout pour communiquer avec un appareil qui ne produit pas de
réponse valable. Une fois que l’objet essaie à nouveau d’établir la
communication le nombre de fois spécifié, il génère une alarme et
Lookout passe ensuite au prochain appareil dans la queue d’interrogation
(si elle existe).

Receive timeout est la durée pendant laquelle Lookout attend une
réponse d’un appareil avant de renouveler la requête.

Communication alarm priority détermine le niveau de priorité des
alarmes générées par l’objet SiemensTI505.

Le paramètre Skip every__polls demande à Lookout de ne pas
interroger l’appareil avec lequel il n’a pas pu établir de communication
au cours des interrogations programmées. Ainsi, Lookout saute cet
appareil pendant le cycle d’interrogation. Une fois que les
communications sont rétablies, l’appareil est interrogé au cours de son
cycle normal.

Configuration H1-TF

1. Installez le logiciel de configuration du driver Siemens TF-NET1413
MSDOS/Windows, y compris l’outil de configuration COML 1413
TF.

2. Configurez l’adresse CP1413 Ethernet MAC, le mappage de
mémoire et les autres paramètres en exécutant le programme suivant
à partir du DOS (et non Windows) :

 C:\SINEC\BIN\NETINST.EXE .

 Ceci crée un fichier de texte nommé C:\SINEC\DATA\
DOS_CONF.DAT qui stocke les paramètres de configuration. Vous
pourrez éditer ce fichier ultérieurement pour changer les paramètres
de la carte au lieu d’exécuter le programme d’installation.
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3. Si vous utilisez un gestionnaire de mémoire tel que EMM386,
ajoutez une instruction d’exclusion de mémoire dans le fichier
CONFIG.SYS de votre ordinateur. Par exemple, entrez :

DEVICE=C:\WINDOWS\EMM386.EXE X=D000-DFFF

La carte CP 1413 Ethernet utilise 64 Ko de RAM à double accès.
Des adresses possibles de démarrage sont D0000 et E0000.

Remarque Vérifiez qu’aucun autre driver n’est mappé sur l’emplacement de la
mémoire désirée.

4. A partir de Windows, exécutez C:\SINEC\COM\COM1413T.EXE
(l’icône à trois pions) et configurez la base de données pour le nom
et l’adresse de l’API que vous chargerez sur la carte CP 1413 au
cours du démarrage du système. Créez un fichier de base de données
nommé STARTUP et enregistrez-le dans le répertoire
C:\SINEC\DATA .

Ce programme crée deux fichiers : votre base de données sera
représentée par les fichiers STARTUP.LDB et STARTUP.TXT. Ces
fichiers contiennent les noms d’association de l’application
nécessaires pour chaque API.

Remarque Il existe une ligne de texte dans DOS_CONF.DAT qui fait référence au
fichier STARTUP.LDB. Pour utiliser un chemin ou nom de fichier différent
pour votre fichier .LDB , modifiez DOS_CONF.DAT de façon à ce qu’il
fasse référence au fichier que vous créez.
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Une configuration SINEC COML pour un API. Vous pouvez augmenter les
tailles PDU et TPDU à 1 000 et 1 024, respectivement.

5. A partir de Windows, exécutez C:\SINEC\H1\H1.EXE  (l’icône à
pion unique) pour créer un fichier de configuration H1. Reportez-
vous à la figure de la page suivante. Ensuite, en utilisant le port
série sur le NIM, téléchargez le fichier de configuration dans H1
NIM de l’API.

Vous devez entrer une adresse unique Ethernet et une association
d'application qui correspond à celle du fichier .LDB . Vérifiez
également que les valeurs du TSAP local et du TSAP à distance
correspondent exactement aux paramètres du fichier .LDB , excepté
que les valeurs de TSAP local et de TSAP à distance sont inversées.

Créez un fichier de configuration H1 pour chaque NIM dans chaque
API.

Remarque L’association d’application, le TSAP local, le TSAP à distance et presque
tous les autres éléments du logiciel Siemens respectent l’usage des
majuscules et des minuscules.

Adresse de
l’ordinateur Lookout

local

Association d’application à
utiliser dans Lookout

Adresse Ethernet
de l’API
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6. Téléchargez la configuration de chaque NIM via le port série du
NIM.

7. Editez votre fichier AUTOEXEC.BAT et ajoutez la commande
suivante à la fin du fichier mais avant toute autre commande
“WIN”) :

 CALL C:\SINEC\BIN\STARTCP.BAT

8. Réinitialisez votre ordinateur.

9. Dans Lookout, créez un objet SIEMENSTI505 pour chaque API en
utilisant l’association d’application appropriée. Vous êtes
maintenant prêt à accéder aux variables des API de Lookout.

Les données membres

Les objets Protocol driver contiennent de nombreuses données. Toutes
les données membres lisibles et écrites (entrées/sorties), les instructions
d’interrogation, la lecture/écriture bloquante, l’utilisation des ports série,
etc., sont regroupés avec l’objet. Ainsi, dès que vous créez un objet
SiemensTI505, vous accédez immédiatement à toutes les données membres
de cet objet (reportez-vous à la liste des données membres ci-dessous).
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Remarque Les objets Protocole driver de Lookout génèrent automatiquement une
structure efficace de lecture/écriture bloquante selon les entrées et les
sorties utilisées dans votre fichier de processus. Vous n’avez pas besoin
de créer votre propre table de blocage d’E/S.

Données membres SiemensTI505

Donnée membre Type Lecture Ecriture Description

AACK1 -
AACK32000

numérique Oui Oui (Alarme analogique) Fanions
d’acquittement de l’alarme

AADB1 -
AADB32000

numérique Oui Oui (Alarme analogique) Zone morte

ACF1 - ACF32000 numérique Oui Oui (Alarme analogique) Fanions
d’alarme C

ACFH1 -
ACFH32000

numérique Oui Oui (Alarme analogique) Fanions d’alarme
C du mot le plus significatif

ACFL1 -
ACFL32000

numérique Oui Oui (Alarme analogique) Fanions d’alarme
C du mot le moins significatif

AERR1 -
AERR32000

numérique Oui Oui (Alarme analogique) Erreur d’alarme

AHA1 - AHA32000 numérique Oui Oui (Alarme analogique) Limite d’alarme
haute

AHHA1 -
AHHA32000

numérique Oui Oui (Alarme analogique) Limite d’alarme
haute-haute (très haute)

ALA1 - ALA32000 numérique Oui Oui (Alarme analogique) Limite d’alarme
basse

ALLA1 -
ALLA32000

numérique Oui Oui (Alarme analogique) Limite d’alarme
basse-basse (très basse)

AODA1 -
AODA32000

numérique Oui Oui (Alarme analogique) Limite de déviation
orange

APV1 - APV32000 numérique Oui Oui (Alarme analogique) Variable du
processus

APVH1 -
APVH32000

numérique Oui Oui (Alarme analogique) Limite haute de la
variable du processus

APVL1 -
APVL32000

numérique Oui Oui (Alarme analogique) Limite basse de la
variable du processus
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Données membres SiemensTI505 (suite)

Donnée membre Type Lecture Ecriture Description

ARCA1 -
ARCA32000

numérique Oui Oui (Alarme analogique) Limite de la
vitesse de changement

ASP1 - ASP32000 numérique Oui Oui (Alarme analogique) Consigne

ASPH1 -
ASPH32000

numérique Oui Oui (Alarme analogique) Limite de consigne
haute

ASPL1 -
ASPL32000

numérique Oui Oui (Alarme analogique) Limite de consigne
basse

ATS1 - ATS32000 numérique Oui Oui (Alarme analogique) Vitesse
d’échantillonnage

AVF1 - AVF32000 numérique Oui Oui (Alarme analogique) Fanions d’alarme

AYDA1 -
AYDA32000

numérique Oui Oui (Alarme analogique) Limite de déviation
jaune

C1 - C32000 logique Oui Oui Registres de contrôle

CommFail logique Oui Non Signal généré par le driver qui est
activé si, pour une raison quelconque,
Lookout ne peut pas communiquer
avec l’appareil

DCC1 -
DCC32000

numérique Oui Non Comptage actuel du tambour

DSC1 -
DSC32000

numérique Oui Oui Pas actuel du tambour

DSP1 - DSP32000 numérique Oui Oui Pas prédéfini du tambour

K1 - K32000 numérique Oui Oui Valeur 16 bits entière non signée de
mémoire K s'étendant de 0 à 65 535

K1. - K32000. numérique Oui Oui Valeur à virgule flottante IEEE 32 bits
de mémoire K

K1D - K32000D numérique Oui Oui Valeur 32 bits entière non signée de
mémoire K

K1S - K32000S numérique Oui Oui Valeur 16 bits entière de valeur de
mémoire K s’étendant de -32 768 à 32
767

LACK1 -
LACK32000

numérique Oui Oui (Boucle) Fanions d’acquittement
d’alarme
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Données membres SiemensTI505 (suite)

Donnée membre Type Lecture Ecriture Description

LADB1 -
LADB32000

numérique Oui Oui (Boucle) Zone morte

LCF1 - ACF32000 numérique Oui Oui (Boucle) Fanions C

LCFH1 -
LCFH32000

numérique Oui Oui (Boucle) Fanions C du mot le plus
significatif

LCFL1 -
LCFL32000

numérique Oui Oui (Boucle) Fanions C du mot le moins
significatif

LERR1 -
LERR32000

numérique Oui Non (Boucle) Erreur

LHA1 - LHA32000 numérique Oui Oui (Boucle) Limite d’alarme haute

LHHA1 -
LHHA32000

numérique Oui Oui (Boucle) Limite d’alarme haute-haute
(très haute)

LKC1 - LKC32000 numérique Oui Oui (Boucle) Gain

LKD1 - LKD32000 numérique Oui Oui (Boucle) Gain dérivatif

LLA1 - LLA32000 numérique Oui Oui (Boucle) Limite d’alarme basse

LLLA1 -
LLLA32000

numérique Oui Oui (Boucle) Limite d’alarme basse-basse
(très basse)

LM1 - LM32000 numérique Oui Oui (Boucle) Mode

LMN1 -
LMN32000

numérique Oui Oui (Boucle) Sortie

LMX1 - LMX32000 numérique Oui Oui (Boucle) Biais

LODA1 -
LODA32000

numérique Oui Oui (Boucle) Limite de déviation orange

LPV1 - LPV32000 numérique Oui Oui (Boucle) Variable du processus

LPVH1 -
LPVH32000

numérique Oui Oui (Boucle) Limite haute de la variable du
processus

LPVL1 -
LPVL32000

numérique Oui Oui (Boucle) Limite basse de la variable du
processus

LRCA1 -
LRCA32000

numérique Oui Oui (Boucle) Limite de la vitesse de
changement

LRSF1 -
LRSF32000

numérique Oui Oui (Boucle) Fanions d’état
rampe/infiltration
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Données membres SiemensTI505 (suite)

Donnée membre Type Lecture Ecriture Description

LS1 - LS32000 numérique Oui Non (Boucle) Etat

LSP1 - LSP32000 numérique Oui Oui (Boucle) Consigne

LSPH1 -
LSPH32000

numérique Oui Oui (Boucle) Limite de consigne haute

LSPL1 -
LSPL32000

numérique Oui Oui (Boucle) Limite de consigne basse

LTD1 - LTD32000 numérique Oui Oui (Boucle) Vitesse

LTI1 - LTI32000 numérique Oui Oui (Boucle) Remise à zéro

LTS1 - LTS32000 numérique Oui Oui (Boucle) Vitesse d’échantillonnage

LVF1 - LVF32000 numérique Oui Oui (Boucle) Fanions V

LYDA1 -
LYDA32000

numérique Oui Oui (Boucle) Limite de déviation jaune

Poll logique Non Oui Au passage de Faux à Vrai, l’objet
Lookout interroge l’appareil

PollRate numérique Non Oui Spécifie combien de fois l’objet Lookout
interroge l’appareil

TCC1 - TCC32000 numérique Oui Oui (Alarme analogique) Valeur actuelle de
l’horloge/compteur

TCP1 - TCP32000 numérique Oui Oui (Alarme analogique) Valeur prédéfinie
de l’horloge/compteur

Update logique Oui Non Signal généré par le driver qui émet
une impulsion chaque fois que le driver
interroge l’appareil

V1 - V32000 numérique Oui Oui Valeur 16 bits entière de valeur de
mémoire V s’étendant de 0 à 65 535

V1. - V32000. numérique Oui Oui Valeur à virgule flottante IEEE 32 bits
de mémoire V

V1D - V32000D numérique Oui Oui Valeur 32 bits entière non signée de
mémoire V

V1S - V32000S numérique Oui Oui Valeur 16 bits entière de valeur de
mémoire V s’étendant de -32 768 à 32
767
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Données membres SiemensTI505 (suite)

Donnée membre Type Lecture Ecriture Description

WX1 - WX32000 numérique Oui Non Entrées d’images de mots ; valeurs 16
bits s’étendant, en général, de 6 400 à
32 000 pour les signaux 4 à 20 mA, et
de 0 à 32 000 pour les signaux de 0 à
5V

WY1 - WY32000 numérique Oui Oui Sorties d’images de mots ; valeurs 16
bits s’étendant, en général, de 6 400 à
32 000 pour les signaux 4 à 20 mA, et
de 0 à 32 000 pour les signaux de 0 à
5V

X1 - X32000 Logique Oui Non Entrées discrètes ; les X non affectés
peuvent servir de registres de contrôle

Y1 - Y32000 Logique Oui Oui Sorties discrètes ; même espace de
mémoire que les entrées discrètes et
donc X37 se rapporte au même point
que Y37. Les Y non affectés peuvent
servir de registres de contrôle

Les messages d’état

Les alarmes suivantes sont des codes d’erreur SINEC rendus par le
logiciel Siemens. Pour plus d’informations, reportez-vous à la
documentation du Siemens SINEC TF.

Error xxxxxxxx: cannot initialize Sinec TF service
(Erreur xxxxxxxx : impossible d’initialiser le service Sinec TF)

Error xxxxxxxx: hardware error
(Erreur xxxxxxxx : erreur de matériel)

Error xxxxxxxx: invalid address
(Erreur xxxxxxxx : adresse non valable)

Error xxxxxxxx: invalid app. assoc. name: xxxx
(Erreur xxxxxxxx : nom d’association d’application non valable : 
xxxx)
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Error xxxxxxxx: more than one object using same app. assoc.
(Erreur xxxxxxxx : plus d’un objet utilise la même association 
d’application)

Error xxxxxxxx: no more space in PDU
(Erreur xxxxxxxx : plus d’espace dans le PDU)

Error xxxxxxxx: no response
(Erreur xxxxxxxx : pas de réponse)

Error xxxxxxxx: no response (reconnecting)
(Erreur xxxxxxxx : pas de réponse [reconnexion en cours])

Error xxxxxxxx: not available at times
(Erreur xxxxxxxx : pas disponible à certains moments)

Error xxxxxxxx: object access not allowed
(Erreur xxxxxxxx : accès à l’objet interdit)

Error xxxxxxxx: object attribute inconsistent
(Erreur xxxxxxxx : attribut de l’objet incohérent)

Error xxxxxxxx: object does not exist
(Erreur xxxxxxxx : l’objet n’existe pas)

Error xxxxxxxx: object not defined
(Erreur xxxxxxxx : objet non défini)

Error xxxxxxxx: object now invalid
(Erreur xxxxxxxx : objet non valable maintenant)

Error xxxxxxxx: type not supported
(Erreur xxxxxxxx : type non supporté)

Error xxxxxxxx: type/alt acc. not consistent
(Erreur xxxxxxxx : type/compte alt non cohérent)
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Sixnet
La classe d’objets Protocol driver (driver de protocole) Sixnet® permet à
Lookout de communiquer avec les téléterminaux IOMUX Sixnet (unités
terminales à distance), les téléterminaux Versamux et les modules E/S
Sixtrak™ montés sur rail DIN.

La classe d’objets Sixnet de Lookout s’interface avec le logiciel Control
Room “poste de contrôle” de Sixnet via des appels éclairs DLL directs
(non DDE). Grâce à cette connexion homogène entre programmes,
Lookout communique avec les appareils Sixnet via votre port série
(RS-232 ou RS-422/485), Ethernet ou RTUnet.

Remarque Cette classe d’objets Protocol driver exige une version 1.0 ou ultérieure,
du logiciel Sixnet Control Room I/O Map et une version 3.5 (15) ou
ultérieure de Lookout.

Créez un objet Sixnet de Lookout pour chaque station que vous
définissez dans votre logiciel Control Room. Nous vous conseillons
d’utiliser les préfixes à huit lettres des stations Sixnet quand vous
nommez les objets Lookout, afin que les noms Sixtags se rapprochent le
plus possible des pseudonymes de Lookout.
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Paramètres Sixnet

Station name  est une liste déroulante de toutes les stations définies dans
le logiciel Control Room. Sélectionnez la station qui représentera l’objet.

PollRate est une expression numérique qui détermine combien de fois
interroger le logiciel Control Room. En général, il s’agit d’une simple
constante temporelle comme 0:01 (une seconde) mais vous pouvez
choisir de créer une expression complexe où PollRate  change
dynamiquement selon des critères spécifiés. Reportez-vous à la section
intitulée Les données membres numériques, au chapitre 5, pour plus
d’informations sur la saisie des constantes temporelles et des variables.

Poll est une expression logique qui, au passage de Faux à Vrai, fait que
Lookout interroge le logiciel Control Room. Il peut s’agir d’une simple
expression comme le signal d’un bouton-poussoir, ou un algorithme
complexe.

Communication alarm priority  détermine le niveau des alarmes
générées par l’objet Sixnet de Lookout. De telles alarmes sont
normalement dues au handshaking DLL avec le logiciel Control Room.

Données membres Sixnet

Un objet Sixnet représente toutes les valeurs d’une station particulière et
comprend donc un grand nombre de données. L’objet supporte la lecture
et l’écriture de tous les types de points de données possibles, y compris
les types d’E/S prédéfinis et définis par l’utilisateur. Quand vous créez
un objet Sixnet, vous accédez immédiatement à toutes les données au
sein de la station d’affectation (reportez-vous à la liste de données
membres ci-après).

Chaque registre du plan mémoire d’E/S de Sixnet correspond à une
donnée membre au sein de l’objet Sixnet de Lookout. Le numéro et
l’adresse du type d’E/S du registre sont encodés dans le nom de la
donnée membre. Les numéros du type d’E/S prédéfinis correspondent
aux préfixes des données membres de Lookout, comme indiqué ci-
dessous.
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Numéro de type
d’E/S

Préfixe donnée membre

0 AI (entrée analogique)

1 AO (sortie analogique)

10 DI (entrée discrète)

11 DO (sortie discrète)

20 LongIn (entrée longue)

21 LongOut (sortie longue)

22 FloatIn (entrée flottante)

23 FloatOut (sortie flottante)

Pour les types d’E/S définis par l’utilisateur, le nom de la donnée
membre de Lookout spécifie le numéro du type d’E/S Sixnet de la façon
suivante :

   <Type de donnée><Numéro type d’e/s>:<Adresse>

où <Type de donnée> est Bit (bit), Byte (octet), Short (court), Word
(mot), Long (long), Float (flottant) ou Double (double) ; <Numéro type
d’e/s> est un chiffre entre 0 et 126 inclus et <Adresse> est un chiffre
dont la gamme autorisée dépend du type de donnée. Ainsi, le point
Sixnet1.Word33:99  de Lookout correspond au centième registre
dont le numéro de type d’E/S est 33 pour la station
Sixnet1.Station . Le registre est lu comme un mot (c’est-à-dire un
chiffre à 16 bits non signé).

Avec Lookout, vous pouvez utiliser n’importe quel type de donnée avec
n’importe quel numéro de type d’E/S. Vous pouvez donc lire une valeur
longue (chiffre à 32 bits signé) à partir de deux registres analogiques
consécutifs et obtenir plus facilement la valeur d’un compteur de 32 bits
stocké dans les registres de 16 bits consécutifs d’un API. Par exemple, la
donnée membre Long0:7  correspondrait aux entrées analogiques AI7
et AI8 et serait interprétée comme un registre signé de 32 bits. Ainsi,
vous pouvez lire la valeur analogique comme une valeur signée (en
utilisant AI0  ou Short0:0 ) ou comme une valeur non signée (en
utilisant Word0:0 ).

Remarque L’écriture d’un bit sur un registre analogique règle la valeur analogique
sur 0 ou 1 ; elle ne règle pas seulement l’un des bits sur 0 ou 1.
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Données membres Sixnet

Donnée membre Type Lecture Ecriture Description

AI0 - AI32499 numérique Oui Oui Entrée analogique encodée comme
nombre entier signé de 16 bits
s’étendant de -32 767 à +32 768

AO0 - AO32499 numérique Oui Oui Sortie analogique encodée comme
nombre entier signé de 16 bits
s’étendant de -32 767 à +32 768

Bit0:0 - Bit126:64999 logique Oui Oui E/S discrètes définies par l’utilisateur
(vrai ou faux)

Byte0:0 -
Byte126:64999

numérique Oui Oui Registre défini par l’utilisateur
encodé comme nombre entier non
signé de 8 bits s’étendant de zéro à
255

CommFail logique Oui Non Signal généré par le driver qui est
activé si Lookout ne peut pas
communiquer avec l’appareil pour
quelque raison que ce soit

DI0 - DI64999 logique Oui Oui Entrée discrète (vrai ou faux)

DO0 - DO64999 logique Oui Oui Sortie discrète (vrai ou faux)

Double0:0 -
Double126:8124

numérique Oui Oui E/S définies par l’utilisateur faisant
référence à 4 registres consécutifs
encodés comme valeur à virgule
flottante unique de 64 bits

Float0:0 -
Float126:16299

numérique Oui Oui Paire de registres définis par
l’utilisateur, encodée comme valeur à
virgule flottante IEEE de 32 bits

FloatIn0 -
FloatIn16299

numérique Oui Oui Valeur à virgule flottante IEEE de 32
bits. Lit les deux registres adjacents
comme valeur à virgule flottante
unique de 32 bits

FloatOut0 -
FloatOut16299

numérique Oui Oui Valeur à virgule flottante IEEE de 32
bits. Ecrit les deux registres
adjacents comme valeur à virgule
flottante unique de 32 bits
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Données membres Sixnet (suite)

Donnée membre Type Lecture Ecriture Description

Long0:0 -
Long126:16299

Numérique Oui Oui Paire de registres définis par
l’utilisateur, encodée comme nombre
entier long signé de 32 bits. Lookout
lit deux registres adjacents comme
chiffre unique de 32 bits s’étendant
de -2 147 483 648 à +2 147 483 647

LongIn0 -
LongIn16299

Numérique Oui Oui Entrée longue encodée comme entier
long signé de 32 bits. Lookout lit
deux registres adjacents comme
chiffre unique de 32 bits s’étendant
de -2 147 483 648 à +2 147 483 647

LongOut0 -
LongOut16299

Numérique Oui Oui Sortie longue encodée comme entier
long signé de 32 bits. Lookout écrit
deux registres adjacents comme
chiffre unique de 32 bits s’étendant
de -2 147 483 648 à +2 147 483 647

Poll logique no Oui Expression Lookout qui génère une
interrogation de l’appareil au
passage de “faux” à “vrai”

PollRate Numérique no Oui Expression Lookout qui détermine la
fréquence d’interrogation de
l’appareil

Short0:0 -
Short126:32499

Numérique Oui Oui Registre défini par l’utilisateur
encodé comme nombre entier signé
de 16 bits s’étendant de -32 767 à
+32 768

Station texte Oui non Nom de la station (par ex.,
“Ordinateur local”)

Update logique Oui non Signal généré par le driver qui
effectue une impulsion chaque fois
que le driver interroge l’appareil

Word0:0 -
Word126:32499

Numérique Oui non Registre défini par l’utilisateur,
encodé comme nombre entier non
signé de 16 bits s’étendant de 0 à 65
535
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Importation de la base de données Sixtags

L’objet Sixnet de Lookout vous permet d’exploiter la base de données
Sixtags de Sixnet. Vous créez d’abord au moins un objet Sixnet, puis la
classe Sixnet ajoute une sélection (Import Sixtags database…) au
menu Options de Lookout. A l’aide de cette commande, vous pouvez
importer un jeu de pseudonymes pour une ou plusieurs stations.

Quand vous
sélectionnez la
commande de menu,
une boîte de dialogue
affiche la liste de tous
les objets Sixnet de
Lookout, y compris
leurs noms de variables et les noms des stations correspondantes. A
partir de la boîte de dialogue, sélectionnez un ou plusieurs noms de
stations et cliquez sur Import. Remarquez que les espaces dans les noms
Sixtags sont remplacés par des caractères de soulignement. Vous pouvez
réimporter des fichiers Tag à mesure que vos données Sixtags sont
modifiées ; Lookout réajustera automatiquement les noms de variables
pseudonymes en temps réel.

Messages d’état

Sixnet .cbx file not found
(Fichier Sixnet .cbs non trouvé)
Si vous recevez ce message lors du chargement d’un fichier de processus
de Lookout qui utilise un objet Sixnet, ou si la classe Sixnet n’est pas
visible dans la liste Select object class quand vous essayez de créer un
nouvel objet Sixnet, il vous faudra peut-être mettre à jour votre logiciel
Lookout. La classe d’objets Sixnet est founie avec la version 3.5 (15) de
Lookout et les versions ultérieures.
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Unable to load Sixnet IOMAP library: iodbase.dll
(Impossible de charger la bibliothèque Sixnet IOMAP : base de données
e/s.dll)
Le logiciel Sixnet n’est pas installé et Lookout ne peut pas trouver la
bibliothèque IODBASE.DLL. Vérifiez que le logiciel Control Room est
correctement installé. Une installation correcte place la bibliothèque
IODBASE.DLL dans le répertoire \WINDOWS\SYSTEM.

No Sixnet configuration currently loaded
(La configuration Sixnet n’est pas chargée)
Le logiciel I/O Map de Sixnet n’a pas encore démarré. Utilisez le
programme I/O Map de Sixnet pour ouvrir et exécuter un fichier de
projet. Le texte cité ci-dessous est un extrait du fichier d’aide du
programme I/O Map :

“The DLL must be loaded and scanning before [Lookout] can
control I/O. The easiest way to load the DLL and start scanning is to
run the Control Room Power Switch. As an alternative, you can
select the ‘Run’ command from the Control menu in I/O Map.”

“Le DLL doit être chargé et scannérisé avant que Lookout puisse
contrôler les E/S. La façon la plus facile de charger le DLL est de
commencer le scannage et d’exécuter le Control Room Power
Switch. Ou vous pouvez sélectionner la commande d’exécution
“Run” à partir du menu de contrôle dans I/O Map.”

Station <name> is not on line
(Station <nom> n’est pas en ligne)
Sixnet indique que la station nommée n’est pas en ligne. Il est possible
que Lookout puisse encore lire ou écrire dans les registres de cette
station, mais les mises à jour ne seront pas transmises à l’appareil à
distance.

Read error (<station name>, type <type number>, address <address>)
Write error (<station name>, type <type number>, address <address>)
Erreur de lecture (<nom de station>, type <numéro de type> adresse <adresse>)
Erreur de l’écriture (<nom de station>, type <numéro de type> adresse
<adresse>)
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L’une des raisons suivantes sera fournie :

• Adresse hors gamme

• Station, adresse ou numéro de type incorrect

• Numéro de type incorrect

Spinner
L’objet Spinner (disque rotatif) est un disque rotatif de petite taille dont
la vitesse de rotation peut varier selon la magnitude d’un Signal
numérique. Ou vous pouvez activer ou désactiver sa rotation via le signal
logique Spin .

Boîte de dialogue de définition des paramètres de Spinner

Les boutons Logic (on/off) et Numeric vous permettent de sélectionner
si le disque rotatif répond à un signal logique ou numérique.
Sélectionnez Logic si vous souhaitez seulement démarrer et arrêter le
disque rotatif. Sélectionnez Numeric si vous souhaitez que la vitesse du
disque rotatif varie selon une variable numérique.
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Spin est une expression logique. Quand le résultat d’une expression
logique est Vrai, le disque rotatif tourne à la vitesse définie dans le
champ Speed when spinning (%) (vitesse de rotation). Speed when
spinning (%)  est une constante numérique dans une gamme de zéro à
100.

Signal est une expression numérique. Le résultat de cette expression
détermine la vitesse de rotation selon la gamme linéaire définie par
Signal value at 0% speed (valeur du signal à 0 % de vitesse) et Signal
value at 100% speed (valeur du signal à 100 % de vitesse).

Données membres Spinner

Donnée membre Type Lecture Ecriture Description

Aucune Les objets Spinner n’ont pas de
données membres

Commentaires En général, les objets Spinner servent à représenter des révolutions sur
une ligne ou à indiquer qu’un moteur est en marche.

e   Spreadsheet
L’objet Spreadsheet (feuille de calcul) enregistre de façon permanente
les données sur disque dans des fichiers tableur. Vous pouvez enregistrer
des données à intervalles réguliers et irréguliers, quand la valeur d’une
donnée change, quand un événement a lieu, ou quand l’un de ces cas se
présente. Ainsi, vous pouvez incorporer des critères complexes
d’enregistrement pour satisfaire quasiment n’importe quelle exigence de
stockage de données.

Chaque enregistrement ajoute automatiquement une nouvelle rangée
dans le fichier tableur. Lookout peut enregistrer une nouvelle rangée de
données environ 10 fois par seconde ; cependant, les horodateurs
associés à chaque rangée sont arrondis à la seconde.

Spinners
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Chaque fichier tableur peut stocker n’importe quel nombre de signaux de
données. Chaque signal de donnée est affecté à une colonne dans la
feuille de calcul, en commençant par la colonne numéro deux. La
première colonne comprend la date et l’heure. La première rangée
comprend les expressions associées aux données dans chaque colonne.
Vous pouvez créer n’importe quel nombre d’objets Spreadsheet pour un
processus particulier.

Name est le nom de fichier utilisé pour créer un fichier tableur. Lookout
affecte un nom de fichier DOS à chaque fichier tableur en ajoutant
l’extension Type au nom. Pour l’instant, Lookout ne supporte qu’un seul
Type : format (.CSV) de valeur séparée par une virgule. La plupart des
bases de données et des tableurs, y compris Microsoft Excel, lisent
directement le format de fichier .CSV.

Etant donné que le paramètre Name est un champ d’expression textuelle,
vous pouvez créer de façon dynamique de nouveaux fichiers .CSV de
noms uniques. Ceci est particulièrement utile pour enregistrer des
données de processus par lots. La boîte de dialogue de définition
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ci-dessus est configurée pour qu’un opérateur puisse entrer un nom de
lot via un objet TextEntry (saisie de texte) avant de commencer le lot.
L’expression textuelle ajoute le nom du fichier au chemin spécifié,
C:\BATLOG\ . Si l’opérateur entre un nom du fichier comme
BATCH71, le nom complet de chemin est C:\BATLOG\BATCH71.CSV .
Quand le signal logique BatchRun  passe à vrai, Lookout crée le
nouveau fichier .CSV et commence à y passer des écritures. Quand
BatchRun  passe à Faux, l’enregistrement se termine mais laisse
l’enregistrement complet de toutes les données associées au lot.

L’exemple ci-dessus force Lookout à stocker le fichier .CSV dans un
répertoire particulier car il spécifie un nom de chemin complet. Si vous
entrez un nom de chemin relatif comme “\BATLOG\”&TextEntry1 ,
le fichier sera situé dans le sous-répertoire de Directory tree location .
Donc, le nom de chemin complet du ficher pourrait être
C:\LOOKOUT\1995\SEP\BATLOG\BATCH71.CSV , par exemple.

Si vous entrez seulement un nom de fichier comme “DATA” ,
l’emplacement du fichier se base sur le chemin spécifié par sélection de
Directory tree location . C’est ainsi que, le nom de chemin complet du
fichier pourrait être C:\LOOKOUT\1995\SEP\DATA.CSV , par
exemple.

Le paramètre Data files location dans la boîte de dialogue System
Options spécifie le répertoire racine dans lequel l’enregistrement de
toutes les données doit commencer. Lookout stocke les fichiers d’alarme
dans les sous-répertoires de ce répertoire racine comme spécifié par
Directory tree location . Reportez-vous à la commande
Options→System... au chapitre 16 pour plus d’informations.

Si vous sélectionnez Daily , Lookout crée tous les jours un nouveau
fichier et sous-répertoire pour le stockage des données. Si vous
sélectionnez Monthly , Lookout crée ces éléments tous les mois et si vous
sélectionnez Yearly , il fait de même tous les ans. Les fichiers Perpetual
sont stockés dans le répertoire racine comme spécifié par votre
paramètre Data files location .
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Les exemples suivants représentent des noms de fichier DOS et des
arborescences créés par Lookout pour un fichier tableur nommé DATA.
Nous supposons pour ces exemples que notre paramètre Data files
location  est C:\LOOKOUT.

Tous les jours

C:\LOOKOUT\1993\SEP\09\DATA.CSV

            \SEP\10\DATA.CSV

            \SEP\11\DATA.CSV

Tous les ans

C:\LOOKOUT\1993\DATA.CSV

       \1994\DATA.CSV

       \1995\DATA.CSV

Tous les mois

C:\LOOKOUT\1993\SEP\DATA.CSV

            \OCT\DATA.CSV

            \NOV\DATA.CSV

Perpétuel

C:\LOOKOUT\DATA.CSV

Les options Mechanisms to trigger data logging  sont un ensemble
d’outils qui servent à créer une structure d’enregistrement simple ou
complexe, selon vos besoins. Ces paramètres enregistrent des données en
se basant sur une horloge, un événement ou toute combinaison des deux.
Quand la feuille de calcul est déclenchée, toutes les données dans le
champ Data sont enregistrées dans le disque.

Interval est une expression numérique qui crée une horloge Pulse avec
une période d’impulsion pendant un temps spécifié et une durée
d’impulsion de zéro. C’est, en général, une valeur constante formatée
telle que 15:00 (quinze minutes), par exemple.

Logging est une expression logique qui active et désactive le paramètre
Interval . Cette expression peut être un interrupteur sur un panneau de
contrôle, une entrée logique provenant d’un appareil externe, ou une
expression plus complexe. C’est, en général, une valeur constante, On
(activé) ou Off  (désactivé).

Log now  est une expression logique qui, au passage d’Arrêt à Marche,
provoque l’enregistrement des données. Une transition de Marche à
Arrêt n’a aucun effet. Cette expression peut être un bouton-poussoir sur
un panneau de contrôle, un signal logique provenant d’un appareil, ou
une expression plus complexe.
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Utilisez l’option Log on every data change  avec prudence. Quand elle
est activée, elle provoque l’enregistrement de données toutes les fois
qu’un des champs de données subit une modification. Cette option est
normalement utilisée pour enregistrer le démarrage et l’arrêt de pompes,
l’ouverture et la fermeture de valves, ou d’autres événements similaires.
Des champs de données contenant ne serait-ce qu’une seule valeur
analogique qui change souvent peuvent provoquer des milliers de
déclenchements. Il en est de même d’une valeur logique.

La fenêtre Data Fields liste toutes les expressions saisies pour
l’enregistrement par ordre de numéro de champ.

Le bouton Save sauvegarde votre nouvelle expression ou modifiée dans
la fenêtre Data Fields  avec un nouveau numéro de champ s’il existe.
Normalement, les Data Fields  contiennent des expressions simples
comme PLC1.Tanklevel .

Le bouton Delete efface l’expression actuellement sélectionnée de la
liste des champs de données.

L’option Format spécifie le format numérique affecté à l’expression
numérique actuellement sélectionnée quand elle est enregistrée dans le
disque. Cette option n’a aucun effet sur les expressions logiques ou
textuelles.

Field indique le numéro du champ de données actuellement sélectionné.

Remarque Les numéros des champs ne doivent pas être modifiés après le stockage
des données car celles-ci ne seront pas affichées sous les en-têtes
appropriés tant qu’un nouveau fichier ne sera pas créé.

Données membres Spreadsheet

Donnée
membre

Type Lecture Ecriture Description

logged Logique Oui Non Impulsion de mise à jour du fichier
tableur. L’objet Spreadsheet génère
cette impulsion logique avec une durée
d’impulsion de zéro après chaque
enregistrement correct
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SquareD
La classe d’objets SquareD permet à Lookout de communiquer avec la
famille des API SCP Square D qui comprend les séries SCP-1xx, 3xx,
4xx, 5xx, 6xx, et 7xx. Lookout peut interfacer avec des API Square D
via une interface série ou une interface SY/MAX. L’interface SY/MAX
supporte les modes de communication SY/MAX et réseau à réseau.

Boîte de dialogue des paramètres de définition de SquareD configurés pour des
communications série

Route est un chemin unique reliant tous les appareils du réseau menant
au port de l’API. N’oubliez pas que pour la carte SY/MAX, le premier
chemin doit être zéro suivi de l’adresse de la carte, car le bord de la carte
SY/MAX est perçu comme port zéro. Le port RS422 sur la carte SY/MAX
est perçu comme port un.

Model spécifie le type particulier d’API représenté par cet objet. Le
paramètre Model spécifié détermine les données membres natives de
l’objet.
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PollRate est une expression numérique qui détermine la fréquence
d’appel de l’appareil. Lookout interroge l’appareil à l’intervalle temporel
spécifié. En général, c’est une simple constante temporelle comme 0:01
(une seconde). Reportez-vous à la section intitulée Les données membres
numériques, au chapitre 5, pour plus pour plus d’informations sur la
saisie des constantes temporelles.

Poll est une expression logique dont le passage de Faux à Vrai fait que
Lookout interroge l’appareil. Ceci peut être une simple expression
comme le signal d’un bouton-poussoir, ou un algorithme complexe.

Communication alarm priority  détermine le niveau des alarmes
générées par l’objet SquareD.

Retry attempts spécifie le nombre de tentatives consécutives entreprises
par Lookout pour communiquer avec un appareil qui ne produit pas de
réponse valable. Une fois que l’objet essaie à nouveau d’établir la
communication le nombre de fois spécifié dans Retry attempts , il
génère une alarme de communication et commence à sauter le nombre
d’interrogations spécifiées dans Skip every n poll requests after comm
failure . Une fois que Lookout a rétabli les communications, il interroge
l’appareil selon le cycle normal défini dans PollRate.

Receive timeout  est la durée pendant laquelle Lookout attend une
réponse d’un appareil avant de renouveler la requête.

Les paramètres d’interface port série

La sélection Serial  Interface active la communication port série entre
votre ordinateur et le port de programmation de votre API. La boîte de
dialogue présentée plus haut représente un API Square D configuré pour
des communications série.

Serial port spécifie le port RS-232C de votre ordinateur que l’objet
utilisera pour communiquer avec l’appareil physique.

Data rate , Parity , Data Bits  et Stop bits se rapportent aux paramètres
de l’appareil physique. Sélectionnez les paramètres configurés pour
votre API.
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Phone number  spécifie le numéro à composer si le port série
sélectionné est configuré pour Dial-up. Ce numéro ne s’applique qu’à
l’objet individuel. Reportez-vous à Options→Serial Ports pour plus
d’informations.

Paramètres d’interface SY/LINK

La sélection SY/LINK  Interface connecte directement votre ordinateur
à un réseau Square D en utilisant une carte SY/MAX. La boîte de
dialogue ci-dessous représente un objet SquareD configuré pour des
communications SY/MAX.

Boîte de dialogue de définition SquareD configurée pour des communications
SY/LINK

Network address  identifie l’adresse de la carte d’interface de votre
ordinateur dans le réseau SY/MAX. Les adresses valables s’étendent de 0
à 99. L’adresse du nœud de la carte doit être unique, c’est-à-dire qu’elle
doit être différente de l’adresse de n’importe quel autre appareil sur le
réseau.
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Interrupt  identifie le paramètre de requête d’interruption IRQ de la carte
d’interface SY/MAX de votre ordinateur. L’affectation d’une
interruption à la carte d’interface améliore la performance générale de
l’ordinateur. Chaque fois que la carte reçoit une réponse, elle génère une
interruption que Lookout reconnaît.

Card memory address  spécifie l’emplacement de l’adresse de base
pour la mémoire de la carte. Cette valeur est automatiquement
sélectionnée. Pour l’instant, une seule carte SY/MAX est supportée par
ordinateur. Lookout cherche la carte et note son adresse dans la case ou
indique qu’il ne l’a pas trouvée.

Les paramètres Network comprennent la taille du réseau et le débit en
bauds. Net size  identifie le nombre d’appareils mis en réseau. La carte
SY/MAX et tous les API ou NIM doivent avoir les mêmes paramètres
pour que la communication ait lieu. Une taille de réseau de 31 devrait
produire une réponse plus rapide. Baud rate  sélectionne le débit en
bauds que la carte SY/LINK  utilise pour communiquer sur le réseau
SY/NET.

Les paramètres RS-422 comprennent baud rate , parity et word size et
se rapportent aux paramètres de l’appareil physique. Sélectionnez les
paramètres configurés sur votre API.

RS-422 mode  vous permet de choisir SY/MAX ou Net-to-net .
SY/MAX utilise le réseau ordinaire, tandis que Net-to-net  utilise les
réseaux distribués élargis, les réseaux à grande capacité (plus de 200
appareils) ou la redondance de réseau (plusieurs chemins entre deux
appareils). Le paramètre par défaut est SY/MAX.

Les données membres

Chaque objet SquareD contient de nombreuses données. Tous les
membres lisibles et écrits (entrées/sorties) sont regroupés avec l’objet.
Ainsi, dès que vous créez un objet, vous accédez immédiatement à toutes
les données membres de cet objet.
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Remarque La classe d’objets SquareD génère automatiquement une structure
efficace de lecture/écriture bloquante selon les entrées et les sorties
utilisées dans votre fichier de processus. Vous n’avez pas besoin de
créer votre propre table de blocage d’E/S. Cependant vous pouvez
assurer une performance optimale en organisant les données de votre
API par groupes adjacents.

Données membres de la classe d’objets SquareD

Donnée membre Type Lecture Ecriture Description

1 - 8176 Numérique Oui Oui Entier non signé 16 bits
s’étendant de 0 à 65 535

1. - 8176. Logique Oui Oui E/S logiques qui lisent et écrivent
tout le registre. Quand vous
écrivez sur le registre, tous les
bits du mot passent à Vrai ou à
Faux

1.0 - 8176.15 Logique Oui Oui Bits individuels dans un registre
lus comme valeurs logiques
Marche/Arrêt. Le bit le moins
significatif est 0 ; le plus
significatif est 15

CommFail Logique Oui Non Signal généré par l’objet qui est
activé si, pour une raison
quelconque, Lookout ne peut pas
communiquer avec l’API

F1 - F8175

(impair seulement)

Numérique Oui Oui Registre à virgule flottante IEEE
32 bits ; lit deux registres de
maintien adjacents comme une
valeur à virgule flottante unique
32 bits

Poll Logique Non Oui Au passage de Faux à Vrai,
l’objet Lookout interroge l’API

PollRate Numérique Non Oui Spécifie la fréquence de
l’interrogation de l’appareil API
par l’objet Lookout

S1 - S8176 Numérique Oui Oui Mot signé 16 bits s’étendant de
-32 768 à +32 768

Update Logique Oui Non Signal généré par l’objet qui émet
une impulsion chaque fois que
l’objet interroge l’appareil
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Messages d’erreur

La classe d’objets SquareD rend compte de l'état des commandes
envoyées à l’API. Quand Lookout reçoit une réponse d’erreur d’un API,
il notifie l’échec sous la forme d’une alarme contenant le code de l’état
et sa signification. Les exemples suivants illustrent ce type d’alarmes :

SY/MAX initialization  error:(0)Cannot  initialize  SY/LINK  board

(Erreur d’initialisation SY/MAX : (0) Impossible d’initialiser la carte SY/LINK)

SY/MAX polling  error:(3)Illegal  address  attempted

(Erreur d’interrogation SY/MAX : (3) Tentative d’adresse non valable)

Response error:(3) Received NAK in response

(Erreur de réponse : (3) Réponse reçue contient un NAK)

Switch
L’objet Switch (booléen) génère un signal logique que les autres objets
reçoivent. Les interrupteurs changent d’état quand vous cliquez dessus
via un bouton de souris, un trackball, un écran tactile ou la barre
d’espacement de votre clavier.

Boîte de dialogue des paramètres de définition de Switch
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Action verification messages  crée des expressions textuelles
dynamiques à afficher dans les boîtes de dialogue de messages.
Reportez-vous au chapitre 10 pour plus d’informations sur la sécurité.

Boîte de dialogue de message Verification

Position source détermine où réside la “valeur” de l’interrupteur. Local
indique que sa valeur réside dans l’objet, sur le panneau de contrôle. Si
l’interrupteur est vers le “haut”, le signal est activé, si vers le “bas” il est
désactivé.

Les interrupteurs Remote obtiennent leur valeur d’une source distante,
souvent d’un registre sur un automate auquel ils sont connectés. Le fait
d’activer l’interrupteur change l’état du registre et le fait de changer
l’état du registre active l’interrupteur.

L’option Remote est particulièrement utile quand vous souhaitez éviter
que Lookout change la valeur des consignes ou des registres au cours de
l’initialisation ou de la reconnexion des communications interrompues.
Utiliser cet interrupteur crée une sorte de signal bouclé. La moitié de la
boucle est formée quand vous connectez le registre de l’interrupteur avec
l’expression Position et la seconde quand vous reliez le signal de sortie
de l’interrupteur au registre du contrôleur. Position est une expression
numérique. N’oubliez pas de terminer la seconde moitié de la boucle
avec la commande Object→Edit Connections….

Comme les interrupteurs à distance Remote, les interrupteurs DDE
(Dynamic Data Exchange [échange dynamique de données] obtiennent
leurs valeurs d’une source à distance. Ceci peut être une cellule dans une
feuille de calcul, une autre application sensible au DDE ou une autre
copie de Lookout mise en réseau. Les derniers paramètres DDE d’un
objet deviennent automatiquement la valeur par défaut de tout nouvel
objet DDE. Reportez-vous au chapitre 13 pour plus d’informations sur
les paramètres Service , Topic  et Item .
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Control security level spécifie le niveau de sécurité minimum des
opérateurs souhaitant accéder à cet objet individuel et le contrôler.

L’option Log events crée une analyse rétrospective permanente de
l’objet : qui a fait quoi et quand. Tous les ajustements du potentiomètre
sont enregistrés dans le disque, y compris l’heure d’ajustement, le nom
de l’utilisateur et l’ajustement effectué. Reportez-vous au chapitre 11
pour plus d’informations sur l’enregistrement d’événements.

Les interrupteurs de type standard peuvent être remplacés par des
symboles graphiques personnalisés. Si vous utilisez des graphiques
personnalisés, spécifiez les deux paramètres On et Off  du symbole.
Reportez-vous au chapitre 8 pour plus d’informations sur la création de
symboles graphiques personnalisés et sur l’utilisation de pixels
transparents.

Données membres Switch

Donnée
membre

Type Lecture Ecriture Description

(implicite) Logique Oui Non Position de l’interrupteur

visible Logique Non Oui Quand Faux, l’objet Switch est invisible
dans le panneau d’affichage. Quand Vrai, il
est visible et contrôlable

Commentaires Si vous avez besoin d’un interrupteur à plus de deux positions, utilisez
un objet Pot. Reportez-vous au chapitre 4, Tour d’horizon du
développeur, pour un exemple d’un interrupteur à positions multiples.

Objets associés Pushbutton (bouton-poussoir), Pot (potentiomètre)
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Tesco
Tesco est une classe d’objets Protocol driver (driver de protocole) qui
permet à Lookout de communiquer avec des automates programmables
Liquitronic LIQ via les protocoles de messagerie LIQ4 (Data Express) et
LIQ5 (Data Express Plus). Créez un objet Tesco pour chaque automate.

Comme c’est le cas pour les autres objets Protocol driver, l’objet Tesco
contient de nombreuses données. Tous les membres lisibles et écrits
(entrées/sorties), les instructions d’interrogation, le blocage
Lecture/Ecriture, l’utilisation des ports série, etc., sont regroupés avec
l’objet. Ainsi, dès que vous créez un objet Tesco, vous accédez
immédiatement à toutes les données membres de cet objet (reportez-vous
à la liste des données membres ci-dessous).

Dans cet exemple, l’objet Driver est configuré pour représenter le nœud 3 du
réseau 2 utilisant le protocole LIQ5.

Route se rapporte au paramètre de l’adresse de l’API tel qu’il est
spécifié dans sa table de configuration. Avec le protocole LIQ4, il s’agit
d’une simple adresse de nœud (1 à 255). Avec le protocole LIQ5, Route
contient les adresses du réseau et du nœud au format network.node ,
comme indiqué dans l’exemple ci-dessous.
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Serial port spécifie le port de communication que l’objet utilise pour
communiquer avec l’appareil externe, mais pas le type de
communication (radio, Dial-up, Hardwired). Le type de communication
est déterminé par la commande Options→Serial Ports….

Data rate , Parity , Data bits  et Stop bits  se rapportent aux paramètres de
l’appareil physique.

Le bouton Defaults remet les paramètres actuels à leurs valeurs par
défaut.

Alarm priority  détermine le niveau des alarmes de communication sous
Tesco.

Phone number  spécifie le numéro à composer si le port série
sélectionné est configuré pour Dial-up. Ce numéro ne sert que pour
l’objet de protocole individuel.

PollRate est une expression numérique qui détermine la fréquence
d’appel de l’appareil. Lookout convertit la valeur numérique de PollRate
en un signal temporel qui représente les jours et les fractions de jour.
Ensuite, Tesco interroge l’appareil à l’intervalle temporel spécifié. En
général, c’est une simple constante temporelle comme 0:01 (une
seconde). Reportez-vous à la section intitulée Les données membres
numériques, au chapitre 5, pour plus d’informations sur la saisie des
constantes temporelles.

Poll est une expression logique dont le passage de Faux à Vrai provoque
l’appel de l’appareil par Lookout. Ceci peut être une simple expression,
comme le signal d’un bouton-poussoir, ou un algorithme complexe.

Retry attempts spécifie le nombre de tentatives consécutives entreprises
par Lookout pour communiquer avec un appareil qui ne produit pas de
réponse valable. Une fois que l’objet essaie à nouveau d’établir la
communication le nombre de fois spécifié dans Retry attempts , il
génère une alarme et Lookout passe ensuite au prochain appareil dans la
queue d’interrogation (si elle existe).

Receive timeout est la durée pendant laquelle Lookout attend une
réponse d’un appareil avant de renouveler la requête.
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Données membres Tesco

Donnée
membre

Type Lecture Ecriture Description

AO0 - AO1023 Numérique Oui Oui Registre de sortie analogique pouvant
maintenir une valeur à virgule flottante
IEEE 32 bits pour la programmation
interne Tescode, ou une valeur de
signal physique AO sous forme de
chiffre entier 12 bits s’étendant de 0 à
4 095

CommFail Logique Oui Non Signal généré par le driver qui est
activé si, pour une raison quelconque,
Lookout ne peut pas communiquer
avec l’appareil

IR0 - 1R1023 Numérique Oui Oui Registre d’index contenant un nombre
entier non signé 32 bits s’étendant de 0
à 4 294 967 295

L0 - L1023 Numérique Oui Oui Registre du niveau (entrée analogique)
pouvant maintenir une valeur à virgule
flottante IEEE 32 bits pour la
programmation interne Tescode, ou
une valeur de signal physique AI en
tant que chiffre entier 12 bits
s’étendant de 0 à 4 095

P0 - P1023 Logique Oui Oui Registre de la pompe (sortie discrète)
associé au canal de sortie physique

Poll Logique Non Oui Au passage de Faux à Vrai, provoque
l’interrogation de l’appareil

PollRate Numérique Non Oui Spécifie la fréquence à laquelle
l’appareil sera interrogé
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Données membres Tesco (suite)

Donnée
membre

Type Lecture Ecriture Description

S0 - S1023 Logique Oui Oui Registre d’état (entrée numérique) qui
peut représenter un canal d’entrée
physique ou une variable de
programmation interne Tescode

SP0 - SP1023 Numérique Oui Oui Registre de consigne qui maintient une
valeur à virgule flottante IEEE 32 bits
avec une portée de +/-3,37 x 1 038

T0 - T1023 Numérique Oui Oui Registre compteur/timer contenant les
compteurs d’impulsions, les horloges
des heures, les horloges HMS, les
compteurs d’événements et les
horloges des secondes tels que
présentés dans TESCO LIQ 5
Programmable Control Operations
Manual (manuel des opérations de
contrôle programmables)

Update Logique Oui Non Signal généré par le driver qui émet
une impulsion chaque fois que le driver
interroge l’appareil

TextEntry
L’objet TextEntry (saisie de texte) vous permet d’introduire
manuellement des remarques textuelles au clavier. Ces remarques
peuvent contenir des caractères numériques et alphanumériques, mais le
résultat de votre entrée sera converti en valeur textuelle. Comme c’est le
cas pour toutes les autres expressions textuelles dans Lookout, votre
remarque peut être enregistrée sur disque, connectée à d’autres données
membres acceptant des signaux textuels, etc. La remarque est enregistrée
et affichée comme entrée à ligne unique : vous ne pouvez pas intégrer
des “retours à la ligne” dans le message.
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Boîte de dialogue des paramètres TextEntry

Entry prompt est le texte qui apparaît au-dessus de la boîte de dialogue
Tex Entry quand un opérateur sélectionne le bouton-poussoir d’entrée
textuelle.

Text source détermine où réside le texte saisi par l’utilisateur. Local
indique où le texte saisi par l’utilisateur se trouve dans l’objet, sur le
panneau de contrôle.

Remote indique que le texte saisi par l’utilisateur réside dans une source
distante, telle qu’une expression textuelle ou un autre objet TextEntry.

Comme c’est le cas pour les objets TextEntry Remote , les objets
TextEntry DDE (Dynamic Data Exchange) obtiennent leurs valeurs
d’une source distante. C’est l’option que vous utilisez pour relier le texte
saisi par l’utilisateur à une cellule dans une feuille de calcul, une table
de sélection de la base de données ou une autre application DDE, y
compris une seconde copie de Lookout mise en réseau. Reportez-vous au
chapitre 13 pour plus d’informations sur les paramètres Service , Topic
et Item .

Remarque Les derniers paramètres DDE utilisés pour un objet deviennent
automatiquement les valeurs par défaut d’un nouvel objet DDE.
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Control security level spécifie le niveau de sécurité minimum des
opérateurs souhaitant accéder à cet objet individuel et le contrôler.

L’option Log events  crée une analyse rétrospective permanente de
l’objet : qui a fait quoi et quand. Une fois sélectionnées, toutes les
saisies textuelles dans cet objet sont enregistrées sur disque, y compris
l’heure de la saisie, le nom de l’utilisateur et la saisie effectuée.
Reportez-vous au chapitre 11 pour plus d’informations sur
l’enregistrement d’événements.

Lookout affiche cette boîte de dialogue des paramètres d’affichage à
l’issue de la définition de l’objet. Elle vous permet de définir la police de
caractères et le style de présentation.

Boîte de dialogue des paramètres d’affichage de TextEntry

Données membres TextEntry

Donnée
membre

Type Lecture Ecriture Description

(implicite) Texte Oui Non Texte actuel saisi par l’utilisateur
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TimeOfxxxx’s
Les objets TimeOfxxxx’s sont des horloges qui génèrent une impulsion
périodique de durée spécifiée ; elles sont activées et désactivées par
On/off signal . La plage temporelle est définie par le type d’horloge
utilisé : une horloge TimeOfMinute est d’une minute, une horloge
TimeOfYear est d’une année, etc. Les sorties de ces horloges passent à
High quand la valeur spécifiée dans Timer offset  pour la période en
cours a expiré et reste High pendant la durée spécifiée dans Timer
duration .

Boîte de dialogue des paramètres de définition de TimeOfDay

Les Timer offset et Timer duration peuvent s’étendre de 0,0 seconde à
une année, la résolution efficace étant de 0,1 seconde sur toute la
gamme. La somme de Timer offset et celle de Timer duration doit
toujours être inférieure ou égale à la plage temporelle.

L’affichage de l’objet indique la gamme de temporisation restante avant
que la sortie ne change d’état ; il est mis à jour environ une fois par
seconde. L’affichage apparaît sous le format sélectionné dans Display
format . Si On/off signal  est désactivé, l’affichage indique “off”.

On/off signal  est une expression logique tandis que Timer offset  et
Timer duration  sont des expressions numériques. Lookout convertit les
valeurs numériques de Timer offset  et de Timer duration  en signaux
temporels qui représentent des jours et des fractions de jour. Ce sont, en
général, de simples constantes temporelles comme 6:10:20 (six
heures:dix minutes:vingt secondes). Reportez-vous à la section intitulée
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Les données membres numériques, au chapitre 5, pour plus
d’informations sur la saisie des constantes temporelles.

Boîte de dialogue des paramètres d’affichage de TimeOfDay

Données membres TimeOfxxxx

Donnée
membre

Type Lecture Ecriture Description

(implicite) Logique Oui Non Valeur logique d’horloge

Commentaires Utilisez TimeOfxxxx’s au lieu d’objets Pulse (impulsion) quand vous
souhaitez synchroniser l’impulsion avec l’horloge. Si, par exemple, une
pompe ne doit fonctionner que de 8:00 heures à 17:00 heures chaque
jour, utilisez l’horloge TimeOfDay.

Objets associés DelayOff, DelayOn, Interval, OneShot, Pulse (impulsion)



Chapitre 18. Définitions des classes d’objets

561

Tiway
Tiway est un objet  Protocol driver (driver de protocole) qui permet à
Lookout de communiquer avec la série d’API 5xx de fabrication
Siemens, antérieurement fabriqués par Texas Instruments.

Les objets Protocol driver contiennent de nombreuses données. Tous les
membres lisibles et écrits (entrées/sorties), les instructions
d’interrogation, la lecture/écriture bloquante, l’utilisation des ports série,
etc., sont regroupés avec l’objet. Ainsi, dès que vous créez un objet
Tiway, vous accédez immédiatement à toutes les données membres de
cet objet (reportez-vous à la liste des données membres ci-dessous).

Remarque Les objets Protocol driver de Lookout génèrent automatiquement une
structure efficace de lecture/écriture bloquante selon les entrées et les
sorties utilisées dans votre fichier de processus. Vous n’avez pas besoin
de créer votre propre table de blocage d’E/S.

Dans cet exemple, Lookout est connecté à  un API modèle 545 de Siemens. Nous
utilisons le port série 1 et chaque interrogation a lieu une fois par seconde.

PLC Model spécifie le numéro du modèle d’API pour l’appareil
demandé.
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PollRate est une expression numérique qui détermine la fréquence
d’appel de l’appareil. Lookout convertit la valeur numérique de PollRate
en un signal temporel qui représente les jours et les fractions de jour.
Ensuite, Tiway interroge l’appareil à l’intervalle de temps spécifié. En
général, c’est une simple constante temporelle comme 0:01 (une
seconde). Reportez-vous à la section intitulée Les données membres
numériques, au chapitre 5, pour plus d’informations sur la saisie des
constantes temporelles.

Poll est une expression logique dont le passage de Faux à Vrai provoque
l’appel de l’appareil par Lookout. Ceci peut être une simple expression,
comme le signal d’un bouton-poussoir, ou un algorithme complexe.

Receive timeout est la durée pendant laquelle Lookout attend une
réponse d’un appareil avant de renouveler la requête.

Retry attempts spécifie le nombre de tentatives consécutives entreprises
par Lookout pour communiquer avec un appareil qui ne produit pas de
réponse valable. Une fois que l’objet essaie à nouveau d’établir la
communication le nombre de fois spécifié dans Retry attempts , il
génère une alarme et Lookout passe ensuite au prochain appareil dans la
queue d’interrogation (si elle existe).

Alarm priority  détermine le niveau de priorité des alarmes générées par
Tiway.

Phone number  spécifie le numéro à composer si le port série
sélectionné est configuré pour Dial-up. Ce numéro ne sert que pour
l’objet de protocole individuel.

Le paramètre Skip every__polls demande à Lookout de ne pas
interroger l’appareil avec lequel il n’a pas pu établir de communication
au cours des interrogations programmées. Ainsi, Lookout saute cet
appareil pendant le cycle d’interrogation. Une fois que les
communications sont rétablies, l’appareil est interrogé au cours de son
cycle normal.
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Les techniques de communication

Lookout communique avec les API Siemens de plusieurs façons :
connexion directe en série au port Local port , connexion en série à un
adaptateur external Unilink Host Adapter  via une carte interne Unilink
PC Adapter ou via une carte interne CTI TCP/IP.

Local Port
Les paramètres de Local port déterminent les valeurs de serial port ,
data rate  et phone number (si elles existent) à utiliser pour une
configuration de connexion directe. Vu que le protocole Local port ne
contient pas d’informations sur l’adresse, cette option ne supporte qu’un
(1) API par port série.

Unilink Host Adapter
Si Unilink Host Adapter  est sélectionné, vous devrez spécifier le port
Serial port  à utiliser et le NIM (Network Interface Module [module
d’interface de réseau) address établi sur l’API. Vous devrez également
configurer plusieurs paramètres sur Unilink Host Adapter en appuyant
sur le bouton Configure UHA....

Les paramètres dans cette boîte de dialogue s’appliquent globalement à tous les
API sur le réseau TIWAY spécifié (chaque réseau exige un port série séparé).
Ainsi, vous ne configurez chaque Unilink Host Adapter qu’une seule fois au lieu
de répéter cette procédure chaque fois qu’un nouvel objet Tiway est créé.
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Data rate spécifie la vitesse de communication entre l’ordinateur et
Unilink Host Adapter. Cette valeur détermine également les paramètres
nécessaires des interrupteurs Dipswitch sur le UHA pour le débit en
bauds sélectionné.

L’option Host Adapter Operating Mode  détermine si Unilink Host
Adapter est le gestionnaire du réseau (Master Host Interface Unit ) ou
une autre unité secondaire (Host Interface Unit ). Il faut juste une MHIU
par réseau TIWAY.

L’activation d'Automatic redundant media  dicte à Unilink Host
Adapter de tenter des communications sur un réseau TIWAY redondant
avec toute unité secondaire dont les communications ont été
interrompues.

Les paramètres TIWAY I Network Settings  configurent les paramètres
de communication pour le réseau TIWAY. Ce réseau relie Unilink Host
Adapter à ses secondaires. Les paramètres de réseau par défaut de
Lookout correspondent exactement aux paramètres par défaut du module
NIM Siemens. Reportez-vous à votre documentation de TIWAY pour
modifier ces paramètres.

Unilink PC Adapter
Etant donné que Unilink PC Adapter  est une carte interne, les goulots
d’étranglement à vitesse série de 19200 bauds sont éliminés, cette
vitesse étant remplacée par la vitesse de bus de 8 MHz PC ISA, d’où une
amélioration considérable des performances sur Unilink Host Adapter  et
les paramètres Local port .

Si Unilink PC Adapter  est sélectionné, vous devrez spécifier la carte
Card à utiliser et le NIM (Network Interface Module [module d’interface
de réseau] address établi sur l’API. Vous devrez également configurer
plusieurs paramètres sur Unilink PC Adapter en appuyant sur le bouton
Configure PCA....



Chapitre 18. Définitions des classes d’objets

565

Les paramètres de cette boîte de dialogue s’appliquent globalement à tous les
API sur le réseau TIWAY spécifié (chaque réseau exige une carte séparée).
Ainsi, vous ne configurez chaque Unilink Host Adapter qu’une seule fois au lieu
de répéter cette procédure chaque fois qu’un nouvel objet Tiway est créé.

L’option PC Adapter Operating Mode  détermine si Unilink PC Adapter
est le gestionnaire du réseau (Master Host Interface Unit ) ou une autre
unité secondaire (Host Interface Unit ). Il faut juste une MHIU par
réseau TIWAY.

L’activation de Automatic redundant media  ne joue pas sur la carte PC
Adapter car elle n’a qu’un port. Si Siemens ajoute un second port,
Lookout supportera automatiquement cette option.

Les paramètres TIWAY I Network Settings  configurent les paramètres
de communication pour le réseau TIWAY. Ce réseau relie la carte
Unilink Host Adapter à ses unités secondaires. Les paramètres de réseau
par défaut de Lookout correspondent exactement aux paramètres par
défaut du module NIM Siemens. Reportez-vous à votre documentation
de TIWAY pour modifier ces paramètres.
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CTI TCP/IP
Lookout supporte les cartes adaptateurs Control Technology
Incorporated’s (CTI) Ethernet TCP/IP pouvant être installées dans les
API SIMATIC TI545. Pour travailler avec de telles cartes, votre PC doit
être muni d’une carte de réseau Ethernet et d’un progiciel Windows
Sockets-Compliant TCP/IP. Ces progiciels sont disponibles auprès de
Microsoft, FTP Software et NetManage, Inc.

L’option de protocole CTI TCP/IP de Lookout est “Windows Sockets
Compliant”. Cette option utilise des supports UDP sans connexion dans
le logiciel, norme de l’industrie des protocoles TCP/IP. Dans ce
protocole, une pile FIFO (première entrée, première sortie) est utilisée
pour le stockage temporaire des messages de communication si le bus de
données est occupé ou si une requête d’interrogations multiples est
générée par plusieurs objets Tiway.

Du fait que CTI TCP/IP utilise des supports pour le stockage temporaire
de requêtes d’interrogation, ce protocole élimine les goulots
d’étranglement créés par plusieurs objets Tiway essayant d’accéder au
bus de données en même temps. Les performancs peuvent sensiblement
s’améliorer sur les paramètres Local port , Unilink Host Adapter  et
Unilink PC Adapter  quand vous configurez un système avec plusieurs
API sur le même réseau.

Si CTI TCP/IP est sélectionné, vous devrez spécifier l’IP address
(Adresse de protocole Internet) de l’API. Une adresse de protocole
Internet contient quatre chiffres séparés par des points, chaque chiffre
s’étendant de zéro à 255 décimal. Ainsi, une adresse Internet typique
peut être 128.7.9.231. Vérifiez que l’adresse IP address  saisie
correspond à l’adresse du protocole Internet de l’API telle que spécifiée
dans son EEPROM ou programmée avec l’API.
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Données membres Tiway

Donnée membre Type Lecture Ecriture Description

X1 - X32000 Logique Oui Non Entrées discrètes ; les X non affectés
peuvent être utilisés comme registres
de contrôle

Y1 - Y32000 Logique Oui Oui Sorties discrètes ; même espace de
mémoire que les entrées discrètes.
Donc X37 se rapporte au même point
que Y37. Les Y non affectés peuvent
servir de registres de contrôle

C1 - C32000 Logique Oui Oui Registres de contrôle

WX1 - WX32000 Numérique Oui Non Entrées d’images de mots ; valeurs
16 bits s’étendant, en général, de 6
400 à 32 000 pour les signaux 4 à 20
mA, et de 0 à 32 000 pour les signaux
de 0 à 5 V

WY1 - WY32000 Numérique Oui Oui Sorties d’images de mots ; valeurs 16
bits s’étendant, en général, de 6 400
à 32 000 pour les signaux 4 à 20 mA,
et de 0 à 32 000 pour les signaux de
0 à 5V

V1 - V32000 Numérique Oui Oui Valeur 16 bits entière non signée de
valeur de mémoire V s’étendant de 0
à 65 535

V1S - V32000S Numérique Oui Oui Valeur 16 bits entier de valeur de
mémoire V s’étendant de -32 768 à
32 767

V1. - V32000. Numérique Oui Oui Valeur à virgule flottante IEEE 32 bits
de mémoire V

V1D - V32000D Numérique Oui Oui Valeur 32 bits entière non signée de
mémoire V

K1 - K32000 Numérique Oui Oui Valeur 16 bits entière non signée de
valeur de mémoire K s’étendant de 0
à 65535

K1S - K32000S Numérique Oui Oui Valeur 16 bits entière non signée de
valeur de mémoire K s’étendant de
 -32 768 à 32 767
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Données membres Tiway (suite)

Donnée membre Type Lecture Ecriture Description

K1. - K32000. Numérique Oui Oui Valeur à virgule flottante IEEE 32 bits
de mémoire K

K1D - K32000D Numérique Oui Oui Valeur 32 bits entière non signée de
mémoire K

LADB1 - LADB64 Numérique Oui Oui (Alarme analogique) Zone morte

AERR1 -
AERR32000

Numérique Oui Oui (Alarme analogique) Erreur

AHA1 - AHA32000 Numérique Oui Oui (Alarme analogique) Limite d’alarme
haute

AHHA1 -
AHHA32000

Numérique Oui Oui (Alarme analogique) Limite d’alarme
haute-haute (très haute)

ALA1 - ALA32000 Numérique Oui Oui (Alarme analogique) Limite d’alarme
basse

ALLA1 -
ALLA32000

Numérique Oui Oui (Alarme analogique) Limite d’alarme
basse-basse (très basse)

AODA1 -
AODA32000

Numérique Oui Oui (Alarme analogique) Limite de
déviation orange

APVH1 -
APVH32000

Numérique Oui Oui (Alarme analogique) Limite haute de
la variable du processus

APVL1 -
APVL32000

Numérique Oui Oui (Alarme analogique) Limite basse de
la variable du processus

ARCA1 -
ARCA32000

Numérique Oui Oui (Alarme analogique) Limite de la
vitesse de changement

ASP1 - ASP32000 Numérique Oui Oui (Alarme analogique) Consigne

ASPH1 -
ASPH128

Numérique Oui Oui (Alarme analogique) Limite de
consigne haute

ASPL1 - ASPL128 Numérique Oui Oui (Alarme analogique) Limite de
consigne basse

ATS1 - ATS32000 Numérique Oui Oui (Alarme analogique) Vitesse
d’échantillonnage

AVF1 - AVF128 Numérique Oui Oui (Alarme analogique) Fanions
d’alarme
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Données membres Tiway (suite)

Donnée membre Type Lecture Ecriture Description

LYDA1 - LYDA64 Numérique Oui Oui (Alarme analogique) Limite de
déviation jaune

TCP1 - TCP32000 Numérique Oui Oui (Alarme analogique) Valeur
prédéfinie de compteur/timer

TCC1 - TCC32000 Numérique Oui Oui (Alarme analogique) Valeur actuelle
de compteur/timer

LMX1 - LMX64 Numérique Oui Oui (Boucle) Biais

LADB1 - LADB64 Numérique Oui Oui (Boucle) Zone morte

LKD1 - LKD64 Numérique Oui Oui (Boucle) Gain dérivé

LER1 - LER64 Numérique Oui Non (Boucle) Erreur

LKC1 - LKC64 Numérique Oui Oui (Boucle) Gain

LHHA1 - LHHA64 Numérique Oui Oui (Boucle) Limite d’alarme haute-haute
(très haute)

LHA1 - LHA64 Numérique Oui Oui (Boucle) Limite d’alarme haute

LLLA1 - LLLA64 Numérique Oui Oui (Boucle) Limite d’alarme basse-
basse (très basse)

LLA1 - LLA64 Numérique Oui Oui (Boucle) Limite d’alarme basse

LODA1 - LODA64 Numérique Oui Oui (Boucle) Limite de déviation orange

LMN1 - LMN64 Numérique Oui Oui (Boucle) Sortie

LPV1 - LPV64 Numérique Oui Oui (Boucle) Variable du processus

LPVH1 - LPVH64 Numérique Oui Oui (Boucle) Limite haute de la variable
du processus

LPVL1 - LPVL64 Numérique Oui Oui (Boucle) Limite basse de la variable
du processus

LRCA1 - LRCA64 Numérique Oui Oui (Boucle) Limite de la vitesse de
changement

LSP1 - LSP64 Numérique Oui Oui (Boucle) Consigne

LSPH1 - LSPH64 Numérique Oui Oui (Boucle) Limite de consigne haute

LSPL1 - LSPL64 Numérique Oui Oui (Boucle) Limite de consigne basse

LTD1 - LTD64 Numérique Oui Oui (Boucle) Vitesse

LTI1 - LTI64 Numérique Oui Oui (Boucle) Remise à zéro
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Données membres Tiway (suite)

Donnée membre Type Lecture Ecriture Description

LTS1 - LTS64 Numérique Oui Oui (Boucle) Vitesse d’échantillonnage

LYDA1 - LYDA64 Numérique Oui Oui (Boucle) Limite de déviation jaune

CommFail Logique Oui Non Signal généré par le driver qui est
activé si, pour une raison
quelconque, Lookout ne peut pas
communiquer avec l’appareil

Poll Logique Non Oui Au passage de Faux à Vrai, l’objet
Lookout interroge l’appareil

PollRate Numérique Non Oui Spécifie combien de fois l’objet
Lookout interroge l’appareil

Update Logique Oui Non Signal généré par le driver qui émet
une impulsion chaque fois que le
driver interroge l’appareil

L’importation de fichiers de variables APT

Après avoir créé au moins un objet Tiway, la classe d’objets Tiway
ajoute une sélection au menu Options de Lookout pour que vous puissiez
importer une base de données de fichiers de variables APT pour chaque
objet Tiway créé. Vous pouvez réimporter des fichiers de variables à
mesure que vos programmes APT sont modifiés ; Lookout réajustera
automatiquement les pseudonymes des noms de variables, en temps réel.
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Trend
Un objet Trend (tendance) affiche un graphe de tendance en temps réel
sur un panneau de contrôle comprenant des courbes de tendance
logiques et numériques. Son graphe défile de droite à gauche, avec les
niveaux des signaux courants se trouvant à l’extrême droite du graphe et
les valeurs les plus anciennes à l’extrême gauche du graphe.

L’objet Trend ne peut pas tracer les données de la base de données
historique Citadel. C’est pourquoi vous ne pouvez pas visualiser les
données qui défilent hors du bord gauche du diagramme. Par contre, la
classe d’objets Trend accède aux informations stockées dans la base de
données Citadel, affichant les données en temps réel et historiques.
Notez, cependant, que la classe d’objets Trend n’est pas disponible dans
les systèmes Lookout Express. Reportez-vous à la définition de la classe
d’objets HyperTrend pour plus d’informations.

Boîte de dialogue des paramètres de définition de Trend

Trend width  est la largeur du graphe en unités temporelles. Les graphes
peuvent avoir une largeur, ou étendue temporelle, allant de deux
secondes à un an. Trend width  dans l’exemple ci-dessus indique une
durée temporelle de 1:00:00 ou une heure. Reportez-vous à la section
intitulée Les données membres numériques, au chapitre 5, pour plus
d’informations sur la saisie des constantes temporelles.
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Sample interval  spécifie la fréquence de capture des valeurs pour le
tracé. L’objet Trend (tendance) divise Sample interval par Trend width
pour déterminer le nombre de points de données à enregistrer
provisoirement pour chaque courbe de tendance. Lookout stocke dans la
RAM ces points de données au sein de l’objet Trend. Donc, soyez
prudent quand vous sélectionnez Sample interval . Il n’est généralement
pas nécessaire de stocker plus de 100 à 200 points pour chaque courbe
de tendance, moins pour des données qui ne changent pas rapidement.
Etant donné que la plupart des résolutions des affichages informatiques
ne peuvent pas exploiter plus de 800 points de données environ, il est
rarement nécessaire de dépasser cette limite.

Les paramètres Trendlines permettent d’ajouter, de modifier ou
d’effacer des expressions du graphe de tendance. Entrez les expressions
logiques et numériques de tracé dans le champ de données à droite du
bouton Accept. Sélectionnez Logical ou Numeric de manière à ce que
ces sélections correspondent au résultat de l’expression courante.

Line color  spécifie la couleur de la courbe de tendance pour l’expression
courante.

Les paramètres Minimum et Maximum déterminent où sera tracée
l’expression sur le graphe de tendance. Minimum  correspond au bas du
graphe tandis que Maximum correspond au haut, quelle que soit la
portée de l’expression. Ces paramètres créent une échelle verticale
imaginaire et affectent individuellement chaque expression, permettant
ainsi de tracer les courbes de tendance n’importe où sur le graphe.

Par exemple, prenez deux expressions numériques qui s’étendent de 0 à
50. Réglez les paramètres Minimum et Maximum sur 0 et 100 pour la
première expression et sur -50 et 50 pour la seconde. La première
expression est tracée dans la moitié inférieure du graphe tandis que la
seconde expression est tracée dans la moitié supérieure du graphe, bien
que les deux fluctuent entre 0 et 50.
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Cette figure montre l’échelle imaginaire de la première expression (où min.=0
et max.=100). Vu que l’expression s’étend de 0 à 50, elle est tracée dans la
moitié inférieure du graphe.

Cette figure montre l’échelle imaginaire de la seconde expression (où min.=
 -50 et max.=50). Vu que l’expression s’étend de 0 à 50, elle est tracée dans la
moitié supérieure du graphe.

L’entrée des deux expressions dans un seul graphe de tendance produit
l’effet suivant. Notez les échelles personnalisées ajoutées de chaque côté
du graphe.
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Si vous sélectionnez Logical comme type d’expression, les paramètres
minimum et maximum deviennent respectivement Position  et Height . Ces
deux valeurs représentent maintenant un chiffre entre 0 % et 100 % et
déterminent l’emplacement de la ligne de base de la courbe de tendance ainsi
que la hauteur de son unité quand l’expression passe à Vrai.

Pour ce tracé d’une valeur logique Position = 10 et Hauteur = 10

Après avoir saisi ou modifié les paramètres de la courbe de tendance,
appuyez sur le bouton Accept, ce qui ajoute l’expression dans la liste
Trendlines . Utilisez le bouton Delete pour enlever l’expression courante
du graphe de tendance. Les boutons Previous et Next vous permettent de
parcourir la liste de toutes les expressions étiquetées pour l’objet de
tendance courant.

Vous pouvez afficher les graphes en plusieurs couleurs, avec différents
styles de ligne temporelle et pas de grille.

Boîte de dialogue des paramètres d’affichage Trend
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Timeline labels  détermine où et comment la date et l’heure sont
affichées sur le graphe de tendance.

Major increments spécifie le nombre de lignes horizontales épaisses
dans un graphe de tendance. Cette valeur est indépendante de la gamme
des expressions de tendance.

Minor increments spécifie le nombre de lignes horizontales fines entre
les grandes lignes de grille d’incrémenation dans un graphe de tendance.
Cette valeur est indépendante de la gamme des expressions de tendance.

Données membres Trend

Donnée
membre

Type Lecture Ecriture Description

visible Logique Non Oui Quand Vrai, la tendance devient visible
sur le panneau de contrôle. Quand Faux,
la tendance est invisible. La valeur par
défaut est Vrai

Commentaires Plusieurs lignes de tendance peuvent être affichées sur une tendance
particulière ; cependant, trop de lignes embrouillent les informations à
afficher. Soyez donc prudent quand vous sélectionnez le nombre de
lignes à afficher dans un objet Trend.

En général, l’objet Trend doit être affiché avec des échelles
personnalisées le long des axes verticaux.

Les affichages des tendances peuvent être mis à jour une fois par
seconde, selon la résolution de l’écran, la taille du graphe et le paramètre
width  de la tendance. Les ordinateurs munis d’adaptateurs d’affichage
plus lents peuvent ralentir considérablement les affichages d’un grand
graphe de tendance. Pour les machines plus lentes à cartes d’affichages
lentes (sans coprocesseur pour graphes), limitez la taille de vos
tendances à mouvement rapide à moins d’un quart de l’écran.

Les objets Trend enregistrent périodiquement les points de données des
courbes de tendance dans le fichier d’état Lookout (.LST ) selon les
valeurs définies dans la boîte de dialogue System Options et chaque fois
que vous fermez votre fichier de processus ou que vous quittez Lookout.
Ainsi, vous ne “perdrez” pas les tracés de vos tendances si vous quittez
Lookout ou si votre ordinateur tombe en panne.



Partie 3. Référence

576

Wizdom
Wizdom est une classe d’objets qui permet à Lookout de communiquer
avec la carte Wizdom Coprocessor Card. Créez un objet Wizdom
(sagesse) pour chaque carte Wizdom installée dans l’ordinateur.

Comme c’est le cas pour les autres classes d’objets conçus pour
communiquer avec les objets d’E/S externes, les objets Wizdom
contiennent de nombreuses données. Tous les membres lisibles et écrits
(entrées/sorties), la lecture/écriture bloquante, l’utilisation des ports
série, etc., sont regroupés avec l’objet. Ainsi, dès que vous créez un
objet Wizdom, vous accédez immédiatement à toutes les données
membres de cet objet (reportez-vous à la liste des données membres ci-
dessous).

L’objet Wizdom scanne des modifications apportées aux données
membres configurées 10 fois par seconde.

Les cartes Wizdom sont des ordinateurs à carte unique. Elles
communiquent avec le PC via la mémoire à double accès (c’est-à-dire,
mémoire RAM atteinte par le processeur du PC et le processeur de la
carte Wizdom).

Dans cet exemple, les paramètres des cavaliers sur la carte sont configurés pour
utiliser une interruption de matériel 7 et une adresse mémoire de début de
D000.
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Card base address  spécifie l’emplacement de début de la mémoire de
l’adresse RAM à double accès. Cette adresse doit correspondre aux
paramètres des cavaliers de la carte. La carte utilise 8K de mémoire
physique.

Hardware Interrupt  identifie le paramètre du cavalier W8 sur la carte
Wizdom. Ce cavalier sélectionne la requête IRQ que la carte génère
quand elle exécute une écriture à double accès (IRQ2 - IRQ7).
Sélectionnez none  si aucun cavalier n’est installé sur W8.

Quand la carte Wizdom écrit une valeur d’entrée dans un emplacement
mémoire, la carte génère une interruption (si configurée), dictant à
l’objet Wizdom de Lookout de procéder immédiatement au scanning.
Ceci accélère les réponses aux modifications des champs.

Remarque Vérifiez qu’aucun autre driver n’est mappé à l’emplacement mémoire ni à
l’interruption sélectionnés.

Remarque Etant donné que le gestionnaire de mémoire EMM386 ne reconnaît que
les premiers 4K de mémoire mappée, il faut ajouter une déclaration
d’exclusion de mémoire dans le fichier CONFIG.SYS de votre ordinateur,
comme indiqué dans la documentation du fabriquant de la carte.
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Données membres Wizdom

Donnée membre Type Lecture Ecriture Description

B0-B1903 Numérique Oui Oui Mot 8 bits s’étendant de 0 à 255

B0.0-B1903.7 Logique Oui Oui 1 bit dans un mot 8 bits

BCD0.2 - BCD1900.16 Réservé pour de futures
applications de décimaux à
codage binaire

BS0-BS1903 Numérique Oui Oui Mot signé 8 bits s’étendant de
-128 à 127

BS0.0-BS1903.7 Logique Oui Oui 1 bit dans un mot signé 8 bits

DF0-DF1896 Numérique Oui Oui Mot de précision double à virgule
flottante IEEE 64 bits

DS0-DS1900 Numérique Oui Oui Mot de double précision signé 32
bits s’étendant de -2 147 483 648
à 2 147 483 648

DS0.0-DS1900.31 Logique Oui Oui 1 bit dans un mot signé 32 bits

DW0-DW1900 Numérique Oui Oui Mot de double précision 32 bits
s’étendant de 0 à 4 294 967 295

DW0.0-DW1900.31 Logique Oui Oui 1 bit dans un mot 32 bits

F0-F1900 Numérique Oui Oui Mot à virgule flottante IEEE 32
bits

S0-S1902 Numérique Oui Oui Mot signé 16 bits s’étendant de -
32 768 à 32 767

S0.0-S2047.15 Logique Oui Oui 1 bit dans un mot signé 16 bits

STR0-STR1900 Réservé à l’application future de
chaîne de caractères

W0-W1902 Numérique Oui Oui Mot 16 bits s’étendant de 0 à 65
535

W0.0-W1902.15 Logique Oui Oui 1 bit dans un mot 16 bits

Commentaires Les adresses des données membres listées dans la table de données
membres partagent les mêmes 4K de mémoire et donc le même bit :

B391.5 = W391.5 = DS391.5
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XBarR
La classe d’objets XBarR est un des outils MSP de Lookout qui joue un
rôle important dans le contrôle de la qualité totale de votre entreprise.
Cette classe d’objets affiche graphiquement un graphe X-barre et/ou un
diagramme R pour un signal donné. Ces diagrammes de contrôle
(nommés également diagrammes des moyennes et d’échelle,
respectivement) vous permettent de suivre votre processus pour
déterminer s’il est sur le point de perdre le contrôle et nécessite un
redressement.

Boîte de dialogue des paramètres de définition XBarR

L’objet XBarR lit la valeur Observed signal chaque fois que Observed
trigger  passe d’Arrêt à Marche. Quand l’objet recueille les observations
spécifiées dans Number of observations per sample  (2-25), il calcule
la moyenne et l’échelle et les trace dans leurs diagrammes respectifs.
Chaque diagramme trace le nombre d'échantillons spécifiés dans
Number of samples to display .
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X-bar Chart limits et R Chart limits peuvent être spécifiés ou calculés,
selon vos besoins. L’objet calcule continuellement les limites du
diagramme selon les nouveaux échantillons à mesure qu’ils
s’accumulent. Ces limites calculées vous permettent de suivre votre
processus pendant un certain temps pour déterminer ses paramètres
limites opérationnels. Une fois que vous connaissez les limites de votre
processus, vous pouvez spécifier les paramètres de limites des
diagrammes en les saisissant directement.

Les limites LCL et UCL identifient les limites de contrôle supérieures et
inférieures. Ces limites définissent en général la gamme acceptable du
processus. CL identifie la ligne médiane. Pour le diagramme X-barre, la
ligne médiane est la moyenne des moyennes d’échantillons. Pour le
diagramme R, la ligne médiane est la moyenne des gammes
échantillonnées.

Vous pouvez afficher les diagrammes X-barres et les diagrammes R en
plusieurs couleurs, avec des styles d’étiquettes et de pas de grille
différents.

Boîte de dialogue des paramètres d’affichage de XBarR
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Quand vous saisissez les paramètres des limites LCL , UCL et CL pour un
diagramme, les valeurs saisies représentent les limites indiquées dans le
diagramme. Le diagramme X-barre suivant indique la limite de contrôle
supérieure, la ligne du centre et la limite de contrôle inférieure saisies
sous forme de constantes. Le diagramme indique que la majorité des 30
derniers échantillons dépassent légèrement la ligne médiane, demandant
peut-être un redressement du processus. Les limites de contrôle
calculées, illustrées sous le graphe, indiquent les nouvelles limites
pouvant être utilisées selon les échantillons courants tracés.

Diagramme X-barre illustrant la limite de contrôle supérieure, la ligne médiane
et les limites de contrôle inférieures.

Si vous laissez  vides un ou plusieurs paramètres de limite pour un
diagramme dans la boîte de dialogue des paramètres de définition, le
diagramme affiche ses limites calculées. Comme l’illustre le diagramme
R ci-dessous, les limites calculées et les limites tracées sont représentées
par la même courbe.

LCL

CL

UCL
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Diagramme R  illustrant la limite de contrôle supérieure, la ligne médiane et la
limite de contrôle inférieure calculées selon les échantillons tracés.

Données membres XBarR

Donnée membre Type Lecture Ecriture Description

R_ChartMax Numérique Oui Non Identifie la partie supérieure du
graphe du diagramme d’échelle (la
valeur du tracé à 100 % de l’axe Y).
L’objet recalcule cette valeur à
mesure que chaque échantillon
nouveau est lu pour assurer que le
tracé est toujours visible sur le
graphe

R_ChartMin Numérique Oui Non Identifie la partie inférieure du
graphe du diagramme d’échelle (la
valeur du tracé à zéro % de l’axe Y).
L’objet recalcule cette valeur à
mesure que chaque échantillon
nouveau est lu pour assurer que le
tracé est toujours visible sur le
graphe

LCL

CL

UCL
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Données membres XBarR (suite)

Donnée membre Type Lecture Ecriture Description

R_CL Numérique Oui Non Ligne médiane du diagramme
d’échelle indiquant la moyenne des
gammes échantillonnées calculées
de la façon suivante :

R

R

n

i
i

n

= =
∑

1

R_LCL Numérique Oui Non Limite de contrôle inférieure du
diagramme d’échelle, calculée selon
les données échantillonnées de la
façon suivante :

LCL D R= 3

où D3  provient d’une table de

facteurs de contrôle standard 3-
sigma

R_Sample Numérique Oui Non Echelle calculée, R , du dernier
échantillon d’observations achevé,
où

( )
R

n

i
i

n

=
−

=
∑ max min

1

R_UCL Numérique Oui Non Limite de contrôle supérieure du
diagramme d’échelle, calculée selon
les données échantillonnées de la
façon suivante :

UCL D R= 4

où D4  provient d’une table de

facteurs de contrôle standard 3-
sigma
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Données membres XBarR (suite)

Donnée membre Type Lecture Ecriture Description

Visible Logique Oui Oui Quand Vrai, les diagrammes X-
barre et R deviennent visibles sur le
panneau de contrôle. Quand Faux,
ils sont invisibles. La valeur par
défaut est Vrai

Xbar_ChartMax Numérique Oui Non Identifie la partie supérieure du
graphe du diagramme X-barre (la
valeur du tracé à 100 % de l’axe Y).
L’objet recalcule cette valeur à
mesure que chaque échantillon
nouveau est lu pour assurer que le
tracé est toujours visible sur le
graphe

Xbar_ChartMin Numérique Oui Non Identifie la partie inférieure du
graphe du graphe du diagramme X-
barre (la valeur du tracé à zéro %
de l’axe Y). L’objet recalcule cette
valeur à mesure que chaque
échantillon nouveau est lu pour
assurer que le tracé est toujours
visible sur le graphe

Xbar_CL Numérique Oui Non Ligne médiane du diagramme X-
barre indiquant la moyenne des
moyennes échantillonnées calculée
de la façon suivante  :

x

x

n

i
i

n

= =
∑

1
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Données membres XBarR (suite)

Donnée membre Type Lecture Ecriture Description

Xbar_LCL Numérique Oui Non Limite de contrôle inférieure du
diagramme X-barre, calculée de
la façon suivante :

LCL x A R= − 2

où A2  provient d’une table de

facteurs de contrôle standard 3-
sigma

Xbar_Sample Numérique Oui Non Moyenne calculée du dernier
échantillon d’observations
achevé, où

x

x

n

i
i

n

= =
∑

1

Xbar_UCL Numérique Oui No Limite de contrôle supérieure du
diagramme X-barre, calculée de
la façon suivante :

UCL x A R= + 2

où A2  provient d’une table de

facteurs de contrôle standard 3-
sigma

Objets associés Average (moyenne), Histogram, Maximum, Minimum, Sample 
(échantillon)

Fonctions associées Avg, Max, Min, Stdev, Stdevp, Sum, Var, Varp
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